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1 Welcome 

Thank you for choosing GCAS® as a companion for your gas chromatograph devices. These help files 

provide guides about GCAS operation. 

1.1 What GCAS is 

GCAS® (Gas Chromatography Analysis Software) is a software tool specifically designed for GC (Gas 

chromatograph) conditional-based monitoring. The main purposes of the monitoring method embed-

ded in the software are: 

1. To analyse instantaneous GC data to see if it is working properly, 

2. To provide and analyse historical data in order to identify changes and predict failures, 

3. To support extended reproducibility tests so that the GC uncertainty may be determined. 

GCAS comes in two versions, GCAS Web and GCAS Desktop. GCAS Web is available for customers us-

ing i-Vigilant central database. Both share the same database, so that you can log in to either version 

and see the same data. GCAS Web is being phased out, therefore i-Vigilant Technologies encourages 

all customers to move onto GCAS Desktop. 

1.2 System Requirements 

GCAS® requires: 

1) Multi-core CPU. 

Even low-power processors like Intel® Atom Z3000 series—found on many tablets and on Intel® 

Compute Stick—would suffice; but running GCAS inside a virtualised environment with single-core 

processor (such as inside Microsoft Azure virtual machine A1 basic tier) will impact the perfor-

mance. 

2) 2 GB of RAM. 

Normal GCAS operation consumes around 60-150 MB RAM, so we need to make sure there is 

enough memory for the entire OS. 

3) Microsoft® Windows® Vista, Windows 7, Windows 8, Windows 8.1, or Windows 10. 

Although many customers still use Windows XP (in 2017), it is no longer supported. GCAS cannot 

function correctly on XP. 

4) Microsoft .NET Framework 4.5.2  

This is available from https://www.microsoft.com/en-us/download/details.aspx?id=42642. 

Windows 8.1 and 10 have included .NET Framework 4.5 therefore no need to install .NET Framework 

unless the setup package tells you. 

5) Microsoft SQL Server Compact Edition (CE) version 4.0. 

This is available from  http://www.microsoft.com/en-us/download/details.aspx?id=17876. 

6) Microsoft Visual C++ 2010 Runtime redistributable x86. 

This is available from http://www.microsoft.com/en-us/download/details.aspx?id=5555.  

http://i-vigilant.com/
https://www.microsoft.com/en-us/download/details.aspx?id=42642
http://www.microsoft.com/en-us/download/details.aspx?id=17876
http://www.microsoft.com/en-us/download/details.aspx?id=5555
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7) To use data capture and/or data provision feature, your PC should have either serial port (RS-

232), Ethernet port, or Wi-Fi. 

8) Internet connection, preferred. 

9) 1280 x 720 screen resolution. 

10) If you need to work with Microsoft Access databases or to export data to Microsoft Access data-

base: You would need a separate licence of Microsoft Office or Microsoft Access 2010/2013/2016, 

or either the free Microsoft Access Database Engine 2010, Microsoft Access Runtime 2013, or Mi-

crosoft Access Runtime 2016. 

a) Get Microsoft Access Database Engine 2010 from  

http://www.microsoft.com/en-us/download/details.aspx?id=13255. 

b) Get Microsoft Access Runtime 2013 from  

http://www.microsoft.com/en-us/download/details.aspx?id=39358. 

c) Get Microsoft Access Runtime 2016 from  

https://www.microsoft.com/en-us/download/details.aspx?id=50040.  

1.3 Supported GC Brands 

GCAS is compatible with any gas chromatograph device using thermoconductivity detector (TCD) 

and peak area formula to calculate response factor.  

GCAS supports these gas chromatographs: 

1. Brand-specific: 

a. Daniel (Emerson) 

b. ABB 

c. Siemens 

d. Elster (Honeywell) 

2. Non brand-specific: 

a. LNG chromatographs (Liquid Natural Gas, up to pentane) 

b. BTEX analysers (aromatic hydrocarbons) 

c. Single gas analysers 

If your GC device is not in this list, consult our support team to find a workaround. Worst case is GCAS 

can only trend your historical data without the ability to provide additional useful information such as 

correlation (R2) and uncertainty values. 

1.4 GCAS Licence and Activation 

GCAS requires a valid GCAS licence to run. GCAS licence carries the information required such as what 

features are available to you, how many number of GC devices you can use, and the expiry date. 

Current version of GCAS operates GCAS licence version 3. GCAS licence version 1 was used for devel-

opment purposes and is now obsolete. GCAS licence version 2 was used by beta (test) version of 

http://www.microsoft.com/en-us/download/details.aspx?id=13255
http://www.microsoft.com/en-us/download/details.aspx?id=39358
https://www.microsoft.com/en-us/download/details.aspx?id=50040
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GCAS. Although current GCAS can read GCAS licence version 2, some features will be unavailable and 

we strongly recommend users of licence version 2 to upgrade their licences into version 3. 

Customers can select which GCAS features to include in order to suit their need. The features are listed 

here: 

o Modules  

• Basic features (always included) – Analysis parameter, Footprint, Calibration data, 

and Comments.  

• Data Analysis 

• Live Data Analysis 

• Data Comparison 

• Calibration Gas Certificate 

• Uncertainty Calculation (automatically unlocks calibration gas certificate module) 

• Uncertainty Trend (automatically unlocks calibration gas certificate module too) 

• ISO 6976 Calculator 

• ISO 6976 Trend 

• GPA 2172 Calculator 

• GPA 2172 Trend 

• ISO 10723 

• Lag Time Calculator 

o Device communication  

• Modbus® Client over Serial 

• Modbus® Client over TCP 

• Modbus® Server over Serial 

• Modbus® Server over TCP 

o Data import  

• Text Import (for Daniel, ABB, and Siemens GCs) 

• CSV Import 

• Manual Data Entry (always included) 

o Data export  

• Export to CSV 

• Export to Microsoft SQL Server Compact Edition 

• Export to Microsoft Office 

o Report 

• Simple Report 

o Databases  

• i-Vigilant Central Database 

• Local Corporate Database 

• Local Offline Database (always included) 

• Work-offline Capability 

Our website offers two packages of GCAS namely Advance and Comprehensive. GCAS Basic package 

has been discontinued and is now superseded by GCAS Demo package (free with read-only access). 

Features included in each package are listed in this table. 

http://www.i-vigilant.co.uk/
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Features GCAS Advance GCAS Comprehensive 

Modules   

Basic features ✓ ✓ 

Data Analysis ✓ ✓ 

Live Data Analysis ✓ ✓ 

Data Comparison  ✓ 

Calibration Gas Certificate ✓ ✓ 

Uncertainty Calculation ✓ ✓ 

Uncertainty Trend ✓ ✓ 

ISO 6976 Calculator ✓ ✓ 

ISO 6976 Trend  ✓ 

GPA 2172 Calculator ✓ ✓ 

GPA 2172 Trend  ✓ 

ISO 10723 ✓ ✓ 

Lag Time Calculator ✓ ✓ 

Communication   

Modbus® Client over Serial  ✓ 

Modbus® Client over TCP  ✓ 

Modbus® Server over Serial  ✓ 

Modbus® Server over TCP  ✓ 

AlertMe  ✓ 

Data import   

Text import ✓ ✓ 

CSV import ✓ ✓ 

Manual Data Entry ✓ ✓ 

Data export   

Export to CSV ✓ ✓ 

Export to Microsoft SQL Server CE ✓ ✓ 

Export to Microsoft Office ✓ ✓ 

Report   

Simple Report ✓ ✓ 

Databases   

i-Vigilant Central Database ✓ ✓ 

Local Corporate Database ✓ ✓ 

Local Offline Database ✓ ✓ 

Work-Offline Capability ✓ ✓ 

Users buying GCAS Advance package have options to purchase add-on features à la carte which are 

appended to their licences. Visit our website for pricing information of each feature. Users buying 

GCAS Comprehensive package have no more add-ons available as they already get access to all GCAS 

features. 
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1.4.1 Types of Licence 

There are two types of GCAS licence: Lifetime and Subscription.  

Lifetime licences or perpetual licences are GCAS licences that never expire. Lifetime licences are in-

tended for customers who purchased retail copies of GCAS, i.e. one-off purchases.  

On the contrary, subscription licences are licences that renew periodically. They are intended for cus-

tomers with subscription plan. Depending on customer preference, renewal period can be monthly, 

quarterly, semester, annual, or biannual. Customer with subscription licence should check for licence 

update periodically or leave the automatic licence update on, in order to ensure continuous access to 

GCAS. 

Trial licence is a subtype of subscription-based licence for new and prospective customers. Depend-

ing on customer request, i-Vigilant Technologies Limited issues trial licences which typically last be-

tween one to three months. Usually, trial licences carry all GCAS features with a limited maximum 

number of GC devices. Within their trial period, customers can upgrade their licences to standard sub-

scription licence with select GCAS features and enough number of GCs to suit their needs. 

Instant trial licence is more specific type of trial licence. This licence is issued only once per computer 

and only valid for 4-day trial. An instant trial licence is upgradable to a regular trial licence (see the 

previous paragraph) which later on, still upgradable again to a full licence. Read more about instant 

trial. 

1.4.2 How Many PCs? 

When you purchase GCAS from i-Vigilant website, the website asks for information such as the pack-

age you want, any feature add-on packs, how many GCs and how many PCs. We generate your licence 

based on this information thus your licence is ready when you go through online activation process. 

Currently our website offers 1, 3, or 5 computers. Contact us if you need more than 5 computers so we 

can arrange a discount for you. This number of PC becomes the activation count. One successful 

online activation will reduce this number by one. If you don’t have internet access and request offline 

activation by sending your computer code, we will send your licence via email then we will also de-

crease your activation count by one. When this activation count reaches zero, you have used up all 

your available licences and cannot activate GCAS on other PCs. 

1.4.3 Online Activation 

If your computer has a working internet connection, we advise to activate your GCAS online. During 

online activation, GCAS contacts GCAS Activation Server maintained by i-Vigilant Technologies to re-

trieve your licence. 
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1. The first time GCAS is run, it requests for activation. The following window pops up. 

 

2. Online activation requires internet connection. 

3. Click Activate online button and you shall see this window: 

 

4. Registration name is your customer identifier name as you have entered during checkout pro-

cess on our website. For offline purchase, we will send your registration name. This name is case 

sensitive, requires exact spelling. 

5. Registration key is six numeric digits and doesn’t start with zero. This key is available on the 

confirmation page and my account page (for online purchase) or in our confirmation email (for 

offline purchase). 

6. If you purchased GCAS through an offline channel such as PO or direct meeting: 

Tell us your computer code either by email, fax, or phone. Our email address is support@i-Vigi-

lant.com. Wait for our confirmation that we have successfully generated your licence. 

7. If you purchased GCAS through our website: 

You don’t have to tell your computer code because your licence is generated automatically at the 

time of first activation. As long as you entered correct registration name and key (case sensitive) 

and you haven’t exceeded your activation count, licence generation should work without prob-

lems. 

8. Type your registration name and registration key, then click  Activate. Provided that all data 

were correct, this window will show. 

mailto:support@i-Vigilant.com
mailto:support@i-Vigilant.com
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Otherwise you see an error message similar to this one. 

 

9. Click Install licence. If UAC is enabled on your computer, and it is usually enabled by default, a 

UAC prompt will appear. If you are the computer administrator, click Yes to continue. Otherwise 

ask your computer administrator to type in the admin password. 

10. The following window confirms that your licence and registration key have been installed on your 

computer. 

 

11. Click Close and now GCAS is activated, ready to use. 

12. In rare cases where UAC is disabled possibly by your system administrator, the licence would be 

installed automatically without UAC prompt. This implies you wouldn’t see the screen as depicted 

in step 8 and 10. 

1.4.4 Offline Activation 

For computers without internet connection e.g. on off-shore location or remote site, you can activate 

GCAS offline. You need your licence string (or QR code image file) together with your registration key 

stored offline such as in your corporate email or in a USB flash drive. 
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1. The first time GCAS is run, it requests for activation. The following window pops up. 

 

2. Offline activation does not require internet connection. 

3. Click Activate offline. UAC prompt may appear. 

4. GCAS Activator window is displayed. 

 

5. Tell us your computer code via email to support@i-vigilant.com or via fax. We need this code to 

generate your licence. After we generate your licence string, we will reduce your activation count 

by one (1) accordingly. 

6. Once you have received our reply, either enter the licence string or load the QR code image. Then 

enter the registration key as well. 

7. Licence string is a long, encoded text which looks similar to this. 

zZPgHRyhHRqMsZijmaukdJaW-

laqhpZulp4SuroCR76Oum6KXoqiZmJ3mkaC1eZq2qpidn6eOp4WYl4GYrYukuHmnl6KutqqupKqKq

ZyU3e/brLWklouss5qgspajqoGTkRSE-

qea6ie6GqqqRnL92obiIqamkvaKsoLSsjaCegaKnrKigpaV7uA== 

mailto:support@i-vigilant.com
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8. QR code image file looks like the following. 

 

This is a standard QR code image that contains the licence string itself. You can use your 

smartphone or any QR code scanner to verify its content. 

9. Click Install on GCAS Activator form. 

10. The following message box confirms that your licence and registration key have been successfully 

installed. On some Windows versions, this message is displayed in a command prompt window 

instead of a message box. 

 

11. Click OK and GCAS is activated, ready to use. 

12. In case GCAS Activator displayed a message about your computer being locked, that is because 

the licence string or the QR code image had been previously installed on this computer but 

somebody deactivated GCAS at some point. You need GCAS Licence Unlock Tool to undo this 

lock, which we will provide upon request. 

1.4.5 Instant Trial 

Instant trial is offered to new and prospective customers to try GCAS quickly without the hassle of 

sending your computer code and waiting for your licence in our reply and for us to set up a database 

for you. Unlike "regular" trial licences, instant trial licence is only valid for 4 (four) days, including the 
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day you started the instant trial. After your trial period expires, GCAS will stop working. You can then 

request for an extended trial or purchase a full licence altogether. Contact us to get an arrangement. 

To try GCAS using instant trial, click Instant 4-day trial on this window.  

 

Read the information presented in the oncoming window. If you agree, click Agree and start instant 

trial. 

 

Instant trial information window. 

A UAC prompt may appear. If you are the computer administrator, click Yes to continue. Otherwise, 

ask an administrator to enter the required password.  

mailto:support@i-Vigilant.com
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If you cannot find the button, instant trial may not be available for you because probably you already 

used it before. Instant trial is only offered once per computer. For example, if a user tries to uninstall 

GCAS after his trial period is over and then reinstalls the software again, he will not see the Instant 4-

day trial button a second time. 

1.4.6 Automatic Licence Update 

Licence update is an update for your licence. For example, a customer has subscription plan and they 

just extended their subscription for another month, the expiry date on their licence is then updated to 

the latest subscription end date. Another example, a customer decided to add more features to their 

licence. Their licence is updated to reflect this change. 

By default, GCAS checks for licence update in GCAS Activation Server once during launch, and once 

every 24 hours. Automatic licence update works only if your computer has a working internet connec-

tion. 

1. If there is any update for the licence in GCAS Activation Server, a window similar to this one shall 

appear. The text on this notification window may vary depending on what kind of update is availa-

ble for you (e.g. extension of expiry date, feature update, or limit upgrade on number of GC). 

 

2. Click Install. It may trigger a UAC prompt. Click Yes on the UAC prompt or ask your computer ad-

ministrator to type the required password. GCAS will update the licence and the window similar to 
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this one shall appear. 

 

3. In rare cases where UAC is disabled by your system administrator, or if GCAS is running in ele-

vated mode (run as administrator), the notification window will appear green instead of yellow. 

The licence is updated automatically and you don’t have to click the Install button. 

 

To configure how GCAS should check licence update automatically, log in to GCAS and go to the Help 

menu > Licence > Configure Auto-update. 
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1.4.7 Manual Licence Update 

1.4.7.1 If you are online 

You can force GCAS to check for licence update now. To do so, go to the Help menu > Licence > 

Check for update. 

 

1.4.7.2 If you are offline 

Should the computer have difficulties connecting to the internet e.g. on remote areas or off-shore 

sites, we will send you a new licence string and/or QR code. To install this new licence, go to the Help 

menu > Licence > Manual Update. 

 

UAC prompt may appear. Afterwards, either enter the new licence string or open the new QR code, 

but re-enter the same registration key as the previous one. (The software automatically does this for 

you.) Click Install and GCAS Activator will replace the installed licence string with the new one. 
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1.4.8 Deactivation 

To uninstall your licence and registration key, start an elevated command prompt (run as administra-

tor) and then execute this command on GCAS installation directory: 

GCASActivate /revoke 

You need an internet connection to perform deactivation. 

 

Deactivation automatically increases your activation count, unless a problem occurred during the pro-

cess such as connection problem to GCAS activation server. If your activation count is not increased, 

please contact us so we can raise your activation count manually. Please attach a screenshot of your 

command prompt window in your email.  
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The deactivation will also "lock" your computer so that the licence string or QR code you have previ-

ously used on this computer cannot be reused. Therefore, we advise not to perform deactivation un-

less necessary. If you are decommissioning or recycling your old computer, it is better to transfer your 

GCAS licence to the new computer using licence migration tool. 

Instant trial users, do not deactivate your instant trial licence because instant trial licence is only of-

fered once per computer—unless you have a full licence or extended trial licence available, or unless 

you decided not to use GCAS. 

1.4.9 Licence Migration 

A GCAS licence can be transferred to another computer using GCAS Licence Migration Tool. This tool 

should be accessible from Start Menu > All Programs > i-Vigilant Technologies > GCAS Licence Mi-

gration. Licence migration is useful when you need to replace your workstation computer with a new 

hardware. 

Licence migration requires internet connection on the old computer which the licence will be trans-

ferred from. Here are the steps. 

1. First, get the computer code of the new computer to which the licence will be transferred. You can 

do this by running GCAS Activator on the new computer (as if you were to do online activation, or 

running GCAS Activator with /compcode command line switch). The computer code is twelve dig-

its, with hyphen separating every 4 digits. 

2. On old computer with existing GCAS licence, run GCAS Licence Migration Tool. A UAC prompt may 

appear. If you are the computer administrator, click Yes to continue. Otherwise, ask an administra-

tor to enter the required password. 

3. Type the computer code of the new computer in the input box. 

 

4. Click Migrate. This tool will connect to GCAS license server and requests a migration. 
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5. The status box in GCAS Licence Migration Tool should notify you when the migration process has 

finished. 

 

6. Go to your new computer and carry out the usual online activation using your registered cus-

tomer name and 6-digit registration key. During migration, this key remained the same. Only the 

computer code embedded in your licence changed. 

Note 

Licence migration deactivates GCAS on your old computer effective immediately. In case of GCAS li-

cence server could not be reached during migration process (e.g. your computer was offline), the de-

activation still occurs. Contact us so we can finish the licence migration for you. Please attach a screen-

shot of GCAS Licence Migration Tool window in your email as we need both computer codes. 

1.5 Integrity Check 

GCAS performs a check on the installation directory during start up in order to ensure that all required 

files are present and unmodified. When GCAS detects a file is missing or has unauthorised changes, it 

presents a warning similar to this. 

mailto:support@i-Vigilant.com
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This notification does not prevent you from using GCAS; you could still dismiss the notification 

through OK button and log in to GCAS as usual. However, there is a higher risk of GCAS crashing at 

some point later. Especially when there is a .dll file missing, this will raise Dll Not Found Excep-

tion or File Not Found Exception error message later on. 

If you see this warning every time you start GCAS, the first step to try is to reinstall GCAS. Have your 

registration key and your licence string or QR code ready in case you need to reactivate GCAS again. 

Should the reinstall action provides no remedy to the problem, you can disable this feature by running 

GCAS with an additional /disablefilecheck parameter. You might want to modify the shortcut to 

GCAS to include this additional switch. 
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2 Database 

GCAS Web and GCAS Desktop reads and stores data into GCAS database. This chapter explains further 

about GCAS database. 

2.1 Where Your Data is Stored 

There are three different choices of data storage: 

1. i-Vigilant central database 

Data is stored in database server(s) maintained by i-Vigilant Technologies. Using this server re-

quires internet connection. 

2. Corporate database server 

Also known as "local corporate database", your data is stored in a database server within your 

company local area network (LAN). 

3. Local offline database 

Data is stored in a file on your computer. This database is permanently offline, isolated from the 

outside world. 

 

Each choice is a distinct GCAS feature in your GCAS licence. For instance, customer with GCAS licence 

that only includes i-Vigilant Central Database and Local Corporate Database cannot use local offline 

database. 

2.2 Supported DBMS 

GCAS database is a relational database managed by a Database Management Server (DBMS). GCAS 

does not develop its own DBMS, but instead uses one of the following commercial DBMSes. 

1. Local corporate database 

a. MySQL version 5 or later, 

b. Microsoft SQL Server 2008 (untested), 2012, or 2014. 

2. Local offline database 

a. Microsoft SQL Server Compact Edition v4.0, 

b. Microsoft Access 2010/2013/2016. 

*Especially for Microsoft SQL Server 2014, you need to install updates for Microsoft .NET Framework 4 

from Windows Update. Microsoft SQL Server 2016 and 2017 are already released at the time this doc-

ument is written, but we haven’t had opportunity to test it out. 

Should you have interest in setting up a local corporate GCAS database within your company network 

or using a local offline database for your company, contact our support team to arrange a deployment 

for you. 
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2.3 Change Database 

Most users do not have to worry about changing database. But if your data is stored in two or more 

databases, tell GCAS which database it should connect to. 

To switch database, make sure that no forms open on your work area and you are not working offline. 

Next, go to File menu > Change Database. 

 

This menu will bring up the Change Database dialogue. Choose which database you would like to use 

whether i-Vigilant central database, your own corporate database, or an offline database file.  
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Enter the required parameters, e.g. IP address or server host name, DBMS username, and DBMS pass-

word. You can test whether the parameters are correct through Test connection button. Make sure 

you have your GCAS username and password registered in the desired GCAS database so you can log 

in to GCAS later. When you click OK, GCAS asks you whether to switch it now or later. 

 

If you click OK, GCAS will: 

1. Unload all workspaces and devices from current database, 

2. Disconnect from current database, 

3. Connect to the new database, and finally 

4. Load workspaces and devices from new database. 

Otherwise if you click Cancel, GCAS keeps connection to current database until you exit the software. 

You can resume working afterwards if your credential (username and password) is exactly the same in 

both databases. Otherwise, GCAS will log you out and you are prompted to log in again using the cor-

rect credential. 

 

2.4 Change Database before Login 

Starting from GCAS 1.7.3.0, login window displays a link to change database. Find the link near the top 

left corner under the database name. 
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This link brings you to the same Change Database dialogue. Enter the required parameters e.g. the IP 

address or server host name, DBMS username, and DBMS password. Click OK and GCAS will restart. 

After restart, you see the new database displayed on the top of login form. 
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2.5 Change Database without Running GCAS 

1. On Windows Vista or 7, open the Start menu then go to All Programs. Within i-Vigilant Tech-

nologies, click on the shortcut Change Database. 

 

2. On Windows 8 or 8.1, open the Start screen. Change the view to All Apps view. Scroll to the 

right, find i-Vigilant Technologies and the same shortcut should be there. 

 

3. On Windows 10, open the Start menu (or Start screen if you are on tablet mode). For Win-

dows 10 systems before the Anniversary Update, you also need to click All Apps. Jump to the 

letter I then find i-Vigilant Technologies. Inside the folder you will find the Change Database 

shortcut. 

 

https://blogs.windows.com/windowsexperience/2016/03/30/windows-10-anniversary-update-brings-new-experiences-and-developer-opportunity/
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4. Alternatively, run GCAS with additional /changedatabase parameter. 

 

Any of the actions above would bypass the login screen straight to the Change Database dialogue. On 

this dialogue box, select the desired database server. 

 

Click OK and start GCAS again. 
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2.6 Reconnect on Network Problem 

If you were disconnected from GCAS database server because of network problem*, GCAS displays an 

overlay notification and the status bar reads Network Problem. Click anywhere on the overlay to 

dismiss the notification. 

 

(*because of network problem and you do not have Work-offline Capability included in your licence; or you do have one but 

you've never set up a temporary database before) 

Wait for network connectivity to recover and then go to the File menu > Reconnect Database in or-

der to reconnect. If the reconnection attempt is successful, GCAS displays a tooltip notification while 

all workspaces and devices are reloaded. Please close and reopen all windows and dialogues that were 

opened before network disconnection. 
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2.7 Temporary Database 

Temporary database is a subset of whole GCAS database. This kind of database is used by work-offline 

feature, on which GCAS operates if it is in offline mode. Temporary databases use Microsoft SQL 

Server Compact Edition as the DBMS. 

Unlike the complete database that stores all data for all GCAS users, temporary database stores only 

data relevant to you. This means temporary database contains data for groups you have been as-

signed to, devices in these groups, and data for these devices only.  Each user would have their own 

temporary database. You would find these databases in [installation directory]\DB-

WorkOffline\ directory. 

By default, GCAS synchronises data from the database server to temporary database for one latest 

month. That is, today minus one month. You can change this range from one month up to two years. 

To set up your temporary database and change how much data to synchronise, go to chapter 33 Work 

offline and 33.1 Set up temporary database.  

2.8 Flush and Backup 

Flush and backup is applicable for users with local offline databases—that is, Microsoft SQL Server 

Compact Edition or Microsoft Access. Users of local corporate databases or i-Vigilant central database 

may skip chapter 2.8 and 2.9. 

Flushing a file means writing any pending changes to the file currently existing in computer memory 

into a permanent storage device—in this case, your hard disk drive. If for some unfortunate reason 

GCAS crashed, or a power cut happened, your database in computer memory/cache is lost. If GCAS 

doesn't flush the file at all, you will lose all data since the time GCAS was started. With a periodic flush, 

you lose only data since the last flush, not all the way back to GCAS start time. Nonetheless, GCAS 

cannot protect your hard disk from physical damages, especially during a power cut event. 

To flush your database manually, go to the File menu on main user interface. Select Flush and 

Backup, then Flush Now.  
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GCAS can also backup your database file after a flush. This feature is not yet turned on as you need to 

set up the backup destination directory beforehand. 

By default, GCAS flushes your database file once every hour. You can configure the automatic flush 

settings at chapter 2.9 Automatic flush and backup. 

2.9 Automatic Flush and Backup 

On main user interface, go to the File menu, select Flush and Backup, and finally Automatic Flush 

and Backup Preferences. This menu shows the Automatic Database Flush and Backup dialogue. 
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To turn off automatic flush, uncheck Flush the database into hard disk drive periodically. All other 

options will be turned off. 

Set the desired flush interval at Flush every field. You can choose between 0.5 hours (every 30 

minutes) and 168 hours (one week). The default is one hour. 

To turn on automatic backup, check Backup database file after flushing and set the desired backup 

directory. The backup directory can be on an internal hard disk of the same PC, an external hard disk, 

a USB thumb drive, or at a network location. Be sure that external drives are plugged or network path 

is accessible when GCAS finished flushing. For network locations, GCAS supports UNC notation such 

as \\server\shared directory\ or mapped network drives. Currently there is no support for FTP, 

SSH/SFTP, or WebDAV access.  

Create monthly subfolders: If this is ticked, GCAS creates additional folders having the format of 

year\month. The database backup files go to the directory\year\month. 

Append "backup" at the end of destination file name: Tick this to add "backup" to the file name. 

For example if your local offline database is Contoso.sdf, the backup file will be Contoso backup.sdf 

(or Contoso backup 1.sdf, Contoso backup 2014-12-11.sdf, depending on what selected at the file 

name options). Tick this option if you back up your database to the same directory as the local offline 

database file itself. 

Notify me if backup failed: This option causes GCAS to display a tooltip notification if backup opera-

tion failed. Cause of failure can be an unplugged external drive, insufficient free space on the hard 

disk, your external drive has a write-protect switch, invalid or inaccessible network locations, a firewall 

that prevented GCAS from reaching the network location, or the target network server is down. 

Use overlay notification: If this option is checked, GCAS prompts an overlay notification instead of a 

tooltip notification. Overlay notification is that black transparent overlay which covers entire working 

area — therefore it will interrupt your work, signifying backup is a high-priority task. Tooltip notifica-

tion disappears after few seconds, but overlay notification remains until you click it to dismiss. Addi-

tionally, upon dismissing the overlay notification, GCAS will open Windows Explorer or File Explorer 

and point it to the location of your local offline database, so you can do the backup manually. 

There are four options that determine how the backup file shall be named. 

1. Keep original file name: The backup file has the same name as the original database file 

(with additional word "backup" if you opt to append "backup" at the end of filename). GCAS 

overwrites the previous backup file because it has the same name. 

2. Append number: GCAS appends a sequential number at the end of file name. This option 

prevents overwriting. 

3. Append date: GCAS appends today's date to the backup file with the format of yyyy-mm-dd. 

This overwrites previous backup files on the same day, hence only one backup file can exist 

per day. 

4. Append timestamp: GCAS appends today's date and current hour and minute with the for-

mat of yyyy-mm-dd-hh-nn. This option prevents overwriting. 

  

file://///server/shared%20directory/
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3 Users, Groups, and Workspaces 

GCAS users are users who are authorised to access data in GCAS database. GCAS requires users to en-

ter their valid credential before presenting the main interface. Each user has their own user type and 

role, which control what kinds of data in the database are accessible to the user and what permissions 

the user has over the data. 

When a GCAS user is assigned into a group, this implies the user is authorised to access, read, and 

write data to a portion of GCAS database which is allocated for this particular group. A user may be 

assigned to multiple groups. 

3.1 User Types and Roles (Concept) 

User types and user roles constitute the access control list (ACL). If you use i-Vigilant central database, 

this ACL is shared between GCAS Web and GCAS Desktop. 

User types control which menus are available to the user. Default installation of GCAS would set up 

three user types: Administrator, super user, and general user. Administrator has access to all areas of 

GCAS modules and menus, while general user has access to essential features only. 

You can create custom user types and assign custom menu permissions to each of them if you are the 

GCAS administrator. To do so, read chapter 31.2 Define new user types and roles and 31.5 Menu per-

missions. 

User roles control which actions are available to the user. An action is a specific command available in 

some modules such as Footprint, Calibration Data, Mole Composition, and Device management. 

Those commands are accessible through the Action menu on the menu bar. Default installation of 

GCAS would set up six user roles: 

• System administrator 

• Engineer 1 

• Engineer 2 

• Partner 

• Read-only 

• Custom 

Similar to user types, system administrator has access to all actions in both GCAS Web and GCAS 

Desktop. On the other side, read-only role has the least access. 

You can also define your own user roles and assign action permissions to them if you are the GCAS 

administrator. Jump to chapter 31.2 Define new user types and roles and 31.6 Action permissions to 

read more. 
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3.2 Groups and Workspaces (Concept) 

Group is the highest hierarchy of all GCs. Each GC device has to be a part of a group. A GCAS data-

base should have at least one group. For example, a company called ACME Ltd. has three different 

platforms. These three platforms are all part of "Platforms" group. 

Workspace is a way to separate GC devices which belong to the same group. Each group may have 

several workspaces. For instance, group Platforms has three different platforms thus each platform has 

its own separate workspace: Platform A, Platform B, and Platform C. 

You should see workspaces of the groups assigned to you on the device panel in the main user inter-

face once you have logged in. Underneath these workspaces are GC devices. If you don't see anything 

on this panel, your GCAS administrator could have not assigned your user account to any groups yet. 

 

One group may have several workspaces, and one workspace contains many GC devices. One GC de-

vice cannot be assigned to multiple workspaces. Chapter 26 Device management explains more about 

creating, moving, and deleting devices (requires user type "super user"). Chapter 31.3 Manage groups 

explains about managing groups and workspaces within groups (requires user type "administrator"). 
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3.3 Edit Your Profile and Change Your Password 

Each user has their associated user profile and credential. User profile is a set of personal information 

such as real name, email address, postal address, and phone number. Credential is the username and 

password required to log in to GCAS database. 

3.3.1 Edit Your Profile 

To edit your user profile, follow the steps below. 

1. Go to the Profile menu > Edit profile. If you do not see this menu, your user type may not have 

the menu permission for it. Contact your GCAS administrator. 

 

2. This menu brings forth the Edit Profile dialogue. 

 

3. Enter the information then click Save. 

Regarding time zone 

If you use i-Vigilant central database, all user comments (e.g. in the Footprint or Calibration Data) have 

their timestamps converted to server time zone. GCAS uses this time zone information in your user 

profile to display timestamps of user comments in the correct time, including times when you are trav-

elling. If you enter a time zone other than the actual time zone you are living in, GCAS may display 

user comments with wrong time and wrong order. 

If you use local corporate database or local offline database, GCAS assumes the server time zone is 

the same as your time zone. No time zone conversion is performed. 
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Empty time zone information is replaced by the default Europe/London (UTC+0 standard time, 

UTC+1 daylight saving time). 

3.3.2 Change Your Password 

Once your GCAS administrator finished creating your user account, it has usually a default password 

of "password" (all lowercase). Otherwise, your administrator should have informed you about your 

initial password. To change your password, follow these steps. 

1. Go to the Profile menu > Change Password. If you don’t see this menu on the menu bar, your 

user type may not have the menu permission for it (i.e. your GCAS administrator prohibits you 

from changing password). 

 

2. The Change Password dialogue will appear. 

 

3. Type your current password once and your desired password twice. Then click Save to commit the 

change. 

4. Use the new password for the next time you log in to GCAS. 

 

3.4 Forgot Your Password? 

If you forgot your password and you use i-Vigilant central database, send a request for password reset 

quoting your GCAS username to support@i-vigilant.com then we will reset your password. 

If you use local corporate database or local offline database, contact your GCAS administrator to reset 

your password. To GCAS administrators, follow chapter 31.1 Manage users to reset a user’s password. 

mailto:support@i-vigilant.com
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3.5 Logging Out 

Go to the Profile menu > Log Out or press Ctrl+L shortcut key to log out. The next user can now 

log in. 

Be informed that if GCAS is in offline mode, only users who have set up their temporary databases can 

log in to GCAS. 

3.6 Automatic Logout on Inactivity 

To protect your data, GCAS can trigger automatic logout if it has been idle for certain period of time. 

The login form will look like this if you leave GCAS without any activity for some amount of time. 

 

By default, GCAS does not log you out automatically. To turn on this feature and to configure the idle 

timeout threshold, go to the Profile menu > Idle timeout. 

 

GCAS pauses the idle timer if you have data capture operation running in background, or if database 

synchronisation between database server and temporary database is in progress. However, GCAS does 

not pause the idle timer if GCAS is providing data through Modbus® server module. Your Modbus 

master software or device will stop getting data when the idle timer hits zero.   
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4 The User Interface 

This chapter is a quick guide about GCAS user interface. 

4.1 Login Form 

When you launch GCAS, you see a splash screen for few seconds then you are presented with login 

form. Enter your GCAS username and password then click Log in. 

 

At the top, login form displays which database you are connected to. In case you frequently switch be-

tween databases, this information helps you to enter correct GCAS credential of current database. You 

can change database straight from here, simply click Change database link under the database name. 

Icon on top-left corner indicates database connectivity status. 

Icon Meaning 

 Database connection is closed. This may indicate network problem or I/O error. If 

you don’t have GCAS feature Work-offline Capability in your GCAS licence, this icon 

is displayed during network problem. 

 (spinning) Database connection is in progress. You can enter credential but GCAS must wait 

until connection is opened successfully before validating your credential. 

 Database connection is open. 

 No database connection currently present. GCAS is in offline mode (see chapter 

33.10) thus no connection is initiated until you log in. 

If you see the offline warning icon next to the Quit button similar to the screenshot on the next page, 

this indicates the login form is in offline mode. Read more on chapter 33.10 Login form in offline 

mode. You need the GCAS feature Work-offline Capability to be included in your GCAS licence to use 

offline mode.  
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The check box Remember me on this database is intended to speed up login process in case you 

have only one user in the GCAS database (thus you always use the same credential) and it is a private 

computer, meaning no one else uses that computer. Ticking this box causes GCAS to automatically fill 

in your username and password the next time GCAS is launched, therefore you can simply hit Enter 

key to log in. Never tick this box on a shared or public computer. 

4.2 Main User Interface 

Once you have entered your valid credential, you would see the main user interface. 

 

4.2.1 Device Panel 

The device panel lists all workspaces assigned to you and all GC devices under these workspaces. Click 

on a GC device to select it. Features such as Footprint, Calibration data, Mole Composition, or Uncer-

tainty Calculator works with one device only, therefore make sure you select the correct device. The 

selected device name is displayed on the top of device panel. Learn more about workspaces. 
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Icon Meaning* 

 Daniel GC, C6+ 

 Daniel GC, C7+ 

 Daniel GC, C9+ 

 Daniel GC, C10+, both type A and type B** 

 ABB GC, C6+ 

 ABB GC, C7+ 

 Siemens GC, C6+ 

 Siemens GC, C7+ 

 Siemens GC, C9+ 

 Siemens GC, C10+ 

 Elster GC, C6+ 

 Elster GC, C7+ 

 Elster GC, C9+ 

 Elster GC, C10+ 

 LNG device, C2− 

 LNG device, C3− 

 LNG device, C4− 

 LNG device, C5− 

 BTEX analyser 

 H2S analyser 

 Moisture analyser (H2O) 

 Single gas analyser 

 Unsupported GC 

*Devices having pentane and above are split into two, the complete one (with neopentane) and without neopen-

tane. These two variants on each device type share the same icon. 

**Daniel C10+ type A has R2 sequence of [C3-C4-C5-C6] and [C7-C8-C9-C10]. 

Daniel C10+ type B has R2 sequence of [C3-C4-C5] and [C6-C7-C8-C9-C10]. 

4.2.2 Recent Device Panel 

Under the device panel is known as recent device panel. This section lists your recently used devices. 

Clicking a device on this list also selects it, which is the same effect as selecting the same device from 

the device panel above. Recent device list is persistent, that is, this list is preserved after you exit GCAS 

and run it again the next time. 
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4.2.3 Search Tool and Toolbar 

There is a small toolbar under recent device panel. It has a search tool to help you find a device if you 

have a lot of GC devices on your device panel. Type the device name and click  Search. When you 

are in search mode, the recent device panel temporarily turns into search results panel. After you find 

the device in the search result list, click the device to select it or click  Finish searching to close the 

search tool. 

The toolbar also contains three more buttons. 

Button What it does 

 Hide recent devices Hides the recent device panel. Your main device panel fills the entire 

sidebar. 

 Show recent devices If the recent device panel is hidden, this button brings it back visible. 

 Clear recent devices Clears your recent device list. 

 Refresh devices Reloads all workspaces and GC devices on your device panel. 

4.2.4 Status Bar 

Status bar at the bottom of the form hosts two elements: work-offline indicator and status indicator. 

Work-offline indicator appears if you have Work-offline Capability included in your GCAS licence and 

you are not using local-offline database. The indicator displays one of these symbols. 

Icon 

(depending on network 

medium) 

Text Meaning 

       Online 
GCAS is working online and is connected to database 

server. 

       Offline 
GCAS is working offline and is connected to temporary 

database. 

       Disconnected 
GCAS is not connected to any database servers. Go to 

File menu > Reconnect Database to reconnect. 

Status indicator displays general status of GCAS and status bar notifications, which are usually re-

lated to database, licence update, and later on–software updates. Specific status associated with spe-

cific module will not be displayed on the status bar, but on their own form instead. For example, Foot-

print form, Calibration Data form, Mole Composition form, and Data Analysis form have their own  

busy indicator on each user interface. Most of the time, status indicator reads "Ready". 

In case you have Modbus® Server over Serial or Modbus® Server over TCP included in your licence and 

you have configured Modbus server module (engine and instances) for data provision, the status bar 

also displays a link "Server is running" after Modbus server finished starting up. Clicking that link 

would take you to Modbus Server Interface window. 
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4.3 Choose Devices Dialogue 

Choose Devices dialogue appears when you open a GCAS database having number of GC devices ex-

ceeding the limit permitted by your GCAS licence. This dialogue lets you choose which GC devices to 

be accessible during current session of GCAS. 

 

As an example, meet Frank. He is a talented GC specialist service engineer. He bought a GCAS licence 

of 5 GC devices. One day a customer called, requesting his help to analyse problems on their GCs. The 

customer exported part of their GCAS database to a Microsoft SQL server compact database and 

handed the .sdf file to Frank. Unfortunately this database has 8 devices. When Frank changes database 

to this .sdf file, GCAS presents Choose Devices dialogue when the main window is being loaded. As his 

licence only permits five GC devices maximum, Frank must choose which five out of these eight to be 

visible during this session. To see the other three, Frank needs to restart GCAS to end current session 

and start a new session, thus displaying the Choose Devices dialogue again. This time, he chooses the 

remaining three (and optionally two out of the other five). 

4.3.1 Persistent Device Selection 

Device selection made through Choose Devices dialogue is not persistent. Next time GCAS is launched, 

it presents Choose Devices dialogue again, allowing you to select the other devices that were not visi-

ble during previous session.  
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To make your device selection persistent, tick Remember my selections on this computer. This 

causes GCAS to remember your selection for the next time GCAS is launched and thereafter. The se-

lection is valid for current GCAS database only. If you change into different GCAS database, Choose 

Devices dialogue may re-appear. Again, you have the option to remember your selections for that da-

tabase as well. 

 

At some point you may change your mind. Go to the Devices menu > Choose Devices to display this 

dialogue again. Here you can change your selected devices to make visible, or simply untick Remem-

ber my selections on this computer to cancel the persistence. Unticking the check box causes GCAS 

to re-display Choose Devices dialogue the next time GCAS is launched. Please note this menu is not 

visible directly after making selection through Choose Devices dialogue. It will be there the next time 

GCAS is launched, so you need to spend one session with your current device selections first. 

4.4 Notifications 

GCAS has four kinds of notifications. 

1. Status bar notification 

Status bar notification is displayed on—what else? —the status bar. This kind of notification 

usually contains less important messages. You probably see the message “xyz form is busy” 

most often when you attempt to close a form which was busy calculating. Status bar notifica-

tions dismiss themselves after few seconds. 
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2. Tooltip notification 

Tooltip notifications contain only informational messages but GCAS needs to catch your at-

tention. It appears at the top-left corner of work area. Tooltip notifications dismiss themselves 

after few seconds. 

 

 

3. Panel notification 

GCAS uses panel notification to ask your decision. The notification is displayed at the bottom 

of work area. Panel notifications have up to three buttons. Click one of them to perform the 

appropriate action and dismiss the notification. 

 

 

4. Overlay notification 

Possibly the most annoying one, overlay notification is the black transparent window which 

covers the entire work area. Overlay notifications interrupt your work therefore GCAS reserves 

them for urgent messages only. Click anywhere on the overlay to dismiss the notification. 

 

In case you missed a notification, check the Notification Log from the File menu. Notification Log win-

dow displays the last 10,000 notifications. Click Replay notification to replay it. Replayed panel notifi-

cations still show decision buttons, but this time these buttons serve no function other than to dismiss 

the notification. 
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4.5 Standard Colour Palette 

This chapter is hidden on the HTML version of GCAS manual. It only serves as a link destination target 

from chapters explaining alternative colour scheme for colourblind users. 

This table lists the standard colour palette which GCAS uses for all charts across different modules. 

Component  Colour Red 

(0-255) 

Green 

(0-255) 

Blue 

(0-255) 

Methane  8 13 145 

Ethane  3 225 72 

Propane  226 127 20 

i-Butane  226 214 45 

n-Butane  168 149 30 

Neopentane  12 172 48 

i-Pentane  205 226 118 

n-Pentane  35 114 21 

Hexane  97 109 95 

Heptane  53 127 220 

Octane  132 60 192 

Nonane  76 34 110 

Decane  4 2 0 

Nitrogen  234 58 58 

Carbon dioxide  21 210 198 

Unnormalised total or R2 pass limit  255 0 0 

Mean  233 94 211 

Mean + 2 standard deviations  241 136 136 

Mean – 2 standard deviations  116 170 236 
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When colourblind-assist is turned on, GCAS switches to this alternative colour palette and turns on 

several visual assistances. This is to aid users with protanopia and deuteranopia. 

Component  Colour R G B Line chart Pie chart Point 

chart 

Methane  8 13 145 Solid line Solid  

Ethane  214 185 90 Solid line Solid  

Propane  180 134 20 Dashed line Horizontal black dash ◆ 

i-Butane  255 255 0 Solid line + 

black shadow 
Solid 

 

n-Butane  188 145 29 Solid line Solid ◼ 

Neopentane  151 125 46 Solid line 10% white-dotted  

i-Pentane  247 217 117 Dashed line + 

black shadow 
10% black-dotted 

◆ 

n-Pentane  119 92 20 Dash-dot Vertical white dash ◼ 

Hexane  109 106 94 Solid line Solid  

Heptane  94 115 219 Solid line Diagonal white stripes  

Octane  53 74 193 Dash-dot Solid  

Nonane  30 42 110 Dashed line Diagonal white criss-cross ◆ 

Decane  4 2 0 Solid line Solid  

Nitrogen  84 78 59 Dash-dot-dot 25% white-dotted  

Carbon dioxide  156 163 195 Dash-dot + 

black shadow 
Solid 

◼ 

Unnorm. total/R2 pass  60 46 0 Solid line Solid ◆ 

Mean  155 151 136 Solid line 

Not applicable Mean + 2 std. dev  97 116 212 Solid line 

Mean – 2 std. dev  146 162 235 Solid line 
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5 Analysis Parameter 

Analysis parameters are collection of information that could assist users when analysing the GC perfor-

mance. When something goes wrong, it is a good idea to compare the parameters stored in this form 

and the actual condition observed on the GC device. 

To view or edit analysis parameter for a particular device, select that device on the device panel on the 

main user interface and then go to the View menu > Analysis Parameter. 

 

The first two fields, cycle time and R2 limit, accept only numeric value. The rest can accept alphanu-

meric characters. If no R2 limit entered, GCAS assumes the default R2 threshold to be 0.995. Click Save 

to commit the change, Cancel to discard the change, or Reset to reload previous values. 

If all input fields are greyed out, your user account might not have sufficient action permission to edit 

Analysis Parameter. Contact your GCAS administrator. 
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6 Gas Acronyms 

On GCAS Desktop and GCAS Web user interface, users might see C1, C2, C3, and so on. These are car-

bon atom count of supported alkane gases. GCAS supports C1 (methane) to C10 (decane). GCAS Web 

supports C1 to C7 (heptane) only.  

Several device types do not read alkane gases therefore such devices use different gas acronyms. 

Notation Alternative 

notation 

Gas name Alternative gas 

name 

Formula 

C1 C1 Methane  CH4 

C2 C2 Ethane  C2H6 

C3 C3 Propane  C3H8 

C4 NC4 n-Butane  C4H10 

 

 IC4 i-Butane, Isobutane Methylpropane C4H10 

 

C5 NC5 n-Pentane  C5H12 

 

 IC5 i-Pentane, Isopentane Methylbutane C5H12 

 

 NEOC5 Neopentane Dimethylpro-

pane 

C5H12 

 

C6 C6 Hexane  C6H14 

C7 C7 Heptane  C7H16 

C8 C8 Octane  C8H18 

C9 C9 Nonane  C9H20 

C10 C10 Decane  C10H22 

N2 N2 Nitrogen  N2 

CO2 CO2 Carbon dioxide  CO2 

B B Benzene  C6H6 

 

 



GCAS® Manual Guide rev. 26 

Page 67 of 587 

 

Notation Alternative 

notation 

Gas name Alternative gas 

name 

Formula 

T T Toluene Methylbenzene C7H8 

 

E E Ethylbenzene  C8H10 

 

X X Xylene 

  o-Xylene, 

  m-Xylene, 

  p-Xylene 

1,2-Dimethyl-

benzene; 

1,3- or 1,4- 

C8H10 

 

H2S H2S Hydrogen sulfide  H2S 

H2O H2O Water vapour, mois-

ture, dew 

 H2O 

G G “The gas” *  anything 

In case of butane and pentane, C4 (without prefix N or I) refers to n-Butane while C5 means n-Pen-

tane. 

* ”The gas” here refer to the gas used by  single gas analysers. It could be any gas, for example 

SO2, SO3, NOx, oxygen, fluorine, or helium. GCAS does not know which gas the device is using, there-

fore we call it “the” gas.  H2S analyser and  moisture analyser are specialised types of single 

gas analyser and use their appropriate gas names. 
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7 Footprint and Calibration Data 

A calibration data is one record or snapshot of gas properties of the analyte read by the GC device. 

GCAS records two main properties, which are the response factor (RF) and retention time (RT). 

GCAS assumes the response factor is calculated using peak area formula. 

𝑅𝐹 =
𝑝𝑒𝑎𝑘 𝑎𝑟𝑒𝑎

𝑚𝑜𝑙𝑒 𝑐𝑜𝑚𝑝𝑜𝑠𝑖𝑡𝑖𝑜𝑛
 

If your GC device uses peak height formula, that is, peak height divided by mole composition, unfortu-

nately your GC device is not compatible with GCAS. Or to the least, the RF chart on both Footprint 

form and Calibration Data form may not help you in the analysis of GC health status. 

Some GC devices use the inverted formula, which is mole composition divided by peak area. These 

devices are still compatible with GCAS however, with a few differences: 

1. RF chart will descend downwards instead of the usual ascending shape, 

2. RF values will be somewhere within the order of 10-6 to 10-8, instead of 106 to 108. 

3. Correlation charts will show a downward slope or negative gradient, unlike the usual upward 

slope. Though, R2 calculation stays the same. 

Elster GC is one example of GC device using the inverted formula. GCAS automatically inverts RF val-

ues when you import data from CSV file or via Modbus data capture. 

Footprint is a special type of calibration data which is usually: 

1. The first data of a GC device, or 

2. A known good data as a reference of comparison for future calibration data. 
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7.1 The Footprint Form 

 

Principal purpose of Footprint form is to show footprint records. It has three sections of charts, which 

are: 

1. Response factor chart, 

2. RF-MW log charts, 

3. Retention time chart. 

 

To open Footprint form, select the device from the device panel then go to View menu > Footprint. 

Response factor chart graphs the response factor from gas with lowest to highest molecular weight. It 

should have a nice ascending slope, otherwise it may indicate problems within your GC device. In case 

you wonder what the dropdown Single-point RF is doing at the top-left corner, that is for ISO 10723 

conversion and you also need GCAS feature ISO 10723 in your licence. Jump to chapter 7.12 for more. 

RF-MW log charts plot the base-10 logarithm of response factor (RF) against molecular weight (MW) 

of certain sequence of gases.  They also calculate the regression line, and computes the square of 

Pearson correlation coefficient (R) value. If R2 value is less than threshold set in the Analysis Parameter 

(default is 0.995), the number turns red and this may indicate problems within GC device. 

Depending on your GC device type, there may be one, two, three, or no RF-MW charts. Daniel, ABB, 

and Elster C6+ and C7+ devices have three correlation charts. GC devices with two ovens such as Dan-

iel C9+ and C10+ have two correlation charts only. Siemens has none. 

Retention time chart graphs the retention time value, or peak time, in the unit of seconds (s). 

http://en.wikipedia.org/wiki/Pearson_product-moment_correlation_coefficient
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Chart view 

To see the exact value of a data point on the charts, hover your mouse cursor over the dots. Other-

wise, switch to table view. On table view, MW is the molecular weight in gram per mole. 
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Table view 

Special value −1 

If you see −1 (negative one) for all RF values in this table view, this means the footprint does not have 

response factor data. This record may come from data capture operation but with an additional con-

figuration to ignore incoming RF data. Similarly, if you see −1.00 for all RT values, the footprint does 

not have retention time data. Read more about incomplete footprint record. 

Retention time chart behaves differently for several GC types. For example, ABB and Elster GCs have 

two detectors while Daniel GCs have one. Siemens GCs have four. Each detector has a predetermined 

sequence of gases coming out from the GC, hence every detector forms a subset of RT chart. For 

these kinds of device, you can show RT charts from both detectors, from the first detector only, or 

from the second detector only.  

 

Example of retention time chart for ABB C6+ GCs. There is a filter dropdown on the right side. 
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7.2 The Calibration Data Form 

 

The main purpose of Calibration Data form is to show calibration data records and also to compare 

this calibration data to the immediate preceding footprint. Similar to Footprint form, the Calibration 

Data form has RF chart, RF-MW log charts, and RT chart. 

To open Calibration Data form, select the desired device on the device panel on main user interface, 

and afterwards go to the View menu > Calibration Data. 

Response factor chart and retention time chart display the calibration data values in red and footprint 

values in blue. You can hide the footprint (blue) line or bar by unticking the Show footprint check 

box on top of footprint timestamp display.  

Unlike the other two charts, RF-MW logarithm charts only calculate the logarithm, regression line, and 

R2 value of calibration data (red) record only. 
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In the same way as Footprint form, switch to table view to see exact numeric values. Here you will see 

the comparison to footprint value side-by-side. 

 

Special value −1 

If you see −1 (negative one) for all RF values in one or both of the table views, this means the calibra-

tion data (or its footprint) does not have response factor data. This record may come from data cap-

ture operation but with an additional configuration to ignore incoming RF data. Similarly, if you see 

−1.00 for all RT values, the calibration data (or its footprint) does not have retention time data. Read 

more about incomplete calibration record. 

Click Copy RF or Copy RT above the desired table grid (calibration data or footprint) to copy RF or RT 

values respectively, because these grids have synchronised scrolling and row selection. 

Retention time chart for several device type provides option to filter by detector in the same way as 

the Footprint form. 

7.3 View Previous Footprints/Calibration Data 

To browse previous record of footprint or calibration data, click  Change footprint or  Change 

calibration data button at the top region of the form. 
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Select a different record then click OK button or double click the record on this list. 

 

You can always reload the latest record through  Load latest footprint or  Load latest calibra-

tion data button. 

7.4 Import New Footprint/Calibration Data 

To import a new footprint or calibration data, follow the steps below. 

1. Select the desired GC device on your device panel. 
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2. Open Footprint or Calibration Data form through the View > Footprint menu or View > Cali-

bration Data. 

If you import new data through Footprint form, the imported data shall be marked as foot-

print. If you import new data through Calibration Data form, the data will be marked as a cali-

bration data. 

3. Notice the Action menu on the menu bar. To continue, pick one of the supported import for-

mats. 

a. Text import 

b. CSV import 

c. Manual entry 

7.4.1 Text Import 

GCAS supports calibration report files generated by GC devices manufactured by Daniel Industries, 

ABB, and Siemens. Should you have the file ready, open the Action menu and select Import Data. If 

you don’t see this menu, your user account may not have the action permission for it or the Text Im-

port feature was not included in your GCAS licence. Contact your GCAS administrator. 

 

Load the data source file and select the appropriate importer module. The importer module depends 

on the format of the file. For example, GCAS supports legacy Daniel report files, Daniel 370XA files, 

and Daniel 700XA files. These three report files have different formats and are not compatible to one 

another, therefore we include three Daniel importer modules to handle each of them. 
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The required files look similar to the screenshots below. 

 

Example of calibration data generated by Daniel GC (legacy format) 

 

Example of calibration data generated by ABB GC 
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Depending on the importer module, most text import will import one record at a time. Siemens im-

porter and Daniel 700XA importer support multiple records inside one text file, thus allowing import 

of many records in one go. In such cases, GCAS prompts a dialogue asking which records to import. 

Click on the column header Import? to quickly tick or untick all records. 

 

GCAS requires the device tag name in the text file must match the device name (tag) in GCAS data-

base. The device tag name is the “Analyzer” in Daniel GC report file, or “Station ID” in ABB GC 

report file. 

7.4.2 CSV Import 

When you wish to upload multiple records in one click or if your GC device has no supported text im-

porter module, you would need to use CSV import. 

The CSV spreadsheet must follow the template to be recognised by GCAS (see chapter 7.4.4). The 

template defines column allocation within the spreadsheet. Failure to comply with this template will 

result in wrong data being associated with wrong gas or component. 

CSV file template should be inside your installation directory. The default directory is C:\GCAS. Look 

for CSV import file template.zip in that folder. If you lose this template, you can easily recre-

ate new one by following the guide in chapter 7.4.4. 

When you are ready to import the CSV file, open the Action menu and choose Import Data - CSV. 
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Likewise if you do not see this menu, your user account may not have the action permission for it or 

the CSV Import feature was not included in your GCAS licence. Contact your GCAS administrator. 

Load the CSV file and click Import. Watch out for the importer module selection. Importer-CSV-

RFinverted means the RF values are inverted before being committed to the database. This importer 

module is originally intended for Elster GCs which use the inverted RF formula, however it is made 

available for any GC using inverted RF. 

RFinverted =
1

RForiginal

 

ABB devices, BTEX devices, and single gas analysers have their own CSV importer module because the 

expected number of columns in the CSV file is different from Daniel, Siemens, Elster, and LNG devices. 

 

7.4.3 Manual Entry 

Aside from text and CSV import, you also have an option to enter the RF and RT values by hand. Man-

ual entry also provides additional options to accommodate some GC devices which calculate RF value 

using the inverted formula (i.e. mole percentage divided by peak area) or GC devices providing only 

the data of peak area. Nevertheless, this method is the least recommended way to import data be-

cause it is very susceptible to human error.  
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Open the action menu and select Import Data - Manual Entry. This menu displays the Manual Data 

Entry form. If you do not see this menu, your GCAS user account may not have the action permission 

for manual entry or your GCAS licence does not include Manual Data Entry. Contact your GCAS ad-

ministrator. 
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First things first, set the footprint or calibration timestamp accordingly. Next you can begin entering 

RF and RT values in the available input fields. 

If your footprint or calibration data does not have retention time data, untick Have Retention Time. 

This will disable all RT input fields. Similarly, if you do not wish to enter RF values, untick Have Re-

sponse Factor. Read more about incomplete footprint or calibration data. 

Response factor input has three options, described below. 

• Response factor values are these values: RF data is the values you entered. 

• Response factor values are inverse of these values: RF data is calculated from the recipro-

cal of the values you entered. If you type 1.567E-7 for example, the RF value will be 

1 / 1.567×10-7, which is 6,381,621 (rounded). Use this option if your GC device uses the in-

verted formula, that is mole percentage divided by peak area. This option is selected by de-

fault if you are entering RF and RT values for Elster GC. 

• Response factor values are calculated from peak area: This option shows two input fields 

for every gas. First input field is for peak area as given by your GC device. Second input field is 

for mole percentage, as in the component data table or calibration gas certificate. RF values 

are then calculated using the formula peak area divided by mole percentage. 

o Mole fraction instead of percentage: This option changes mole percentage input 

into mole fraction. GCAS will convert mole fraction back into percentage at later 

stage. 

Users with ISO 10723 included in their licences should see an additional check box next to Have Re-

sponse Factor box. This check box reads Mark as MLC. Check this box if you know you are going to 

enter multilevel-calibrated response factors. 

Retention time input has two options, and both are related to its gas order. To make RT input fields 

use the same gas order as RF input fields, choose Follow RF gas order. This is particularly useful if 

you want to paste the numbers from your spreadsheet (see tip box below) but the gas order in your 

spreadsheet is different from the default sort order. 

Note 

For ABB devices, the Manual Data Entry form will always input single-point RF values. Do not enter ex-

ponential RF values here. 

Tip 

You can copy numbers from Microsoft Excel or other spreadsheet processing software. Press Ctrl+V 

on the first text box and the rest will follow. Alternatively, click  Paste next to the corresponding in-

put field series. 



GCAS® Manual Guide rev. 26 

Page 82 of 587 

 

 

Click Hide options link near the top-right corner to hide both option panels and to make larger room 

for the input fields. 

Always check the numbers — and also the timestamp — before you click Save. Once it is saved, the 

record is not editable. 

7.4.4 CSV Import Template Explained 

Lost your CSV template? This chapter explains the structure and column assignments of CSV import 

templates for footprint and calibration data just in case the original template files are missing. There 

are templates for mole composition imports too, but those are going to be explained in chapter 8.3.3. 

On the next page, there are CSV column assignments for footprint/calibration import of regular GC 

devices except ABB (Daniel, Siemens, Elster, and LNG). ABB devices have their own CSV template be-

cause they may include exponential RF values. For CSV template of BTEX devices, jump here. For single 

gas analysers, jump there. 
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CSV template for: Daniel, Siemens, Elster, LNG 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Record flag. Put 1 for footprint or 2 for calibration data. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Methane response factor. 

5 E Nitrogen RF. 

6 F Carbon dioxide RF. 

7 G Ethane RF. 

8 H Propane RF. 

9 I i-Butane RF. 

10 J n-Butane RF. 

11 K Neopentane RF. * 

12 L i-Pentane RF. 

13 M n-Pentane RF. 

14 N Hexane RF. 

15 O Heptane RF. * 

16 P Octane RF. * 

17 Q Nonane RF. * 

18 R Decane RF. * 

19 S Are they multilevel-calibrated RF? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

20 T Methane retention time. 

21 U Nitrogen RT. 

22 V Carbon dioxide RT. 

23 W Ethane RT. 

24 X Propane RT. 

25 Y i-Butane RT. 

26 Z n-Butane RT. 

27 AA Neopentane RT. * 

28 AB i-Pentane RT. 

29 AC n-Pentane RT. 

30 AD Hexane RT. 

31 AE Heptane RT. * 

32 AF Octane RT. * 

33 AG Nonane RT. * 

34 AH Decane RT. * 

* If your GC device doesn’t read this gas, fill in 0 (zero). 

On the next page there are CSV column assignments for footprint/calibration import of ABB devices. 

ABB has its own template because there are many more columns required as ABB data may have ex-

ponential RF. The number of columns goes to 66. 
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CSV template for: ABB 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Record flag. Put 1 for footprint or 2 for calibration data. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Methane response factor. 

5 E Nitrogen RF. 

6 F Carbon dioxide RF. 

7 G Ethane RF. 

8 H Propane RF. 

9 I i-Butane RF. 

10 J n-Butane RF. 

11 K Neopentane RF. * 

12 L i-Pentane RF. 

13 M n-Pentane RF. 

14 N Hexane RF. 

15 O Heptane RF. * 

16 P Octane RF. * 

17 Q Nonane RF. * 

18 R Decane RF. * 

19 S Are they multilevel-calibrated RF? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

20 T Are they exponential RF? Fill 0 for single-point or 1 for exponential. 

If you write 1 in both column 19 and 20, column 19 (MLC) takes over. 

21 U Methane retention time. 

22 V Nitrogen RT. 

23 W Carbon dioxide RT. 

24 X Ethane RT. 

25 Y Propane RT. 

26 Z i-Butane RT. 

27 AA n-Butane RT. 

28 AB Neopentane RT. * 

29 AC i-Pentane RT. 

30 AD n-Pentane RT. 

31 AE Hexane RT. 

32 AF Heptane RT. * 

33 AG Octane RT. * 

34 AH Nonane RT. * 

35 AI Decane RT. * 

36 AJ Methane peak area (PA). 

37 AK Nitrogen PA. 

38 AL Carbon dioxide PA. 
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CSV template for: ABB (continued) 

Column Excel name Description 

39 AM Ethane PA. 

40 AN Propane PA. 

41 AO i-Butane PA. 

42 AP n-Butane PA. 

43 AQ Neopentane PA. * 

44 AR i-Pentane PA. 

45 AS n-Pentane PA. 

46 AT Hexane PA. 

47 AU Heptane PA. * 

48 AV Octane PA. * 

49 AW Nonane PA. * 

50 AX Decane PA. * 

51 AY Use existing calibration gas certificate?  

- If you put 1 (yes), column 52 to 66 are ignored and GCAS uses the cali-

bration certificate installed before the record timestamp of first CSV row.  

- If you put 0 (no), GCAS reads column 52 to 66 as the mole percentage 

portion of the calibration certificate. 

52 AZ Methane mole percentage as in calibration certificate. 

53 BA Nitrogen mole percentage as in calibration certificate, and similarly to end. 

54 BB Carbon dioxide mole percentage. 

55 BC Ethane mole percentage. 

56 BD Propane mole percentage. 

57 BE i-Butane mole percentage. 

58 BF n-Butane mole percentage. 

59 BG Neopentane mole percentage. * 

60 BH i-Pentane mole percentage. 

61 BI n-Pentane mole percentage. 

62 BJ Hexane mole percentage. 

63 BK Heptane mole percentage. * 

64 BL Octane mole percentage. * 

65 BM Nonane mole percentage. * 

66 BN Decane mole percentage. * 

* If your GC device doesn’t read this gas, fill in 0 (zero). 

 

On the next page there are CSV column assignments for footprint/calibration import of BTEX devices. 

For single gas analysers, jump here. 
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CSV template for: BTEX 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Record flag. Put 1 for footprint or 2 for calibration data. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Benzene response factor. 

5 E Toluene RF. 

6 F Ethylbenzene RF. 

7 G Xylene RF. 

8 H Are they multilevel-calibrated RF? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

9 I Benzene retention time. 

10 J Toluene RT. 

11 K Ethylbenzene RT. 

12 L Xylene RT. 

And finally, below are CSV column assignments for footprint/calibration import of single gas devices 

(  single gas analyser,  H2S analyser, and  moisture analyser). 

CSV template for: Single gas 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Record flag. Put 1 for footprint or 2 for calibration data. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Response factor of H2S/moisture/"the gas". 

5 E Is it multilevel-calibrated RF? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

6 F Retention time of H2S/moisture/"the gas". 

In case your GC device does not provide RF data at all, or no RT data at all, set all RF values or RT val-

ues to -1 (negative one). This will cause GCAS to regard these data as incomplete footprint or calibra-

tion data. RF or RT chart will not be rendered instead of being graphed as all-zeroes. 

7.5 Change Record Flag and Status (Single Record) 

7.5.1 Change Record Flag 

Footprint and calibration data share the same record structure in database, distinguished by a flag. 

This flag can flip from footprint to calibration data and vice versa. To change this flag, do the follow-

ing. 
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1. From an open Footprint or Calibration Data form, go to Action menu > Set Status. If you do not 

see this menu, your user account may not have the action permission for it. Contact your GCAS 

administrator. 

 

2. This will show Set Status and Flag dialogue. 

 

3. Choose one of the options in Set flag group, whether to set the record as a footprint or as a cali-

bration data. Click OK to commit the change. 

4. Notice that the record is reloaded using the other form. That is, for footprint it will be reloaded 

using Calibration Data form, and for calibration data it will be reopened using Footprint form. 

5. The Comments tab opens automatically and it is advised to write a comment of why the record 

flag was changed. Comments tab will not open in case your GCAS user account doesn’t have ac-

tion permission to post comments. 
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7.5.2 Change Status 

Every footprint or calibration record has a status bit that can change from active to inactive or vice 

versa. Inactive records will not be included in data analysis therefore will not affect the calculation of 

mean and standard deviation in data analysis. Below are the steps to mark records as inactive or ac-

tive. 

1. From an open Footprint or Calibration Data form, go to Action menu > Set status. If you do not 

see this menu, your user account may not have the action permission for it. Contact your GCAS 

administrator. 

 

2. This will show Set Status and Flag dialogue. 

 

3. Choose one of the options in Set status group, whether to mark this record as active or inactive. 

Click OK to commit the change. 

4. The form will reload the record and you should see the new status on the top section. Next, the 

Comments tab opens automatically and it is advised to write a comment of why the record status 
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was changed. Comments tab does not open if your GCAS user account doesn’t have action per-

mission to post comments. 

 

7.6 Change Record Flag and Status (Multiple Records) 

Chapter 7.5 explained what record flag and status are, plus how to change them on the current cali-

bration record. If you need to do it on a range of record, it is faster to use the bulk set status tool ra-

ther than repeating the same step on every record. 

 

From an open Footprint or Calibration Data form, go to Action menu > Set Status (Bulk). This menu 

brings forth Set Status and Flag for Multiple Records dialogue. This window has two views called simple 

view and advanced view. The first you see now is the simple view. 

7.6.1 Simple View 

In simple view, GCAS asks you whether to set status, set flag, or set both, while providing a flag filter 

and timestamp range. 
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To set status only, set flag as No change while setting the status as Active or Inactive as appropriate. 

Conversely, to set flag only, set status to No change while setting the flag to Footprint or Calibration 

data. To set both, don’t select No change on either box. 

Flag filter is the dropdown after the word “for all”. This filter applies change to all records inside the 

selected date range (unfiltered), or just to the calibration records, or just to the footprint ones. Finally, 

set the date range and click OK. 

Note 

A little note here if you set flag to footprint through bulk operation. Although it is perfectly permitted 

to have many sequential footprint records in GCAS database, they may mess up the mean and standard 

deviation calculation in Data Analysis. 

GCAS does not add automatic comment like what it did on the single record status change for this bulk 

operation. If you need to add comment or to exclude some records from the bulk operation, you need 

to use the advanced view. Click Advanced button to move to the advanced view. 

7.6.2 Advanced View 

In advanced view, GCAS offers more customisations on this bulk operation. You can tune the list to 

display records matching the filters, tick exactly which records to apply changes on, and attach a com-

ment to them. 
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First, decide whether to set status, set flag, or both. To set status only, set the flag to (no change). To 

set flag only, set the status to no change. To set both, don’t select no change on either side. 

Select the option Show all records to display all footprint and calibration data, or set a date/time fil-

ter to limit the selection. Then, click Refresh to load records into the list. You can enforce additional 

filter by current status or by current flag (or both) at the bottom-left region of this dialogue if re-

quired. Click Refresh again to apply these filters. GCAS begins to load all records which fulfil these cri-

teria. Once the list is populated completely, begin ticking or unticking records to include or exclude 

them from the bulk operation. To quickly select all or unselect all, click the column header. 
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Note 

A little note here if you set flag to footprint through bulk operation. Although it is perfectly permitted 

to have many sequential footprint records in GCAS database, they may mess up the mean and standard 

deviation calculation in Data Analysis. 

Once you make sure everything is correct, click OK to begin the bulk operation. 

Want GCAS to put comment on every affected record? Check Add comment to each record and en-

ter your comment. The comment box recognises seven keywords called macro(s) which it automati-

cally highlights in red. Macro identifier starts with the '@' symbol and is all-uppercase. GCAS replaces 

these macros with actual values before writing them to database. 

Macro keyword  Will be replaced with 

@OLDSTATUS Previous record status ("active" or "inactive") 

@NEWSTATUS New record status ("active" or "inactive") 

@OLDFLAG Previous record flag ("footprint" or "calibration data") 

@NEWFLAG New record flag ("footprint" or "calibration data") 

@DATE Current computer date, e.g. "19 May 2016". 

@TIME Current computer time in 24-hour format, e.g. "14:47:36". 

@DATETIME Current computer date and time, e.g. "19 May 2016 14:47:36". 

For instance, this comment macro: 

This record was set as @NEWSTATUS at @DATETIME because there was an error 

in the Modbus data capture configuration. 

will be replaced with actual values such as: 

This record was set as inactive at 19 May 2016 14:51:12 because there was 

an error in the Modbus data capture configuration. 

Which you can easily verify by visiting any record included in this bulk set status after the operation 

completed. 

7.7 Incomplete Footprint or Calibration Data 

There are cases of incomplete footprint record or incomplete calibration data. A footprint or calibra-

tion record is said to be incomplete if it has only response factor data, or only retention time data, but 

not both. Incomplete records usually come from data capture operation but with additional configura-

tion to ignore RF data or ignore RT data. 

If GCAS was instructed to ignore RF data, it assigns the special value −1 (negative one) to all RF val-

ues. The same goes for RT, which GCAS assigns −1 to all RT fields. You shall see this special −1 value 

when you switch to table view on either Footprint or Calibration Data form. 
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Why −1? This value is used to differentiate the 0 (zero) value, which indicates the gas is missing or not 

present in the calibration inlet. By default, GCAS will still plot zero values on RF or RT chart, but not the 

−1's. You can override this behaviour by starting GCAS with an additional /drawincompleteRFRT pa-

rameter. 

When you view an incomplete record, its response factor chart or retention time chart will display a 

text annotation on top of itself. For example, 

 

In the screenshot above, the calibration record does not have retention time data. You only see blue 

bars (footprint), but red bars (calibration) are missing. Another example, 
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…the calibration record has RF data but its footprint does not. You only see red line (calibration) but 

blue line (footprint) is missing. The chart displays annotation that the footprint does not have RF data. 

If you are on Calibration Data form, the annotation may obscure part of the chart. Click once on the 

annotation to reveal the  close icon. Click again on the  close icon to remove the annotation. 

(Footprint form does not have this feature.) 

 

7.8 Zoom and Scroll (RF Chart Only) 

Daniel C9+ and C10+ devices have a distinctive characteristic on their RF charts: The line chart rises 

slowly, but suddenly jumps to a much higher number starting at the first gas being detected by the 

second detector. 

 

In order to zoom a part of this chart, drag a rectangle on the area you would like to zoom in. 

Use the scroll bars to pan the zoomed chart. 

To zoom in further, drag another rectangle area. 

To zoom out, either click both circled minus buttons Θ or right click on the chart then select Zoom 

All-Out. 
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The crosshair cursor is the dotted magenta line which appeared when you click anywhere on the chart 

region or as a remnant of a zoom operation. These lines may act as a ruler or guide. To remove these 

lines, right click on the chart and select Hide Crosshair Cursors. 

 



GCAS® Manual Guide rev. 26 

Page 96 of 587 

 

7.9 GC Health Status 

GCAS may suggest an action should you see a fail alarm, which is R2 (correlation) value being under 

the defined threshold. For the time being, this feature is only available to Daniel C6+ and C7+ GCs. 

Go to the Health status tab on either Footprint form or Calibration Data form. In the example below, 

the correlation value of light-and-heavy components (methane, ethane, hexane) happened to be un-

der the threshold. 

 

Let's take a detour to the RF-MW charts. Here we see the R2 (correlation) value of C1-C2-C6 is short 

under the threshold of 0.995. By looking at the third chart, we see that C6 is below the trend line. Hex-

ane is lower than where it should be. 
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We can infer that the hexane backflush stage is late, so that a part of hexane eluted to the second col-

umn. To achieve the goal in this example, we need to adjust the timing of valve 2 to close a bit faster. 

After making such adjustment, we have a good correlation on the next calibration cycle: 

 

GC health status is only available for Daniel C6+ and C7+ devices. Method of suggestion based on R2 

values for Daniel C9+, Daniel C10+, ABB GC, Siemens GC, Elster GC, and other GC types is currently 

not available. 

7.10 Insert Comment 

Users can comment on a record as a medium of communication between engineers or as an archive 

about what happened to the GC. It is useful to write comments when an action is being done upon GC 

device, or in case of unexpected behaviour has occurred. You are also taken to the comment section 

automatically whenever record property is changed (either record flag or record status). It is a good 

practice to provide explanation on why the record property was changed. 
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1. To insert comment, open the Comments tab or go to Action menu > Add Comment. 

2. Write your comment on the text box at the lower section of the form then click on Submit button. 

3. Make sure the comment is correct (e.g. free from spelling errors) because once inserted into data-

base, you will not be able to remove the comment. This is a part of the requirement for audit trail. 

If you do not see the textbox and the Submit button, i.e. the comment grid fills up the entire form, 

your user account may not have action permission to write comments or your user role is Read-only. 

Contact your GCAS administrator. 

7.11 Send to Correlation Calculator 

This shortcut is intended for unsupported GC or those in special needs. For example, your GC is Daniel 

C10+ complete type A, and was actually calibrated with C10 calibration gas (decane is present). But 

later on, your process gas is only up to C9 (decane is missing). This would break the correlation 

calculation (R2) because the response factor of decane is zero. To work around this problem, open the 

Action menu from an open Footprint or Calibration Data form, then select Send to Correlation 

Calculator.  

 

This menu will send all response factor values from methane (C1) to decane (C10) to Correlation Cal-

culator. Only normal butane and normal pentane are included, their isomers are not. Once the Corre-

lation Calculator form is open, simply delete any unwanted gases and the calculator will get you the 

correct R2 result. In our example before, C10+ type-A device treated as C9+ should have R2 of C6-C7-

C8-C9, not C7-C8-C9-C10. In Correlation Calculator form, delete methane, ethane, propane, butane, 

pentane, and decane; this will give you the correlation of hexane, heptane, octane, and nonane. Visit 

chapter 19 to read more about correlation calculator. 

Send to Correlation Calculator menu works with BTEX devices as well. It should be noted that both 

ethylbenzene and xylene have the same molar mass, therefore their log(MW) are the same so their 

dots look aligned on an invisible vertical line. For single gas devices however, this menu just simply 
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opens Correlation Calculator but does not send any data—because correlation calculation requires at 

least three gases. 

 

Correlation Calculator with data sent from Footprint or Calibration Data form. Delete unwanted gases to 

get the correct R2 result. For example, to get the correlation of C7-C8-C9-C10, delete everything from 

methane to hexane. 

7.12 Multilevel-Calibrated RF (ISO 10723) 

GCAS supports the traditional single-point response factors as well as multilevel-calibrated (MLC) re-

sponse factors. 

Note 

This feature requires ISO 10723 feature in your GCAS licence. 

Users with ISO 10723 feature in their licences will see MLC selector at top-left region of response fac-

tor chart. This dropdown lets you change the displayed RF whether the single-point or the MLC one. 

GCAS performs ISO 10723 conversion on-the-spot, therefore the actual RF values in the database are 

not affected. By default, GCAS displays single-point RF.  
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Single-point RF has the familiar graph as discussed so far, it has to be ascending and the values are in 

the range of millions to hundreds of millions. However multilevel-calibrated RF is different: All values 

are close to one (1.0), therefore its chart is somewhat horizontally flat. Multilevel-calibrated RF has no 

much use as it is not usable for correlation calculation, but you can easily detect anomalies if the chart 

is not flat. 

ISO 10723 conversion for footprint/calibration data requires: 

1. A multilevel calibration (MLC) coefficient set installed before the timestamp of the foot-

print/calibration record, and 

2. An active calibration gas certificate installed before the timestamp of the footprint/calibration 

record. 

If these two conditions are not met, the footprint or calibration record is said to be not convertible. For 

calibration data, these conditions must be fulfilled for both the calibration record itself and the pre-

ceding footprint. GCAS displays a  warning icon next to the MLC dropdown selector if your foot-

print or calibration data is not convertible; also if the calibration data is convertible but its preceding 

footprint isn’t. In the latter case, the MLC coefficients probably sit between the footprint timestamp 

and calibration record timestamp. Click on the warning icon to see the detailed reason why the record 

is not convertible. 

 

MLC conversion warning icon. 
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To see the MLC coefficients associated with current record, open the Action menu, select ISO 10723, 

then click View MLC Coefficients. This menu calls Multilevel Calibration Coefficients form and loads 

the correct coefficient set associated with current footprint or calibration data. 

7.12.1 MLC Flag Bit 

Footprint and calibration records have an additional flag bit to indicate whether the RF values are sin-

gle-point or multilevel-calibrated. If you don’t have ISO 10723 feature in your licence, this flag bit is 

always set to single-point. To recap, footprints and calibration data have three flag bits: One to indi-

cate active/inactive, another one to indicate whether it is a footprint or calibration data, and the last 

one to indicate whether its RF are single-point or MLC. 

Open the Action menu and select ISO 10723. The first submenu is not clickable but it tells you what 

the flag bit of current record is. In the screenshot below, it tells us the flag bit for this record is single-

point. 

 

You can change the MLC flag bit if necessary, however there is one important difference between 

“Mark As” and “Convert To”. Read more on the next chapter, 7.12.2. 

7.12.2 Mark As versus Convert To 

Open Action menu, select ISO 10723, then select Mark As… or Convert To… and GCAS reveals this 

dialogue box. 
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Current flag bit is highlighted in yellow to clarify what the current flag bit is. Next, decide whether you 

need to mark the flag bit or convert the whole record. 

Mark As changes the flag bit only. The original numbers of all RF values are untouched. Use this if you 

notice: 

• MLC selector shows “single-point” but the chart is horizontally flat and all numbers are close 

to one (1.0). Also when the selector is changed to multilevel-calibrated, the chart is still flat 

but all numbers become very close to zero. You need to mark the record as MLC. 

• MLC selector shows “multilevel-calibrated” but the chart is not horizontally flat and instead 

the numbers skyrocket to scale of hundreds of billions or even trillions. Also when the selector 

is changed to single-point, the chart suddenly forms a nice ascending shape and the numbers 

now make sense. You need to mark the record as single-point. 

Convert To changes the flag bit and converts all RF values, thus changing the actual numbers stored 

in database—permanently. Use this when you see the record is good (the numbers make sense), 

which is completely opposite condition of when to use Mark As. 

Because Convert To also converts the actual RF values, you will get the desired numbers during data 

export. For example, you want to export footprint/calibration data into CSV. All records are marked as 

MLC. If you go to export directly, all RF values in the result CSV will also be close to one (1.0) as they 

were in MLC. On the contrary if you use Convert To single-point before the export, RF numbers will be 

in scale of millions like typical single-point RF values. 

Mark As requires an action permission to "change MLC flag bit". On the other hand, the Convert To 

operation requires "change MLC flag bit" plus a permission called “MLC permanent conversion”. Had 

your GCAS administrator not given you this permission, GCAS displays a message saying that you 

don’t have sufficient permission to perform conversion when you select Convert To in this dialogue 

box. 

Important 

Be very cautious when using Convert To. Performing permanent conversion on wrong record will dam-

age the record permanently. For instance, a calibration record is wrongfully marked as single-point 

where it should’ve been marked as MLC. You should use Mark As MLC here. But if you apply Convert 
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To MLC instead, the numbers will change to somewhere close to zero—destroying the record for 

good. 

7.12.3 Change MLC Flag Bit (Multiple Records) 

Changing MLC flag bit as described in chapter 7.12.2 only changes one record at a time. Sometimes 

you need to change flag bit of a bunch of records, such as when you notice calibration records com-

ing from data capture should be marked as MLC but you forgot to set it in Modbus mapping. There-

fore, all these records are still wrongly marked as single-point. To save time, go to the Action menu, 

select ISO 10723, then select Mark As… (Bulk). 

This dialogue lets you change MLC flag bit of all records of the selected GC device (no exceptions), or 

limited to certain date range, or specific selections of available records. For specific selections, a  

star indicates a footprint. 
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Note 

There is no Convert To feature for bulk operation because it may damage multiple records. 

7.12.4 MLC Constraints 

We moved the explanation about concepts and application of MLC constraints to chapter 24.2. Most 

of the time, users need not to worry about MLC constraints. However, there is a slim chance the de-

fault MLC constraints causes nonsensical RF values, such as 300 billion where it should be about 17 

million. In such cases, you may need to override the MLC constraints in order to get the correct result. 

Read more on chapter 24.2 about MLC constraints. 

7.13 Exponential RF 

This chapter applies to ABB devices only. If you have GC devices of other brands, skip ahead to 

chapter 7.14. 

By default, ABB devices outputs exponential response factor instead of single-point RF. Single-point RF 

is what GCAS uses for all calculations. Exponential RF is called exponential because the conversion for-

mula contains exponential function (ex). This formula is proprietary of ABB.  

Exponential response factor values are typically between 0 to 20, unlike the single-point RF that may 

go to billions. Conversion between exponential RF and single-point RF is computed through a propri-

etary formula and it involves a coefficient that we call multiplier (M). These multiplier values (one for 

each gas) are calculated automatically when you import a calibration data or capturing calibration 

data through Modbus connection.  

Footprints and calibration data without multiplier values are said to be not convertible to exponential 

RF. Please note there is a distinction between being inconvertible to multilevel-calibrated and incon-

vertible to exponential RF. The state of inconvertibility to multilevel-calibrated RF is already explained 

in chapter 7.12. 

7.13.1 View Exponential RF 

On ABB devices, the MLC selector provides one more option to select: Exponential RF. This option 

graphs the exponential RF values on the RF chart. Exponential RF chart does not produce nice ascend-

ing slope like single-point RF chart, thus the only use of exponential RF chart is to verify that GCAS 

captured the correct data from calibration report imports or data capture. 
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7.13.2 The Multiplier Form 

Usually users don't think much about multiplier values. But they are still accessible from the Action 

menu in case the footprint/calibration record you are viewing doesn't have one. From an open Foot-

print or Calibration Data form that is viewing an ABB calibration record, open the Action menu, and 

select View Multiplier Values. 
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The Multiplier Form displays the associated multiplier values of this record. Otherwise if the foot-

print/calibration record does not have multiplier values, the form looks like this. 

 

There is a toolbar at the top of the form. Click  Copy to clipboard to copy multiplier values. To 

make every value displays the same number of decimal digits, activate  Align decimal. Every but-

ton on the toolbar has the corresponding menu in the Action menu too. 



GCAS® Manual Guide rev. 26 

Page 107 of 587 

 

7.13.3 Add, Edit, or Delete Multiplier Values 

When your calibration record does not have multipliers, GCAS can display its single-point RF values 

but not its exponential RF. To make it convertible, please supply multiplier values. Click  Add button 

on the toolbar. The form enters edit mode and you can begin typing the numbers. If the form says 

"This calibration record doesn't have multiplier values" but the  Add button is still disabled, 

probably your user account does not have the action permission to add multipliers. Contact your 

GCAS administrator. 

 

When you are done, double check everything for a potential typing error. Finally, click  Save. 

To edit an existing multiplier values, click  Edit on the toolbar. Similar things happen—the form en-

ters edit mode and you can start modifying the numbers. To commit your edit, click  Save. To can-

cel and revert back to the original values, click  Discard. If the  Edit button is disabled even 

though there are multiplier values present to edit, your GCAS user account may not have the action 

permission to edit multipliers. Contact your GCAS administrator. 



GCAS® Manual Guide rev. 26 

Page 108 of 587 

 

 

After saving, the parent Footprint form or Calibration Data form should refresh itself. Try reselecting 

the MLC selector to Exponential RF in order to verify the exponential RF values have been recalculated 

correctly. 

And finally to delete multiplier values, click  Delete. Similar to Add and Edit action, the delete ac-

tion is guarded by action permission. Deleting multiplier values will put your calibration record to in-

convertible state (inconvertible to exponential RF). Deleting multipliers is also effectively the same as 

editing all multiplier values to zero. 

 

GCAS prompts this confirmation. Select Yes to proceed. After deletion, the form becomes empty and 

displays "This calibration record doesn't have multiplier values". 

7.13.4 Copy Multipliers from Other Records 

Multipliers are expected to stay the same between calibration records. If there are variations on the 

numbers, they should occur after quite insignificant decimal place. You can overwrite multiplier values 

of current calibration record by multiplier values of another calibration record. Your GCAS user ac-

count needs the action permission to edit multipliers. If you can edit, of course you can edit the multi-

pliers to match the previous record, for instance. 
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To do that, click Copy from on the toolbar and select the appropriate submenu. Copy multipliers 

from previous calibration record will overwrite current multipliers using those belong to calibration 

record before the current one, while Copy multipliers from a calibration record pops a Select Record 

dialogue to let you choose which calibration record to be the copy source. 

 

Next, GCAS shows a confirmation dialogue that the multipliers are about to be replaced by the new 

ones. Value differences are highlighted in red. Click Confirm to proceed. Multiplier form will update 

itself and the parent Footprint form or Calibration Data form should refresh too. 

 

7.13.5 Copy Multipliers to Other Records 

This action is the opposite of previous action. Suppose you have the latest calibration record with 

good multiplier values, but all of your previous calibrations didn’t have multipliers yet. You can copy 



GCAS® Manual Guide rev. 26 

Page 110 of 587 

 

current multipliers to all those records because multiplier values are coefficients that are not expected 

to change much anyway. Likewise, your GCAS account needs the action permission to edit multipliers. 

Click Copy to on the toolbar. Then decide whether to Copy multipliers to a record which shows the 

familiar Select Record dialogue to choose the copy target; or Copy multipliers to all existing records 

to update all calibration records of this GC device. Note that the latter (copy to all records) only up-

dates calibration records already existing in the database. Future calibration records are not affected. 

 

Likewise, GCAS displays a confirmation dialogue. But this time the arrow direction is reversed. Click 

Confirm to continue. 
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7.14 Printing 

From an open Footprint or Calibration Data, go to the File menu on the main menu bar. Select Page 

Setup to configure paper size and print orientation. Select Print Preview to get a preview or Print to 

begin printing. Alternatively, the menu Print Preview and Print are also found inside the Action menu. 

The Quick Print menu immediately sends the footprint or calibration data to your default printer ac-

cording to what has been set in Windows Control Panel, using current page setup (default is A4 por-

trait). 

 

Print preview dialogue. 



GCAS® Manual Guide rev. 26 

Page 112 of 587 

 

GCAS has different print layout for portrait and landscape orientation. GC health status and user com-

ments are printed on subsequent pages.  
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8 Mole Composition 

Mole composition (formerly “mole percentage”) is a record of, as its name suggests, mole composition 

of either calibration gas or process gas in one chromatography cycle. 

Note 

In order to use features related to mole composition e.g. Mole Composition form, mole composition 

data capture, and mole composition data analysis, you need GCAS feature Live Data Analysis in your 

GCAS licence. 

Early versions of GCAS recognised only mole percentage, but now GCAS can work with any scale. We 

generalise mole percentage, fraction, or whatever scale it is, into one name – mole composition. From 

this chapter onwards, the term “mole composition” may be abbreviated as “MC”.  

8.1 The Mole Composition Form 

Mole Composition form displays mole composition data presented in grid view. By default, numbers 

in this grid is the normalised composition. The pie chart next to the grid helps visualising the data, alt-

hough in many cases methane composition overwhelms everything else. This is caused by the use of 

balanced methane in calibration gas. 

To open Mole Composition form, select the device from device panel on the main user interface, then 

go to the View menu > Mole Composition. 
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Mole Composition form as seen by users with ISO 10723 feature included in GCAS licence. 

Users without ISO 10723 feature will not see features related to multilevel calibration (MLC). 

As mole composition data may come from multiple streams, the stream number is displayed on top of 

the pie chart. Some GC designates stream 1 as the calibration stream and stream 2 as process stream, 

while some others specify stream numbers the other way around. GCAS can also handle GC devices 

with more than two streams, the appropriate stream number is always there on top of the pie chart. 

Remove mode check box will hide the mode (Latin: modus) from the pie chart. That is, the datum with 

highest value among other data. For example, if you have methane composition at 90%, it would be 

difficult to see other gases cramped in the remaining 10%. Ticking this option will hide methane from 

the pie chart. 

Show legend toggles show or hide the legend of pie chart. 

High precision causes the form to show all numbers in 8-digit decimals instead of four digits. If you 

see some rounding errors, that is because GCAS uses 32-bit floating point for mole composition data 

to save database space. 

Colourblind assist. To aid users with colour blindness (protanopia and deuteranopia), GCAS provides 

an alternative colour scheme for the pie chart. 

 

https://en.wikipedia.org/wiki/Mode_(statistics)
http://en.wikipedia.org/wiki/Color_blindness#Dichromacy


GCAS® Manual Guide rev. 26 

Page 115 of 587 

 

Show unnormalised reveals another set of columns in grid view: the unnormalised composition. If 

you have ISO 10723 feature in your licence, this check box also reveals the unnormalised MLC compo-

sition as well. Nonetheless, the pie chart always displays normalised composition. This should be 

checked at all time for single gas devices. 

Note 

On ABB devices, there are three columns (or two if you don't have ISO 10723 feature included). The 

additional column is allocated to display exponential mole composition. 

Show difference check box is available for customers having ISO 10723 feature in their licences or if 

the GC device is ABB. This check box reveals an additional column in grid view, called the delta. It con-

tains the difference between normalised single-point composition and normalised MLC composition, 

or difference between normalised single-point composition and normalised exponential composition. 

Delta is computed as single-point minus MLC or single-point minus exponential. 

8.2 View Previous Records 

To load previous mole composition data, click  Change record button at the top region of the 

form. Select a different record, then click OK or double click the list item. 

 

Select Record dialogue. Timestamps on this screenshot are fictional, actual records are usually 4-7 

minutes apart. 

You can always load the latest mole composition data through  Load latest record button.  



GCAS® Manual Guide rev. 26 

Page 116 of 587 

 

8.3 Import New Composition Data 

To import new mole composition data, follow these steps. 

1) Select the desired GC device on your device panel. 

2) Open Mole Composition form through the View menu > Mole Composition. 

3) Notice the Action menu on the menu bar. To continue, pick one of the supported import formats. 

a. Text import 

b. CSV import 

8.3.1 Text Import 

For the time being, text import for mole composition is supported for Siemens GC and Daniel 700XA 

only. These two importer modules support multiple records inside one text file as well. 

Continuing, open the Action menu and find Import Data. If you do not see this menu, your user ac-

count may not have the action permission for it or the text import feature is not included in your 

GCAS licence. Contact your GCAS administrator. 

 

Load the text file and click Import. If the text file contains multiple records, GCAS presents additional 

dialogue to choose which records to import. 
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In this additional dialogue, click on the column header Import? to quickly select or unselect all rec-

ords. Also you can change the stream number by navigating to the third column (Stream) at the de-

sired row and then press F2 to enter edit mode. 

 

Additional dialogue to select which records to import. Column 3 (Stream) is editable. 

GCAS treats all numbers in the text file as unnormalised composition and will normalise them before 

they are committed to GCAS database. 

8.3.2 CSV Import 

The CSV file must follow the standard template for mole composition. Failure to comply with the tem-

plate will cause wrong data to be associated with wrong gas or component. The template file should 

be in your installation directory or in the browser/HTML version of GCAS Manual. Look for CSV im-

port file template.zip in your installation directory. If you lose this template, you can easily 

recreate new one by following the guide in chapter 8.3.3. 

Now open the Action menu and select Import Data - CSV. Load the CSV file and then click Import. 
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If you do not see this menu, your user account may not have the action permission for it or the CSV 

import feature is not included in your GCAS licence. Contact your GCAS administrator. 

GCAS treats all numbers in the CSV file as unnormalised composition and will normalise them before 

they are committed to GCAS database. 

8.3.3 CSV Import Template Explained 

Lost your CSV template? This chapter explains the structure and column assignments of CSV import 

templates for mole composition just in case the original template files are nowhere to be found. There 

are templates for footprint and calibration import too, but those have been explained in chapter 7.4.4. 

Here are CSV column assignments for mole composition import of regular GC devices except ABB 

(Daniel, Siemens, Elster, and LNG). ABB devices have their own template because there is one addi-

tional column that is specific to ABB. For BTEX devices and single gas analysers, go to page 120. 

CSV template for: Daniel, Siemens, Elster, LNG 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Stream number. 
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CSV template for: Daniel, Siemens, Elster, LNG (continued) 

Column Excel name Description 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Methane mole composition. 

5 E Nitrogen MC. 

6 F Carbon dioxide MC. 

7 G Ethane MC. 

8 H Propane MC. 

9 I i-Butane MC. 

10 J n-Butane MC. 

11 K Neopentane MC. * 

12 L i-Pentane MC. 

13 M n-Pentane MC. 

14 N Hexane MC. 

15 O Heptane MC. * 

16 P Octane MC. * 

17 Q Nonane MC. * 

18 R Decane MC. * 

19 S Unnormalised total. 

20 T Are they multilevel-calibrated MC? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

* If your GC device doesn’t read this gas, fill in 0 (zero). 

Here are CSV column assignments for mole composition import of ABB devices. The columns are 

similar to Daniel, Siemens, Elster, and LNG, but with addition of one column to indicate exponential 

MC. 

CSV template for: ABB 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Stream number. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Methane mole composition. 

5 E Nitrogen MC. 

6 F Carbon dioxide MC. 

7 G Ethane MC. 

8 H Propane MC. 

9 I i-Butane MC. 

10 J n-Butane MC. 

11 K Neopentane MC. * 

12 L i-Pentane MC. 
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CSV template for: ABB (continued) 

Column Excel name Description 

13 M n-Pentane MC. 

14 N Hexane MC. 

15 O Heptane MC. * 

16 P Octane MC. * 

17 Q Nonane MC. * 

18 R Decane MC. * 

19 S Unnormalised total. 

20 T Are they multilevel-calibrated MC? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

21 U Are they exponential MC? Fill 0 for single-point or 1 for exponential. 

If you put 1 in both column 20 and 21, column 21 (MLC) takes over. 

* If your GC device doesn’t read this gas, fill in 0 (zero). 

Below are CSV column assignments for mole composition import of BTEX devices.  

CSV template for: BTEX 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Stream number. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Benzene mole composition. 

5 E Toluene MC. 

6 F Ethylbenzene MC. 

7 G Xylene MC. 

8 H Unnormalised total. 

9 I Are they multilevel-calibrated MC? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 

And lastly here are CSV column assignments for mole composition import of single gas devices (

 single gas analyser,  H2S analyser, and  moisture analyser). 

CSV template for: Single gas 

Column Excel name Description 

1 A Device tag name. (Yes, you can import data for multiple devices in one go.) 

2 B Stream number. 

3 C Record timestamp in the format of dd/mm/yyyy hh:mm or mm/dd/yyyy 

hh:mm depending on your device date format. Both use 24-hour clock. 

4 D Mole composition of H2S/moisture/"the gas". 

5 E Unnormalised total (which is the same as column 4). 

6 F Is it multilevel-calibrated MC? Fill 0 for single-point or 1 for MLC. 

If you don’t have ISO 10723 in your licence, always fill 0 (zero). 
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8.4 Spot Sampling 

A spot sample is a special mole composition record. Regular mole composition record is the composi-

tion of gases read by the GC device, but spot sample is the composition of gases before they enter GC 

device. Spot sampling is conducted directly on the pipeline (on the sample probe) before entering the 

pressure letdown system (hence the name “spot”).  

The purpose of spot sampling is to verify if your pressure letdown system works properly — no leak-

age, no condensation, no dropout, etc. If the spot sample record is very close to the regular mole 

composition record (taking the lag time into account), then generally speaking your pressure letdown 

system should be fine. 

To enter spot sample data, select the device from the device panel then open the Mole Composition 

form through View menu > Mole Composition. Open the Action menu, then click Spot Sampling. 

 

This brings forth the Spot Sampling form. First thing first, enter the date and time of when the 

sample was taken. This is a common mistake for leaving the date/time input to be current computer 

time. Once the record commits to database, you cannot change its timestamp but you can set it as in-

active and re-enter a same record with the correct timestamp.  

The next step is to key in mole composition value of each gas. The composition you are entering now 

is the unnormalised composition. 
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As you type, the total/sum is updated accordingly and all values are automatically normalised in the 

rightmost column. The form deduces the correct scale automatically. Therefore, for a few first gases, 

total/sum for normalised column may display 1 (mole fraction) or 10 (decimal). As you fill in more and 

more fields, the scale will change accordingly and typically end up in 100 (percentage). 

Always double-check the numbers to avoid potential human error. When you are ready, click Save to 

commit the record. 

Tip 

You can copy values from Microsoft Excel or other spreadsheet processing software. Press Ctrl+V 

inside the first text box and the rest will follow. Alternatively, click  Paste button. 
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Click  Clear to reset all fields back to zero. 

8.5 Change Record Status (Single Record) 

Similar to footprint and calibration data record, every mole composition record has a status bit indi-

cating either active or inactive. Similarly, inactive records will not appear in data analysis and will not 

affect the calculation of mean and standard deviation, uncertainty calculation, ISO 6976/GPA 2172 

trend, and many others. To change record status of the mole composition record currently loaded, do 

the following: 

1. From an open Mole Composition form, go to Action menu > Set Status. If you do not see this 

menu, your user account may not have the action permission for it. Contact your GCAS ad-

ministrator. 
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2. This will show Set Status dialogue. Choose the appropriate record status then click OK. 

 

3. The form will reload the record and you should see the new status at the upper section. After-

wards, the Comments tab opens automatically and it is recommended to write a comment of 

why the record status was changed. Comments tab does not open in case your GCAS user ac-

count doesn’t have the action permission to post comments 
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8.6 Change Record Status (Multiple Records) 

Mole composition records mostly came from a data capture operation. To make it worse, many users 

set the data capture in unattended mode. If an error happened during unattended data capture, bad 

records will still be committed into database. This may lead to numerous unusable records in the da-

tabase and it is a tedious work to set their status as inactive one by one. GCAS includes a tool to set 

record status in bulk (batch) operation. 

From an open Mole Composition form, open the Action menu and select Set Status (Bulk). If you do 

not see this menu, your user account may not have the action permission for it. Contact your GCAS 

administrator. 

 

This menu brings the Set Status for Multiple Records dialogue. This window has two views, namely sim-

ple view and advanced view. The first time this dialogue opens, it is on simple view. 

 

8.6.1 Simple View 

Using simple view, you set the desired record status (active or inactive) for all mole composition rec-

ords between the two date/time perimeters. This may or may not be filtered to a stream number. 
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The user interface in simple view is pretty straightforward. Depending on how many stream numbers 

ever recorded into the database, stream number selection may look like this. 

 

If you choose (all streams), that will change record status of all mole composition records within the 

defined date boundaries regardless of stream numbers except spot samples. If you choose (spot sam-

ples), the status change only applies to spot sample records within the date interval. All next choices 

afterwards are the actual stream numbers available. You can also type the desired stream number if it 

is not on this list. To confirm, click OK and GCAS begins the batch operation. 

Note 

GCAS does not add automatic comment such as "This record status was changed to in-

active at <current computer time>" for bulk status change in simple view. Use advanced 

view if you want to attach comments to these records. 

To switch into advanced view, click Advanced button. 

8.6.2 Advanced View 

Advanced view offers more flexibility to set record status for multiple records. In advanced view, GCAS 

gives a list of mole composition records and you tick which ones to change status. 
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For the first time, GCAS lists all records within the last 24 hours. To change the date filter, choose Fil-

ter by date/time and enter the desired interval. If you choose Show all records, this turns off the 

date filter and you see all records ever exist for this GC device since the beginning. Click Refresh at 

the top right corner to apply the new date filter and reload the list. 

At the bottom left corner, there is a selection of available stream numbers. Change which stream num-

ber to display on the record list, then click Refresh to apply the stream number filter and reload the 

list. 

Tick or untick records you want to have their status to change. The Current status column displays 

current record status before the operation begins. To view the record content, click View record but-

ton available at each row. That button opens a new Mole Composition form and loads that particular 

record. In the example screenshot on the next page, there are 6 records to be set as inactive when 

you press OK button. The rest (those without check mark) are left untouched, thus their status remains 

active. 
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Click on the column header of the check boxes to quickly check all or uncheck all records in the list. 

 

Click the column header to quickly tick all or untick all records. 

You can also attach a comment to each record like what GCAS does in single record status change. To 

do so, give a check mark at Add comment to each record. Then write your comment at the text box 

provided. The same comment is applied to every ticked record when their statuses are being changed. 

The comment box recognises five keywords called macro(s) which it automatically highlights in red. 

Macro identifier starts with the '@' symbol and is all-uppercase. GCAS replaces these macros with ac-

tual values before writing them into database. 
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Macro keyword  Will be replaced with 

@OLDSTATUS Previous record status ("active" or "inactive") 

@NEWSTATUS New record status ("active" or "inactive") 

@DATE Current computer date, e.g. "15 September 2014". 

@TIME Current computer time in 24-hour format, e.g. "16:28:44". 

@DATETIME Current computer date and time, e.g. "15 September 2014 

16:28:44". 

For instance, this comment macro: 

This record was set as @NEWSTATUS at @DATETIME. Calibration gas tank is 

used up therefore the unnormalised total gradually declines. 

will be replaced with actual values such as: 

This record was set as inactive at 02 October 2014 14:24:01. Calibration 

gas tank is used up therefore the unnormalised total gradually declines. 

Which you can easily verify by visiting any record included in bulk operation, like this one. 

 

To switch back into simple view, click Simple button at the left side of OK button. 

8.7 Change Stream Number 

There are times a user may forget to set the correct stream number while importing mole composition 

data. Starting from GCAS version 1.8.2.0, Mole Composition form provides an option to change 

stream number. This is applicable to a single record or to multiple record via bulk operation.  
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From an open Mole Composition form, open the Action menu and select either Change Stream 

Number or Change Stream Number (Bulk). The former is for single record, and the latter is for mul-

tiple records. 

 

Changing stream number requires action permission of the same name, "change stream number". If 

your GCAS administrator did not assign you this permission, both Change Stream Number menu and 

Change Stream Number (Bulk) will not be visible. 

8.7.1 Single Record 

The dialogue for single record stream change is pretty straightforward. Select a new stream number 

from the dropdown list or manually type a number between 0 and 32,767, and finally click OK. 

 

Once the stream number is changed, Mole Composition form switches to the Comments tab and 

writes a default comment for you. It is a good idea to provide an explanation about the reason of this 

stream number change. Edit this comment as required and click Submit to save the comment. 
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8.7.2 Multiple Records 

The dialogue for bulk operation has similar workflow as change record status (multiple records, ad-

vanced view). Initially you set the desired stream number on the yellow dropdown, then configure 

whether to show all records or to filter them by date. Click Refresh to load the records and populate 

the list.  
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The dialogue also provides an optional filter by [old] stream number at the bottom-left corner. If you 

change these filters, be sure to click Refresh again to update the record list. Once the list is populated, 

tick or untick the records to include or exclude them from this bulk operation.  

You can also make GCAS add a comment to every affected record just like what happened on single 

record stream change. Check Add comment on each record followed by entering your comment on 

the designated text box. The comment box recognises certain keywords, called macro(s) that are auto-

matically highlighted as red. These macros are replaced by actual values before being written to data-

base. 

Macro identifiers start with '@' symbol and are all-uppercase. There are five keywords valid for bulk 

stream number change: 

Macro keyword  Will be replaced with 

@OLDSTREAM Previous stream number. 

@NEWSTREAM New stream number. 

@DATE Current computer date, e.g. "20 May 2016". 

@TIME Current computer time in 24-hour format, e.g. "16:53:14". 

@DATETIME Current computer date and time, e.g. "20 May 2016 16:53:14". 

For example, the default comment 

The stream number of this record was changed from [ @OLDSTREAM ] to [ @NEWSTREAM ] 

at @DATETIME. 

will become 

The stream number of this record was changed from [ 1 ] to [ 2 ] at 19 May 2016 

16:55:00. 

depending on the new stream number and your current computer clock. Ultimately, click OK to begin 

bulk operation. 

8.8 Insert Comment 

Like footprint and calibration records, users can also put comments on a mole composition record.  
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1. To insert comment, open the Comments tab or go to Action menu > Add Comment. 

2. Write your comment on the text box at the lower section of the form, then click Submit. 

3. Make sure the comment is correct (e.g. free from spelling errors) because once inserted into data-

base, you will not be able to remove the comment. 

If you do not see the textbox and the Submit button, i.e. the comment grid fills up the entire form, 

your user account may not have action permission to write comments or your user role is Read-only. 

Contact your GCAS administrator. 

8.9 Automatic or Fixed Scale 

Early versions of GCAS worked with percentage scale only, but now it works with any scale up to parts 

per billion (PPB). GCAS automatically determines which scale to use according to the unnormalised 

total value. If the unnormalised total is around 100, then it is percentage. If it is around 1000, probably 

it is permillage (‰). 

The automatic scale may not work as you expect. For example, a problem on the GC or the pipeline 

caused the unnormalised total to drop to 15%. This number is close to 10, therefore GCAS assumes 

the scale is decimal (0 to 10). You know the GC reads the composition in percentage scale, hence the 

decimal scale may hinder troubleshooting. 

To override this automatic scaling, browse to the desired mole composition record then open the Ac-

tion menu. Under Normalisation Scale, select which scale to use. Mole Composition form is now 

locked to the selected scale until it is closed. 
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8.10 Send to ISO 6976 Calculator or GPA 2172 Calculator 

Users whose GCAS licence includes GCAS feature ISO 6976 Calculator shall see an additional action 

menu called Send to ISO 6976 Calculator. This shortcut sends the mole composition record to ISO 

6976 Calculator tool. It calculates the calorific value (CV) and other properties of this composition. 
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Users with ISO 10723 feature included in their licences shall see two submenus. One will send normal-

ised single-point composition, while the other will send normalised multilevel-calibrated composition. 

Users without ISO 10723 see no submenus, as the menu itself will send normalised single-point com-

position. One exception is for ABB devices; you should see one additional submenu Send Exponential 

Values. This submenu grabs the normalised exponential composition and feeds it to ISO 6976 Calcu-

lator. For more information about ISO 6976 Calculator, visit chapter 20. 

 

Sending mole composition record to GPA 2172 Calculator is very similar. Assuming you have GPA 

2172 Calculator feature in your GCAS licence, open a Mole Composition form and browse to the de-

sired record. In the Action menu, instead of selecting Send to ISO 6976 Calculator, you should choose 

Send to GPA 2172 Calculator instead. The submenus should be the same. You may choose to send 

normalised single-point compositions, normalised multilevel-calibrated compositions (requires ISO 

10723), or normalised exponential composition (ABB devices only). 

8.11 Multilevel-Calibrated MC (ISO 10723) 

Multilevel-calibrated compositions exist because of multilevel calibrated response factor values. By 

taking MLC response factors, multiplying them with composition defined in the calibration certificate, 

and dividing them by original single-point compositions, you get MLC compositions. 
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Note 

This feature requires ISO 10723 feature in your GCAS licence. 

Users with ISO 10723 feature included in their licences will see two columns when Mole Composition 

forms is loaded for the first time. First is normalised single-point composition, second is normalised 

MLC composition. Unlike multilevel-calibrated RF, multilevel-calibrated mole composition (MC) have 

values close to its single-point counterpart. The difference between single-point and MLC mole com-

position is usually called bias. 

ISO 10723 conversion for mole composition requires: 

1. A multilevel calibration (MLC) coefficient set installed before the timestamp of the mole com-

position record, and 

2. An active, MLC-convertible calibration data or footprint before the timestamp of the mole 

composition record; which in turn requires: 

3. A multilevel calibration (MLC) coefficient set installed before the timestamp of this foot-

print/calibration record, and finally 

4. An active calibration gas certificate installed before the timestamp of this footprint/calibration 

record. 

If one or more of these conditions are not met, the mole composition record is said to be not converti-

ble. GCAS displays a  warning icon at the bottom of the form, under the pie chart, if: 

1. One or more of the four conditions above are not fulfilled, or 

2. The MLC coefficient set used by the mole composition record and coefficient set used by the 

preceding footprint/calibration data are different. This can happen if there is a new coefficient 

set installed between the timestamp of the calibration data and the timestamp of mole com-

position record. 

 

Click on the warning icon to see the detailed reason why the record is not convertible. Some items on 

the warning dropdown are shortcuts. For example if it says the record is not preceded by any MLC co-

efficient sets, clicking on that item brings you the MLC Coefficients form in edit mode so you can en-

ter the coefficients straight away. 

Non-convertible records display “N/A” in either single-point or MLC columns in both normalised and 

unnormalised, depending on its MLC flag bit. Records having flag bit marked as single-point which is 
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not convertible into MLC will show “N/A” in MLC columns and vice versa. Additionally, the delta col-

umn (through Show difference check box) will be empty. 

Note 

Spot samples are never convertible. Spot samples are always marked as single-point compositions. 

To see the MLC coefficients associated with current record, open the Action menu, select ISO 10723, 

then click View MLC Coefficients. This menu calls Multilevel Calibration Coefficients form and loads 

the correct coefficient set associated with current mole composition record. To see the calibration 

data or footprint which is used by current mole composition record, click View Associated RF in the 

same ISO 10723 menu. 

8.11.1 MLC Flag Bit 

Similar to footprint and calibration data, all mole composition records have MLC flag bit to indicate 

whether it is single-point or multilevel-calibrated. The easiest way to see MLC flag bit is to look at the 

title of pie chart. It says the stream number, for example “Stream 2”, and if the MLC flag bit is multi-

level-calibrated then the title appends “(MLC)” after stream number. If there is no other text, then it is 

single-point. Alternatively, open the Action menu and select ISO 10723. The first submenu is not click-

able but it states the MLC flag bit. 
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You can change MLC flag bit if necessary, however do this with caution. Because single-point compo-

sitions and MLC compositions are similar in values unlike single-point RF versus MLC RF which are 

completely different, it is easy to mistake which composition is single-point or MLC. 

8.11.2 Mark As versus Convert To 

Open Action menu, select ISO 10723, then select Mark As… or Convert To… and GCAS shows this 

dialogue box. 

 

Current flag bit is highlighted in yellow to clarify what the bit value is. Next, decide whether you need 

to mark the flag bit or convert the whole record. 

Mark As changes the flag bit only. The original numbers of all mole values are untouched. By contrast, 

Convert To changes the flag bit and converts all mole values, thus changing the actual numbers 

stored in database. Permanently. 

Mark As operation requires an action permission called "change MLC flag bit". On the other hand, 

Convert To operation requires "change MLC flag bit" plus one additional action permission called 

“MLC permanent conversion”. Had your GCAS administrator not granted you this permission, GCAS 

displays a message saying that you don’t have sufficient permission to perform conversion when you 

select Convert To in this dialogue box. 

Important 

Be extra cautious when using Convert To. Performing permanent conversions on wrong record will 

damage the record permanently. Furthermore because single-point compositions and MLC composi-

tions are similar in terms of numeric values, always double or triple check before using Convert To. 

8.11.3 Change MLC Flag Bit (Multiple Records) 

Chapter 8.11.2 explained how to change flag bit for one record. Mole composition records usually 

come from data capture operation, thus you may need to change flag bit of tens or even hundreds of 

records. To save your time, open the Action menu, select ISO 10723 and then click Mark As… (Bulk). 
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The dialogue box is slightly different from Set Flag Bit for Multiple Records dialogue belonged to foot-

print and calibration data. The Set Flag Bit for Multiple Records dialogue for mole compositions lets 

you filter by stream number, and later (optionally) by date or specific selections of records. 

 

 

 

Note 

There is no Convert To feature for bulk operation because it may damage multiple records. 
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8.11.4 MLC Constraints 

We moved the explanation about concepts and application of MLC constraints to chapter 24.2. Most 

of the time, users need not to worry about MLC constraints. However, there is a slim chance the de-

fault MLC constraints generates silly unnormalised total such as in the screenshot below. The ethane 

exceeds 150% which is nonsense. In those rare cases, you may need to override the MLC constraints in 

order to get the correct result. Read more on chapter 24.2 about MLC constraints. 

 

8.12 Exponential Composition 

This chapter is specific for ABB devices only. If you have GC devices of other brands, skip ahead. 

Chapter 7.13 Exponential RF has explained about exponential response factor and the need of multi-

pliers (M). To make things more complicated, ABB devices that are configured to output exponential 

RF will also output exponential mole composition.  

Although the name "exponential" may put some imagination that the values will skyrocket exponen-

tially, in reality exponential composition values more-or-less look like multilevel-calibrated composi-

tion. The values are close to the single-point composition, differing by a thin bias. The name "expo-

nential" comes from the formula behind the screen that involves exponential function (ex). Once again, 

this formula is proprietary of ABB. 
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The Mole Composition form looks different on ABB devices. It includes additional column to display 

exponential composition straight away. In addition, there are two delta columns—one is the difference 

between single-point and multilevel-calibrated composition, while the other is the difference between 

single-point and exponential composition. The delta column for single-point minus MLC is not availa-

ble for users without ISO 10723 feature on their licences. 

 

In the screenshot example above, the multilevel-calibrated column just shows "N/A" because this 

demo device does not have MLC coefficients in the database. ABB devices can have MLC coefficients 

too just like any other devices, therefore it is possible for all three columns display data. On another 

occasion, you may see the exponential column contains the word "Inconvertible" like the screen-

shot on the next page. 
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Check the Exponential MC warning at the bottom-left of the form to see why the single-point com-

position could not be converted to exponential. Usually the cause is missing multiplier values on the 

preceding calibration record. Click on that warning to open Calibration Data form on the said calibra-

tion record, then open Action menu and select View Multiplier Values, and finally follow chapter 

7.13.3 to add multipliers. 
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9 Calibration Gas Certificate 

Calibration gas certificate is a record of composition and uncertainty of a certified calibration gas 

package. These certificates usually come as a papers (hardcopies) or labels attached to the gas tank or 

canister. Calibration certificate module is required by Uncertainty Calculation module and is also used 

in ISO 10723 conversion. 

Note 

To use Calibration Gas Certificate module, you need GCAS feature either Calibration Gas Certificate or 

Uncertainty Calculation, or Uncertainty Trend to be included in your licence.  

GCAS feature Calibration Gas Certificate is given to customers who'd like to unlock Calibration Gas 

Certificate module but do not want the full Uncertainty Calculation module. If you purchased Uncer-

tainty Calculation feature or Uncertainty Trend, you have access to Calibration Gas Certificate module 

automatically. 

9.1 The Calibration Gas Certificate Form 

Calibration Gas Certificate form displays the content of a calibration certificate and its properties. To 

open Calibration Gas Certificate form, select a device on your device panel and go to the View menu > 

Calibration Certificate. 
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Calibration Gas Certificate form. Data in this screenshot is fictional, for illustration purpose only. 

First tab is called Table; here you see all mole percentage values and their corresponding absolute un-

certainty (as written on your paper certificate). It also shows the relative uncertainty which is calculated 

from your absolute uncertainty. This relative uncertainty is calculated at the k value (coverage factor) 

that is embedded in the certificate record in GCAS database. To find out what is the k value for this 

record, switch to the second tab. Relative uncertainty (also known as Ucal gas) is a part of uncertainty 

calculation. 

Second tab is Information where other properties of the certificate is listed. Third tab is Comments, 

which like the other forms in GCAS, displays user comments for the certificate. 

 

The "Information" tab. Data is fictional. 
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9.2 View Previous Certificates 

To view other calibration certificates, Click  Change certificate. Select a different certificate, then 

click OK or double click the list item. 

 

Click  Load latest certificate to return to the most up-to-date certificate. 

9.3 Input a New Certificate 

As calibration certificates come as hardcopies, you need to enter the mole percentage and uncertainty 

values meticulously by hand. Open the Action menu and select New Certificate. If you do not see this 

menu, you may not have the action permission for it. Contact your GCAS Administrator. 

 

The New Calibration Certificate entry form shall appear. Begin by entering certificate properties such 

as certificate number, issue date, install date, expiry date, minimum storage and/or usage pressure, 
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minimum storage and/or usage temperature, cylinder/gas tank/canister serial number, and the k value 

(coverage factor). 

 

Afterwards, enter the mole percentage and absolute uncertainty value of each gas in the certificate. Be 

alert for potential human error while typing. When you are confident with all entries, click Save to save 

the certificate record into database. 

Note 

Certificate number, k number (coverage factor) and install date must be specified. Other properties 

can have blank or null data. Typically, the next calibration cycle after the certificate install date is 

flagged as a footprint. 

If the certificate does not specify minimum storage/usage pressure and temperature, set them blank. 

If the cylinder number is not available, leave it blank too. If there is no info about issue date and expiry 

date, untick the corresponding check box inside the date picker. 

Unlike Mole Composition module which recognises any scale, calibration gas certificate must be ex-

pressed in percentage. This rule also applies to BTEX devices and single gas analysers. 
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Like any other text box series in GCAS interface, you can paste numbers from Microsoft Excel or other 

spreadsheet processing software. Press Ctrl+V inside the first text box and the rest will follow. Al-

ternatively, click  Paste. 

9.4 Edit a Certificate 

Sometimes human errors happen. If you did a mistake when entering numbers in the previous chap-

ter, go to the Action menu and select Edit Certificate. If you do not see this menu, you may not have 

the action permission for it. Contact your GCAS Administrator. 

 

This menu brings forth Edit Calibration Certificate form which is the same form as New Calibration 

Certificate but its function now is to correct mistakes in the numbers. Correct every wrong value and 

then click Save. 
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Although you can use Edit Calibration Certificate form to change the certificate install date, this can 

trigger unwanted side effect. If another certificate has already existed on the same date, GCAS will use 

whichever stored first in the database. 

9.5 Change Certificate Status 

Every certificate record has a status bit indicating whether the certificate is active or inactive. GCAS will 

not use inactive certificates in uncertainty calculation and ISO 10723 conversion. 

To change certificate status, open the Action menu and select Set Status or k-Number. If you do not 

see this menu, your GCAS user account does not have action permission for it. 

 

This menu brings forth the Set Status and k-Number dialogue where you can flip records status from 

active to inactive or the other way round. 

 

After you change the status, Calibration Gas Certificate form will reload the record and displays the 

new status at the top region of the form. It also switches to Comments and asks you to write a com-

ment of why the status was changed. Comments tab does not open in case your GCAS user account 

doesn’t have action permission to post comments. 
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9.6 Change k Number (Coverage Factor) 

Use the same Action menu as the previous chapter, Set Status or k-Number. This menu calls the Set 

Status and k-Number dialogue, then go choose a new k value. 

 

After you click OK, the form reloads the certificate and recalculates absolute uncertainty values ac-

cording to the new coverage factor. 
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Calibration certificate on k = 1 (left) and k = 2 (right). Data is fictional. 

9.7 Copy/Share Certificate to Other Devices 

A calibration gas certificate may be used by two or more GC devices. Before GCAS version 1.9.0.0, the 

only way to share a certificate is by going to New Certificate menu then enter the numbers on each 

device repetitively. Those days were over as we have Copy Certificate tool now. 

In order to copy certificate, first you need to open the source calibration certificate. Select the GC de-

vice on your device panel and go to View menu > Calibration Gas Certificate. Navigate to the certifi-

cate you want to copy. Next, open the Action menu > Copy Certificate to Other Devices. 

 

Copying certificate uses the same action permission as creating new certificate. If your GCAS user ac-

count can input a new certificate, you can copy existing certificate as well. 
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That menu brings Copy Certificate to Other Device dialogue. Please allow a few moments as it loads all 

GC devices accessible to your account. Once it's done, tick the target device you want to copy this cer-

tificate to. Tick as many devices as required. The calibration certificate is copied to all ticked devices. 

Finally, click Start copy. Copy progress is displayed on the progress log box. 

 

Note 

You can copy certificate only to devices having the same device type. Reason for this is because other 

device types may not have the same gases as the source device, like neopentane or benzene for ex-

ample. In the screenshot above, the source certificate is used by a Daniel C7+ complete device. Thus, 

the tree view on this window displays just Daniel C7+ complete devices. Other device types are ex-

cluded.  

You have the option to change the certificate number, install date, and cylinder number if required. 

Check the corresponding property to enable the text box or date picker, then change the property 

value before you click Start copy. 

9.8 Insert Comment 

If you need to put notes or other properties that were not supported by New Calibration Certificate 

form, post them in comments. 
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1. Open the Comments tab or go to Action menu > Add Comment. 

2. Write your comment on the text box at the lower section of the form, then click Submit. 

3. Make sure the comment is correct (e.g. free from spelling errors) because once inserted into data-

base, you will not be able to remove the comment. 

If you do not see the textbox and the Submit button, i.e. the comment grid fills up the entire form, 

your user account may not have action permission to write comments or your user role is Read-only. 

Contact your GCAS administrator. 

9.9 Send to ISO 6976 Calculator or GPA 2172 Calculator 

Although this feature is rarely used, calibration certificates do have mole composition. This means 

GCAS can calculate the calorific value and other properties of a calibration gas composition. Users 

whose GCAS licence includes GCAS feature ISO 6976 Calculator shall see an additional action menu 

Send to ISO 6976 Calculator. Users with GPA 2172 Calculator feature also see action menu Send to 

GPA 2172 Calculator. 

 

Similar to Send to ISO 6976 Calculator menu on mole composition, this menu sends the mole compo-

sition part of the calibration certificate to ISO 6976 Calculator tool. Then it calculates the calorific value 

(CV) and other properties automatically. 
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The same can be applied for GPA 2172 calculation too. On the action menu, select Send to GPA 2172 

Calculator. 
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10 Data Analysis 

Data Analysis is a tool to see trend of GC parameters over time in history. 

Note 

This module requires GCAS feature Data Analysis to be included in your GCAS licence. 

Data Analysis works for one device as it displays trends of various data for one device. The comple-

ment of Data Analysis is called Data Comparison, which consists of several modules and one of them 

is Mole Composition Comparison. 

10.1 The Data Analysis Form 

Select the desired GC device on the device panel, then go to the View menu > Data Analysis. The 

form consists of three sections: parameters, chart, and comments. 

 

Parameters section at the top is where you set everything in order to get the chart you want. Chart 

section at the bottom graphs the chart. Comments tab is the place to write your comment. 

10.2 Parameters, Chart Types, and Components 

This chapter explains the contents of the parameter section of Data Analysis form. 



GCAS® Manual Guide rev. 26 

Page 155 of 587 

 

10.2.1 Parameters 

 

This is the main switch to select which parameter to be graphed on the chart. Users can graph the fol-

lowing parameters: 

1. RF - Response factor 

2. RT - Retention time 

3. MC – Mole composition 

4. R2 - Correlation parameter 

If you see the MC (mole composition) option is disabled, it means you do not have Live Data Analysis 

feature in your GCAS licence. 

10.2.2 Chart Types 

Chart Types are more specialised options for the selected parameter. Available chart types vary, de-

pending on the selected parameter. 

10.2.2.1 Selected parameter: RF (response factor) 

 

These options show up when the selected parameter is response factor (RF). 

1. RF trend graphs the actual response factor values over time in history. 

2. RF deviation trend graphs the deviation (difference) of RF values against footprints in percent-

age. This gives further options which are: 
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• Each latest footprint: Each RF value is compared against its latest footprint. 

 

 

• This footprint only: All RF values are compared against a particular footprint value. The foot-

print to set as the comparison base is configurable through Change footprint link. 

 

10.2.2.2 Selected parameter: RT (retention time) 

 

These options show up when the selected parameter is retention time (RT). They are very similar to RF 

chart types. 
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1. RT trend graphs the actual retention values over time in history. The unit of measurement is sec-

ond (s). 

2. RT deviation trend graphs the deviation (difference) of RT values against footprints, also in sec-

onds (s). This also gives two further options: 

• Each latest footprint: Each RT value is compared against its latest footprint similar to RF devi-

ation chart. 

• This footprint only: All RT values are compared against a particular footprint value. The foot-

print to set as the comparison base is configurable through Change footprint link. 

 

 

10.2.2.3 Selected parameter: R2 (correlation) 

 

The chart will only show the actual value of R2 calculations. This parameter is not compared against 

footprint values, but against a low alarm limit. The low alarm limit is configured in the Analysis Param-

eter form. If it is not set, the default limit 0.995 is used. 

10.2.2.4 Selected parameter: MC (mole composition) 

 

The chart will graph mole composition values of the selected stream. Refer to the user manual of your 

GC device to know which stream numbers deliver mole percentage data. 

Available stream numbers are determined from data that has been existed in database and also the 

mole composition stream definition in Register Mapping form. If you know there is a stream number 
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that is not on this dropdown list yet, simply type the stream number on the dropdown box manually 

then click the  Refresh button or press F5. 

You can also display spot sample records and/or calibration gas certificate alongside the regular mole 

composition record on the chart. Spot samples are displayed as triangles, calibration certificates are 

displayed as bigger triangles, while regular mole composition values appear as ordinary line charts. 

Tick the corresponding check box to show or hide these special records. 

Apply lag time check box will shift all spot sample dots to the right amount of calculated lag time. 

Thus, the triangle points are closer to the regular mole composition line chart or even coincide. This 

way you can see if the spot sample dot and the line are far apart in terms of Y-axis value, it indicates 

problems within your pressure letdown system. This check box is available if you have GCAS feature 

Lag Time Calculator in your licence. 

Users with GCAS feature ISO 10723 included in their licences see an additional dropdown selection 

ISO 10723 trend. This dropdown contains three options: 

- Single-point compositions converts any multilevel-calibrated records within the plot range 

into single-point compositions before graphing them to the chart. Records already marked as 

single-point are plotted as usual.  

- MLC compositions converts any single-point records within the plot range into multilevel-

calibrated compositions before graphing them to the chart. Records already marked as multi-

level-calibrated are plotted as usual. 

- Don’t convert ignores the MLC flag bit and plots all records within the plot range as they are. 

Use this if you have slow network connection to the database server and you are confident 

that this GC device never have mixed MLC records and single-point records. Never select this 

option if you are unsure whether the device has mixed MLC flag bit as it will produce invalid 

MC trend chart. 

Users with both GCAS feature ISO 10723 and Data Comparison included in their licences see a link 

Compare both under the ISO 10723 trend dropdown. This link is available if only one gas is selected. 

It calls Mole Composition Comparison form, sends the selected gas, date/time range, and stream 

number, then instructs Mole Composition Comparison form to compare single-point versus MLC 

compositions. If the single-point and MLC curves are overlap or very close to each other, your GC is 

more likely in a good condition. If they drift too far, your GC has too much bias. 

10.2.3 Components 

Components are selections of available gases to draw on the chart. In most use, usually only one gas is 

selected. GCAS can display multiple gases on one chart as required. 
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10.2.3.1 Selected parameter: RF or RT 

 

Components for C7-complete devices. 

Depending on your GC device type, you would see between 1 to 15 gases. C6-without-neopentane 

have ten gases, while C10-complete devices have fifteen. 

10.2.3.2 Parameter selected: MC (mole composition) 

You should see all gases as in RF or RT, with one additional component at the bottommost of the list: 

Unnormalised total. GCAS always graphs normalised mole composition chart for gas component — 

except for, obviously, the unnormalised total. 

10.2.3.3 Parameter selected: R2 (correlation) 

 

Available R2 series for Daniel C7 devices. 

For R2 parameter, you may see one, two, three, or no items. Depending on your GC device type, the 

wording of these items may vary. These components graphs different R2 values calculated from their 

RF-MW logarithm computation. 

Device type  Available R2 trends 

Daniel C6+ C1-C2-C6 

C3-C4-C5 

C1-C2-C3-C4-C5-C6 

Daniel C7+ C1-C2-C7 

C3-C4-C5-C6 

C1-C2-C3-C4-C5-C6-C7 

Daniel C9+ C3-C4-C5 

C6-C7-C8-C9 

Daniel C10+ type A C3-C4-C5-C6 

C7-C8-C9-C10 
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Device type  Available R2 trends 

Daniel C10+ type B C3-C4-C5 

C6-C7-C8-C9-C10 

ABB C6+ C3-C4-C5 

C4-C5-C6 

C3-C4-C5-C6 

ABB C7+ C3-C4-C5-C6 

C4-C5-C6-C7 

C3-C4-C5-C6-C7 

Siemens C6+, C7+, C9+, C10+ Siemens does not have R2 trend. 

Elster C6+ C3-C4-C5 

C4-C5-C6 

C3-C4-C5-C6 

Elster C7+ C3-C4-C5-C6 

C4-C5-C6-C7 

C3-C4-C5-C6-C7 

Elster C9+ C3-C4-C5-C6-C7-C8-C9 * 

Elster C10+ C3-C4-C5-C6-C7-C8-C9-C10 * 

LNG C2−, C3−, C4−, C5− LNG devices do not have R2 trend. 

BTEX analyser BTEX analysers do not have R2 trend. 

Single gas devices  

(H2S, moisture, 1-gas) 

Single gas analysers do not have R2 trend. 

*subject to change in the future. 

10.3 Date and Time Range (Plot Range) 

When you open the Data Analysis form, it tries to load data from the last 30 days. To change this date 

and time range, set the desired range using the two date pickers inside the options box. The time uses 

24-hour format. Click  Refresh button to reload the chart. 
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When the chart is refreshed, chart data is cached in computer memory. So if you select or unselect 

some components, the requested data is loaded from memory instead of database as long as date 

and time range does not change. Every time you push the refresh button, it also refreshes this cache. 

Cache is cleared when the form is closed. 

GCAS counts how many records are to be displayed, and displays this count under the date picker in-

put fields. Would there be too many records to load, GCAS alerts you that the load-and-draw process 

may take a prolonged time. Also, the dots of the line chart may clutter the chart area thus makes it 

difficult to interpret. Alert limit is hardcoded to 150 records for RF, RT, and MC; and 100 records for R2. 

 

10.4 Mean and Standard Deviations 

On certain parameters, GCAS can calculate the mean (average) and twice the standard deviations. The 

table below describes which parameter has this capability. 

Parameter Mean & 2 std. dev enabled? Available options 

RF Yes 1. x records from footprint, 

2. All records from footprint, 

3. What being displayed 

RT Yes 1. x records from footprint, 

2. All records from footprint, 

3. What being displayed 

MC Yes 1. What being displayed 

 

 

R2 No None 
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Note 

GCAS can only calculate mean and standard deviations if only one component is selected. Mean and 

standard deviations cannot be computed for two or more active components on the chart. 

Important 

If you are working offline, computed mean and standard deviations may not be accurate because it 

depends on how much data available on your temporary database. GCAS displays offline warning icon 

to alert this potential source of inaccuracy. Try to stay in online mode as much as possible while work-

ing with Data Analysis module. 

To show or hide the mean and twice standard deviations, use the checkbox Display mean and ± 2 × 

standard deviations. 

 

There are three options for mean and standard deviation calculation. 

a) x records from footprint (default x = 25 records) 

Mean and twice standard deviations are calculated from first x records (default is 25) after each 

footprint. 

 

Special case if you are drawing RF or RT deviation trend and you have chosen a particular foot-

print as a comparison base, this option will calculate the mean and twice the standard deviations 
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from x records after that footprint only. 

 

b) All records from footprint 

Mean and twice standard deviations are calculated from all records between footprints. 

 

Special case if you are drawing RF or RT deviation trend and you have chosen a particular foot-

print as a comparison base, this option will calculate the mean and twice the standard deviations 

from all records between the selected footprint and one next footprint thereafter. 

 

c) What being displayed 

The mean and twice standard deviations are simply calculated from all the data points which 

have been drawn on the chart for your choice of date range. Unlike the other two options which 

require database reload through the Refresh button, this option uses the data already there on 

the chart area. 
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In addition, GCAS provides simple statistics when mean and standard deviation lines are on. Click 

Generate summary link under the three radio buttons, then the Data Analysis form generates a sta-

tistics summary for you. 

 

10.5 Zoom Mode and Selection Mode 

This button switches whether the chart is in zoom mode or selection mode. Zoom mode lets you zoom 

in to a particular area of the chart in case there are too many data points cramped on small area. Se-

lection mode allows you to drag a rectangle to select a pack of data points and manipulate them us-

ing the available context menus.   

 

As shown in the example screenshot above, the chart is now in zoom mode. Click it to toggle. 

  

In zoom mode, drag a rectangle on the region you would like to zoom. 
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Use the scroll bars to pan the zoomed chart. To zoom in further, drag another rectangle on the area 

you would like to enlarge more. 

Click on the circled minus button Θ on both scroll bars to zoom out one step. To zoom all-out, simply 

press the Home button on your keyboard. Otherwise, right-click on the chart and select Zoom All Out 

submenu. 

In selection mode, drag a rectangle to select an area on the chart. Right click the selection to open 

context menus and you see several menus available in selection mode. Chapter 10.9 will explain each 

function of these menus. To cancel selection, right click the chart and choose  Clear Selection 

Area. 
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10.6 Change Axes Scale 

When zoom is not enough, you can enforce a custom range for both X-axis and Y-axis of the chart. To 

do this, right-click on the chart and select either Set X-axis Scale or Set Y-axis Scale. 

 

For Y-axis, specify the desired numeric range. The input fields accept decimal values. For example, take 

the chart screenshot above and let us enter this range: 

 

Chart is then drawn within the new, confined range similar to the screenshot on the next page. Notice 

that the chart line is truncated because there are data points having values outside of this range. 
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To revert back to the automatic scale, right-click the chart and select Reset Y-axis scale. 

For X-axis, specify the desired date and time interval. 

 

Similarly, to undo the scale you would right click on the chart and select Reset X-axis scale. 

Depending on the custom date interval, the date mark on the X-axis may include the time. For more 

detailed interval such as from 00:00 to 08:00 of the same day, the X-axis would display the date and 

the time (hh:mm:ss) as well. When you reset X-axis scale but you notice the date/time marks on X-axis 

do not reset, right click on the chart and choose Reset X-axis Tick Mark Format. 

10.7 Save or Copy the Chart 

To save the chart as image file, right click on the chart and select Save Chart as Picture. 
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To copy the chart, right click and select Copy Chart Image. Then you may paste the image into Mi-

crosoft Paint, Microsoft Office, or any software that accepts bitmap image/picture data on clipboard. 

Tips before saving or copying 

Enlarge the chart by maximising the Data Analysis form, collapsing the device panel, and expanding 

the chart area through the  Expand button at the top of Data Analysis form. 

To make the line chart black, use the toggle colour/black button  on the options box. This button 

is available if only one component is ticked. Black line appears better on monochrome printers if the 

saved file or copied image is about to be printed. 

If you do not want the gridlines or chart legend to be included in the image file, right click on the 

chart and uncheck Show Gridlines or Show Legend or both. 

10.8 Colourblind Assistance 

To aid users with colour blindness (protanopia and deuteranopia), GCAS provides an alternative colour 

scheme for the chart. Use the  Colourblind assist button on the options box. 

http://en.wikipedia.org/wiki/Color_blindness#Dichromacy
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Normal colour scheme, colourblind assistance turned off. 

 

Alternative colour scheme, colourblind assistance turned on.  

Similar colours are distinguished by dash or dotted style. 
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10.9 Selection Mode Menus 

These menus are available if Data Analysis chart is in selection mode and there is a selection rectangle 

on the chart. 

 

Menu Which  

parameter? 

Licence 

requirement 

Function 

Zoom In Here Any - Zooms in to the selection area. 

Generate Summary 

Here 

Any - Generates statistical summary for the se-

lected area (in contrast to Generate sum-

mary link which generates summary for the 

entire X-axis) 

Frame This Selection Any - Literally puts a rectangular frame around 

the selection, for presentation purpose. 
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Menu Which  

parameter? 

Licence 

requirement 

Function 

Remove Frames Any - Deletes all frames created through Frame 

This Selection menu. 

Set These Records as 

Inactive 

Any - Sets all records within the X-axis range of 

the selection area as inactive. If you are on 

R2 trend chart, this sets the underlying 

footprint/calibration records as inactive. 

Mark These Records 

as Single-Point 

RF, MC ISO 10723 Sets the MLC flag bit of all records within 

the X-axis range of the selection area as 

single-point RF or MC. 

Mark These Records 

as MLC 

RF, MC ISO 10723 Sets the MLC flag bit of all records within 

the X-axis range of the selection area as 

multilevel-calibrated RF or MC. 

Send to ISO 6976 

Calculator (Averaged) 

MC ISO 6976 

Calculator 

Sends the averaged mole composition 

value of each gas of all records contained 

inside the selection area to ISO 6976 Calcu-

lator. 

The ISO 6976 output values may be differ-

ent from the next menu (sending to ISO 

6976/GPA 2172 Trend and then activating 

the mean and standard deviation lines). 

Send to GPA 2172 

Calculator (Averaged) 

MC GPA 2172 

Calculator 

Sends the averaged mole composition 

value of each gas of all records contained 

inside the selection area to GPA 2172 Cal-

culator. 

The GPA 2172 output values may be differ-

ent from the next menu (sending to ISO 

6976/GPA 2172 Trend and then activating 

the mean and standard deviation lines). 

Send to ISO 6976 / 

GPA 2172 Trend 

MC ISO 6976 

Trend 

-or- 

GPA 2172 

Trend 

Loads ISO 6976/GPA 2172 Trend form and 

instructs it to plot the ISO 6976 or GPA 

2172 values for mole composition records 

contained inside the selection area. 

Send to Correlation 

Calculator (Selection, 

Averaged) 

RF trend;  

not RF error 

trend 

- Sends the averaged RF value of any gases 

that intersects with the selection area, to 

Correlation Calculator.  

For example, if your selection area contains 

methane and ethane line, only methane 

and ethane are sent to Correlation Calcula-

tor. Their RF values inside the selection 

area are averaged and then sent. 
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Send to Correlation 

Calculator (All Gases, 

Averaged) 

RF trend;  

not RF error 

trend 

- Sends the averaged RF value of all gases of 

all records contained inside the selection 

area to Correlation Calculator.  

Send to Mole Com-

position Comparison 

MC; 

requires only 

one gas se-

lected 

ISO 10723 

and Data 

Comparison 

Sends mole composition values of the se-

lected gas of all records contained inside 

the selection area to Mole Composition 

Comparison; then instructs the form to 

compare the single-point versus MLC com-

position of that gas. 

10.10 Other Visual Cues 

Enlarge chart area by hiding the parameters panel through the  Expand button. To show the pa-

rameters panel again, click  Collapse. 

 

 

Hover your mouse cursor over a data point to see its value. 
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Alternatively, use the  Show values button (or right click on the chart and choose Show Values). 

 

 

We don’t recommend to show values on chart with many data points as the number labels may flood 

the chart area — unless you have zoomed it in. 
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Crosshair cursors are the dashed lines appearing on the chart when you left-click on it or as a remnant 

of zoom operation. These may act as a ruler or guide. To remove them, click  Hide crosshair cursor 

button (or right-click on the chart then select Hide Crosshair Cursors). 

 

 

To use black background, right click on the chart and click Toggle Light/Dark Background menu. 

Use the same menu to revert back to white. The black background is permanent when you save the 

chart as image file or copy chart image to clipboard. 

 

10.11 Insert Comment 

To view or write comment, open the Comments tab. 
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Write your comment and set the appropriate date of topic, then click Submit. Your comment will have 

a yellow background to distinguish it from comments by other users. Date of topic is an additional 

information of which calibration data/footprint/mole composition record you are writing your com-

ment for, thus other users know the correct data point to refer to. 

Make sure that the comment is correct e.g. free from spelling errors, because once submitted you 

would not be able to remove your comment. This is a part of audit trail requirements. 

The main  Refresh button does also reload comments. 

If you do not see the text box to write your comment, i.e. you only see the comment grid view, your 

GCAS user account doesn't have the action permission to write comment in Data Analysis. Contact 

your GCAS administrator. 
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11 Uncertainty Calculation 

Uncertainty Calculation is a module to calculate the uncertainties of your GC device. This is related to 

condition-based maintenance which allows early detection of GC failures. Method to calculate GC un-

certainties is described in the journal article  

Sutan, A. and Daniel, P., "Gas Chromatography – Conditional Based Monitoring and Live Uncertainty 

Calculation", North Sea Flow Measurement Workshop (2012)  

and  

Sutan, A and Daniel, P., "Gas Chromatography Maintenance using Uncertainty-Based CBM", The Amer-

icas Flow Measurement Conference (2013). 

Note 

This module requires GCAS feature Uncertainty Calculation to be included in your GCAS licence. 

Uncertainty calculation takes five input groups: 

1. Uncertainty from the calibration gas — a calibration gas certificate is mandatory; 

2. Uncertainty from GC repeatability and linearity, 

3. Uncertainty from GC reproducibility, 

4. ISO 6976:1995 inputs, and 

5. GPA 2172-09 inputs. 

And it produces three output groups: 

1. Uncertainties of ISO 6976:1995 outputs, 

2. Uncertainties of GPA 2172-09 outputs, and 

3. Uncertainties of GC for each gas component. 

11.1 The Uncertainty Calculator Form 

To calculate uncertainties of a particular GC device, select the device on your device panel or recent 

device panel. Then, go to the View menu > Uncertainty Calculation. 

The form behaves like a wizard although it is not. It has a collection of pages categorised into three 

groups: inputs, calculation, and outputs. To navigate between pages, use the two buttons at the bot-

tom-right corner Next page or Previous page; or you can also jump to the desired page straight 

away through the navigation tree on the left side. 

http://www.i-vigilant.co.uk/cz_doc/download/GCAS%20NSFMW%202012.pdf
http://www.i-vigilant.co.uk/cz_doc/download/GCAS%20NSFMW%202012.pdf
http://www.i-vigilant.co.uk/cz_doc/download/Gas%20Chromatography%20Maintenance%20Using%20Uncertainty%20Basis%20Conditional%20Based%20Monitoring.pdf
http://www.i-vigilant.co.uk/cz_doc/download/Gas%20Chromatography%20Maintenance%20Using%20Uncertainty%20Basis%20Conditional%20Based%20Monitoring.pdf
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Uncertainty Calculator form and its parts. 

The form features 30 pages as laid out in the navigation tree. Each terminal item links to its page 

within the form. Click on any item below to read more about its part. 

• Inputs 

o Uncertainties to include 

o Uncertainty from the calibration gas 

o Uncertainty from GC repeatability and linearity 

▪ Repeatability 

▪ Linearity 

▪ Mole percentage range 

o Uncertainty from GC reproducibility 

o ISO 6976 / GPA 2172 inputs 

• Calculations (normally collapsed) 

o Uncertainty of calibration gas 

o WRM RF and standard deviation 

o Uncertainty of repeatability 

o Footprint and calibration data 

o Uncertainty of reproducibility 

o Standard relative uncertainty 

o Compressibility factor 

o ISO 6976 calculation 

o GPA 2172 calculation 

o ISO 6976 sensitivity analysis for Ucalibration gas and Ureproducibility 
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o ISO 6976 sensitivity analysis for Urepeatability 

o GPA 2172 sensitivity analysis for Ucalibration gas and Ureproducibility 

o GPA 2172 sensitivity analysis for Urepeatability 

• Outputs 

o ISO 6976 uncertainties 

▪ Summary page 

▪ Uncertainty of CV (calorific value) 

▪ Uncertainty of MW composition 

▪ Uncertainty of Wobbe index 

▪ Uncertainty of relative density/specific gravity 

▪ Uncertainty of standard density 

o GPA 2172 uncertainties 

▪ Summary page 

▪ Uncertainty of GHV (gross heating value) 

▪ Uncertainty of compressibility 

▪ Uncertainty of relative density 

The navigation button Next page and Previous page change pages in sequential order. They may 

skip some pages depending on the selection you made on the previous page. 

At any time you leave input pages, Uncertainty Calculator form should perform all calculations. Once 

you are at intermediary calculation pages or output pages and you notice a mistake, you can always 

go back to the input pages either by clicking Previous page button successively until the form arrives 

at the desired page, or jump straight away using the navigation tree. After you make some changes in 

the inputs and go forward to later page, the form shall perform automatic recalculation thus new out-

put values will update accordingly. If you notice the form does not recalculate, click Recalculate but-

ton or press F5 key on your keyboard to force a recalculation. 

11.2 Calculation Steps 

The form calculates your GC uncertainty is using the sequence below. 

1. Calculate Ucal gas if selected. 

2. Calculate Urepeatability if selected. 

3. Calculate Ureproducibility if selected. 

4. Calculate UGC at k = 1 which is the standard relative uncertainty. (k is coverage factor.) 

5. Calculate Zmix (compressibility factor of mixture) and Zair based on the given base temperature 

and combustion temperature. 

6. Perform all ISO 6976 calculations. 

7. Perform all GPA 2172 calculations. 

8. Perform sensitivity analysis on ISO 6976 outputs. 

9. Perform sensitivity analysis on GPA 2172 outputs. 

10. Calculate UCV, UMW, UWobbe, USG, and Uρ — all uncertainties of ISO 6976 outputs. 

11. Calculate UGHV, UZ, and URD — all uncertainties of GPA 2172 outputs. 
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11.3 Input Pages 

Input pages collect all required information before the form performs a calculation. Visit subchapters 

below to get help about a specific page. 

11.3.1 Uncertainties to Include 

You can select which uncertainties to include in the calculation of standard relative uncertainty (UGC). 

UGC = √ (Ucal gas)
2

+ (Urepeatability)
2

+ (Ureproducibility)
2
 

For example, if you decide not to include uncertainty from the calibration gas, Ucal gas is replaced by 

zero and the formula changes to 

UGC = √ (Urepeatability)
2

+ (Ureproducibility)
2
 

You must select at least one uncertainty component in order to proceed to the next page. If you don't, 

UGC will be zero and all subsequent calculations afterwards will be meaningless. 

Also in this page there is a check box to control whether to include ISO 6976 standard measurement 

uncertainty of 0.05% at the end of calculation. In the standard, ISO 6976 uncertainty is 0.1% at k = 2. 

Calculation of combined standard uncertainty uses k = 1, hence the ISO 6976 measurement uncer-

tainty becomes 0.05%. Every result of ISO 6976 calculation shall carry this 0.05% uncertainty. The same 

thing is also available for GPA 2172 calculation through a separate check box. By default, these two 

check boxes are ticked.  

Note 

GPA 2172 calculation is not available for BTEX devices, moisture analysers, and single gas devices 

that are not H2S. GPA 2172 calculation results for these device types will be all-zeroes and yield the 

uncertainty value of 0.1%. 

11.3.2 Uncertainty from the Calibration Gas 

Select a calibration certificate in GCAS database. By default, GCAS loads the last installed certificate. 

This certificate is used later on when calculating Ucal gas, Ureproducibility, ISO 6976 calculations, and GPA 

2172 calculations. 

You can see all installed calibration certificates through Calibration Gas Certificate form. That form 

also provides a way to submit a new certificate if the desired certificate has not been entered to the 

database. 
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11.3.3 Uncertainty from GC Repeatability and Linearity 

To calculate Urepeatability, GCAS requires three sets of information: repeatability coefficients, response 

concentration coefficients, and mole percentage range. 

11.3.3.1 GC Repeatability 

𝑠𝑖 = 𝑎 + 𝑏𝑥𝑖
∗ + 𝑐𝑥𝑖

∗2
+ 𝑑𝑥𝑖

∗3
 

In this formula, si is the standard deviation of unnormalised component i. The letter i is a simplification 

of enumeration from methane (e.g. from i = 0) to the highest carbon count. Four coefficients a, b, c, 

and d are called repeatability coefficients or parameters of precision factors. Detailed explanation of 

this formula is available on journal article Sutan, A. and Daniel, P., "Gas Chromatography – Conditional 

Based Monitoring and Live Uncertainty Calculation", North Sea Flow Measurement Workshop (2012).  

You need to enter these repeatability coefficients on the provided data grid. Double click the cell or 

press F2 to invoke edit mode. Alternatively, you can paste from Microsoft Excel or other spreadsheet 

processing software as long as there are 4 (four) columns and equal number of rows. Click the Paste 

link above the grid to do so. The next link Reset all will reset all numbers back to zero. 

 

Because these coefficients rarely change (about once a year), we suggest you to store these coeffi-

cients in database and recall them the next time you open Uncertainty Calculator form. To store a new 

coefficient set, click New set. This link opens a blank Uncertainty Coefficients form and you type (or 

paste) the coefficient numbers there. Visit chapter 12 to get detailed explanation of Uncertainty Coef-

ficients form. 

If GCAS detects there is at least one coefficient set in database, GCAS loads the latest coefficient set 

automatically for you. Nonetheless, if this is not the coefficient set you want, you can change which 

http://www.i-vigilant.co.uk/cz_doc/download/GCAS%20NSFMW%202012.pdf
http://www.i-vigilant.co.uk/cz_doc/download/GCAS%20NSFMW%202012.pdf
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coefficient set in the database to load. Click Choose existing coefficient set, then GCAS displays the 

familiar Select a coefficient set dialogue. 

 

Hover your mouse over the list item, on its date column, to reveal a tooltip about the description of 

the coefficient set. (Due to Windows limitation, tooltip can only appear at the first column.) Click OK 

or double click the list item to load the coefficient set. 

You can edit the coefficients after you load them from database too. Just go to the cell, double click or 

hit F2 to invoke edit mode, and enter the correct number. However, this change is only temporary as it 

is only used in current session of uncertainty calculation. If you need a permanent edit, you have to use 

Uncertainty Coefficients form then either create a new coefficient set or edit the existing one. Click 

Edit this set to open Uncertainty Coefficients form and invoke its edit mode. This link is only available 

if you haven't changed any numbers since the coefficient set is loaded from database. To undo all 

changes and revert back to the original coefficients from database, click Reload set. 

11.3.3.2 GC Linearity 

Formula displayed on this wizard page is very similar to GC repeatability: 

𝑠𝑖 = 𝑎 + 𝑏𝑥𝑖
∗ + 𝑐𝑥𝑖

∗2
+ 𝑑𝑥𝑖

∗3
 

Yet, the s here is different from the previous s. This formula is used to calculate the standard deviation 

of mixture gas and sample gas. The coefficients a, b, c, and d here are called response concentration 

coefficients or parameters of true calibration functions.  
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Similarly, you need to enter these response concentration coefficients on the provided data grid. Dou-

ble click the cell or press F2 to enter edit mode. Alternatively, you can paste from Microsoft Excel or 

other spreadsheet processing software as long as there are 4 (four) columns and equal number of 

rows. 

 

You can also load a coefficient set stored in database. If you already loaded a set for GC repeatability, 

it also loads for GC linearity. Go to page 180 to read more about loading a coefficient set from data-

base. 
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11.3.3.3 Mole Percentage Range 

 

Choose how the mole percentage plus-minus range be calculated. This plus-minus range will affect 

the final Urepeatability value. 

• Assume universal range: Every gas (component) uses the same range. This is the most inac-

curate option but provides a fail-safe estimate if you do not have sufficient data in Mole Com-

position module. 

• Set individual range: Each gas (component) has its own plus-minus range and is independ-

ent from one another. This option has better accuracy compared to the universal range. 

• Manual range: You will type the minimum mole percentage and maximum mole percentage 

directly at WRM RF page later. Accuracy depends on these values. Use this option if you want 

to test some unexpected numbers. 

• Use ±2 standard deviation of mole composition: The plus-minus range is taken from this 

standard deviation: 

 

of mole composition records within the given period. This option provides the best accuracy. 
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Balanced gas option keeps your mole percentage low limit and high limit at 100%. This option is 

turned on by default and you can designate which one as the balanced gas. Typically, methane is the 

balanced gas because it is the largest component in the mixture and outnumbers other gases many 

times. To turn off this behaviour, untick Balanced gas check box.  

Two tables below illustrate how the calculation will go if balanced gas option is turned off (top) and 

turned on (bottom). In this example, balanced gas is methane and a universal plus-minus range 15% is 

enforced. 

Component Mole percentages 

as in certificate 

Mole percentages 

− 15% 

Mole percentages 

+ 15% 

Methane 89.540070 76.1091 102.9711 

Nitrogen 0.064110 0.0545 0.0737 

CO2 0.131230 0.1115 0.1509 

Ethane 0.061000 0.0519 0.0702 

Propane 0.055400 0.0471 0.0637 

i-Butane 0.049180 0.0418 0.0566 

n-Butane 0.056100 0.0477 0.0645 

Neopentane 0.065100 0.0553 0.0749 

i-Pentane 1.665080 1.4153 1.9148 

n-Pentane 2.202900 1.8725 2.5333 

Hexane 5.548780 4.7165 6.3811 

Total 99.43895 84.5232 114.3548 

Balanced gas option is turned off. 

Component Mole percentages 

as in certificate 

Mole percentages 

− 15% 

Mole percentages 

+ 15% 

Methane* 89.540070 91.5860 88.6163 

Nitrogen 0.064110 0.0545 0.0737 

CO2 0.131230 0.1115 0.1509 

Ethane 0.061000 0.0519 0.0702 

Propane 0.055400 0.0470 0.0637 

i-Butane 0.049180 0.0418 0.0566 

n-Butane 0.056100 0.0477 0.0645 

Neopentane 0.065100 0.0553 0.0749 

i-Pentane 1.665080 1.4153 1.9148 

n-Pentane 2.202900 1.8725 2.5333 

Hexane 5.548780 4.7165 6.3811 

Total 99.43895 100.0000 100.0000 

Balanced gas option is turned on for methane. While other gases follow ±15% range,  

methane is calculated by 100 – sum of the others. 

However, if you choose another gas which has relatively small percentage as the balanced gas and it 

causes plus-minus range to fall onto negative number, GCAS replaces the negative percentage with 
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zero and thus their summation is not guaranteed to be 100%. Always choose the component with 

largest percentage as the balanced gas. 

11.3.4 Uncertainty from GC Reproducibility 

 

Select a footprint as a reference. You can see all footprints through Footprint form. If you choose a 

footprint that happens before the certificate installation date, GCAS displays a  warning icon. 

Next, decide how many calibration data to include in the calculation. GCAS offers three choices: 

• Until GCAS bumps into next footprint: The selected footprint itself and all calibration data 

up to one last calibration before next footprint are included in the calculation of Ureproducibility. 

• Until today: The selected footprint itself and all calibration data including subsequent foot-

prints and all their calibration data afterwards, all the way to this very moment (i.e. current 

computer time) are included in the calculation of Ureproducibility.  

• Custom range: You can choose from which calibration record exactly to which calibration rec-

ord that are included in the calculation of Ureproducibility. A  star indicates a footprint. 

11.3.5 ISO 6976/GPA 2172 Inputs 

ISO 6976 and GPA 2172 calculation require five inputs: 

1. Mole composition to use — here GCAS uses the selected calibration certificate as the mole 

composition, 

2. Base pressure (ISO 6976). The default is 1 atmosphere (101325 Pa) absolute, 
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3. Base temperature (ISO 6976), 

4. Combustion temperature (ISO 6976), and 

5. Reference pressure (GPA 2172). 

GCAS supports six pairs of combustion-base temperature: 

• 0°C / 0°C 

• 15°C / 0°C (combustion temperature = 15°C, base temperature = 0°C) 

• 25°C / 0°C 

• 15°C / 15°C 

• 20°C / 20°C 

• 25°C / 20°C 

Split numbers are a set of numbers to indicate the composition of components higher than the de-

vice actually supports. For example, a C6+ device reads methane, ethane, propane, butane, pentane, 

and hexane (denoted "C6+"). The plus sign at "C6+" here indicates that higher C numbers such as C7 

and C8 are merged into C6 because the device cannot distinguish them. Split numbers are obtained 

through lab testing and are expressed using the format n/n[/n[/n]…] where n is a number. Sum of all 

numbers should be 100. For example, a C6+ device has split numbers on hexane as 60/30/10. This 

means mole percentage of hexane is actually 60% of the current hexane, heptane is 30% of hexane, 

and octane is 10% of hexane. Split numbers increase the accuracy of ISO 6976 outputs. 

If you have these split numbers, enter them at the designated input text box. For C6+ devices you can 

enter up to 5 splits—which are the division among C6/C7/C8/C9/C10. C7+ devices accept maximum 4 

splits, and C9+ devices accept maximum two splits. C3− devices (LNG) may go up to 8 splits, but 

C10+, BTEX, and single gas devices cannot have a split number. 

The split numbers being entered should add up to 100. If they don't, GCAS will normalise them before 

redistributing the certificate mole percentage. For example, 50/30 normalises to 62.5/37.5 so their sum 

becomes 100. 

If you don't have split numbers, leave it blank. GCAS will treat hexane or heptane or whatever the 

highest carbon count as a single entity throughout the calculation. 

11.4 Calculation Pages 

When you finished with ISO 6976/GPA 2172 inputs, clicking Next page will take you directly to the 

output summary page and skipping the calculation pages. They were skipped because most users are 

only interested with the results. If you want to visit calculation pages, please check Show intermedi-

ary calculations before clicking Next page. Alternatively, expand the "CALCULATIONS" node at the navi-

gation tree then pick an item to navigate. 

Calculation pages consist of thirteen pages: 



GCAS® Manual Guide rev. 26 

Page 187 of 587 

 

1. Uncertainty of calibration gas 

This is the result of Ucal gas calculation at k = 2. 

To obtain Ucal gas at k = 1, divide these values by 2. 

2. WRM RF and standard deviation 

This is the required calculation before we get Urepeatability. Here you see the mole percentage 

low limit and high limit according to the mole percentage range defined during input page. 

Also if you selected manual mole percentage range, you need to enter these low and high 

limits in this page. Head to chapter 11.4.1 to get help on that topic. 

3. Uncertainty of repeatability 

This is the result of Urepeatability calculation at k = 1. 

4. Footprint and calibration data 

The form displays the response factor of the selected footprint and also average of all calibra-

tion data included in this calculation. To see where the average calculation of the calibration 

data came from, click on numbers that look like links. That will open another form to show the 

data feed. If you notice weird or unusual numbers at the average columns, open the detailed 

view to see if there are offending calibration records that should've been set as inactive. 

5. Uncertainty of reproducibility 

This is the result of Ureproducibility calculation at k = 1. 

6. Standard relative uncertainty 

This is the result of UGC at k = 1. To this point, we are half way finished with the calculation. 

7. Compressibility factor 

It shows the calculation of Zmix and Zair based on the base pressure and temperature specified 

at ISO 6976/GPA 2172 input page. 

8. ISO 6976 calculation 

This page is probably worth visiting if you are interested with the calorific value, relative den-

sity, or some other outputs of ISO 6976 calculation. 

9. GPA 2172 calculation 

Similar to the ISO 6976 calculation page, this page presents the gross heating value and other 

outputs of GPA 2172 calculation. 

10. ISO 6976 sensitivity analysis (calibration gas & GC reproducibility) 

This page displays the relative sensitivity of all ISO 6976 outputs for Ucalibration gas and 

Ureproducibility. 

11. ISO 6976 sensitivity analysis (GC repeatability) 

This page displays the relative sensitivity of all ISO 6976 outputs for Urepeatability. 

12. GPA 2172 sensitivity analysis (calibration gas & GC reproducibility) 

This page displays the relative sensitivity of all GPA 2172 outputs for Ucalibration gas and Ureproduci-

bility. 

13. GPA 2172 sensitivity analysis (GC repeatability) 

This page displays the relative sensitivity of all GPA 2172 outputs for Urepeatability.  

11.4.1 Manual Mole Percentage Range 

If you selected manual mole percentage range for the calculation of Urepeatability, you need to enter 

mole percentage range on the WRM RF and standard deviation page. The column turns white to indi-
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cate that it is editable. Initial numbers on these columns are copied from your calibration gas certifi-

cate. Enter a lower value for mole percentage low limit and higher value for the high limit. On all op-

tions other than manual range, these columns appear yellow and is read-only. 

Double click the cell or press F2 to enter edit mode. Type the minimum value or maximum value, then 

press Enter to commit. After you press Enter, you should see all columns on current row to the 

right side is recalculated. Urepeatability is recalculated, thus UGC and subsequent calculations also change. 

 

Note  

Manual mole percentage range is not balanced. The sum of low limit may be less than 100, and the 

sum of high limit can be more than 100. 

11.4.2 Regarding Sensitivity Analysis 

Starting from GCAS version 1.3.1.0, GCAS calculates two sensitivity sets. One for 

Ucal gas and Ureproducibility, and the other for Urepeatability. Sensitivity of calibration gas and GC reproducibil-

ity is based on the mole percentages in your calibration certificate. Sensitivity of GC repeatability is 

based on the average between mole percentage lower bound and upper bound range.  

If you chose universal mole percentage range or individual mole percentage range during that input 

page, the sensitivity of GC repeatability becomes the same as sensitivity of calibration gas and GC re-

producibility. The reason is mole range for GC repeatability is also taken from the calibration certifi-

cate. 
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But if you selected manual mole percentage range or used ±2 standard deviations of mole composi-

tion records, the lower and upper bound of mole percentage range do not correspond to the calibra-

tion certificate anymore. Thus, GCAS calculates the correct sensitivity values and use these values for U

repeatability. 

11.5 Output Pages 

Output pages display calculation results. The output is divided into two categories, one for each 

standard (ISO 6976 and GPA 2172). In each category, there is one summary page plus as many detail 

pages as required. One detail page is for one ISO 6976/GPA 2172 output value. 

11.5.1 Summary Page 

Summary page displays five uncertainties of ISO 6976 outputs or three uncertainties of GPA 2172 out-

puts, as well as expanded relative uncertainty (k = 2) of each component. You can copy the report to 

clipboard, save it to a text file, or print it. 

 

11.5.2 Detailed Pages 

There are five detail output pages for ISO 6976 outputs and three detail pages for GPA 2172 outputs. 

These pages share the same layout and same logic. 
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Column names starting with U are uncertainties. U(repro) for example, is the uncertainty of GC repro-

ducibility at k = 1. Column names starting with S are sensitivities. As already explained in chapter 

11.4.2, sensitivity for GC repeatability becomes identical to sensitivity of calibration gas and GC repro-

ducibility if the mole percentage range is set to universal or individual mode. 

What may be the interest here are the cells coloured in green. For example, let's use the screenshot 

above. The screenshot tells us uncertainty of calorific value, but the same layout applies to other detail 

pages as well. 

The cell at bottom-right corner rendered in bold font is the CV absolute uncertainty, or UCV. It has a 

unit megajoules per cubic metre (MJ/m3). If you want to see how much the CV itself is, visit the ISO 

6976 calculation page. Note that not all ISO 6976 outputs have units—look for the unit at the title la-

bel. Relative density and Wobbe index do not have unit. 

Above the absolute uncertainty is the combined expanded uncertainty. This is UCV expressed in per-

centage, not in MJ/m3. The percentage is measured against the CV (again, in the ISO 6976 calculation 

page). Expanded uncertainty implies k = 2. And there is also combined standard uncertainty which 

indicates k = 1. 

Standard uncertainty is calculated using this formula: 

𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑢𝑛𝑐𝑒𝑟𝑡𝑎𝑖𝑛𝑡𝑦

=  √(𝑈𝑐𝑎𝑙 𝑔𝑎𝑠 × 𝑆𝑐𝑎𝑙 𝑔𝑎𝑠)
2

+  (𝑈𝑟𝑒𝑝𝑒𝑎𝑡𝑎𝑏𝑖𝑙𝑖𝑡𝑦 × 𝑆𝑟𝑒𝑝𝑒𝑎𝑡𝑎𝑏𝑖𝑙𝑖𝑡𝑦)
2

+ (𝑈𝑟𝑒𝑝𝑟𝑜𝑑𝑢𝑐𝑖𝑏𝑖𝑙𝑖𝑡𝑦 × 𝑆𝑟𝑒𝑝𝑟𝑜𝑑𝑢𝑐𝑖𝑏𝑖𝑙𝑖𝑡𝑦)
2
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where U and S are uncertainty and sensitivity respectively, given that all uncertainties are included. If 

you opt out the Ucal gas for instance, the column U(cal gas) will be overlaid with a diagonal strokes in-

dicating the values are disregarded. Ucal gas is treated as zero, so the formula above only contains 

Urepeatability and Ureproducibility. 

 

The Uncertainty Calculator form when Ucal gas is excluded. Notice the CV absolute uncertainty is different 

from the previous screenshot (0.044011 versus 0.045389 MJ/m3). 

There is a precision control at the top right region of these pages. This slider/track bar controls how 

many decimal digits to display on the grid. Each detail page is independent, a precision control for 

one page does not affect the other pages. By default, GCAS displays six digits after the decimal point. 
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12 Uncertainty Coefficients 

Uncertainty Coefficients (capitalised C) is a tool to store uncertainty coefficients (repeatability coeffi-

cients and response concentration coefficients) in GCAS database so that you don’t have to re-enter 

the same set of coefficients over and over again as they rarely change. 

Note  

This module requires GCAS feature either Uncertainty Calculation or Uncertainty Trend to be included 

in your licence. 

As seen at chapter 11.3.3, the coefficient input page on Uncertainty Calculator form has several links 

related to Uncertainty Coefficients. This chapter explains about Uncertainty Coefficients form which is 

the place to enter the uncertainty coefficient set. 

The term coefficient set refers to collection of uncertainty coefficients (a, b, c, d), two packages of them 

(repeatability and response concentration), of all gases. Every gas has their own coefficients and these 

coefficients are bundled together into one coefficient set record in GCAS database. 

12.1 The Uncertainty Coefficients Form 

Uncertainty Coefficients form is accessible from the View menu > Uncertainty Coefficients. But be-

fore that, you need to select the correct GC device from the device panel or recent device panel. 
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Uncertainty Coefficients form has two tabs, one for repeatability coefficients and the other for re-

sponse concentration coefficients. Repeatability coefficients are used to calculate standard deviation 

of GC repeatability, and response concentration coefficients are used to calculate standard deviation 

of GC linearity. At the bottom, there is a text box to display additional note or description about the 

coefficient set. 

Each coefficient set consists of four coefficients, namely a, b, c, and d on both repeatability and re-

sponse concentration. These are the coefficients of this formula: 

𝑠𝑖 = 𝑎 + 𝑏𝑥𝑖
∗ + 𝑐𝑥𝑖

∗2
+ 𝑑𝑥𝑖

∗3
 

Where s is the standard deviation of one gas/component used in the part of calculation, and xi is mole 

fraction of this component. 

12.2 View Previous Coefficient Sets 

To view other uncertainty coefficient sets, click  Browse another set. Select a different coefficient 

set, then click OK or double click the list item. 
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“Select a coefficient set” dialogue (Windows 10 doesn’t render form border) 

Click  Load latest set to return to the most up-to-date uncertainty coefficient set. 

12.3 Edit Mode 

In order to edit the coefficients or the description, you need to put Uncertainty Coefficients form in 

edit mode. Open the Action menu and select Edit Mode. You know the form is on edit mode when 

you see  pencil icon, some labels are coloured orange, and there is a Save button at the top region 

of the form. 
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The Uncertainty Coefficients form in edit mode. 

During edit mode, you can edit the numbers in both grids (repeatability coefficient grid and response 

concentration coefficient grid). Date of test field at the top and Description text box at the bottom of 

the form also become editable. 

Note 

Edit mode is mainly intended for editing the description or correcting minor mistakes. If there are too 

many coefficients to edit, we suggest you to create a new set and set this record to inactive instead. 

Uncertainty coefficients do not have comment feature. Put short comments in the description text box 

if you like. 

You can paste the coefficient numbers from Microsoft Excel or other spreadsheet editing software, as 

long as there are 4 columns and equal number of rows. Click Paste link above the grid to paste the 

numbers. The Reset link resets all numbers in the grid back to zero. Both Repeatability Coefficients tab 

and Response Concentration Coefficients tab have their own Paste and Reset command link. 

When you finished editing the numbers and the description, click Save button or go to Action menu > 

Save Changes to commit the change. The form exits its edit mode and becomes read-only again. 
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Otherwise to cancel editing and discard all of your changes, open Action menu and select Edit Mode 

again to remove its tick mark. This will exit edit mode and reload the coefficient set from the database. 

12.4 Create New Coefficient Set 

Creating a new set instead of editing an existing set over and over again provides some advantages, 

such as 

- You have a historical record of coefficient sets. When the annual multilevel calibration is con-

ducted, it generates a new set and this should be entered as a new set too. 

- You can test several sets with minor differences in the Uncertainty Calculator form. Make sure 

to write the correct description for the uncertainty set in order to avoid confusion when se-

lecting the coefficient record in Uncertainty Calculator. 

From an open Uncertainty Coefficients form, open the Action menu and select New Coefficient Set. 

This menu creates a blank coefficient set (all zeroes) with the timestamp set to current computer time. 
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Begin entering the coefficient numbers one by one. Be watchful for potential human error. Alterna-

tively, you can paste the coefficients from Microsoft Excel or other spreadsheet editing software as 

long as there are 4 columns and equal number of rows. Click Paste to do so. 

Enter both coefficient sets. Switch tab to move from repeatability coefficients to response concen-

tration coefficients or vice versa. If you forget to enter coefficients for the other tab, GCAS will alert 

you if one tab has all zeroes upon save. 

Don’t forget to set the date of test. This is the date information of when the multilevel calibration 

was conducted, not the date of when these coefficient sets was entered. 

Write the description. It is a good practice to provide a description about this coefficient set. 

When you are finished, click Save button or go to the Action menu > Save Changes to save these co-

efficients into database. Otherwise to cancel all of these, go to the Action menu > Edit Mode to re-

move its tick mark. The form will revert to the last record viewed. 

12.5 Change Record Status 

Like other types of record in GCAS database, uncertainty coefficient set has a status bit indicating 

whether the record is active or inactive.  
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To change status, open the Action menu and select Set Status. This menu brings the Set Status dia-

logue where you can flip the status bit from active to inactive or vice versa. 

   

Click OK and GCAS instructs the Uncertainty Coefficients form to reload the set with the new status. 

 

We believe it is a good practice to provide a short note of why the set was made inactive or active. To 

write this note, invoke edit mode from the Action menu, write the note on the description box, and 

finally click Save. 
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13 Uncertainty Trend 

Uncertainty Trend is a module to graph uncertainties of a GC device over time. It is equivalent to run-

ning many individual uncertainty calculations, with the same configuration, for an increasing range of 

calibration data, and finally plotting result numbers on a graph. 

The chart has a threshold line. When uncertainty line crosses the threshold line, it is time to perform a 

preventive maintenance of the GC. 

Note 

This module requires Uncertainty Trend to be included in your GCAS licence. 

13.1 The Uncertainty Trend Form 

Select a device on your device panel or recent device panel, then go to the View menu > Uncertainty 

Trend. 

 

This form has three pages: Parameter page, chart page, and comment page. The buttons at the bot-

tom of the form do the navigation between these pages. 

When Uncertainty Trend form is opened, it shows the parameter page. This page configures all param-

eters required to perform uncertainty calculation. These parameters are 

• Uncertainties to include, 
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• Calibration certificate, 

• Footprint reference, 

• Plot range, 

• Uncertainty coefficients*, 

• Mole percentage range*, 

• ISO 6976 parameters, 

• GPA 2172 parameters, 

• Direction, and 

• Threshold line. 

*available if Uncertainty of GC repeatability is ticked. 

Each parameter is explained in chapter 13.2. After all parameters are set correctly, click Start graphing 

and GCAS will start the calculation.  

Note 

Uncertainty calculation is slow because it loads many different data from database. Moreover, uncer-

tainty trend calculation is a sequence of many uncertainty calculations. Depending on how wide your 

plot range and how many calibration records inside the plot range, one trend calculation may take 

from few seconds to ten minutes or even more. Fast CPU and good network connection between your 

computer and the database server help reducing the calculation time. 

13.2 Uncertainty Trend Parameters 

This chapter explains each uncertainty trend parameter. 

13.2.1 Uncertainties to Include 

 

As explained in chapter 11, uncertainty calculation takes up to three components: Uncertainty of cali-

bration gas (Ucal gas), uncertainty of GC repeatability + linearity (Urepeatability), and uncertainty of GC re-

producibility (Ureproducibility). These components may be included or excluded, which turns their values 

to zero if excluded. 

However in uncertainty trend, Ureproducibility must be included. You see an asterisk (*) indicating that it 

should be left checked. Well, technically, you can uncheck Ureproducibility. Though, we strongly discourage 

it because excluding Ureproducibility would graph a straight line across all available calibration records. 
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Note 

The GC device must have a calibration gas certificate. Uncertainty Trend form cannot graph your chart 

if there are no certificates installed. 

You cannot tick Uncertainty of GC repeatability if your GC device has no uncertainty coefficients 

stored in database. Uncertainty coefficient selection field and mole percentage range options will be 

disabled. To create a new coefficient set, rewind to chapter 12.4. 

13.2.2 Calibration Certificate 

 

This section controls which certificates to use. There are two options: Reset calculation at each certifi-

cate, or pin a certificate for everything. The default is reset calculation at each certificate. 

On first option, whenever a new calibration certificate installed, all data after the certificate are calcu-

lated using the new certificate.  

On the other hand, the second option forces the Uncertainty Trend form to use a particular calibration 

certificate for all data within entire plot range. Click Change to display the Select Certificate dialogue 

and select the desired certificate. 
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13.2.3 Footprint Reference 

 

This section controls which footprints to use while calculating Ureproducibility. Similar to calibration certifi-

cate parameter, there are two options here: Reset reference at each footprint, or pin a particular foot-

print for all data. The default is reset reference at each footprint, as illustrated by the timeline in the 

next page. 
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Sometimes users want to test how the uncertainty trend would turn out using several different foot-

prints. Select the second option, then click Change to select the footprint.  

 

The footprint selected through this dialogue box is used to calculate Ureproducibility of all data in the plot 

range, regardless of the timestamp of the footprint—even if the footprint occurs after the plot range 

ends. 
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13.2.4 Uncertainty Coefficients and Mole Percentage Range 

 

This section is available if uncertainty of GC repeatability is checked on the first section. Your GC de-

vice must have uncertainty coefficients stored in database, otherwise you cannot tick uncertainty of 

GC repeatability. 

Select which coefficient set to use through Change button. 

 

Next, choose one of the mole percentage range options. 
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1. Universal: Every component has the same plus-minus range. The default is ±20%. 

2. Individual: Every component has its own plus-minus range. Click Set range to enter these in-

dividual ranges. 

 

3. Manual: You need to explicitly set the value of lower bound and upper bound of each com-

ponent. For comparison, the mole composition from the calibration gas certificate is displayed 

in the second column. 

 

4. Use plus-minus twice standard deviations: The range is taken from twice of standard devia-

tion of mole composition records over the specified period of time, filtered to the specified 

stream. 
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Finally, the last check box controls whether to treat the component having largest percentage as the 

balanced gas. Balanced component means its composition is not taken from the calibration certificate, 

but from 100% minus the others instead. Balanced gas keeps the mole percentage sum at 100%, while 

without balanced gas it may go over 100% and under 100%.  

Unlike Uncertainty Calculator form which you can choose which one to become the balanced gas, Un-

certainty Trend always selects the gas with largest mole percentage as balanced. For a rare occasion 

where there are multiple gases sharing the same largest percentage (e.g. two gases have 40% each), 

GCAS selects the first gas as the balanced one. Gases are sorted using RF sort order. Balanced gas op-

tion is ignored if you chose manual mole percentage range. 

13.2.5 ISO 6976 and GPA 2172 Parameters 

 

This section contains the base pressure and combustion-metering temperature pairs for ISO 6976 cal-

culation. These parameters are used for all data within the plot range. 

Default base pressure is one atmosphere, or 1.01325 bar. GCAS supports six combustion and metering 

temperature pairs, which are: 

• 0°C / 0°C 

• 15°C / 0°C (combustion temperature = 15°C, base temperature = 0°C) 

• 25°C / 0°C 

• 15°C / 15°C 

• 20°C / 20°C 

• 25°C / 20°C 

 

For GPA 2172, there is only one parameter to set—the reference pressure. The default is also one at-

mospheric pressure. You can make Uncertainty Trend form to use the same base pressure for both 

ISO 6976 and GPA 2172 calculation by ticking Same as ISO 6976 base pressure, or you can specify a 

different reference pressure for GPA 2172. 
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13.2.6 Direction 

 

Direction of calculation determines which calibration records to include in the calculation. Uncertainty 

calculation may go forward or backward. 

On forward direction, list of calibration data to include is enumerated from footprint. For every cali-

bration data in the plot range, calculation of Ureproducibility at that point will include all calibration data 

from the last footprint (including that footprint itself) and accumulatively go forward up to that point. 

 

(This picture is animated in the HTML version of GCAS Manual.) 

Do not confuse "the last footprint" in the previous paragraph with the "reference footprint". Reference 

footprint is set on this section. The last footprint only marks where the collection of calibration data 

begins. Reference footprint and "last" footprint may coincide, but that is not always the case. You can 

pin any footprint as a reference, but uncertainty calculation in forward direction uses one last footprint 

before every single dot on the chart. It uses the timestamp of last footprint, in order to query calibra-

tion records from the timestamp of last footprint to the timestamp of the current dot being calculated. 

There is a minimum limit to start calculation. The default is one (1), which means forward calculation 

can start at one calibration data after every footprint within the plot range. You can set the minimum 
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for example, ten, so the calculation starts after 10 calibrations following every footprint. You will see a 

gap on the chart after every footprint indicating the number of dots within those gaps is below the 

minimum limit, therefore calculation could not start. 

At Calibration data inclusion mode, there are two options. If you select Reset at each footprint, the 

list of calibration record used for the calculation is restarted whenever a new footprint is encountered 

as GCAS goes forward. This option causes each calibration data is calculated together only with its im-

mediate preceding footprint, and not the previous footprint before that one. If you see the animated 

image in the HTML version GCAS manual, that animation assumes Reset at each footprint is selected. 

The other option–Continuous throughout plot range–breaks this barrier. The list of calibration rec-

ords in use just grow bigger along the timeline as GCAS goes forward, no matter whether a new foot-

print is encountered. When GCAS comes across the second footprint on the timeline, this footprint is 

included in the list as if it was a regular calibration data.  

On backward direction, list of calibration data to include is counted from the calibration data being 

calculated. For every calibration data in the plot range, calculation of Ureproducibility at that point will in-

clude all calibration data from that point and go backward to the last x days or last x record before 

that point. 

 

(This picture is animated in the HTML version of GCAS Manual.) 

Set how many days or how many records to travel backwards. The default is 30 days. You can go 

backward to as far as 2 years (730 days). At some occasions, the GC devices has 30 data in one day; 

you might consider going backward 30 records, not days. 

While GCAS is travelling backward, it may find a footprint before it fulfils the specified x days or x rec-

ords. Decide what GCAS should do when it bumps into a footprint, whether to stop or to continue. 

The default is stop at footprint (trim at footprint). By stopping at footprint, the number of calibration 

data included in the calculation is less than x days or x records, but GCAS does not include data before 

the footprint which are usually calibrated under different configuration. If you see the animated image 
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in the HTML version of GCAS manual, that animation shows what happens if Trim at footprint is se-

lected. 

13.2.7 Plot Range 

 

Set the plot range start and end date. Or, select two calibration records as the starting and ending 

point of this range. GCAS displays a warning label if the footprint reference is a pinned footprint and 

that footprint occurs within this plot range or after this plot range. 

13.2.8 Miscellaneous 

 

This section sets the threshold red line on the chart. The default is 0.2%. When the uncertainty chart 

line crosses this threshold line, it is recommended to perform a preventive maintenance on your GC. 

The check box Include standard calculation uncertainty 0.05% controls whether ISO 6976 or GPA 

2172 standard measurement error of 0.05% (0.1% at k = 2) should be included in the final calculation 

of each data point in the chart. By default, these two check boxes are ticked. 

13.3 Uncertainty Trend Chart 

Once you set all the required parameters, click Start graphing at the bottom of the form. Uncertainty 

Trend form switches to chart page and begins the calculation. 



GCAS® Manual Guide rev. 26 

Page 211 of 587 

 

 

Calculation in progress. 

Note 

Uncertainty calculation is slow because it loads many different data from database. Moreover, uncer-

tainty trend calculation is a sequence of many uncertainty calculations. Depending on how wide your 

plot range and how many calibration records inside the plot range, one trend calculation may take 

from few seconds to ten minutes or even more. Fast CPU and good network connection between your 

computer and the database server help reducing the calculation time. 

Because uncertainty trend calculation is slow, GCAS provides Pause button to temporarily halt the cal-

culation and Stop button to abort the calculation. The keyboard shortcut F7 is designated for Pause 

button and Esc for Stop button. While calculation is in progress, you cannot use other modules or 

they will run slower than usual. This is because the database server is busy serving the data required 

for uncertainty calculation. 

The screenshot on the next page is how the form looks like after the calculation is finished. It is an ex-

ample of a healthy GC based on uncertainty of calorific value. The blue uncertainty line is well below 

the red threshold line. 
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Here is the same chart with the threshold line hidden from view. The Y-axis scale adjusts itself accord-

ingly so the variations of the uncertainty values become clearer. To show or hide the threshold line, 

click  Show threshold line or right click the chart and select Show Threshold Line. 
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Click the button Choose which uncertainties to show at the top-left corner to pick which uncertainty 

lines to display. There are five uncertainty lines for ISO 6976 outputs and three lines for GPA 2172 out-

puts. Tick which ones to show on the chart and click OK. Devices not supporting GPA 2172—such as 

BTEX analyser or moisture analyser—will have all GPA 2172 uncertainty lines lie flat at 0.1%. 

 

To go back to the parameter page, click Back to parameters at the bottom of the form. To read or 

write comments instead, click View comments. 

Note 

If you went back to the parameter page but didn't change anything then clicked Start graphing, the 

form quickly returns to the chart view. But if you changed one thing on the parameters, the Start gra-

phing button will clear the chart and initiate a recalculation. 

13.3.1 Comparing Previous Chart 

Uncertainty Trend form remembers one last set of charts every time it performs a complete calcula-

tion. Once the calculation completes, you can compare the current chart to the previous chart. A typi-

cal scenario is first you graph a chart, go back to the parameters page, change one or two things, and 

finally graph a new chart.  

 Show previous chart button displays current chart (of current parameters) on top of previous 

chart (of previous parameters). Previous charts have the same colour, only lighter. All eight line charts 

have their "previous" lines. 
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In the example screenshot above, previous UCV (light blue) is forward calculation with minimum 2 data 

to start calculation. Current UCV (dark blue) is backward calculation, going backward 30 records and 

trim at footprint. They coincide until the 30th dot then they start to diverge. 

Be aware that  Refresh button erases previous chart prior to the recalculation. 

13.3.2 Zoom and Scroll 

Drag a rectangle over the area you want to zoom in. Pan around the chart using the provided scroll 

bars. Drag another rectangle to zoom in further. 
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To zoom out, click the circled minus button Θ on both scroll bars. Press Home on your keyboard or 

right click the chart and select Zoom All-Out to undo all zoom-in operations. 

13.3.3 Change Axes Scale 

If zoom was not enough, you can enforce a custom range for both X-axis and Y-axis of the chart. 

Right-click the chart and select either Set X-axis Scale or Set Y-axis Scale. 

 

For Y-axis, specify the desired numeric range. The input fields accept decimal values. If you set a cus-

tom axis range that is smaller than the actual range of the chart, then the chart will be truncated simi-

lar to this one. 

 

For X-axis, specify the date and time interval. 
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To cancel these custom scales and revert back to automatic scale, right-click the chart and select ei-

ther Reset X-axis Scale or Reset Y-axis Scale. 

13.3.4 Save or Copy the Chart 

To save the chart as image file, right-click on the chart and select Save Chart as Picture. 

 

Similarly, to copy the chart into clipboard, right click and select Copy Chart Image. Then you may 

paste the image onto Microsoft Paint, Microsoft Word, or any software that accepts bitmap image. 

13.3.5 Export Values to Microsoft Excel or CSV 

Click  Copy to Excel above the chart. This button launches Microsoft Excel and opens a new work-

sheet, then copies all eight uncertainty lines to the sheet. Only current uncertainty values are copied, 

the previous values are not. At the bottom of the sheet, GCAS writes all parameters that created such 

uncertainty values. This feature requires Microsoft Excel 2010, 2013, 2016, or later versions. 
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When you see "Error", it means the trend was calculated in forward direction and there were not enough 

data points after a footprint to start calculating. 

If the chart contains so many data points, exporting to Excel may take longer time. Therefore, we rec-

ommend exporting to CSV files instead. Open the dropdown menu of  Copy to Excel button and 

select Save as CSV. 
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13.3.6 Other Visual Cues 

Hover your mouse pointer over a data point on the chart to reveal a tooltip about that point. Typically, 

the tooltip displays the X-axis value (the date and time value), Y-axis value, and the N (number of cali-

bration data used to calculate the uncertainty at this point). For backward calculation, the tooltip has 

additional info whether GCAS bumped into footprint, and if so, whether the backward iteration 

stopped at footprint or continued through. 

 

Press  Show values or right-click the chart and select Show Values to display the uncertainty val-

ues. Be aware that too many data points on the chart will clutter the chart view. 
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GCAS displays four digits after decimal points. Should you need a higher precision, right-click the 

chart and select Use 8-Decimal Precision on Labels. Now the labels display 8 digits after decimal 

point. 

These dotted lines are called cursors. Cursors appear when you [left] click on a chart or as a remnant of 

zoom operation. Cursor may act as a guide to compare Y-axis values of two data points. Click  Hide 

crosshair cursors or right-click on a chart and select Hide Crosshair Cursors to remove them from 

view. 

 

In several occasions when you are comparing current chart to previous chart, the two lines come so 

close that the current line chart obscures the previous line chart. Click  Use thin lines in order to 

make all line charts be one pixel wide, making it easier to see two lines that are too close to each 

other. 
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13.3.7 Colourblind Assistance 

To aid users with colour blindness (protanopia and deuteranopia), GCAS provides an alternative colour 

scheme for the chart. Use the  Colourblind assist button to switch colour scheme. 

13.3.8 Uncertainty Trend Diagnostic 

Should you notice the uncertainty trend chart has some erroneous data points, the calculation at that 

point might have included too few or too many calibration data. To see exactly which records were 

included in the calculation of a data point, run GCAS with additional /UTdiagnostic switch. (UT = Un-

certainty Trend) 

 

With uncertainty trend diagnostic mode activated, click on any dot on the chart. GCAS displays the 

Uncertainty Trend Diagnostic form that lists the calibration records used to calculate the uncertainties 

of this dot.  

http://en.wikipedia.org/wiki/Color_blindness#Dichromacy
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Forward calculation must include the last footprint before this data point. Hence this is what we meant 

by "last footprint" in chapter 13.2.6, not the "reference footprint". This footprint should be at the first 

row on this grid. 

Backward calculation may or may not have footprints in this grid view. For example, you are graphing 

uncertainty trend with backward calculation for 30 days. If the footprint was 40 days ago, that foot-

print won't be included in the calculation. On another data point where the footprint was 25 days be-

fore; this footprint should be at the last row if you set the form to trim at footprint. If you set to con-

tinue through (i.e. include data before footprint) there may be more records preceding this footprint. 

Had the records on the displayed grid do not conform to the two paragraphs above, this indicates a 

bug. Kindly please report the bug to support@i-Vigilant.com. 

13.4 Insert Comment 

Click View comments button at the bottom of the Uncertainty Trend form. This button brings you to 

the comment page. Comments on this form is similar to comments on Data Analysis; the comments 

aren't bound to a particular record. Instead, you need to provide the date of topic so other users 

know the background or context of your comment. 

mailto:support@i-Vigilant.com
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Write your comment with the appropriate date of topic, then click Submit. Your comment will have a 

yellow background to distinguish it from comments by other users. 

Make sure that the comment is correct e.g. free from spelling errors, because once submitted you 

would not be able to remove your comment. This is a part of audit trail requirements. 

Click  Refresh comments to reload comments. 

If you do not see the text box to write your comment, i.e. you only see the comment grid view, your 

GCAS user account doesn't have the action permission to write comment in Uncertainty Trend. Con-

tact your GCAS administrator. 

13.5 Printing 

When you are viewing the chart, go to the File menu on the main menu bar. Select Page Setup to 

configure paper size and print orientation. There is Print Preview menu on the File menu or on the 

dropdown menu of this button. Click  Print to begin printing. The Quick Print menu on the main 

File menu sends the uncertainty trend chart to your default printer according to what has been set in 

Windows Control Panel, using current page setup (default is A4 portrait). 
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GCAS lays out print content differently on portrait and landscape orientation. If your uncertainty trend 

calculation included uncertainty of GC repeatability and linearity, GCAS also prints the uncertainty co-

efficients used in the calculation. Individual or manual mole percentage range is also printed on page 

two. Moreover, any pinned calibration certificate or footprint reference will be included in the printout 

as well. 

 

Print preview dialogue. 

13.6 Uncertainty Trend Form to Component Uncertainty Trend 

Form Linkage 

Now that you get an uncertainty trend chart, you may wonder how much the uncertainty values of 

each component (each gas) are. Component uncertainties are handled by another module named 

Component Uncertainty Trend—visit chapter 15 later on.  

The usual way to get component uncertainty trend chart is by visiting the View menu on main menu 

bar and selecting Component Uncertainty Trend. This will bring forth the Component Uncertainty 

Trend form. Then, configure the component uncertainty parameters to match those set on Uncertainty 

Trend form. Finally, click Start graphing and in a few moments you shall get your component uncer-

tainty trend chart. 

There is a faster way to do this. Use this button  View component uncertainty trend in the same 

plot range (what a long name, sorry) at the top of uncertainty trend chart. This button opens Compo-

nent Uncertainty Trend form, sends all your uncertainty trend settings, and instructs Component Un-

certainty Trend form to begin graphing immediately. 
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14 Uncertainty Trend Comparison 

Uncertainty Trend Comparison is a module to display uncertainty trends across devices. This module is 

one of the three data comparison modules, the other two are Mole Composition Comparison and ISO 

6976/GPA 2172 Trend Comparison. To access this module, go to the Tools menu and select Uncer-

tainty Trend Comparison. 

Note 

This module requires two GCAS features to be included in GCAS licence: Uncertainty Trend and Data 

Comparison. 

Uncertainty Trend Comparison form is no more than a place to show multiple uncertainty trend lines 

from different devices. It requires existing Uncertainty Trend forms that have their charts graphed al-

ready. Just drag the chart from Uncertainty Trend form and drop it on Uncertainty Trend Comparison 

form. 

14.1 Add Uncertainty Trend to Compare 

Drag the uncertainty trend chart of an existing Uncertainty Trend form and drop it on Uncertainty 

Trend Comparison form. When you release your mouse button, the Uncertainty Trend form sends un-

certainty trend data of all eight trends, not just the ones being displayed. The comparison chart also 

features a legend showing the device name and its uncertainty trend direction. 

 

Once the chart is dropped, select which ISO 6976 or GPA 2172 uncertainties to show or hide by ticking 

these check boxes shown in orange in the next page. By default, Uncertainty Trend Comparison form 

displays whichever uncertainty trends already visible on the originating Uncertainty Trend form. 
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The screenshot down here illustrates the area to drag. Begin dragging on the orange area. If you drag 

inside the chart itself, you would zoom in the chart, not drag it.  

 

Drag uncertainty trend charts from multiple devices to make a comparison. The maximum number of 

chart lines in Uncertainty Trend Comparison form is 18. These 18 chart lines can be distributed such as 

for example: 

- two uncertainties (UCV and UMW) times 9 devices, or  

- five uncertainties (UCV, UGHV, URel. density ISO 6976, URel. density GPA 2172, and UStd. density) times three de-

vices, or  

- one uncertainty for 18 devices.  

If you add more than 18 uncertainty trends, the form keeps displaying them but the chart line colours 

wrap over again so that it's difficult to distinguish two chart lines with the same colour. 
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14.2 Update Existing Uncertainty Trend in Comparison 

If you made a change in Uncertainty Trend form and redrew the chart, the trend chart in Uncertainty 

Trend Comparison form is not updated automatically. You need to push the update manually. 

To do this, it's very simple. Just re-drag the new chart and drop it once again on Uncertainty Trend 

Comparison form. The comparison form detects that the associated GC device is already listed, so it 

redraws all existing chart lines with new data. 

14.3 Remove or Hide Uncertainty 

Trend from the Comparison 

To temporarily hide an uncertainty trend line of a particu-

lar device, untick the check box of that device in the list 

box shown in green (see right). To show it again, tick the 

box. 

To remove chart lines of a device, highlight the device in 

the list of Devices to compare above (in green) and then 

click  Remove one on the toolbar. Alternatively, high-

light the device and press Delete on your keyboard. All 

uncertainty trend lines of this device should disappear. 
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To remove all chart lines and start over from blank, click  Remove all on the toolbar. Then you can 

drag new uncertainty trend charts and drop them on this form. 

14.4 Save or Copy the Chart 

To save the chart as an image file, click  Save button on the toolbar. 

To copy the chart as image, click  Copy button on the toolbar. Then you can paste the image onto 

Microsoft Paint or any software accepting bitmap data. 

14.5 Toolbar Items 

 

Show threshold button toggles the red line in Y-axis that defines the maximum limit of healthy status 

of a GC device. Default threshold is set at 0.2%, but you can type your preferred threshold value in the 

text field next to the button.  

Unlike Uncertainty Trend form in which the red threshold line is always visible when the form is tog-

gled to show threshold, the threshold line in Uncertainty Trend Comparison form is embedded in Y-

axis. It does not show if Y-values of visible chart lines are all far below or above the threshold value. 

 Use thin lines. This button is pressed by default. It changes chart lines to either appear thin (1-

pixel wide) or thick (2-pixel wide).  

 Show values button toggles whether Y-axis value of every dot should be displayed in labels. Do 

not activate this button if there are too many chart lines visible on the chart or if a chart line contains 

too many points, because it will clutter the chart. 

 Colourblind assist changes the colour scheme used by all chart lines. It also reverts the line thick-

ness to thick (2-pixel wide). 

 Show legend. This button determines whether the chart legend is visible. Because chart legend 

displays the device name and uncertainty trend direction, it may occupy quite a lot of horizontal 

space. Hide the legend if you fancy the chart to use the full space available. This button also features a 

dropdown menu to position the chart legend around the chart. Screenshot in the next page is an ex-

ample of chart legend being docked at bottom-centre of the chart. 
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 Hide crosshair cursors button removes the cursor lines (the dotted magenta lines) from the chart. 

These magenta lines appear after you click once or as a remnant of a zoom operation. Yes, the uncer-

tainty trend comparison chart is zoomable, and the way to zoom and scroll the chart is the same as 

uncertainty trend chart. 

14.6 Printing 

To print this uncertainty trend comparison chart, click  Print on the toolbar. Alternatively click  

Print preview to get a preview before printing. The Print and Print preview command is also availa-

ble from the File menu on main menu bar. 

Tip 

Chart legend is printed too. Because chart legend may take quite a lot of horizontal space, uncertainty 

trend comparison chart looks better on landscape orientation. Or alternatively, reposition the chart 

legend using the dropdown menu of  Show legend button. 

On portrait orientation, the printed chart occupies approximately ⅓ of page height. On landscape ori-

entation, the chart occupies 40% of page height. GCAS uses this layout so that the chart will not be 

hideously stretched in vertical direction. 
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Print preview dialogue of uncertainty trend comparison.  
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15 Component Uncertainty Trend 

Component Uncertainty Trend is a module to graph uncertainties of components (gases) of a GC de-

vice over time. So, it is similar to the regular Uncertainty Trend module but it is graphed for every gas 

instead of being aggregated into one metric such as the CV or the standard density. 

In case you notice the uncertainty trend graph started to increase at some point, you can switch to 

component uncertainty trend graph to find out which gas(es) causing this problem. 

Note 

Component Uncertainty Trend module uses the same GCAS feature Uncertainty Trend in your GCAS 

licence. 

15.1 The Component Uncertainty Trend Form 

Pick a device on your device panel or recent device panel, then go to the View menu > Component 

Uncertainty Trend. 
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Unlike the Uncertainty Trend form that is split into three "wizard"-y pages, Component Uncertainty 

Trend is a single page form. The parameters are at the top, while the chart is at the bottom. Compo-

nent uncertainty trend parameters are the same as the regular uncertainty trend, but without ISO 6976 

and GPA 2172 inputs. Also, component uncertainty trend graph does not have a threshold line.  

Note 

Uncertainty calculation is slow because it loads many different data from database. Moreover, uncer-

tainty trend calculation is a sequence of many uncertainty calculations. Depending on how wide your 

plot range and how many calibration records inside the plot range, one trend calculation may take 

from few seconds to ten minutes or even more. Fast CPU and good network connection between your 

computer and the database server help reducing the calculation time. 

15.2 Component Uncertainty Trend Parameters 

This chapter explains each component uncertainty trend parameter. 

15.2.1 Uncertainties to Include 

 

These check boxes control the uncertainties to include in the calculation. Similar to the regular uncer-

tainty trend, Ureproducibility is mandatory. Although technically you can untick Ureproducibility, it is strongly 

discouraged because excluding Ureproducibility would graph a boring straight line on the chart. 

Note 

The GC device must have a calibration gas certificate. Component Uncertainty Trend form cannot 

graph your chart if there are no certificates installed. 

You cannot tick Uncertainty of GC repeatability & linearity if your GC device has no uncertainty co-

efficients stored in database. Uncertainty coefficient selection field and mole percentage range op-

tions will be disabled. To create a new coefficient set, rewind to chapter 12.4. 
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15.2.2 Calibration Certificate 

 

This section controls which certificates to use. There are two options: Reset calculation at each certifi-

cate, or pin a certificate for everything. The default is reset calculation at each certificate. 

The same thing goes like the regular Uncertainty Trend module. The illustration below shows how 

thing goes if the first option (reset at each certificate) is selected. 

On the other hand, the second option forces the Component Uncertainty Trend form to use a particu-

lar calibration certificate for all data within entire plot range. Click  (Change) to display the Select 

Certificate dialogue and select the desired certificate. 

15.2.3 Uncertainty Coefficients 

 

This section is available if uncertainty of GC repeatability is checked on the first section. Your GC de-

vice must have uncertainty coefficients stored in database, otherwise you cannot tick uncertainty of 

GC repeatability. 
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By default, Component Uncertainty Trend form loads the latest coefficient set for you. If this set is not 

the one you wanted, click this button  to call Select Coefficient Set dialogue and pick the desired co-

efficient set. 

15.2.4 Mole Percentage Range 

 

This section is also available if uncertainty of GC repeatability is checked on the first section. Here you 

are presented with four radio buttons. Pick one and click Configure to access more tailored options. 

1. Universal: Every component has the same plus-minus range. When you click the Configure but-

ton, GCAS displays a dialogue to select the universal range. Default range is ±20%. 

 

  

2. Individual: Every component has its own plus-minus range. When you click the Configure but-

ton, GCAS displays a dialogue to set a range of each gas independently. 

 

  

3. Manual: You can explicitly set the value of lower bound and upper bound of each component. 

Click Configure to enter these values. For comparison, the mole composition from the calibration 

gas certificate is displayed in the second column. Do not forget to balance the gas with the high-

est composition. 
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4. ±2σ : This means "plus/minus twice the standard deviation". This option causes GCAS to take the 

standard deviation, times two, over a defined range of mole composition records. Click Config-

ure to define this time period and the stream number. 

 

15.2.5 Footprint Reference 

 

This section controls which footprint(s) to use while calculating Ureproducibility. Similar to calibration cer-

tificate parameter, there are two options here: Reset reference at each footprint, or pin a particular 

footprint for all data. The default is to reset reference at each footprint, as illustrated by the timeline 

on the next page. 
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If you need to test how the result would turn out using different footprints, select the second option 

(pin a footprint) and then click the button with this icon . It calls the Select Footprint dialogue and 

you can pick the desired footprint. 

15.2.6 Direction 

Direction of calculation determines which calibration records to include in the calculation. As the trend 

calculation goes, GCAS accumulatively load more calibration records in the desired direction, up to the 

specified limit. 

On forward direction, list of calibration records is enumerated from footprint. The calculation of Urepro-

ducibility starts from the footprint itself and accumulatively go forward until either GCAS finds the next 

footprint or up to the end of plot range, depending on the setting. The picture down here is animated 

in the HTML version of GCAS manual. The animation shows how the calibration records are used if the 

calculation is set in forward direction and the inclusion mode is set to "reset at footprint". 
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There is a minimum limit to start the calculation. The default is two (2), which means forward calcula-

tion can start at two calibration data after every footprint within the plot range. You can set the mini-

mum for example, ten, so the calculation starts after 10 calibrations following every footprint. The big-

ger this minimum limit, the greater the gap you see on the chart after every footprint. 

At Range inclusion mode, there are two options. If you select Reset at each footprint, the list of cal-

ibration record used for the calculation is restarted whenever a new footprint is encountered as GCAS 

goes forward. This option causes each calibration data is calculated together only with its immediate 

preceding footprint, and not the previous footprint before that one. If you see the animated image in 

the HTML version GCAS manual, that animation assumes Reset at each footprint is selected. The other 

option–Continuous throughout plot range–breaks this barrier. The list of calibration records in use 

just grow bigger along the timeline as GCAS goes forward, no matter whether a new footprint is en-

countered. When GCAS comes across the second footprint on the timeline, this footprint is included in 

the list as if it was a regular calibration data.  

On backward direction, list of calibration data to include is counted from every single calibration data 

being calculated. For every calibration record in the plot range, calculation of Ureproducibility at that point 

will include that calibration data plus all records going backward to the last x days before that point. 

 

The picture above is animated in the HTML version of GCAS manual. The animation shows how back-

ward direction applies to all calibration records in the plot range assuming the limit is set at 30 days 

and the bump behaviour set as "trim at footprint". 



GCAS® Manual Guide rev. 26 

Page 238 of 587 

 

 

Default limit for backward direction is 30 days. You can go backward to as far as 2 years (730 days). 

While GCAS is travelling backward, it may find a footprint before it fulfils the specified x days. Decide 

what GCAS should do when it bumps into a footprint, whether to stop or to continue. The default is 

stop at footprint (trim at footprint). By stopping at footprint, the number of calibration data included 

in the calculation may be less than x days, but GCAS does not include data before the footprint which 

are usually calibrated under different configuration. The other option—Include data before foot-

print—treats any footprints encountered along the way as regular calibration records. 

15.2.7 Plot Range 

 

Set the plot range start and end date. Or, select two calibration records as the starting and ending 

point of this range. Click the corresponding link to call the familiar Select Record dialogue where you 

can pick the desired record. 

15.2.8 Coverage Factor and Graph Type 

 

Before starting the calculation, Component Uncertainty Trend form asks you two last things. First, set 

the coverage factor (k). The default is k = 2. Second, select whether you want to graph the relative 

component uncertainty or absolute component uncertainty. Both types are measured in percentage. 

To distinguish them, use this formula: 
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absolute uncertainty =  
relative uncertainty (drop the % symbol)

100
 ×  mole composition in certificate 

15.3 Component Uncertainty Trend Chart 

Click Start Graphing at the component uncertainty trend parameter section 8 to begin the calcula-

tion. 

 

Note 

Uncertainty calculation is slow because it loads many different data from database. Moreover, uncer-

tainty trend calculation is a sequence of many uncertainty calculations. Depending on how wide your 

plot range and how many calibration records inside the plot range, one trend calculation may take 

from few seconds to ten minutes or even more. Fast CPU and good network connection between your 

computer and the database server help reducing the calculation time. 

Because uncertainty trend calculation is slow, GCAS provides Pause button to temporarily halt the cal-

culation and Stop button to abort the calculation. The keyboard shortcut F7 is designated for Pause 

button and Esc for Stop button. While calculation is in progress, you cannot use other modules or 

they will run slower than usual. This is because the database server is busy serving the data required 

for uncertainty calculation. 

Unlike the regular uncertainty trend chart, component uncertainty trend does not have a threshold 

line. The reason is, we have to draw different threshold lines for every single gas. 

The check boxes next to the chart enlist the gases. These check boxes control whether the chart line of 

its associated gas should be displayed or hidden. By default, only the first gas is displayed. 

15.3.1 Zoom and Scroll 

Drag a rectangle over the area you want to zoom in. Pan around the chart using the provided scroll 

bars. Drag another rectangle to zoom in further. 
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To zoom out, click the circled minus button Θ on both scroll bars. Press Home on your keyboard or 

right-click the chart and select Zoom All-Out to undo all zoom-in operations. 

15.3.2 Change Axes Scale 

If zoom was not enough, you can make the chart axes use a custom scale. Right-click the chart and 

select either Set Y-axis Scale or Set X-axis Scale menu.  

 



GCAS® Manual Guide rev. 26 

Page 241 of 587 

 

For Y-axis, enter the desired lower bound and upper bound. If the custom range defined between the 

Y-minimum and Y-maximum is smaller than the actual Y-value range of the chart, this will truncate the 

chart. 

 

For X-axis, enter the desired starting and ending date. This may either cut or extend the chart. 

 

To undo the custom scale and go back to the automatic scale, right-click the chart and choose Reset 

X-axis Scale or Reset Y-axis Scale depending on which axis currently has the custom scale. 

15.3.3 Save or Copy the Chart 

To save the chart as image file, click the  Save button on the toolbar at the left side of the chart. Al-

ternatively, right-click the chart and select Save Chart as Picture. 

To copy the chart into clipboard, click  Copy on the left toolbar, or right-click the chart and select 

Copy Chart Image. 
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15.3.4 Export Values to Microsoft Excel or CSV 

On the toolbar at the left side, click  Copy to Excel. This button launches Microsoft Excel and opens 

a new workbook, then copies the uncertainty values of each gas to the sheet. At the bottom of the 

sheet, GCAS writes all parameters that created such uncertainty values so other team member can re-

create the same chart on their GCAS later. This feature requires Microsoft Excel 2010, 2013, 2016, or 

later versions. 

 

 

When you see "Error", it means the trend was calculated in forward direction and there were not enough 

data points after a footprint to begin the calculation. 

If the chart contains so many records, exporting to Excel may take longer time. Therefore, we recom-

mend exporting to CSV files instead. On the left toolbar, click  Export to CSV. Using CSV export is a 

lot faster but you lose the formatting and cosmetics of Excel worksheet. 
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15.3.5 Other Visual Cues 

Hover your mouse pointer over a data point on the chart to reveal a tooltip about that point. Typically, 

the tooltip displays the X-axis value (the date and time value), Y-axis value, and the N (number of cali-

bration data used to calculate the uncertainty at this point). For backward calculation, the tooltip has 

additional info whether GCAS bumped into footprint, and if so, whether the backward iteration 

stopped at footprint or continued through. 

 

Press  Show values or right-click the chart and check Show Values to display the uncertainty val-

ues on each dot. By default, these values are presented as 4-digit decimals. If you need 8-digit preci-

sion, right-click the chart and tick Use 8-Decimal Precision on Labels. 

 

Beware that having too many data points, multiplied by the number of chart lines (number of gases 

being displayed), can clutter the chart like this one. 
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These dotted lines down here are called cursors. Cursors appear when you [left] click on a chart or as a 

remnant of zoom operation. Cursor may act as a guide to compare Y-axis values of two data points. 

Click  Hide crosshair cursors on the toolbar or right-click the chart and select Hide Crosshair Cur-

sors to remove them from view. 

 

Component Uncertainty Trend form draws the chart using thick lines by default. But if you fancy thin 

lines or if you are displaying a lot of gases at once, toggle the  Use thin lines button on the left 

side toolbar. 

15.3.6 Colourblind Assistance 

To aid users with colour blindness (protanopia and deuteranopia), GCAS provides an alternative colour 

scheme for the chart. Use the  Colourblind assist button on the left-side toolbar to switch colour 

scheme. 

 

15.3.7 Uncertainty Trend Diagnostics 

In case you notice the component uncertainty trend chart has some erroneous data points or just 

plain curious, you can use uncertainty trend diagnostics to see exactly which calibration records were 

included in the calculation of a data point in the chart. To enable uncertainty trend diagnostics, run 

GCAS with additional /UTdiagnostic switch. (UT = Uncertainty Trend) 
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With uncertainty trend diagnostic mode activated, click on any dot on the chart. GCAS displays the 

Uncertainty Trend Diagnostic form that lists the calibration records used to calculate the component 

uncertainties of this dot.  

 

Forward calculation must include the last footprint before this data point. This footprint may or may 

not be the same as the reference footprint. (Refer to chapter 13.2.6 Uncertainty trend direction for more 

info about reference vs last footprint). This last footprint should be at the first row on this grid. 

Backward calculation may or may not have footprints in this grid view. For example, you are graphing 

component uncertainty trend with backward calculation for 30 days. If the footprint was 40 days ago, 

that footprint won't be included in the calculation. On another data point where the footprint was 25 

days before; this footprint should be at the last row if you set the form to trim at footprint. If you set 

to continue through (i.e. include data before footprint) there may be more records preceding this 

footprint. 

Had the records on the displayed grid do not conform to the two paragraphs above, this indicates a 

bug. Kindly please report the bug to support@i-Vigilant.com. 

mailto:support@i-Vigilant.com
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15.4 Component Uncertainty Trend Form to Uncertainty Trend 

Form Linkage 

Let's see we found a case where the uncertainties of all gases rose at 1st of August 2017, like the one 

in this chart. 

 

You might want to see how this increment of component uncertainties affect the overall CV uncertain-

ties. The usual method is to fire up Uncertainty Trend form via the View menu on main menu bar, and 

configure the Uncertainty Trend form to match the parameters set in Component Uncertainty Trend 

form. But there is a shortcut: Use this button , called "View uncertainty trend in the same plot 

range", on the toolbar at the left side of component uncertainty trend chart. 

 

This button calls the Uncertainty Trend form, sends current component uncertainty trend parameters 

including the plot range, and instructs Uncertainty Trend form to start graphing immediately. Within a 

few moments, you will get the complete CV uncertainty graph. 
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15.5 Printing 

After Component Uncertainty Trend form finished graphing the chart, find the  Print preview or 

 Print button on the toolbar at the left side of the chart. Alternatively, you can print component un-

certainty trend chart from the main File menu > Quick Print, Print Preview, or Print. The Quick Print 

menu sends the chart to your default printer as configured in Windows control panel. 

 

GCAS lays out print content differently on portrait and landscape orientation. To change orientation, 

go to the File menu and select Page Setup. If your component uncertainty trend calculation included 

uncertainty of GC repeatability and linearity, GCAS also prints the uncertainty coefficients used in the 

calculation. Individual or manual mole percentage range is also printed on page two. Moreover, any 

pinned calibration certificate or footprint reference will be included in the printout as well. 
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Print preview of component uncertainty trend. 
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16 Comments 

All user comments, e.g. on Footprint form, Calibration Data form, Mole Composition form, Calibration 

Gas Certificate form, Data Analysis form, Repeatability Test module (only on GCAS Web), Uncertainty 

Trend form, and ISO 6976/GPA 2172 Trend form, are consolidated in the Comments form. 

16.1 The Comments Form 

To view user comments of a certain device, select that device on your device panel and go to the View 

menu > Comments. 

 

Leftmost column is the comment type, which contains information of what the comment was written 

for. Clicking any link inside this column will take you to the corresponding form and load that particu-

lar record. 

The  Refresh button on the toolbar reloads comments for the selected date filter and type filter. 

16.2 Filter Comments by Type 

You can hide or show certain types of comments. For example, you can hide all comments for foot-

print records. Use the seven toggle buttons on the Filter section of the toolbar. 
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 : Show or hide comments for footprint records. 

 : Show or hide comments for calibration data. 

 : Show or hide comments for mole composition records. 

 : Show or hide comments for calibration gas certificates. 

 : Show or hide comments for data analysis module. 

 : Show or hide comments for ISO 6976/GPA 2172 trends. 

 : Show or hide comments for uncertainty trends. 

16.3 Filter Comments by Date 

When you open the Comments form for the first time, it loads comments from the last three months. 

You can change the date filter by selecting the desired filter on the dropdown, or choose "Custom 

Range" and enter the desired date interval on subsequent dialogue box. 

 

16.4 Search Comments 

Type the search term in search box and then click  Search. The search box accepts any of the fol-

lowing: 

• Words in user comments 

• Usernames, 

• Full date in British English format (e.g. "07 February 2014") — this will search for any matches 

in both Date of Topic and Date Posted column. 

 

Any match will be highlighted in yellow. If you do not see any results while you know there should be 

some, make sure the active filter does not hide some comment types or try changing the date range. 

To finish searching, click  Clear search results. 

16.5 Delete Comments 

In order to maintain auditability, GCAS users are not allowed to remove any comments. Not even 

GCAS administrator can erase comments. 

Some scenarios tolerate comment deletion. For example, you post comment in a wrong record. Or 

you double-post the same comment. The only way to delete your comments is to contact your data-

base administrator (DBA) and ask him/her to remove your comments at database-level. Include  
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- your username,  

- the selected GC device (or date of topic for comments on module not bound to any GC),  

- the date and time when your comment was posted,  

- timestamp of the record for which the comment was written, and  

- the content of your comment  

in your enquiry.  
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17 Dashboard 

Dashboard is a place to see health status of all your GC devices in one place. This helps if you have nu-

merous GC devices across different workspaces like one in the screenshot below. Health status of each 

GC device is represented by a "LED light" on its dashboard tile.  

To access dashboard, go to the View menu > Dashboard or press Ctrl+D. 

 

Each tile presents GC tag name, light indicators, and maximum 6 (six) health statuses. Choose between 

1 to 6 out of 12 available health statuses to display. 

 

On the next page, we list all twelve GC health statuses to pick from. To customise which ones to dis-

play and the order of these items, visit chapter 17.1 Dashboard settings. Chapter 17.1.1 provides more 

detailed explanation on each item. 
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No. Health status GCAS licence feature requirement 

1 Lowest correlation (R2) of last calibration None 

2 Uncertainty of calorific value 

Uncertainty Calculation +  

ISO 6976 Calculator 

3 Uncertainty of molecular weight composition 

4 Uncertainty of Wobbe index 

5 Uncertainty of relative density (ISO 6976) 

6 Uncertainty of standard density 

7 Uncertainty of gross heating value 
Uncertainty Calculation + 

GPA 2172 Calculator 
8 Uncertainty of gas compressibility 

9 Uncertainty of relative density (GPA 2172) 

10 Date of last calibration record None 

11 Date of last mole composition record 

Live Data Analysis 12 Unnormalised total of last mole composition 

record 

GCAS on its default setting displays four health statuses: lowest correlation (R2), date of last calibra-

tion, date of last mole composition record, and uncertainty of calorific value (CV). If you use GPA 2172 

instead of ISO 6976, you might want to substitute uncertainty of CV with uncertainty of gross heating 

value (GHV). 

Date of last calibration is useful to find out which GC device has not been calibrated for a long time. 

Date of last mole composition record is useful to detect connection problems during unattended data 

capture. Unnormalised total of last mole composition is used to determine fault in the detector or a 

possibility of missing gases in the line. 

The health status indicator may display one of the followings: 

Appear-

ance 
Colour Meaning 

 
Black 

- GCAS is loading or calculating the data, or 

- Calculation was aborted through  Stop calculation button on the 

toolbar, or 

- All rules are turned off. This should not happen (no users should ever 

turn off every rule). 

 
Red GC is not healthy. At least one health status failed. 

 
Yellow 

Yellow represents "error" state, which is probably caused by 

- One or more health statuses cannot be determined because some data 

was missing, 

- Calculation result yielded a "NaN" (not-a-number) which comes from a 

division by zero or taking logarithm of zero or negative number; or 

- Network connection to GCAS database server goes down or interrupted 

while calculation was in progress. 
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Appear-

ance 
Colour Meaning 

 
Green GC is healthy. All health statuses passed. 

 
White 

GC has no data. There are no active calibration records, no active calibra-

tion certificates, or no active mole composition records. 

Users with colour blindness 

 

Simulated black, red, yellow, green, and white indicator in protanopia vision 

GCAS Dashboard does not include alternative colour scheme for users with colour blindness. We apol-

ogise if this affects you. 

Click  Refresh at the top toolbar to recalculate GC health status of all devices. During refresh, the 

Dashboard form displays a progress bar. On slow network connection, calculation of GC uncertainties 

may take longer time, like one or two seconds per device. You may abort this calculation via  Stop 

calculation button. 

A healthy GC has a green tile and all health statuses are displayed using a green font. If one health 

status (or several) fails, the tile turns red and the offending health status(es) is displayed using red 

font. 

  

Example of a healthy GC and unhealthy GC.  

In this example, we hid the previous status indicator (the "small LED") temporarily. 

When you find a health status displayed using black font, it indicates the rule for that health status is 

turned off. Should a rule be turned off, it will not affect the final decision whether the dashboard tile 

becomes green or red—regardless of the health status itself passed or failed. More details about rules 

are on chapter 17.1.2. 
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Example tile when rules for date of last calibration and last mole composition are turned off. 

Dashboard tiles feature previous status indicator ("small light") next to the current status indicator (the 

"big light"). Whenever the Dashboard is refreshed, first the main status colour moves to the previous 

status indicator, and then the current status indicator updates its colour according to the latest health 

status data. By this way, you can quickly spot a device that was previously green now changed to red 

or previously red turned into green like the example on the next page. You can get rid of previous sta-

tus indicator if you like. Jump to chapter 17.1.4 for more detailed customisation of tile appearance. 

 

The device 1B was green, but turned red on last refresh. 

Dashboard window also prints the time of last refresh on the toolbar. This information may help if you 

leave Dashboard open to monitor all your devices continuously. Moreover, if you leave Dashboard 

open for a prolonged time, we recommend turning off the idle timer in order to prevent automatic 

logout on inactivity. On a different topic, there is an auto-refresh timer which is configurable through 

Dashboard Settings dialogue. 

 

17.1 Dashboard Settings 

From an open Dashboard window, click Dashboard settings on the toolbar. Alternatively, return to 

GCAS main window and go to the View menu > Dashboard Settings. This shall bring forth the Dash-

board Settings dialogue. 
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Dashboard Settings dialogue has five tabs, and each of them is explained in its own subchapters be-

low. A preview tile is available at the left region reflecting new appearance as soon as you change a 

setting. 

17.1.1 Health Status to Display 

List box on the left contains all available GC health statuses to display. If you see some items missing, 

the missing items may require a GCAS feature in your GCAS licence.  

No. Health status GCAS licence requirement 

1 Lowest correlation (R2) of last calibration None 

2 Uncertainty of calorific value 

Uncertainty Calculation + 

ISO 6976 Calculator 

 

3 Uncertainty of molecular weight composition 

4 Uncertainty of Wobbe index 

5 Uncertainty of relative density (ISO 6976) 

6 Uncertainty of standard density 

7 Uncertainty of gross heating value 
Uncertainty Calculation + 

GPA 2172 Calculator 
8 Uncertainty of gas compressibility 

9 Uncertainty of relative density (GPA 2172) 

10 Date of last calibration record None 

11 Date of last mole composition record 

Live Data Analysis 12 Unnormalised total of last mole composition 

record 

Click an item and click Show to display the health status on the dashboard tile. Dashboard tiles hold 

maximum 4 items as laid out in list box on the right. Click an item on the right-hand list and click Hide 

to take this health status out of dashboard tiles. The list box on the right also determines the or-

der/sequence of displayed health statuses. Reorder items through Move up or Move down button. 



GCAS® Manual Guide rev. 26 

Page 257 of 587 

 

17.1.1.1 Lowest correlation (R2) of last calibration 

Depending on the device type, the table below summarises how the lowest R2 is determined. 

Device type Lowest R2 is the lowest among these R2 values 

Daniel C6+ C1-C2-C6 C3-C4-C5  

Daniel C7+ C1-C2-C7 C3-C4-C5-C6  

Daniel C9+ C3-C4-C5 C6-C7-C8-C9  

Daniel C10+ type A C3-C4-C5-C6 C7-C8-C9-C10  

Daniel C10+ type B C3-C4-C5 C6-C7-C8-C9-C10  

ABB C6+ C3-C4-C5 C4-C5-C6 C3-C4-C5-C6 

ABB C7+ C3-C4-C5-C6 C4-C5-C6-C7 C3-C4-C5-C6-C7 

Elster C6+ C3-C4-C5 C4-C5-C6 C3-C4-C5-C6 

Elster C7+ C3-C4-C5-C6 C4-C5-C6-C7 C3-C4-C5-C6-C7 

Elster C9+ C3-C4-C5-C6-C7-C8-C9   

Elster C10+ C3-C4-C5-C6-C7-C8-C9-C10   

Notice that lowest R2 for Daniel C6+ and C7+ devices are determined only by first two correlations. 

The third correlation (C1-C2-C3-C4-C5-C6 or C1-C2-C3-C4-C5-C6-C7) is ignored. If the lowest R2 falls 

below the R2 threshold defined in the Analysis Parameter of a device (typically 0.995), the tile for that 

device turns red. In case you need the tiles to turn red if the R2 is below a certain custom threshold 

instead of using Analysis Parameter data, you can override the rules. Chapter 17.2 will explain more. 

Siemens devices, LNG, BTEX, and single gas analysers do not have R2 trend, therefore their R2 is 

treated as green and you should see "R2 = N/A" on the dashboard tile. 

17.1.1.2 Uncertainties 

There are eight uncertainty health statuses to display. Uncertainty of calorific value (CV) is probably 

the most used among the others. The calculation uses the inputs described below. All inputs are con-

figurable through uncertainty calculation settings tab. 

• Calibration certificate. Certificate is used by all three uncertainty components and thus is 

mandatory. If a device doesn’t have any calibration certificates, GCAS aborts uncertainty calcu-

lation for this device, uncertainty health status on its dashboard tile turns grey, and presents 

the text "no certificate" on the tile. 

• Uncertainty coefficients. This is used by uncertainty of GC repeatability. If no coefficient sets 

are available for a device, Urepeatability is not included in the uncertainty calculation of that de-

vice. 

• Mole percentage range. This is also used by uncertainty of GC repeatability. You can override 

all devices to use the same range (default is ±20%) or let each device use its own range based 

on each own last uncertainty calculation configuration. 

• Footprint. Footprint is used by uncertainty of GC reproducibility. If a device doesn't have any 

footprints, Ureproducibility is not included in the uncertainty calculation of that device. 
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• Calibration data. This is also used by uncertainty of GC reproducibility. Set how many calibra-

tion records to include in the calculation of each device. 

• ISO 6976 and GPA 2172 calculation. All devices on GCAS Dashboard use the same ISO 6976 

and GPA 2172 basic settings. Also, one base pressure is shared by both ISO 6976 and GPA 

2172 calculation. 

Last uncertainty calculation configuration is the configuration on the input pages the last time you 

opened Uncertainty Calculator form. Each device has its own last uncertainty configuration. 

Complete uncertainty calculation—all three Ucal gas, Urepeatability, and Ureproducibility are present—is indi-

cated by no asterisk symbol on dashboard tile. Incomplete uncertainty calculation has asterisk symbol 

on it. For example, the dashboard tile displays U(CV)* = 0.1206%. 

By default, dashboard tiles turn red if their combined expanded uncertainty exceeds 0.2%. You can 

change this threshold or the uncertainty type (absolute or combined expanded) at the rules tab. You 

can also override the threshold at per-device level or per-workspace level depending on your need. 

Chapter 17.2 explains more about overriding rules. 

17.1.1.3 Date of last calibration 

Date of last calibration record indicates how long time has passed since GC was last calibrated. On 

dashboard tiles, date of last calibration has  calibration data icon. If last calibration was marked as 

footprint, it has  footprint icon. 

By default, the dashboard tile should've turned red if date of last calibration is older than 3 days. How-

ever due to various calibration policy among groups or platforms, this rule is turned off. To change the 

threshold (i.e. how many days to make it red) and turn on the rule, go to rules tab. Furthermore, you 

can override the rule for date of last calibration at per-workspace and per-device level. Visit chapter 

17.2 Overriding rules for more information. 

17.1.1.4 Date of last mole composition 

Date of last mole composition shows the timestamp of latest mole composition record (among all 

streams). On dashboard tiles, date of last mole composition has  mole composition icon. 

Date of last mole composition is useful to monitor the connectivity between your GC device and GCAS 

running in another computer next to the GC device. Should a problem occurred and the data capture 

terminated, mole composition records stop coming and you notice the timestamp of last mole com-

position record is stationary after several dashboard refreshes. 

Default setting dictates that dashboard tiles should turn red if date of last mole composition record is 

older than three hours. You can change the threshold, the time unit (minutes, hours, days), or turn off 

the rule at the rules tab. Do not put unrealistic threshold for instance, 1 minute, because mole compo-

sition records usually come every 4~7 minutes. Specifying the threshold to a value lower than GC cy-

cle time will cause the dashboard tile to become everlasting red. 
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Rules for date of last mole composition is also overridable at per-workspace and per-device level. Visit 

chapter 17.2 Overriding rules for more information. 

17.1.1.5 Unnormalised total of last mole composition 

Unnormalised total of last mole composition displays the… well… total or sum of the latest mole rec-

ord after unnormalisation, regardless of its stream number. Whatever stream number has the latest 

mole composition record, GCAS Dashboard takes its unnormalised total value to display. On dash-

board tiles, this health status is represented as “Σ mole”.  You can use this health status to determine if 

there is a problem at the detector or if one or more gases are missing from the line. 

GCAS defines a range where unnormalised total should be within, to make the tile green. Unnormal-

ised total value outside this range will turn the tile red. GCAS employs three different ranges for un-

normalised total rule—one for regular devices, one for single-gas devices, and the last one for BTEX 

devices. Regular devices encompass Daniel, Siemens, ABB, Elster, and LNG analysers. Single gas de-

vices include H2S and moisture/H2O analysers. Go to the rules tab to set the range of all three. As 

usual, unnormalised total range at each device or each workspace can be overridden separately if re-

quired. 

17.1.2 Rules 

 

Simply put, rules are definitions of conditions causing a dashboard tile to become red. Every GC health 

status displayed on dashboard tiles has its own rules to define above what value or below what value 

the health status should make the dashboard tile red. For example, uncertainty of CV has a rule that if 

a device has combined expanded CV uncertainty more than 0.2%, it is unhealthy.  

Rules can be turned on or off. When a rule is turned off, it doesn't affect the decision whether the 

dashboard tile should become green or red. For example, a user decided to display lowest R2, uncer-

tainty of CV, and date of last calibration. The rule for R2 is turned on, rule for uncertainty of CV is 
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turned on, but the rule for date of last calibration is turned off. After next refresh, it turned out that 

minimum R2 is 0.9974, combined expanded uncertainty of CV is 0.1250%, and date of last calibration is 

seven days ago. Rule for R2 makes the tile green, rule for U(CV) makes the tile green, but the rule for 

date of last calibration makes the tile red. We expect the tile to become red by now. However, as the 

rule for date of last calibration was turned off, the tile is only affected by the rule of R2 and U(CV). 

Green meets green becomes green; hence the tile stays green. To turn off a rule, uncheck the corre-

sponding check box on this tab. 

• Rule for lowest R2 (correlation) is the simplest rule of all: if a device has lowest R2 below the 

threshold defined in its Analysis Parameter, it is unhealthy.  

• Rule for uncertainties has two configurable fields: the uncertainty type (absolute or combined ex-

panded), and the threshold value. Absolute uncertainty changes the unit to the absolute unit such 

as MJ/m3 for uncertainty of CV, while expanded uncertainty changes the unit to percentage.  

• Rule for date of last calibration has two configurable fields, which state how many 

days/hours/minutes to make the tile red. These fields accept decimal number. For example, 3.25 

days translate to 3 days and 6 hours.  

• Rule for date of last mole composition has two fields similar to the rule for date of last calibration 

—the threshold limit and its time unit. These fields accept decimal number too. 

• Rule for unnormalised total of last mole composition has three rows. Each row defines the range 

on different device types—regular devices, single-gas, and BTEX. If the unnormalised total of a de-

vice falls within the appropriate range, the health status check is a pass. If it goes outside of the 

range, the health status is a fail. 

Date rules, consisting of rule for date of last calibration and rule for date of last mole composition rec-

ord, are overridable. More information about overriding a rule is on chapter 17.2. To delete all overrid-

ing rules in one go, click Clear all overriding rules on this tab. 

17.1.3 Uncertainty Calculation Settings 
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This tab configures several inputs used by uncertainty calculation of all devices. If your GCAS licence 

doesn't include Uncertainty Calculation, this tab only displays a text your GCAS licence does 

not include uncertainty calculation. 

Some inputs allow you to select "follow last uncertainty configuration". Last uncertainty configuration 

is the configuration you have set on the input pages the last time you opened Uncertainty Calculation 

form. Every device has its own last uncertainty configuration. 

Which uncertainties to include: Choose the uncertainties to include in the calculation. This setting 

applies to all GC devices listed on GCAS Dashboard. If you untick Ucal gas for example, all devices will 

exclude Ucal gas in their uncertainty calculation. We recommend leaving the default setting which all un-

certainties are ticked. There are two special cases though. 

First, if a device does not have uncertainty coefficients but Urepeatability is ticked here, GCAS will exclude 

Urepeatability for that device only. Other devices are not affected. Second, if a device does not have any 

active footprint records but Ureproducibility is ticked, GCAS will exclude Ureproducibility for that device only. 

Either way, the uncertainty health status displayed on the dashboard tile will bear an asterisk mark (*) 

on them, indicating an incomplete uncertainty calculation. 

For all three uncertainties, which calibration certificate to use: Choose whether to use latest cali-

bration certificate of each device, or to follow last uncertainty configuration of each device. 

For uncertainty of GC repeatability, which uncertainty coefficients to use: Choose whether to use 

latest uncertainty coefficient set, or to let each device follow its own last uncertainty configuration. 

And what about mole plus-minus range: Either set a universal plus-minus range for all devices, or 

let them follow their last uncertainty configuration. To use the other three options that you saw on 

Uncertainty Calculator form—i.e. individual range, manual range, and use ±2 standard deviations—

you must select "Follow last uncertainty configuration" and configure each GC device independently. 

The reason for that is, every device may have different stream numbers and different composition on 

their calibration gas certificate. 

For uncertainty of GC reproducibility, which footprint to use: There are three choices. Use latest 

footprint, use first footprint found after the certificate timestamp, or follow last uncertainty configura-

tion. If you selected first footprint after certificate but there are no actual footprints after certificate 

timestamp, GCAS falls back to the latest footprint. 

And how many calibration data to include: Pick one of the choices.  

• From footprint to today (the default) takes the footprint itself, all calibration data afterwards, 

all subsequent footprints, and all subsequent calibration data after them, all the way until cur-

rent computer time. 

• x days from y. The default x is 30 and y is "today". This option causes GCAS to take all calibra-

tion data counted down from today—or last calibration record, if selected—down to that 

starting point minus x days. You can also set what GCAS should do if it encounters a footprint 

during the countdown, either to stop the countdown (trim at footprint) or continue through. 

The figure on the next page illustrates how various settings affect the calibration data range. 
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• Follow last uncertainty configuration causes GCAS to follow last uncertainty configuration of 

each device—including custom calibration data range if you have set them through Uncer-

tainty Calculator form beforehand. 

ISO 6976 and GPA 2172 calculation: This section controls the base pressure used by both standards, 

as well as the combustion-metering temperature pair. These settings apply to all devices. Also, you 

have check boxes to control whether the standard measurement error 0.05% should be included after 

every ISO 6976 or GPA 2172 calculation. 

Calibration data ranges under various settings.  

These calibration data are used by the uncertainty calculation of GC reproducibility. 
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17.1.4 Display Style 

 

Display style tab configures the appearance of dashboard tiles. 

Precision: Select how many decimal digits to display on numeric health status (lowest R2 and uncer-

tainties). The default precision is 4 digits. However, if you opt to show both types of uncertainties (i.e. 

expanded and absolute), GCAS can only display 2 to 5 digits. If you choose to display uncertainty of 

CV and GHV together, we recommend cranking the precision up to 6 or 7 digits because these two 

values are so close to each other. 

For uncertainties, show me: Select which type of uncertainties to display. This setting applies to un-

certainty health statuses. Most users prefer combined expanded uncertainty (expressed in percentage) 

over absolute uncertainty (expressed in units such as MJ/m3 for CV). There is also a choice to display 

both, however GCAS can only fit 2 to 5 decimal digits due to space limitation. 

For date information, show me: Select date format to display. This setting applies to date of last cali-

bration and date of last mole composition record. The default is absolute date which shows the exact 

date-month-year-hour-minute. GCAS Dashboard uses 24-hour clock. The other choice is rough rela-

tive timespan like "3 days ago" or "5 hours ago". 

Bold font on the device name makes the device tag name on dashboard tiles use bold face. Look at 

the preview tile at the left side of this dialogue box to see if you fancy the bold font. 

Show previous light (the small "LED" light) determines whether the previous status indicator light 

is visible. Uncheck this box and the tiles show the main status indicator (the big LED light) only. If the 

small light is set to visible, you can adjust its vertical position relative to the big light as well. 

Text alignment box contains several options to change the text alignment of device name, all four 

health status texts, and health status icons when they are available. Date of last calibration and date of 

last mole composition use icons to distinguish between each other. The default alignment is middle-
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centre for device name, centre-align for health status texts, and left-align for health status icons. An 

example of tile customisation may look like this. 

 

17.1.5 Alarm Alert 

This tab configures email submission in order to send you alarm alerts. To explain this tab further, we 

need to explain first about what alarm itself is. Jump to chapter 17.4 to get started. Detailed explana-

tion about alarm alerts is on chapter 17.4.2. 
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17.1.6 Miscellaneous 

 

The Miscellaneous tab configures other behaviours which are not categorised into the other four tabs. 

Play sound when all calculations completed makes GCAS play a “ding” sound after all calculations 

completed. On slow connection, a dashboard refresh may take minutes to complete so GCAS can no-

tify you that dashboard refresh is finished. 

Auto refresh causes the Dashboard form to refresh itself once every the-defined-interval. The default 

is 1 hour, but you can change it between 1 minute and 4320 minutes (3 days). By default, auto-refresh 

is turned off. If you turn auto-refresh on and leave Dashboard open for a long time, we recommend to 

turn off automatic logout on inactivity. 

This auto refresh setting also affects data provision refresh schedule if you link Modbus server module 

with Dashboard on Modbus Server Interface window. Disabling Dashboard's auto refresh while Dash-

board-Modbus server link is still active would cause Modbus server not refreshing at all; unless you 

click Refresh on Dashboard window—which Modbus server data refresh would follow after Dash-

board refresh completes. 

Open Dashboard window as soon as I log in instructs GCAS to open Dashboard immediately after 

all workspaces and devices have been loaded. This only works after GCAS login, not after changing 

database or refreshing device panel. 

When I click a tile, select the action you want GCAS to do. There are four options. 

• Do nothing. 

• Open Footprint/Calibration Data form: This action opens the footprint or calibration record 

who has the lowest R2 displayed on the dashboard tile. 

• Open Mole Composition form: This action opens the latest mole composition record, as-

suming that the date of latest mole composition record is displayed on the dashboard tile. If 

your GCAS licence doesn't have Live Data Analysis, this option is not available. 
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• Open Uncertainty Calculator form: This action opens Uncertainty Calculator form for the de-

vice represented by the dashboard tile, but that's it. The settings at the Uncertainty Calculator 

form may be different from the settings defined by the uncertainty calculation settings tab, 

hence may produce different uncertainty values. Both dashboard tile and the Uncertainty Cal-

culator form should produce the same values if everything on uncertainty settings tab was set 

to "follow last uncertainty configuration". If your GCAS licence doesn’t have Uncertainty Calcu-

lation feature, this option is not available. 

17.2 Overriding Rules 

Rules for all GC health statuses are overridable at device level or workspace level. Overriding at device 

level causes the dashboard tile of this device to ignore the general rules and use the overridden rules 

instead. Overriding at workspace level causes all dashboard tiles under this workspace to use the over-

ridden rules. 

For example, you have set the general rule for date of last calibration stating all devices who were cali-

brated past 3 days ago shall be red. However, there's this one platform called Workspace X which en-

forces a different calibration policy, for instance, once every 7 days. This causes the dashboard tiles 

under Workspace X to become red if their last calibration date is, let's say, 5 days ago. By overriding 

calibration date rule for Workspace X, we can specify that all devices under Workspace X uses 7-day 

rule, not three. 

Device-specific override has priority over workspace-specific override. For instance, Workspace X has 

five GC devices named X1, X2, X3, X4, and X5. These five devices were calibrated 9 days ago. Your 

general rule state 3-day calibration rule, but those under Workspace X are overridden to use 7-day 

calibration rule. Now let's override the date rule for device X4 to be 14 days. As a result, device X1, X2, 

X3, and X5 become red while device X4 is still green. 

 

Illustration about how override levels work. 

You can even override the on/off status of a rule. For example, the general rule for last calibration date 

is turned on, but this particular device is overridden as turned-off. You shall see other devices have 
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green or red font on their dashboard tiles, while this device has black text for its last calibration date. 

The same applies for the other way around, if the general rule is turned off but you wish to turn on 

date rules for several devices or workspaces. 

17.2.1 Per-Device Override 

To override rules at device level, right-click the dashboard tile of the said device. 

 

The menu brings us to the Override Rules dialogue box. All twelve health statuses are displayed on this 

dialogue but the ones you are not displaying are greyed out. 

 

You can override each rule independently. Inside each section, there are three options: 

Do not override. If this is selected, you are revoking the override—causing the device to fall back to 

either per-workspace override (if defined) or to the general rules set at the rules tab. 

Turn off rule. Select this if you want to override the on/off status of the rule. If the general rule is 

turned on, this option turns off the rule just for this device. You should see the associated health sta-

tus is presented in black text. Other devices are still following the rule, unaffected by this override. 
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Override. The last option overrides the actual threshold for this device. This device will follow the 

threshold defined here instead of the threshold defined at workspace-level override (if any) or the 

general rule. In addition, in case the general rule is turned off, selecting this option will turn on the 

rule just for this device. 

The table below shows an example of overriding calibration date rule.  

General rule Device-level override Result: Dashboard tile becomes red if last calibration 

is older than 

ON, 3 days Do not override 3 days 

OFF Do not override Rule is turned off 

ON, 3 days Turn off rule Rule is turned off 

OFF Turn off rule Rule is turned off 

ON, 3 days Override, 7 days 7 days 

OFF Override, 7 days 7 days 

When you are ready, click OK to close the dialogue window and you shall see the Dashboard window 

applies your new rules. For example, we overrode device ABB_TEST1B to turn off its calibration date 

rule in the screenshot down here. 

 

17.2.2 Per-Workspace Override 

To override rules at workspace level, right-click the heading text or click the  gear icon. 

 

This also brings the Override Rules dialogue box. But this time, it applies to all devices within this 

workspace. 
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Similar to per-device override, this dialogue shows override options for all GC health statuses but only 

the ones you are displaying are available to change. You can override each rule independently. Inside 

each section, there are three options: 

Do not override. If this is selected, you are revoking the override—causing all devices within this 

workspace to fall back to the general rules set at the rules tab. 

Turn off rule. Select this if you want to override the on/off status of the rule. If the general rule is 

turned on, this option turns off the rule just for devices within this workspace. You should see the cor-

responding GC health status of all devices in this workspace renders in black text. Devices in other 

workspaces are still following the rule, unaffected by this override. 

Override. The last option overrides the actual threshold for all devices inside this workspace. These 

devices will follow the threshold defined here instead of the threshold defined at the general rule. In 

addition, in case the general rule is turned off, selecting this option will turn on the rule just for this 

workspace. 

Remember, device-level overrides take priority over workspace-level overrides. Here is an example of 

a workspace-level override on calibration date rule: 

General rule Workspace-level 

override 

Device-level 

override 

Result: Dashboard tiles turn red if 

last calibration is older than 

ON, 3 days Do not override Do not override 3 days 

OFF Do not override Do not override Rule is turned off 

ON, 3 days Do not override Turn off rule Rule is turned off 

OFF Do not override Turn off rule Rule is turned off 

ON, 3 days Do not override Override, 7 days 7 days 
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General rule Workspace-level 

override 

Device-level 

override 

Result: Dashboard tiles turn red if 

last calibration is older than 

OFF Do not override Override, 7 days 7 days 

ON, 3 days Turn off rule Do not override Rule is turned off 

OFF Turn off rule Do not override Rule is turned off 

ON, 3 days Turn off rule Turn off rule Rule is turned off 

OFF Turn off rule Turn off rule Rule is turned off 

ON, 3 days Turn off rule Override, 7 days 7 days 

OFF Turn off rule Override, 7 days 7 days 

ON, 3 days Override, 5 days Do not override 5 days 

OFF Override, 5 days Do not override 5 days 

ON, 3 days Override, 5 days Turn off rule Rule is turned off 

OFF Override, 5 days Turn off rule Rule is turned off 

ON, 3 days Override, 5 days Override, 7 days 7 days 

OFF Override, 5 days Override, 7 days 7 days 

17.2.3 Revoking (Cancelling) an Override 

To revoke device-specific overriding rules, bring the Override Rules dialogue by right-clicking the ap-

propriate dashboard tile. Next, select Do not override option at the corresponding rule. Click OK to 

commit the change and the Dashboard window shall update itself. The device should return to work-

space-level override (if defined) or to the general rule. 

To revoke workspace-specific overriding rules, bring the Override Rules dialogue by right-clicking the 

heading text or through  gear icon. Then, select Do not override option at the corresponding rule. 

Click OK to commit the change. The devices in this workspace should return to the general rule. 

To revoke all device-specific and workspace-specific overrides, open Dashboard Settings then go to 

the rules tab. Click Clear all overriding rules button at the bottom and finally finish it by clicking OK. 

17.3 Printing 

You can print GCAS Dashboard on a paper as a snapshot of current condition of your GC devices. To 

print, click the Print dropdown button on Dashboard toolbar. Use the familiar menu Page setup, 

Print preview, and Print. Alternatively, open the File menu on main menu bar and the printing menus 

are also available right there.  
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A note when you are printing GCAS Dashboard using monochrome printer, it may result in very similar 

shades of grey like the one on the next page. 

To fix this problem, select the appropriate menu My printer supports colour or My printer is mono-

chrome before you print. For monochrome printers, make sure to select My printer is monochrome 

because GCAS uses the thumbs-up or thumbs-down symbol to indicate device health status—much 

more distinguishable than shades of grey. 
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Left: GCAS Dashboard, showing red and green on various devices, printed using a monochrome printer. 

Right: The dashboard, printed using a monochrome printer, but with “My printer is monochrome” option 

selected. 

17.4 Alarms 

Alarm is an event when a GC device changes status among red, yellow, or green. When a device goes 

from green to red, that is one alarm. The next day it changes back from red to green, that becomes 

another alarm. Colour change from and to black or white is not considered as an alarm. 

GCAS raises alarms every time the Dashboard refreshes. After applying rules (colours) to all tiles, GCAS 

checks which ones changed colour. Those who changed are recorded in the alarm log.  

To access alarm log, click the Alarms button on Dashboard toolbar. 
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17.4.1 The Alarms Window 

The Alarms window lists what parameter of a device that triggered the alarm and its value during the 

change. This icon  indicates the device had been green but then became red. Similarly, this icon 

 indicates the device had been yellow but later turned green. 

To export the alarm log, click Export to Excel or Export to CSV on the toolbar. 
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To print the alarm log, click Print. Or open the drop-down menu of the Print button to access the 

Page setup and Print preview menu. 

 

To delete alarms, click Delete alarms and choose how many alarms to keep. If you want to delete all, 

select Keep nothing. 

 

The View options menu configures how the alarm log should be displayed. 
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a. Oldest to newest or Newest to oldest changes the sort direction based on the alarm 

timestamp. 

b. Group by device name would categorise alarm items based on device name and would result in 

something similar to this. 

 

c. Background colour gives a colour coding based on the health status of each alarm. 

17.4.2 Alarm Alert 

Alarm alert is a feature to notify you or the designated recipients via email when at least one alarm is 

triggered. GCAS sends one alert email every time the dashboard finishes refreshing, and this email 

contains all alarms raised during that refresh. To make this happen, please allocate one email account 

on your corporate mail server to GCAS. 

Alarm alert works with a traditional SMTP server for email submission. GCAS cannot send alert 

through other types of mail transfer protocol such as Microsoft Exchange ActiveSync (EAS) protocol. 

Do not get mistaken between Microsoft Exchange Server and Exchange ActiveSync, for GCAS works 

with Microsoft Exchange Server provided that it is configured to allow SMTP connection in addition to 

EAS protocol. 

Q: Why does GCAS need access to my internal mail server? Why don't you guys send me alerts 

from some address like alert@i-Vigilant.com? 

A: There are reasons why we choose to use customer's own mail server.  

• Because the mail server is already inside your network, emails are delivered faster because 

they are treated as local (intranet) traffic. 

• If we send alerts from external mail address such as alert@i-Vigilant.com, we have to per-

suade your network administrator to allow our email domain address to be in the whitelist. 

Otherwise the alert mails may end up marked as spam or junk. That also involves continual 

blocklist suppression request to public spam blocklist services such as SpamCop and Spam-

Haus. 

• External emails must go through several layers of corporate network security such as firewall 

packet scans, antivirus scans, and so on. This yields longer delivery time and increases the risk 

of alert mails get undelivered. 

https://en.wikipedia.org/wiki/Exchange_ActiveSync
https://en.wikipedia.org/wiki/Microsoft_Exchange_Server
mailto:alert@i-Vigilant.com
mailto:alert@i-Vigilant.com
https://www.spamcop.net/
https://www.spamhaus.org/
https://www.spamhaus.org/
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• If your corporate use Microsoft Exchange Server (with SMTP enabled), Exchange can deliver 

the alert through push mail. That's even better. 

Using email as delivery method also poses several risks. 

• GCAS requires a working network connection to the mail server. If the network is down, the 

emails won't get sent. This problem escalates if your network topology involves VPNs. When 

the public internet connection goes down, so does the VPN connection, and emails won't get 

sent either. 

• Alarm alert emails are HTML emails. Some corporates impose a restriction on their mail serv-

ers such as only allowing plain text emails or requiring S/MIME signature. In these cases, 

GCAS cannot send emails. 

To set up alert, go to Dashboard Settings dialogue and navigate to Alarm alert tab. Check Enable 

alert to begin. 

 

Fill these two mandatory fields: Send as and Send to. Send as is the email allocated for GCAS; it will 

become the "From:" field of an alert email. Send to contains the list of intended recipients. You can put 

multiple recipients and designate each one, who is the To: recipient (primary), who is the Cc: (car-

bon copy), and who becomes Bcc: (blind carbon copy). 

https://en.wikipedia.org/wiki/S/MIME
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To temporarily exclude a recipient, untick the check box on the Send? column. 

Unticked recipients will not get emails. 

 

To remove one or more recipients, highlight their rows and press Delete on your keyboard. 

Next, specify the mail server host name (or its IP address) and its Port. Your network administrator or 

IT department can provide this information. Afterwards, set one of the connection security options. 

• None: Connection to the mail server is not encrypted. 

• Implicit SSL/TLS: GCAS sets up SSL encryption at the time connection is established. After-

wards, email submission begins on secured communication. 

• Explicit STARTTLS: The connection begins as an unsecured, then GCAS issues a STARTTLS 

command to upgrade the connection to be a secured one. 

The port is typically 25 for unsecured connection, 465 for implicit TLS, and 587 for explicit TLS. But the 

port should be set according to the instruction given by your network administrator. 

Moving down, depending on your mail server, it may require authentication before the server accepts 

email submission. If so, check SMTP server requires authentication and fill in the username and 

password of the mail account allocated for GCAS alert. 

Continuing down, you see a check box to enable or disable quiet hours. Quiet hours are an interval 

period where GCAS would refrain from sending you alert emails. In case you need your evening time 

not to be disturbed, check the box and set the start and end time. 

Click Test sending email to verify the configuration is correct. You should get this kind of email if the 

test succeeded. 

https://en.wikipedia.org/wiki/Transport_Layer_Security
https://en.wikipedia.org/wiki/STARTTLS
https://en.wikipedia.org/wiki/STARTTLS
https://en.wikipedia.org/wiki/SMTP_Authentication
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In case your mail server enforces implicit or explicit TLS security, GCAS executes standard SSL certifi-

cate chain validation—the one that is performed by your internet browser all the time. If the SSL cer-

tificate is untrusted, GCAS presents you a dialogue illustrated on the next page. 

Many corporate networks employ self-signed SSL certificate to create secured connections. Self-

signed certificates are not trusted unless the root certificate is distributed and installed on every com-

puter by your network administrator. If you trust the certificate, click Yes, allow TLS connection to 

continue email submission. You are prompted this dialogue only once per session. 
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18 Mole Composition Comparison 

Mole Composition Comparison is a tool to compare trends of mole composition across different de-

vices. This module complements the Data Analysis module. Through Data Analysis you see mole com-

position trend of various gases for one device, now on Mole Composition Comparison you see mole 

composition trend of one gas for various devices. 

Note 

This module requires two GCAS features to be included in your GCAS licence: Live Data Analysis and 

Data Comparison. 

18.1 The Mole Composition Comparison Form 

To open Mole Composition Comparison form, go to the Tools menu > Mole Composition Compari-

son. 

 
 

Mole Composition Comparison form has two resizable sections. Parameters and device list are at the 

top, while the comparison chart is at the bottom. 
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18.2 Parameters and Device List 

The top section of the form has a linear flow. Select the gas and comparison date range (under section 

❶), browse the devices to compare (❷) and add them to the comparison list (❸), select which 

stream of these devices (❸) and finally click Go (❹) to start graphing.  

18.2.1 Gas and Date Range 

 

GCAS supports 20 gases to compare (15 + 4 + 1) across different devices. Please note that not all de-

vices have a complete range of gases, for some do not have neopentane and some others do not 

have heptane and higher. When you set the gas octane to compare then tick a device which doesn't 

include octane for example, its line will lie on the X-axis because its Y-values are all zeroes. 

One thing that may confuse users is that they see Methane/Benzene/The gas instead of just me-

thane. Also, nitrogen is shared with toluene, CO2 is shared with ethylbenzene, and ethane with xylene. 

This is because BTEX devices and single gas analysers reuse the same database columns as regular GC 

devices. We don't have special database columns for aromatic hydrocarbons because there would be 

too much rewriting of the entire software. Single gas devices use the methane table column to store 

values of their gas. Hence, methane is shared with benzene, "the gas", hydrogen sulfide, and moisture. 

Nitrogen is shared with toluene, carbon dioxide is shared with ethylbenzene, and ethane with xylene.  

Mole Composition Comparison is a universal tool, that implies it isn't bound to a specific GC device. 

You can include multiple devices in the comparison list, each of different device type, and there is no 

way to predict whether you are going to compare regular GC to regular GC or BTEX to BTEX. This is 

why the dropdown says "Methane/Benzene/The gas" instead of just "Methane" or just "Benzene". Alt-

hough comparing regular GC to a BTEX or single gas device is pretty much meaningless, rest assured 

that the selection "Methane/Benzene/The gas" behaves completely as "Methane" during a compari-

son of C6+ device to C7+ device. 
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18.2.2 Devices and Comparison List 

 

On the left, you see the device tree view. It lists all your workspaces and devices within each work-

space. The grid on the right is known as comparison list.  

Hover your mouse pointer over a device to view more information about data availability and stream 

numbers. In the screenshot below, the device 8425R has stream 1, stream 2, and spot samples. De-

vices which don't have mole composition records at all are displayed as semi-transparent and cannot 

be added to the comparison list. 

 

To compare devices, add the devices from the device tree view to the comparison list. Either select the 

device then click Add, or double click the device, or drag the device and drop it onto comparison list. 

Note 

A Mole Composition Comparison form which was opened through Send to shortcut from Data Analy-

sis’ Send to Mole Composition Comparison menu or Compare both link, is locked to one particular de-

vice and one particular stream number. Device tree view is empty and you cannot add another device 

into comparison list. The text above the chart should clearly indicate the form is locked. Click Reset 

and reload device list next to this text in order to unlock Mole Composition Comparison form back 

into normal mode. 
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Once the device has been added to the comparison list, select the stream number to compare.  You 

can compare different streams of the same device too. To do so, add the device to the comparison list 

twice, then select different stream number for each of them. Moreover if you have ISO 10723 feature 

which we will explain very soon, this tool can also compare the single-point composition vs. multi-

level-calibrated composition of the same device, same stream number. 

 

The column Show? contains check boxes which are used to hide or show the line chart of correspond-

ing comparison entry after the chart has been rendered completely. Column Device lists device tag 

names. Column Stream lets you choose which stream to compare. If you find the stream "spot" in 

these dropdowns, you are comparing spot sample records. Spot samples are treated as a special 

stream. 

The column Convert contains options for stream conversion. Typically, the available options are "sin-

gle" (single-point) and "MLC" (multilevel-calibrated). Users without ISO 10723 feature see these 

dropdowns contain only one option which is "single", thus the column Convert serves no use. Nev-

ertheless, for ABB devices, the Convert dropdowns include additional option: "exp." (exponential). 

This option converts the stream to exponential mole composition. 

To remove an entry from the comparison list, highlight its row on the grid and then click Remove or 

press Delete on your keyboard. Every time a comparison entry is removed from the comparison list, 

its line chart is also removed. However, if you add it back, you need to redraw the chart because its 

data in the cache has already gone. This is the difference between removing an entry versus temporar-

ily hiding it (by unticking the check box inside the Show? column). In addition, click Remove all to 

empty the comparison list and start over. 

Note 

Maximum number of entries in comparison list is 15 entries. 

GCAS will alert you if there are duplicate comparison entries.  

Duplicate = same GC device + same stream number + same stream conversion. 
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18.2.3 Start Graphing 

 

When everything else are correct, simply click Go. GCAS loads the required mole composition data 

and renders the chart. The Go button turns into Refresh button unless you change the selected gas, 

comparison date range, devices, stream numbers, or single-point/MLC switch. 

Equal scaling, if ticked, forces all comparison entries to use the same normalisation scale. Tick this op-

tion if you are comparing multiple devices having different scales, such as this GC uses fraction and 

that GC uses percentage. More about scaling equalisation on chapter 18.3.2. 

If you include one or more spot sample streams in the comparison list, the check box Apply lag time 

to spot samples shifts all spot sample dots to the right according to the amount of most recent lag 

time value of each dot. Jump to chapter 25.2 Lag Time form to create new lag time records. 

Users with ISO 10723 feature in their licences see an additional command link Clear MLC cache. This 

clears the cache used by ISO 10723 conversion. The cache contains MLC coefficients, calibration certif-

icates, single-point RF, MLC RF, and MLC constraints. Click this link if you notice the multilevel-cali-

brated streams are graphed incorrectly. Once the MLC cache is emptied, refresh the chart. 
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18.3 Comparison Chart 

The chart graphs the historical mole composition of the selected gas over time, limited by your plot 

range, device, stream number (and single-point or MLC selection for ISO 10723) at a time. This chart 

has maximum capacity of 15 comparison entries. The legend at right side tells what gas it is, the de-

vices, and their stream numbers. Multilevel-calibrated streams (ISO 10723) are indicated with super-

script M after their number, like 1M for stream 1. Exponential streams (only on ABB devices) are indi-

cated with superscript E. 

 

By default, GCAS draws the chart using thin lines, unlike all other charts in GCAS which use 2-pixel 

width. Line charts having data points less than 100 have small dot markers along its body. Line charts 

with more than 100 dots are presented without markers. 
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18.3.1 Show or Hide Some Devices 

Untick the checkbox at the column Show? inside the comparison list to temporarily hide a device (a 

line) on the chart. Check the checkbox to bring the line visible. 

 

If you remove a device from this list, its line chart is also removed. After you add the device back, you 

need a full refresh to redraw the lost line. 

18.3.2 Scaling Equalisation 

GCAS stores mole composition records as-they-are in the database. There is no information about its 

scale stored in database. Most devices use percentage scale (0 to 100). Some others output fraction 

scale (0 to 1). GCAS determines scaling by the unnormalised total. For example, if the unnormalised 

sum is near 1, the device uses fraction scale. If the sum is near 100, it is percentage. If near 1000, it is 

permillage (‰). 

GCAS supports fraction scale (0 to 1) up to PPB scale (0 to 1,000,000,000) officially. This becomes a 

problem in mole composition comparison: What happens when you compare device A with percent-

age scale and device B with fraction scale? 

The answer, GCAS plots mole composition records as they are. The two line charts will appear far apart 

as device A has methane composition about 70 (percentage scale) while device B has around 0.7 (frac-

tion scale). Thus, the line chart of device A flies high up there while device B lies low near the X-axis. 

To circumvent this problem, Mole Comparison Composition form is equipped with scaling equalisa-

tion. However, it is not enabled by default. The reason is most users have all GC devices generating 

mole composition records on the same scale, or at least configured to output on the same scale. 

Therefore, scaling problems rarely affect GCAS users. 

If you do compare devices with different scaling, be sure to tick Equal scaling before you click Go. Se-

lect one of four available scales: fraction, percentage, permillage, or parts-per-million (PPM). 
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Continuing our example about device A and B, with mole fraction scaling equalisation, you are 

downscaling device A to fraction (0 to 1) while device B remains in fraction scale. If you select percent-

age on this dropdown, you are upscaling device B to percentage (0 to 100) instead. 

18.3.3 Zoom Mode and Selection Mode 

This toggle button controls whether the comparison chart is in zoom mode or selection mode. 

 

  

Toggle button to switch between zoom or selection mode. 
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Zoom mode lets you zoom to a specific area of the chart. Drag a rectangle over the area you want to 

zoom in. Pan around the chart using the provided scroll bars. Drag another rectangle to zoom in fur-

ther. To zoom out, click the circled minus button Θ on both scroll bars. Press Home on your keyboard 

or right click the chart and select Zoom All Out to undo all zoom-in operations. 

 

Selection mode enables you to create selection area on the chart, then you can manipulate the rec-

ords contained inside the selection rectangle using available context menu. Chapter 18.3.8 explains 

the function of each menu. To clear selection area, right click the chart and select  Clear Selection 

Area.  
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18.3.4 Save or Copy the Chart 

To save the chart as image file, right click on the chart and select Save Chart as Picture. 
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Similarly, to copy the chart into clipboard, right click and select Copy Chart Image. Then you may 

paste the image onto Microsoft Paint, Microsoft Word, or any software that accepts bitmap image. 

18.3.5 Export Values to Microsoft Excel or CSV 

Once the chart has been graphed completely, click  Copy to Microsoft Excel. This button opens a 

new Excel worksheet. Then GCAS writes all data point of all line charts available onto this worksheet.  

Note 

This feature requires Microsoft Excel 2010, 2013, 2016, or later, to be installed.  

GCAS prevents you from exporting to Excel if there are duplicate comparison entries. 

 

Every device or stream in comparison list has its own column and the rows are timestamps. If there are 

two or more data points from different devices or streams sharing the exact same timestamp, they are 

merged into one row in Excel worksheet. 

In some scenarios where the comparison chart contains many records (> 200), it is faster to export to 

CSV file instead. Open the dropdown menu of   Copy to Microsoft Excel button and find the Save 

as CSV menu. 
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18.3.6 Comparison of Averages 

When you click Go or Refresh, GCAS renders the chart and at the same time computes the average of 

each line. These average values are presented on a secondary column chart. Click Show average 

chart button (having icon �̅�) to bring the average chart visible. 

 

Each comparison entry has its own average bar (or technically ‘column’ as it is a column chart). Show-

ing or hiding a line chart through the Show? check box in the comparison list also displays or conceals 

its average bar. You can also zoom the average chart in case all bars are of the same height thus mak-

ing it difficult to see the difference among them, provided that the chart is in zoom mode. 

18.3.7 Send to ISO 6976/GPA 2172 Trend Comparison 

Now that you have the mole composition trend of various devices or streams, ever wondered how 

much calorific value each stream would stack against one another? If you have the GCAS feature ISO 
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6976 Trend or GPA 2172 Trend included in your licence, you see the button Send to ISO 6976/GPA 

2172 Trend Comparison is enabled next to Copy to Microsoft Excel button. 

This button calls ISO 6976/GPA 2172 Trend Comparison form and communicates the necessary infor-

mation such as the plot range and content of the comparison list. Then ISO 6976/GPA 2172 Trend 

Comparison form handles the rest. Because this "Send to" shortcut bypasses some of the ISO 

6976/GPA 2172 Trend Comparison's standard startup routines, the ISO 6976/GPA 2172 Trend Com-

parison form is locked to your comparison list only. To unlock the form, click Reset and reload device 

list. 

 



GCAS® Manual Guide rev. 26 

Page 292 of 587 

 

 

 Send to ISO 6976/GPA 2172 Trend Comparison button transmits the entire plot range. To 

compare ISO 6976 or GPA 2172 trends of a limited range, switch Mole Composition Comparison form 

to selection mode and use the right-click menu Send to ISO 6976/GPA 2172 Trend Comparison as 

illustrated in chapter 18.3.8. 

18.3.8 Selection Mode Menus 

These menus are available if the form is in selection mode and there is a selection area. Unlike Data 

Analysis, Mole Composition Comparison requires the selection area to be contiguous, that is, no rec-

ord (dots on chart) jumping out from selection rectangle then return back inside. If your selection area 

is not contiguous, GCAS will alert you and propose a corrected selection area. Nonetheless if you disa-

gree with the new selection area, click Cancel on the message box. 
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Menu Function 

Zoom In Here Zooms in to the selection area. 

Generate Summary Here Generates statistical summary for the selected area. 

Frame This Selection Literally puts a rectangular frame around the selection, for presenta-

tion purpose. 

This works on the average chart too. 

Remove Frames Deletes all frames created through Frame This Selection menu. 

Set These Records as Inactive Sets all records within the X-axis range of the selection area as inac-

tive. GCAS displays an additional dialogue if your selection area co-

vers several devices/stream numbers. 

Send to ISO 6976 Calculator 

(Selection Averaged) 

This menu requires ISO 6976 Calculator in GCAS licence. It sends the 

averaged mole composition value of all gases of all records con-

tained inside the selection area to ISO 6976 Calculator. As the chart 

has only one gas, the entire data table is reloaded from the data-

base. GCAS displays an additional dialogue if your selection area co-

vers several devices/stream numbers. 

Send to ISO 6976 Calculator 

(Entire X-axis Averaged) 

This menu requires ISO 6976 Calculator in GCAS licence. It sends the 

averaged mole composition value of all gases of all records in the 

entire X-axis. Actually, it doesn’t even need a selection area. GCAS 

displays an additional dialogue if you have more than one compari-

son entry in the comparison list. 

Send to GPA 2172 Calculator 

(Selection Averaged) 

This menu requires GPA 2172 Calculator in GCAS licence. It sends 

the averaged mole composition value of all gases of all records con-

tained inside the selection area to GPA 2172 Calculator. As the chart 
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has only one gas, the entire data table is reloaded from the data-

base. GCAS displays an additional dialogue if your selection area co-

vers several devices/stream numbers. 

Send to GPA 2172 Calculator 

(Entire X-axis Averaged) 

This menu requires GPA 2172 Calculator in GCAS licence. It sends 

the averaged mole composition value of all gases of all records in 

the entire X-axis. Actually, it doesn't even need a selection area. 

GCAS displays an additional dialogue if you have more than one 

comparison entry in the comparison list. 

Send to ISO 6976 / GPA 2172 

Trend Comparison 

This menu requires ISO 6976 Trend or GPA 2172 Trend in GCAS li-

cence. It loads the ISO 6976/GPA 2172 Trend Comparison form and 

instructs the form to compare ISO 6976 or GPA 2172 values based 

on the mole composition records contained inside the selection 

area. Contrast to Send to ISO 6976/GPA 2172 Trend Comparison 

button, this menu transmits the X-axis range of selection area rather 

than the entire plot range. 

These menus Set These Records as Inactive, Send to ISO 6976 Calculator (plus the GPA 2172 coun-

terpart), and Send to ISO 6976/GPA 2172 Trend Comparison may trigger a further confirmation if 

your selection area covers more than one device or one stream. Please confirm which device(s)/stream 

number(s) to have their records set as inactive or be sent to ISO 6976 Calculator, GPA 2172 Calculator, 

or to ISO 6976/GPA 2172 Trend Comparison tool. Setting as inactive merges two comparison entries 

having same device, same stream number, but different stream conversion option. 

  

Confirmation dialogue boxes. Tick which device(s)/stream(s) then click Continue. 

GCAS opens as many ISO 6976 Calculator or GPA 2172 Calculator forms as necessary and sets their 

descriptions accordingly, so you know which is which. 

18.3.9 Other Visual Cues 

Click  Show values or right click the chart and select Show Values to display the mole composition 

values. 
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GCAS prompts a warning if one or more devices have over 100 dots on the chart. We do not recom-

mend displaying value labels on line charts with over 100 dots because it will clutter the chart area. 

Nevertheless, you can choose to continue displaying labels despite the 100+ dots, just be informed 

that GCAS may appear 'not responding' for a while because the layout engine of the chart is busy. 

 

These dashed lines are called cursors. Cursors appear when you click on a chart or as a remnant of 

zoom operation. Cursor may act as a guide to compare Y-axis values of two data points. Click  Hide 

crosshair cursors or right click on a chart and select Hide Crosshair Cursors to hide these lines from 

view. 

 

By default, GCAS draws the chart using a thin line. The toggle button  Use thin line is pressed. If 

you prefer the usual thick lines, click this button to raise it from its pressed state. 
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18.3.10 Colourblind Assistance 

To aid users with colour blindness (protanopia and deuteranopia), GCAS provides an alternative colour 

scheme for the chart. Use the  Colourblind assist button to switch colour scheme. 

 

Alternative colour scheme when colourblind assist is turned on.  

Colourblind assistance works better with thick lines like in this screenshot. 

 

  

http://en.wikipedia.org/wiki/Color_blindness#Dichromacy
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19 Correlation Calculator 

Correlation Calculator is a tool to find the R2 (correlation) value for arbitrary number of data. Footprint 

and Calibration Data already calculated R2 value of the calibration record, however they follow a cer-

tain order of components/gases for each GC device type. If you need to calculate the correlation value 

without following those rules, use this Correlation Calculator tool instead. This tool does not only cal-

culate RF-MW correlation like those in Footprint or Calibration Data, but also calculates correlation of 

any x and y number pair. 

19.1 The Correlation Calculator Form 

To open Correlation Calculator, go to the Tools menu > Correlation Calculator. Correlation Calcula-

tor can also be opened through Send to shortcut, such as from Footprint or Calibration Data or from 

Data Analysis. This Correlation Calculator form has three sections which are data input section, data 

table section, and chart section. 

 

This calculator has two modes, named RF-MW Calculator and Any X-Y Calculator. The first mode cal-

culates the correlation value for the given pairs of RF (response factor) and MW (molecular weight). 

On the other side, Any X-Y Calculator computes the correlation value for the given pairs of arbitrary X 

and Y values. Use this mode if you need the X-axis to be something other than the logarithm of mo-

lecular weight.  

The active tab on the data table section indicates current active mode. Switch tab to change mode. 
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19.2 RF-MW Calculator 

Switch to RF-MW Calculator tab on the data table section. This would change the data entry section to 

the screenshot below. 

 

Add a new entry by selecting the desired gas from the MW (molecular weight) dropdown, and type its 

response factor value in the RF text box. Click  Add to insert this entry into data table. This entry is 

also graphed on the chart immediately. 

Note 

You cannot add the same gas more than once. Should the selected gas has existed in the data table 

section, GCAS presents a warning message. 

You cannot put negative number in response factor entry field because logarithm of negative num-

bers is undefined. 

To remove one or more entries, click row header(s) to highlight data row(s) you wish to delete. Next, 

press Delete on your keyboard. The corresponding dot(s) on the chart will disappear as well. 

 

You can edit the response factor value should a mistake happened. Double click the response factor 

cell, enter the correct value, then press Enter to commit. The corresponding dot on the chart shall 

move upwards or downwards according to the new response factor value. 
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Whenever there are minimum three entries in data table, GCAS computes the regression line and cal-

culates their correlation. The R2 value is displayed at the top of the chart. Regression line and R2 value 

are also updated after changes of existing RF values are committed. If you remove several entries leav-

ing less than three in data table, both regression line and R2 value disappear from the chart. 

 

Note 

Correlation data sent from Data Analysis’ context menu Send to Correlation Calculator may include 

gases with non-relatable correlation such as i-butane, i-pentane, nitrogen, and carbon dioxide. GCAS 

displays these gases as red dots in the R2 chart, indicating they should be removed. 

19.3 Any X-Y Calculator 

Switch to Any X-Y Calculator tab on the data table section. This would change the data entry section 

to the screenshot on the next page. 
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Unlike RF-MW calculator, here you can enter literally any real numbers for X and Y values. Click  

Add to insert this entry into data table. This entry is also graphed on the chart immediately. 

Note 

If you need to find the correlation of the logarithm of X and Y instead of just X and Y, visit the next 

chapter Any log(X)-log(Y) calculator. 

Similar to RF-MW Calculator, to delete one or more entries you need to highlight the row(s) and then 

press Delete on your keyboard. In addition, to edit the X value or Y value, double click on the corre-

sponding cell to enter edit mode. Press Enter on your keyboard to commit the change and to up-

date the chart. 

  

As soon as there are three entries or more, GCAS calculates the regression line and correlation value. 

This chart updates automatically if there are entries removed or edited. 



GCAS® Manual Guide rev. 26 

Page 301 of 587 

 

 

19.4 Any log(X)-log(Y) Calculator 

Any X-Y Calculator has another option calculate the correlation of 10log X (base-ten logarithm of X) 

against 10log Y, instead of just X against Y. To use this option, switch the Correlation Calculator to Any 

X-Y Calculator mode, then begin entering pairs of X and Y values as usual. 

When you are done, tick the check box Take base-10 logarithm before calculating R2. GCAS com-

putes the logarithm of both X and Y value in each pair, updates the chart, and finally recalculates the 

regression line and the correlation (R2 value). 

Note 

This time, do not enter zero or negative numbers in any X values or any Y values. Logarithm of 0 yields 

negative infinity and is not graphable. Logarithm of negative numbers are undefined. If GCAS encoun-

ters zero, it will change it to one (1). If GCAS finds a negative number, GCAS replaces it with the abso-

lute value of that number.  

Unticking the check box will revert this calculator tool to the regular Any X-Y Calculator mode. 
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Difference between regular X-Y correlation (top) and logarithmic X-Y correlation (bottom). 
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20 ISO 6976 Calculator 

ISO 6976 Calculator is a tool to calculate the calorific value (CV), molar mass composition, Wobbe in-

dex, relative density, and standard density of any given mole composition, as defined by ISO 

6976:1995 standard. 

Note 

To use ISO 6976 Calculator, you need the GCAS feature ISO 6976 Calculator in your GCAS licence. 

ISO 6976 calculation takes four inputs: 

1. Mole composition, 

2. Base pressure, 

3. Combustion temperature, 

4. Metering (base) temperature. 

Mole composition input may come from a manual input or an existing record. ISO 6976 Calculator 

treats the input composition as unnormalised so it will normalise them before performing calculation; 

except in BTEX and single gas mode. BTEX compositions are usually trace value (in ppm scale) act-

ing as residual components from the normal alkane gases. Single gas devices just read one gas so it is 

meaningless to normalise its composition because it will end up in 100%. 

Note 

To force GCAS to always normalise input composition even it is BTEX or single gas, run GCAS with ad-

ditional /normaliseISO6976 switch. 

Base pressure is typically the atmospheric pressure (1 atm or 101,325 Pa). GCAS support six pairs of 

combustion and metering temperature: 

• 0°C / 0°C 

• 15°C / 0°C (combustion temperature = 15°C, base temperature = 0°C) 

• 25°C / 0°C 

• 15°C / 15°C (the default) 

• 20°C / 20°C 

• 25°C / 20°C 

20.1 The ISO 6976 Calculator Form 

There are multiple ways to open ISO 6976 Calculator form:  

1. For one-time offline calculation: Go to the Tools menu on GCAS main window and then select 

ISO 6976 Calculator. Through this menu, you will enter the mole composition by hand (man-

ual input) or through copy-and-paste. 

http://www.iso.org/iso/iso_catalogue/catalogue_tc/catalogue_detail.htm?csnumber=13531
http://www.iso.org/iso/iso_catalogue/catalogue_tc/catalogue_detail.htm?csnumber=13531


GCAS® Manual Guide rev. 26 

Page 304 of 587 

 

2. Sent by Mole Composition form. Open the desired mole composition record, go to the Action 

menu, and select Send to ISO 6976 Calculator. If you have GCAS feature ISO 10723, choose 

which one to send either the single-point or the MLC. If your device is ABB, you have the op-

tion to send exponential composition as well. Through this method, ISO 6976 Calculator form 

uses the selected mole composition record. 

3. Sent by Calibration Gas Certificate. Open the desired calibration gas certificate, go to the Ac-

tion menu, and select Send to ISO 6976 Calculator. By this way, ISO 6976 Calculator form 

uses the mole percentage portion of the selected calibration certificate. 

4. Sent by Data Analysis. Graph some mole composition trend, put the Data Analysis form in se-

lection mode, drag a selection rectangle, then right click the chart, and select Send to ISO 

6976 Calculator. Records inside the selection area are averaged and then sent to ISO 6976 

Calculator form. 

5. Sent by Mole Composition Comparison. Load a range of records, then right click the compari-

son chart, and select either Send to ISO 6976 Calculator (Selection) or Send to ISO 6976 

Calculator (Entire X-axis). The former requires a selection area while the latter doesn’t. You 

may need to confirm which device(s)/stream(s) to be sent to ISO 6976 Calculator. 

 

The grid on the left is the mole composition input. Grey cells are not editable. Depending on the se-

lected mode down there, the grid contains either one gas, 4 aromatic gases, or all 15 gases from me-

thane to decane including neopentane. Default mode is normal which puts ISO 6976 Calculator to ac-

cept alkane gases. These two modes H2S and H2O are essentially the same (single gas), but the gases 

have different molar mass that would affect the final ISO 6976 calculation. 
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At the top centre region of the form, set the base pressure and combustion-metering temperature 

pair. When all inputs are correct, click Calculate. Calculation results are displayed on the grid at the 

bottom region. In addition of five properties of ISO 6976 standard, the calculator also displays the 

compressibility factor (Z) of the input composition. 

20.2 Ways to Enter Composition 

Input composition can come from a manual input, copy-and-paste, or an existing record. 

20.2.1 Manual Input 

Go to the input composition grid. Press F2 or double click the cell to invoke edit mode. There is total 

row at the bottom of the grid which updates every time you finish editing a cell. You might need to 

scroll the grid or resize the form. 

 

Take care about the gases your GC device doesn't read. For example, a C7+ device has no octane, 

nonane, and decane. Some GC devices do not read neopentane too. Set the composition of these un-

available gases to zero. 

Click Reset to reset all numbers back to zero. 
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20.2.2 Normal Paste and Smart Paste 

Copy a block of cells from Microsoft Excel or your favourite spreadsheet processing software, then 

click Paste at ISO 6976 Calculator form. If your block of cells has one column, GCAS processes a nor-

mal paste. If it has two, GCAS processes a smart paste. 

Normal paste is like the Paste button on Microsoft Excel; it pastes the cells sequentially. Some safe-

guards implemented are cells containing non-number like alphabets will translate into zero, and nega-

tive numbers are converted into positive. 

 

Smart paste works for two-column data. First column must be the gas name. Second column is the 

value. The good thing is, you don't have to worry about gas order as GCAS will reorder the gases into 

the correct sequence. GCAS recognises standardised gas names (e.g. "Methane", "Benzene", "i-Bu-

tane") as well as some well-known names (e.g. "Isobutane", "Pentane"—translated as normal pentane 

or n-Pentane), and even their acronyms. Gas names are not case-sensitive. Having said that, these 

three blocks of cells on the next page will work. 
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20.2.3 Load a Mole Composition Record 

To use a mole composition record, we have two methods. Both require Live Data Analysis feature in 

your GCAS licence. 

First method as already described in chapter 8.10: Open a Mole Composition form, go to the Action 

menu, and select Send to ISO 6976 Calculator. 

Second method is described as the following. 

1. Go to the Tools menu > ISO 6976 Calculator on GCAS main window. 

2. While ISO 6976 Calculator window is open, select the device from your device panel or recent 

device panel. 

3. Look under the input grid. Click Use a mole composition record of <device name>. The 

<device name> follows the actual device you are selecting, and is updated whenever you 

change the selected device on main window. 

4. That link opens a Select Record dialogue. Pick a record and click OK. 
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20.2.4 Load a Calibration Certificate 

Open a Calibration Gas Certificate form, browse to the desired certificate, then go to the Action menu 

and select Send to ISO 6976 Calculator. The ISO 6976 Calculator form shall load the mole percent-

age portion of the calibration certificate. 

20.3 Add Description 

Description is an optional text for presentation purpose only. When there are multiple ISO 6976 Calcu-

lators open at the same time, add a text description to each of them hence you can easily identify 

which is which. 
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Open the Action menu and select Show Description Box. This reveals a text box above the output 

section of the form. Enter any description to this text box. To hide this text box, open the Action menu 

and clear the check mark on Show Description Box. 

 

Description text is used when you are switching windows through the Window menu on the main 

menu bar, and when you are comparing two ISO 6976 Calculators. GCAS automatically fills the de-

scription text for cases where ISO 6976 Calculator is opened through a Send to shortcut from Data 

Analysis or Mole Composition Comparison. 

20.4 Compare Two ISO 6976 Calculators 

Ever wondered how much is the difference of CV between two ISO 6976 Calculators? Wonder no 

more. Starting from GCAS version 1.7.3.0, ISO 6976 Calculator has been equipped with a comparison 

tool. Probably the most common use for comparing two ISO 6976 results is when you are calculating 

how much the CV difference is between single-point mole composition stream and its multilevel-cali-

bration counterpart. 

To make a comparison, first add description to each ISO 6976 Calculator form you wish to compare. 

Next, go to the Action menu and select Compare to, then choose the target ISO 6976 Calculator form 
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which appeared on the submenu. If you didn’t add description, the submenu simply says “(no de-

scription)”. It will become problematic if there are three or more ISO 6976 Calculators open and 

none of them has description. 

 

This is the ISO 6976 Comparison form. It compares all ISO 6976 outputs between the two calculator 

forms. Left column is the ISO 6976 Calculator which initiated comparison, let’s call it A. The right col-

umn is the ISO 6976 Calculator selected as comparison target, let’s call it B. Then you get the delta 

(difference) which is A minus B, and finally the delta expressed in percentage relative to A. Units in ISO 

6976 Comparison form follows the ISO 6976 Calculator, like the CV is still in MJ/m3. 

 

GCAS displays a warning if the two ISO 6976 Calculators did not have the same base pressure and 

combustion-metering temperature pair. Correct the mistake in the ISO 6976 Calculator (parent) form, 

click Calculate on the parent form to recalculate using the new pressure or temperature value, and 

finally click Refresh on ISO 6976 Comparison to re-compare. 
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21 GPA 2172 Calculator 

GPA 2172 Calculator is a tool to calculate gross heating value (GHV) and relative density of any given 

mole composition, as defined by GPA 2172-09 standard. GPA 2172 is more commonly used in North 

America while other regions use ISO 6976. 

Note 

To use GPA 2172 Calculator, you need the GCAS feature GPA 2172 Calculator in your GCAS licence. 

Unlike ISO 6976, GPA 2172 calculation takes two inputs: 

1. Mole composition, 

2. Reference pressure. 

In addition, GPA 2172 is not applicable for BTEX devices, moisture analysers, and single gas ana-

lysers that are not H2S. The mole composition input is treated as unnormalised so it will normalise 

them before performing calculation, except for H2S devices which is left unnormalised.  

Note 

To force GCAS to always normalise input composition, run GCAS with additional /normaliseGPA2172 

switch. 

Reference pressure is typically the atmospheric pressure expressed in pounds per square inch 

(14.69595 psi). In case a GCAS module has both ISO 6976 and GPA 2172 calculation, both ISO 6976 

base pressure and GPA 2172 reference pressure are combined into one input field. GPA 2172 does not 

have temperature input as it always assumes 60°F (15.55°C). 

21.1 The GPA 2172 Calculator Form 

Similar to ISO 6976 Calculator form, there are multiple ways to open GPA 2172 Calculator form. 

5. For one-time offline calculation: Go to the Tools menu on GCAS main window and then select 

GPA 2172 Calculator. Through this menu, you will enter the mole composition by hand (man-

ual input) or through copy-and-paste. 

6. Sent by Mole Composition form. Open the desired mole composition record, go to the Action 

menu, and select Send to GPA 2172 Calculator. If you have GCAS feature ISO 10723, choose 

which one to send either the single-point or the MLC. If your device is ABB, you have the option 

to send exponential composition as well. Through this method, GPA 2172 Calculator form uses 

the selected mole composition record. 

7. Sent by Calibration Gas Certificate. Open the desired calibration gas certificate, go to the Action 

menu, and select Send to GPA 2172 Calculator. By this way, GPA 2172 Calculator form uses 

the mole percentage portion of the selected calibration certificate. 

http://www.techstreet.com/standards/gpa-2172-09?product_id=1601645
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8. Sent by Data Analysis. Graph some mole composition trend, put the Data Analysis form in se-

lection mode, drag a selection rectangle, then right click the chart, and select Send to GPA 

2172 Calculator. Records inside the selection area are averaged and then sent to GPA 2172 

Calculator form. 

9. Sent by Mole Composition Comparison. Load a range of records, then right click the compari-

son chart, and select either Send to GPA 2172 Calculator (Selection) or Send to GPA 2172 

Calculator (Entire X-axis). The former requires a selection area while the latter doesn't. You 

may need to confirm which device(s)/stream(s) to be sent to GPA 2172 Calculator. 

 

The grid on the left is the mole composition input. Grey cells are not editable. Depending on the se-

lected mode down there, the grid contains either all 15 gases or only one (hydrogen sulfide). Unlike 

ISO 6976 Calculator form, GPA 2172 Calculator does not support BTEX and H2O mode. 

At the top centre region, set the reference pressure. When all inputs are correct, click Calculate. Calcu-

lation results are displayed on the grid at the bottom region. GCAS displays the compressibility value 

(Z), gross heating value (GHV) in both imperial and metric units, as well as the relative density.  

21.2 Ways to Enter Composition 

Input composition can come from a manual input, copy-and-paste, or an existing record. 
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21.2.1 Manual Input 

Go to the input composition grid. Press F2 or double-click the cell to invoke edit mode. There is total 

row at the bottom of the grid that updates every time you enter a value. You might need to scroll the 

grid or resize the form. 

Take care about the gases your GC device doesn't read. For example, an LNG C5− device does not 

have hexane to decane. Set the composition of these unavailable gases to zero. 

Click Reset to reset all numbers back to zero. 

21.2.2 Normal Paste and Smart Paste 

Copy a block of cells from Microsoft Excel or your favourite spreadsheet processing software, then 

click Paste at GPA 2172 Calculator form. If your block of cells has one column, GCAS processes a nor-

mal paste. If it has two, GCAS processes a smart paste. 

Normal paste is like the Paste button on Microsoft Excel; it pastes the cells sequentially. Some safe-

guards implemented are cells containing non-number like alphabets will translate into zero, and nega-

tive numbers are converted into positive. 

 

Smart paste works for two-column data. First column defines the gas name, while the second column 

contains values. The order of these gases does not matter as GCAS will reorder gases into the correct 

sequence. GCAS recognises standard gas names (e.g. "Methane", "Benzene", "i-Butane") as well as 
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some well-known names (e.g. "Isobutane", "Pentane"), and even their acronyms. Gas names are not 

case-sensitive. 

 

This block of cells would work with smart paste. 

21.2.3 Load a Mole Composition Record 

To use a mole composition record, you need Live Data Analysis feature in your GCAS licence. 

Method one: As already described in chapter 8.10: Open a Mole Composition form, browse to the de-

sired record, go to the Action menu, and finally select Send to GPA 2172 Calculator. 

Method two: 

1. Go to the Tools menu > GPA 2172 Calculator on GCAS main window. 

2. While GPA 2172 Calculator window is open, select the device from your device panel or recent 

device panel. 

3. Look under the input grid. Click Use a mole composition record of <device name>. The 

<device name> follows the actual device you are selecting, and is updated whenever you 

change the selected device on main window. 

4. That link opens a Select Record dialogue. Pick a record and click OK. 

21.2.4 Load a Calibration Certificate 

Open a Calibration Gas Certificate form, browse to the desired certificate, then go to the Action menu, 

and select Send to GPA 2172 Calculator. The GPA 2172 Calculator form shall load the mole percent-

age portion of the calibration certificate. 
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21.3 Add Description 

Description is an optional text for presentation purpose only. When there are multiple GPA 2172 Cal-

culators open at the same time, adding a text description to each of them would help you identify 

which window is which. 

 

Open the Action menu and select Show Description Box. This reveals a text box above the output 

section of the form. Enter any description to this text box. To hide it, open the Action menu again and 

clear the check mark on this menu. 

 

Description text is used when you are switching windows through the Window menu on the main 

menu bar. GCAS also fills in the description text automatically for cases where GPA 2172 Calculator is 

opened through a Send to shortcut from Data Analysis or Mole Composition Comparison. 
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22 ISO 6976/GPA 2172 Trend 

ISO 6976/GPA 2172 Trend is a module to plot historical ISO 6976 output values or GPA 2172 output 

values over time. This module should not be confused with Uncertainty Trend which graphs the uncer-

tainty of ISO 6976 or GPA 2172 outputs. ISO 6976/GPA 2172 Trend takes a collection of mole compo-

sition records then performs ISO 6976 and GPA 2172 calculation on each of them using the same pa-

rameters, and finally displays the trend on a line chart. 

Note 

This module requires at least one GCAS feature ISO 6976 Trend or GPA 2172 Trend to be included in 

your GCAS licence. If you have both, fantastic! 

Mole composition records of BTEX analysers and single gas devices are not normalised. To override 

this behaviour, run GCAS with additional /normaliseISO6976 or /normaliseGPA2172 switch (or 

both). 

GPA 2172 calculation is not applicable for BTEX analysers, H2O analysers, and single-gas analysers 

that are not H2S. The resulting chart will be all-zeroes for these devices. 

22.1 The ISO 6976/GPA 2172 Trend Form 

Select the desired GC device on device panel or recent device panel, and then go to the View menu > 

ISO 6976/GPA 2172 Trend. Similar to Data Analysis, ISO 6976/GPA 2172 Trend form has three sec-

tions: parameters, chart, and comments. 

 

Chapter 22.2 Calculation properties and 22.3 Plot range and stream conversion explain the parameter 

section in greater detail. 
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22.2 Calculation Properties 

 

Check boxes on this list control which ISO 6976 and GPA 2172 outputs to show. Typically, only one 

output is checked. GCAS can graph two gross heating value (GHV) outputs, one in imperial unit 

(BTU/ft3) and the other in metric unit (MJ/m3). 

Set the base pressure and the combustion-metering temperature pair. These properties are used to 

calculate ISO 6976 outputs throughout the entire plot range. Default base pressure is one atmospheric 

pressure. There are six combustion-metering temperature pairs supported: 

- 0°C / 0°C, 

- 15°C / 0°C, 

- 25°C / 0°C, 

- 15°C / 15°C (default), 

- 20°C / 20°C, 

- 25°C / 20°C. 

For GPA 2172 calculation, the base pressure is the same as reference pressure. GCAS performs the 

necessary unit conversion behind the screen hence entering a value of 1.0 atm will be interpreted as 

14.6959 psi. Combustion-metering temperature selection has no effect on GPA 2172 calculation as it 

always assumes 60°F (15.55°C). 

If your GCAS licence only has one trend feature—for example only ISO 6976 Trend is included, you will 

not see GPA 2172 outputs on the check box list. 
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22.3 Plot Range and Stream Conversion 

 

These options control which data source to feed into ISO 6976 and GPA 2172 calculator inside ISO 

6976/GPA 2172 Trend form. Set the date and time range as well as the stream number and finally click 

 Refresh to start graphing. It may take a while to plot the complete chart on slow network connec-

tion to database server. GCAS provides  Pause button to temporarily halt the operation (or press 

F7) and  Stop button (or press Esc) to abort the calculation. 

 

ISO 6976/GPA 2172 Trend form, calculation in progress. Dots disappear after 100 data points. 

GCAS determines which stream numbers available based on the existing mole composition records 

and mole composition streams configuration in Modbus register mappings. Nevertheless, if the de-
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sired stream number is not listed on this dropdown, just type the number manually and hit  Re-

fresh. In addition, if your GC device has spot sample data, you can graph the ISO 6976 or GPA 2172 

trend of those spot sample records too. The word "spot" will appear on stream selection. 

Given that you have ISO 10723 feature included in your GCAS licence, you shall see an additional 

dropdown for stream conversion. This dropdown controls whether the underlying mole composition 

records should be converted to single-point or to multilevel-calibrated values prior to ISO 6976/GPA 

2172 calculation. One special case, this dropdown will appear on ABB devices regardless of the ISO 

10723 feature availability in your licence. For ABB devices, you have the option to convert the mole 

composition records into exponential composition as well. Non-convertible records will produce gaps 

on the ISO 6976/GPA 2172 trend chart. The default selection is Don’t convert (Compute as is) which 

will bypass all ISO 10723 prerequisites and ABB exponential conversion prerequisites. This would let 

ISO 6976/GPA 2172 Trend form to plot the graph while ignoring the MLC flag bit of the underlying 

mole composition records. Do not select this option if you suspect the GC device might have mixed 

record types. 

Under the stream conversion dropdown, there is a link named Compare both. Or if the device is ABB, 

this link may read Compare all. This link summons ISO 6976/GPA 2172 Trend Comparison tool and 

tells it to compare ISO 6976 trend or GPA 2172 trend based on single-point mole composition records 

versus the trend based on multilevel-calibrated mole composition records. It requires an additional 

GCAS feature Data Comparison. 

22.4 Mean and Standard Deviations 

 

Mean and standard deviations are calculated based on all data points currently appearing on current 

ISO 6976/GPA 2172 trend chart. Tick this check box to reveal the mean and twice the standard devia-

tion lines. GCAS cannot show mean and standard deviation lines for previous chart, they are for cur-

rent chart only. Mean and standard deviations will not show if there are multiple ISO 6976 or GPA 

2172 trends in the chart. 
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Next to the check box, you see a link called Generate summary. This link generates statistical sum-

mary for the entire X-axis. To generate summary on a certain portion of X-axis, switch to selection 

mode and use the right-click menu instead. 

 

Had you opted to show previous chart as well, this summary includes the difference between current 

chart and previous chart. 
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22.5 Save or Copy the Chart 

To save the chart as image file, right click on the chart and select Save Chart as Picture. 

 

Similarly, to copy the chart into clipboard, right click and select Copy Chart Image. Then you may 

paste the image onto Microsoft Paint, Microsoft Word, or any software that accepts bitmap image. 

22.6 Comparing Previous Chart 

ISO 6976/GPA 2172 Trend form remembers the last ISO 6976 or GPA 2172 trend chart before you 

changed something. By this way, you can quickly compare current ISO 6976/GPA 2172 trend versus 
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the one before parameter change. Typical use of previous chart is to compare calorific value (CV) 

based on single-point mole compositions versus CV based on multilevel-calibrated mole composi-

tions. To do so, first graph a CV trend with stream conversion set to single-point. Next, change the 

stream conversion to multilevel-calibrated and hit  Refresh to graph the CV trend on MLC. Finally, 

click  Show previous chart button. Current chart (dark blue) is the CV based on MLC compositions, 

while previous chart (light blue) is the CV based on single-point compositions. 

 

Example of a bad GC. Current CV (dark blue) is based on multilevel-calibrated compositions, while previ-

ous CV (light blue) is based on single-point compositions. If these two drift too far apart, this indicates 

problems within the GC. A good GC should have these two be really close or even coincide. 

Be reminded that only one previous chart is cached. If you change a parameter the third time, first 

chart graphed is lost when you click  Refresh. 

22.7 Zoom Mode and Selection Mode 

The radio buttons depicted on the next page control whether ISO 6976/GPA 2172 Trend form is in 

zoom mode or in selection mode. 
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In zoom mode, drag a rectangle on a region you would like to zoom. 

 

Pan the chart using the provided scroll bars. Drag another rectangle to zoom in further. To zoom out 

one step, click on the circled minus button Θ on both scroll bars. To zoom all-out, simply press the 

Home button on your keyboard or right-click on the chart and select Zoom All Out submenu. 

In selection mode, drag a rectangle to create a selection area. Right click the chart and you see several 

menus are now available. Chapter 22.8 Selection mode menus will explain the function of each menu. 

To clear selection area, right click the chart and select  Clear Selection Area.  
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22.8 Selection Mode Menus 

Assuming the chart is on selection mode and you have a selection rectangle, these menus are availa-

ble. 

 

Menu What it does 

Zoom In Here Zooms in to the selection rectangle. 

Generate Summary Here Generates statistical summary for all data points inside the selec-

tion rectangle. 

- If you activate previous chart alongside current ISO 6976/GPA 

2172 trend chart, the summary also includes differences be-

tween the two. 

- GCAS looks at the X-axis range only. Data points excluded by 

the selection rectangle (having Y-axis values outside of selec-

tion rectangle) are also included for statistical calculation. 
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Frame This Selection Literally puts a rectangular frame around the selection area, for 

presentation purpose only. 

 

Remove Frames Removes all rectangular frames created through Frame This Selec-

tion menu. 

Set Underlying Mole Compo-

sition Records as Inactive 

As it says, this menu sets all underlying mole composition records 

within the selection area as inactive. Once it's done, the ISO 

6976/GPA 2172 trend lines will have a gap on it and the 

mean/standard deviation values are invalidated. Refresh the chart 

to get the correct values. 

22.9 Other Visual Cues 

Set the chart to zoom mode. Click anywhere on the chart to place these crosshair cursors. These dot-

ted pair of line acts as a ruler to compare Y-axis values between several data points. To remove them, 

click  Hide crosshair cursors. 

 

Hover your mouse pointer over a data point to show a tooltip about its value. 
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Or click  Show values to display values on labels. 

 

If you need higher precision, right click the chart and tick Use 8-Decimal Precision on Labels. Untick 

this menu to revert back to 4-digit decimals. 

 

In case of current ISO 6976/GPA 2172 line and previous ISO 6976/GPA 2172 line are so close together, 

click  Use thin lines to draw the chart using 1-pixel wide lines. 
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22.10 Export Values to Microsoft Excel or CSV 

Once the chart has been graphed completely, click  Copy to Microsoft Excel. This button opens a 

new Excel worksheet. Then GCAS writes all data points of all line charts onto this worksheet.  

 

 

Note 

This feature requires Microsoft Excel 2010, 2013, 2016 or later, to be installed.  

GCAS writes all five ISO 6976 outputs plus three GPA 2172 outputs to a new Microsoft Excel work-

sheet, with both current ISO 6976/GPA 2172 trend and previous ISO 6976/GPA 2172 trend values. If 

there is no previous chart graphed before, previous ISO 6976/GPA 2172 trend values are all blanks. No 

worries, you can export to Microsoft Excel even if current ISO 6976/GPA 2172 trend chart has a differ-

ent date/time range than the previous chart. 
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To export as CSV instead, open the dropdown menu of  Copy to Microsoft Excel button and then 

select Save as CSV. 

 

22.11 Insert Comment 

To view or write comments, open the Comments tab. 

 

Write your comment and set the appropriate date of topic, then click Submit. Your comment will have 

a yellow background to distinguish it from comments by other users. Date of topic is an additional 
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information of which mole composition record you are writing your comment for, thus other users 

know the correct data point to refer to. 

Make sure that the comment is correct e.g. free from spelling errors, because once submitted you 

would not be able to edit nor remove your comment.  

To refresh comments, click the same  Refresh button. 

If you do not see the text box to write your comment, i.e. you only see the comment grid, your GCAS 

user account doesn't have the action permission to write comment in ISO 6976/GPA 2172 trend. Con-

tact your GCAS administrator. 
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23 ISO 6976/GPA 2172 Trend Comparison 

ISO 6976/GPA 2172 Trend Comparison is a tool to compare ISO 6976 or GPA 2172 trends across de-

vices. It is a part of Data Comparison feature, which stands in line after Mole Composition Comparison. 

Do not confuse ISO 6976 trend comparison with ISO 6976 comparison. The former is what we are go-

ing to talk in this chapter, while the latter is a bonus feature of ISO 6976 Calculator. 

Note 

This module requires two or three GCAS features to be included in GCAS licence: ISO 6976 Trend or 

GPA 2172 Trend (or both), then combined with Data Comparison. 

ISO 6976 calculation on BTEX devices and single gas analysers uses their underlying mole composition 

which are not normalised. To override this behaviour, run GCAS with additional /normaliseISO6976 

switch. 

GPA 2172 calculation on H2S devices is not normalised. To override this behaviour, run GCAS with ad-

ditional /normaliseGPA2172 switch. 

23.1 The ISO 6976/GPA 2172 Trend Comparison Form 

The form is accessible through the Tools menu > ISO 6976/GPA 2172 Trend Comparison. 
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Similar to Mole Composition Comparison form, ISO 6976/GPA 2172 Trend Comparison form has two 

resizable sections. Parameters are at the top, chart is at the bottom. This form is designed with similar 

UI experience with Mole Composition Comparison therefore users can use it straight away without 

reading this chapter further. 

23.2 Parameters and Device List 

The top section of the form has a linear flow. Select what ISO 6976 or GPA 2172 output you need, the 

comparison date range, and ISO 6976 properties (❶), then browse the devices to compare (❷) and 

add them to the comparison list (❸), select which stream of these devices (❸) and finally click Go 

(❹) to start graphing.  

23.2.1 Plot Range and Calculation Properties 

 

First thing first, select which ISO 6976 or GPA 2172 output to compare. The default selection is calorific 

value (CV). There are two gross heating value (GHV) outputs, one in imperial unit and the other in 

metric. Going down, there are date and time pickers to set the plot range. Scroll down once more and 

you see the ISO 6976 and GPA 2172 properties (base pressure and combustion-metering temperature 

pair). 

Default base pressure is the atmospheric pressure (1 atm). For GPA 2172 calculation, this base pres-

sure becomes the reference pressure. GCAS performs unit conversion behind the screen, therefore en-

tering a value of 1.01325 bar will be interpreted as 14.6959 psi. 

GCAS supports six combustion-metering temperature pairs. This option is applicable to ISO 6976 cal-

culation only, as GPA 2172 always assumes 60°F (15.55°C). These six pairs are: 

• 0°C / 0°C 

• 15°C / 0°C (combustion temperature = 15°C, base temperature = 0°C) 
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• 25°C / 0°C 

• 15°C / 15°C (the default) 

• 20°C / 20°C 

• 25°C / 20°C 

23.2.2 Devices and Comparison List 

 

Device tree view is on the left. It lists all your workspaces and devices within each workspace. The grid 

on the right is known as comparison list.  

Hover your mouse pointer over a device to view more information about data availability and stream 

numbers. In the screenshot below, the device ABB_TEST1A has three streams: stream 1, stream 2, and 

spot sample records. Because ISO 6976 and GPA 2172 calculation are based on mole composition rec-

ords, devices having no mole composition records at all are displayed as semi-transparent and cannot 

be added to the comparison list. 

 

To compare devices, add the devices from the device tree view to the comparison list. Either select the 

device then click Add, or double click the device, or drag the device and drop it onto comparison list. 
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Note 

An ISO 6976/GPA 2172 Trend Comparison form which was opened via Send to shortcut from Mole 

Composition Comparison's Send to ISO 6976/GPA 2172 Trend Comparison button or right-click menu, 

as well as through the Compare both link on ISO 6976/GPA 2172 Trend form; is locked to a certain 

number of comparison entries. Device tree view is empty and you cannot add another device into 

comparison list. The text above the chart should clearly indicate the form is locked. Click Reset and 

reload device list next to this text in order to unlock ISO 6976/GPA 2172 Trend Comparison form 

back into normal mode. 

Once the device has been added to the comparison list, select the stream number. ISO 6976/GPA 

2172 Trend Comparison form reads the mole composition records for this stream number. You can 

compare ISO 6976 or GPA 2172 trend values coming from different streams of the same device too. 

To do so, add the device to the comparison list twice, then select different stream number for each of 

them. In addition, if your devices have spot sample records, you shall find the word "spot" in the 

stream selector dropdown. Spot samples are treated as a regular mole composition stream here. And 

finally, if you have ISO 10723 feature in your GCAS licence, this tool can also compare the ISO 

6976/GPA 2172 trend values based on single-point composition vs. multilevel-calibrated composition 

of the same device, same stream number. 

  

The column Show? contains check boxes which is used to hide or show the line chart of correspond-

ing comparison entry after the chart has been rendered completely. Before you click Go, these check 

boxes have no effect. 

The column Convert contains dropdowns to switch the conversion between "single" (single-point) 

and "MLC" (multilevel-calibrated). Users without ISO 10723 feature in their licences will find these 

dropdowns contain only one item, that is "single", hence the Convert column serves no use. But re-

gardless of ISO 10723 feature availability, these dropdowns will add one more selectable option for 

ABB devices: "exp." (exponential). This last option converts the selected mole stream into exponential 

composition. As a result, you can compare all three stream conversions on an ABB device—single-

point, multilevel-calibrated, and exponential. 
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To remove an entry from the comparison list, highlight its row on the grid and then click Remove or 

press Delete on your keyboard. Every time a comparison entry is removed from the comparison list, 

its line chart is also removed. However if you add it back, you need to redraw the chart because its 

data in the cache has already gone. This is the difference between removing an entry versus temporar-

ily hiding it (by unticking the check box inside the Show? column). In addition, click Remove all to 

empty the comparison list and start over. 

Note 

Maximum number of entries in comparison list is 15 entries. 

GCAS will alert you if there are duplicate comparison entries. 

Duplicate = same GC device + same stream number + same stream conversion. 

23.2.3 Start Graphing 

 

When you are ready, click Go. GCAS loads the required mole composition data, calculates their ISO 

6976 and GPA 2172 values, then renders the chart. The Go button turns into Refresh button unless 

you change the selected ISO 6976/GPA 2172 output, calculation properties, comparison date range, 

devices, stream numbers, or stream conversion. 

If you included one or more spot sample streams in the comparison list, the check box Apply lag 

time to spot samples shifts all spot sample dots to the right according to the amount of most recent 

lag time value of each dot. Head to chapter 25.2 Lag Time form to create new lag time records. 

Users with ISO 10723 feature in their licences see an additional command link Clear MLC cache. This 

clears the cache used by ISO 10723 conversion. The cache contains MLC coefficients, calibration certif-

icates, single-point RF, MLC RF, and MLC constraints. Click this link if you notice ISO 6976/GPA 2172 

trends based on multilevel-calibrated streams are not correct. Once the MLC cache is emptied, refresh 

the chart. 
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23.3 Comparison Chart 

The chart graphs ISO 6976 or GPA 2172 output values based on mole composition records over time. 

This chart has maximum capacity of 15 comparison entries. The legend at your right-hand side tells 

the devices and their stream numbers. Multilevel-calibrated streams (ISO 10723) are indicated with su-

perscript M after their number, like 2M for stream 2. Exponential streams (only on ABB devices) are in-

dicated with superscript E. 

 

By default, GCAS renders the chart using thin lines, unlike all other charts in GCAS which use 2-pixel 

width. Line chart having data points less than 100 has small dot markers along its body. Line charts 

with more than 100 dots are presented without markers. 
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23.3.1 Show or Hide Some Devices 

To temporarily take a comparison entry off the chart, untick its check box at the column Show? inside 

the comparison list. Check the check box to bring the line visible. 

 

If you remove a device or stream from this list, its line chart is also removed. After you add the device 

or stream back, you need a full refresh to redraw the lost line. 

23.3.2 Zoom Mode and Selection Mode 

Click this button to switch between zoom mode and selection mode. 
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Toggle button to switch between zoom or selection mode. 

Zoom mode enables zooming to a specific area of the chart. Drag a rectangle over the area you want 

to zoom in. Pan around the chart using the provided scroll bars. Drag another rectangle to zoom in 

further. To zoom out, click the circled minus button Θ on both scroll bars. Press Home on your key-

board or right click the chart and select Zoom All Out to undo all zoom-in operations. 

Selection mode lets you create a selection area on the chart, then makes some context menu availa-

ble to manipulate the data inside this selection area. Chapter 23.3.5 explains the function of each 

menu. To clear selection area, right click the chart and select  Clear Selection Area.  

 

23.3.3 Save or Copy the Chart 

To save the chart as image file, right click the chart and select Save Chart as Picture. Or if you prefer 

copying the image directly onto Microsoft Power Point for example (or any software accepting bitmap 

image), right click the chart and select Copy Chart Image. 
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23.3.4 Export Values to Microsoft Excel or CSV 

Above the chart, located at the rightmost button, click  Copy to Microsoft Excel. This button 

opens a new Excel worksheet. Then GCAS writes all data points of all line charts available onto this 

worksheet.  

Note 

This feature requires Microsoft Excel 2010, 2013, 2016 or later, to be installed.  

GCAS prevents you from exporting to Excel if there are duplicate comparison entries. 

Duplicate = same GC device + same stream number + same conversion option. 

Every device or stream in comparison list has its own column and the rows are timestamps. If there are 

two or more data points from different devices or streams sharing the exact same timestamp, they are 

merged into one row in Excel worksheet. 
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Should the comparison chart contain many records (> 200), it is much faster to export to CSV file in-

stead. Open the dropdown menu of  Copy to Microsoft Excel button and find the Save as CSV 

menu. 

 

23.3.5 Selection Mode Menus 

These menus are available if ISO 6976/GPA 2172 Trend Comparison form is in selection mode and 

there is a valid selection rectangle on the chart. Similar to Mole Composition Comparison, ISO 

6976/GPA 2172 Trend Comparison requires a contiguous selection area. If there are several data points 

leaking out of your selection rectangle, GCAS alerts you while proposing a new selection area. 
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Menu Function 

Zoom In Here Zooms in to the selection area. 

Generate Summary Here Generates statistical summary for the selected area. 

Compare Averages (Selec-

tion) 

Prompts you to select two comparison entries out of whichever 

available inside the selection area; then compares the average of the 

two, giving you the delta and difference in percentage. See chapter 

23.3.6.2 for details. 

Compare Averages (Entire X-

axis) 

Prompts you to select two comparison entries out of all lines availa-

ble on the chart; then compares the average of the two, giving you 

the delta and difference in percentage. This menu does not even 

need a selection area. See chapter 23.3.6.2 for details. 

Frame This Selection Literally puts a rectangular frame around the selection, for presenta-

tion purpose. 

This works on the average chart too. 

Remove Frames Deletes all frames created through Frame This Selection menu. 

Set Underlying Mole Compo-

sition Records as Inactive 

As ISO 6976 and GPA 2172 calculation are based on mole composi-

tion records, this menu sets the underlying mole composition rec-

ords contained inside the selection area as inactive. You need to re-

fresh the chart afterwards. If your selection rectangle covers more 

than one line chart, GCAS prompts you to select which ones to set as 

inactive. 

These menus Compare Averages (both of them) and Set Underlying Mole Composition Records as 

Inactive may display a confirmation dialogue like the ones in the next page. Setting mole composition 

records as inactive should merge a pair of single-point and MLC entries of the same device same 

stream number into one entity. Average comparison requires you to select exactly two entries. 
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Confirmation dialogue boxes. 

23.3.6 Comparison of Averages 

ISO 6976/GPA 2172 Trend Comparison form offers two methods for average comparison. For quick 

and rough visual comparison, use the average chart. For detailed comparison, use the right-click menu 

Compare Averages. 

23.3.6.1 The 'Average' Chart 

For a rough visual comparison, ISO 6976/GPA 2172 Trend Comparison form provides an additional bar 

chart that shows the average value of every comparison entry. Click Show average button (the one 

having �̅� symbol) to reveal this chart. The average value of each bar is displayed on the label sitting at 

the top end of the bar. 
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23.3.6.2 'Compare Averages' Menu 

Sometimes users need a more detailed information of how two comparison entries differ to each 

other. To do this, switch the chart to selection mode. Afterwards, either draw a selection rectangle and 

right click then choose Compare Averages (Selection), or right click without a selection and select 

Compare Averages (Entire X-axis). If your chart or selection rectangle contains more than two lines, 

you are prompted to select two among them. 

 

 

Next, GCAS builds a comparison and displays them on a text viewer window similar to this one on the 

next page. 
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First row is the comparison. First column is the first comparison entry which was selected on the previ-

ous dialogue box, let's call it A. Next column is the second comparison entry, let's call it B. Then the 

delta is A minus B, and finally you get absolute difference in percentage relative to A. 

Second row contains number of data (N) used to calculate the average. The reason is ISO 6976/GPA 

2172 Trend Comparison form can compare trends between devices, and each GC device may not have 

the same number of data. 

23.3.7 Other Visual Cues 

By default, GCAS draws the chart using a thin line. The toggle button  Use thin lines is pressed. If 

you prefer the usual thick lines, click this button to raise it from its pressed state. 

Click  Show values or right click the chart and select Show Values to display the ISO 6976 or GPA 

2172 values. GCAS presents a warning if one or more devices have over 100 dots on the chart. We do 

not recommend displaying value labels on line charts with over 100 dots because it will clutter the 

chart area. 

 

This is how the chart would look like if the user clicked Yes anyway. 
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These dashed lines in the screenshot down here are cursors. Cursors appear when you click on a chart 

or as a remnant of zoom operation. Cursor may act as a ruler line to compare Y-axis values of two 

data points. Click  Hide crosshair cursors or right click the chart and select Hide Crosshair Cur-

sors to hide these lines from view. 

 

23.3.8 Colourblind Assistance 

To aid users with colour blindness (protanopia and deuteranopia), GCAS provides an alternative colour 

scheme for the chart. Use the  Colourblind assist button to switch colour scheme. 

 

CV trend comparison chart with colourblind assist turned on. 

Colourblind assistance works better if you use  thick lines because thick lines have subtle shadow to 

aid the user distinguishing the yellow line and white background. 

  

http://en.wikipedia.org/wiki/Color_blindness#Dichromacy
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24 ISO 10723 

ISO 10723:2012 is a standard method used to adjust values in non-linear GC devices. Support for ISO 

10723 first came in GCAS version 1.6.0.0. We gradually added more features and modules and finally 

full support of ISO 10723 was completed in version 1.7.3.0. With ISO 10723, GCAS makes a differentia-

tion between single-point and multilevel-calibrated (MLC) response factor and mole composition. 

All subchapters in this chapter assume you have GCAS feature ISO 10723 included in your licence. 

24.1 MLC Coefficients (Concept) 

Multilevel calibration coefficients (abbreviated MLC coefficients) are the coefficients of the analysis 

function as described in ISO 10723 standard. Similar to uncertainty coefficients, although not about 

the same meaning, MLC coefficients consist of four coefficients. These four come from the equation 

𝑦 = 𝑎 + 𝑏𝑥 + 𝑐𝑥2 + 𝑑𝑥3 

where y is multilevel-calibrated peak area, x is single-point peak area, and a, b, c, d are the MLC coeffi-

cients. Coefficient a and b are mandatory, and also b must not equal to zero. Coefficient c and d are 

not always present in the analysis function, depending on the GC.  

The term coefficient set refers to collection of MLC coefficients for all gases. Every gas has their own 

analysis function/equation, thus has their own coefficients. These coefficients are bundled together 

into one record of MLC coefficient set in GCAS database. 

24.2 MLC Constraints (Concept) 

Multilevel calibration constraints (abbreviated MLC constraints) are a set of rules to determine which 

root to use in polynomial MLC to single-point conversion. The opposite direction, single-point to MLC 

conversion, doesn’t need constraints. MLC constraints consist of linear constraint, quadratic constraint, 

and cubic constraint. Recall the equation of analysis function: 

𝑦 = 𝑎 + 𝑏𝑥 + 𝑐𝑥2 + 𝑑𝑥3 

During MLC to single-point conversion, the task is “given this y value, find x that satisfies this equa-

tion”. A polynomial function may have several roots (solutions) therefore MLC to single-point conver-

sion requires constraints to select the correct root. On the other hand, single-point to MLC conversion 

is much easier. “Find y, given this x value” means GCAS simply substitutes the x and evaluate the func-

tion to get y. 

http://www.iso.org/iso/catalogue_detail.htm?csnumber=55712
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Linear constraint 

If the coefficient c and d are zero, the equation becomes 

y = a + bx which is linear. Linear functions are guaranteed to 

have one root, but it can be negative.  

Linear constraint tells GCAS to disregard the negative root 

(then set x into zero), or to take absolute value in order to 

make the x positive. The default is to reject (disregard) negative 

root. 

 

Quadratic constraint 

If the coefficient d is zero, the equation becomes 

y = a + bx + cx2 which is quadratic. Quadratic functions may 

have two real roots, one real root, or no real roots at all (solu-

tion is imaginary root). 

GCAS always disregards imaginary root and sets x to zero, as 

well as any real roots which are negative. But in cases of one or 

two positive roots, quadratic constraint tells GCAS to use either 

the smallest positive or largest positive. The default is to use 

the smallest positive. 

 

Cubic constraint 

If all the coefficients are non-zero, the equation is cubic. Cubic 

functions may have one real root (+ 2 imaginaries), two real 

roots, or three real roots. Even though every possibility con-

tains real roots, the roots may be negative. GCAS always rejects 

negative real roots. That leaves the positive ones, which are 

subject to the constraints described below. One exception: if all 

roots are negative, GCAS sets the x into zero. 

GCAS has different cubic constraint depending what type of 

record is being converted. For response factor, GCAS offers 

four choices: 

1. Use the smallest positive, 

2. Use the largest positive, 

3. Use the one which yields a single-point RF value inside a 

range, or 

4. Use the one which yields a single-point RF value inside or 

closest to a range. 

If you choose option 3 or 4, you have to set the range’s lower 

and upper bound. The default is between 500,000 and 
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25,000,000 because typical single-point RF values fall between 

that range. 

For mole composition, GCAS offers another four choices: 

1. Use the smallest positive, 

2. Use the middle one if there are 3 roots, or smallest one if 

there are 2 roots, 

3. Use the middle one if there are 3 roots, or largest one if 

there are 2 roots, or 

4. Use the largest positive. 

In both cases, the default cubic constraint is option 1. 

Most of the time, you don’t have to worry about MLC constraints. As far as we tested, the default 

constraint has worked for vast, vast majority of RF and mole composition records. There is a tiny tiny 

chance the default constraints do not produce the expected result, which in this case you need to 

override the MLC constraints. Visit chapter 24.3 to read more about levels of MLC constraints override, 

or chapter 24.5 for how to actually override the MLC constraints. 

24.3 MLC Constraints Override Level (Concept) 

MLC constraints have a scope. From the most generic 

to the most specific, the order of scopes is: global, de-

vice, coefficient, and record.  

Global constraints are hardcoded inside your GCAS 

database. The factory values are reject negative root 

for linear functions, use smallest positive for quadratic 

functions, and use smallest positive for cubic func-

tions—although you can change these global con-

straints if required.  Second level of override is device-level. All ISO 10723 conversions on this device 

will use these MLC constraints instead of global constraints.  Third level of override is coefficient-

level. All records using a particular MLC coefficient set shall use these constraints instead of the de-

vice-level constraints. But records using another MLC coefficient set will use other coefficient-level 

constraints if that coefficient set has one, or fall back onto device-level if not. Fourth level is record-

level. On this level, the MLC constraints apply to that record only. Other records may have either their 

own record-level constraints, or fall back onto coefficient-level. 

While GCAS is converting from MLC records to single-point, GCAS loads MLC constraints from the 

most specific which is at record-level. If current record has no record-level override, GCAS moves 

down one step and looks for coefficient-level override. If the MLC coefficients used by this record has 

no overridden MLC constraints, GCAS moves down one step again and looks for device-level override. 

If current GC device has no MLC constraints defined either, then GCAS falls back to the global MLC 

constraints. 
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24.4 The Multilevel Calibration Coefficients Form 

Multilevel Calibration Coefficients form, abbreviated as MLC Coefficients form, is a form to enter or edit 

MLC coefficients of a GC device. Select the desired device from your device panel or recent device 

panel, then go to View menu > Multilevel Calibration Coefficients. 

 

24.4.1 View Previous Coefficient Sets 

Click  Browse another set at the top of the form. This button shows the Select a coefficient set dia-

logue. Select the desired coefficient set then click OK or double click on the list item. 
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You can always return to the latest coefficient set through   Load latest set button. 

24.4.2 Edit Mode 

In order to edit the coefficients or the description, you need to put MLC Coefficients form in edit 

mode. Open the Action menu and select Edit Mode. You know the form is on edit mode when you 

see  pencil icon, some labels are coloured orange, and there is a Save button at the top region of 

the form. 
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During edit mode, you can edit the numbers in the grid. Date of test field at the top and Description 

text box at the bottom of the form also become editable. 

Note 

Edit mode is mainly intended for editing the description or correcting minor mistakes. If there are too 

many coefficients to edit, we suggest you to create a new set and set this record to inactive instead. 

MLC Coefficients form does not have comment feature. Put short comments in the description text 

box if you like. 

You can paste the coefficient numbers from Microsoft Excel or other spreadsheet editing software, as 

long as there are 4 columns and equal number of rows. Click Paste link above the grid to paste the 

numbers. The Reset link resets all numbers in the grid back to zero.  

When you finished editing the numbers and the description, click Save button or go to Action menu > 

Save Changes to commit the change. The form exits its edit mode and becomes read-only again. 
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Otherwise to cancel editing and discard all of your changes, open Action menu and select Edit Mode 

again to remove its tick mark. This will exit edit mode and reload the coefficient set from the database. 

24.4.3 Create New Coefficient Set 

From an open MLC Coefficients form, open the Action menu and select New Coefficient Set. This 

menu creates a blank coefficient set (all zeroes) with the timestamp set to current computer time. 

 

Begin entering the coefficient values one by one. Be alert for potential human error. Alternatively, you 

can paste the coefficients from Microsoft Excel or other spreadsheet editing software as long as there 

are 4 columns and equal number of rows. Click Paste to do so. 
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Don’t forget to set the date of test. This is the date information of when the multilevel calibration 

was conducted, not the date of when the coefficients were entered. 

Write the description. It is a good practice to provide a description about this coefficient set. 

When you are finished, click Save button or go to the Action menu > Save Changes to save these co-

efficients into database. Otherwise to cancel all of these, go to the Action menu > Edit Mode to re-

move its tick mark. The form will revert to the last record viewed. 

24.4.4 Change Record Status 

Like other types of record in GCAS database, MLC coefficient set has a status bit indicating whether 

the record is active or inactive. Inactive coefficient sets are not used for MLC conversions; thus GCAS 

will look further backward to find the previous active coefficient set. 

To change status, open the Action menu and select Set Status. This menu brings the Set Status dia-

logue where you can flip the status bit from active to inactive or vice versa. 
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Click OK and GCAS will update the new status which then instructs the MLC Coefficients form to re-

load the set with the new status. 

24.5 Overriding MLC Constraints 

Chapter 24.2 already explained what MLC constraints are, and chapter 24.3 explained four levels of 

MLC constraints. This chapter explains how to actually override MLC constraints if the global or prede-

fined constraints produce nonsensical RF or mole composition values. 

24.5.1 Overriding Constraints for Footprint/Calibration Data 

From an open Footprint form or Calibration Data, open the Action menu, select ISO 10723, then select 

Change MLC Constraints. The MLC Conversion Constraints (RF) dialogue appears. 
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Make changes as necessary. In this screenshot example, we are changing the cubic constraint as well 

as changing the target RF value range. When you click OK, GCAS presents you another dialogue ask-

ing which override level these new constraints are about to be applied. 

 

From top to bottom, each radio button corresponds to global constraints, device-level, coefficient-

level, and finally record-level. Make a decision then click OK. The Footprint or Calibration Data form 

will reload the record and you may see the RF chart is now different from the previous one. If not, try 

another constraint values. 
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Note 

Each option in this dialogue box requires its own action permission. The GCAS administrator has au-

thority to assign which user roles can change global constraints, device-level, coefficient-level, or rec-

ord-level. For example, an administrator may prohibit regular users to change global and device-level 

constraints, but permit them to change coefficient-level and record-level constraints. If your adminis-

trator didn’t grant you permission for a specific override level, its radio button will be disabled. Ulti-

mately if no permissions are given, you will not see Change MLC Constraints in the Action menu from 

the beginning. 

Which override level should I apply to? 

Be careful with the first option in Apply Constraints dialogue box. Yes, that option means you are 

changing the value of global constraints. All other devices in the same GCAS database will use the new 

constraint values you just specified. 

Condition Recommended override level 

You are unsure whether the new constraints would 

produce unwanted side-effects on other records. 

Record-level 

Some records are broken, while some others are 

not. 

Coefficient-level if those broken records use 

the same MLC coefficients, otherwise apply 

record-level override to each of those one by 

one. 

All records are broken, but records on other GC de-

vices are not. 

Device-level 

All records are broken, regardless of what GC device 

they belong to. (A very ultra-rare case) 

Global 

(Also check all MLC coefficient values for potential mis-

takes.) 

24.5.2 Overriding Constraints for Mole Compositions 

Many operations involving multilevel-calibrated mole compositions such as Data Analysis (MC value 

trending), uncertainty calculation, and ISO 6976 calculation, automatically load MLC constraints. Their 

MLC constraint overrides are set through Mole Composition form. 

Open Mole Composition form, then browse to the desired record. Or if you plan to apply coefficient-

level override, browse to any record which is using the MLC coefficient set in question. Then open Ac-

tion menu, select ISO 10723 and then Change MLC Constraints. The menu brings the MLC Conver-

sion Constraints (MC) dialogue. 
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Change the constraints as necessary by paying attention to which gas that causes silly values followed 

by which degree of polynom the MLC coefficients of that gas is. Click OK and GCAS presents the fa-

miliar Apply Constraints dialogue box. Select an override level and hit OK again to commit. 

 

Note 

Each option in this dialogue box requires its own action permission. The GCAS administrator has au-

thority to assign which user roles can change global constraints, device-level, coefficient-level, or rec-

ord-level. For example, an administrator may prohibit regular users to change global and device-level 

constraints, but permit them to change coefficient-level and record-level constraints. If your adminis-

trator didn’t grant you permission for a specific override level, its radio button will be disabled. Ulti-

mately if no permissions are given, you will not see Change MLC Constraints in the Action menu from 

the beginning. 

Which override level should I apply to? 

Be careful with the first option in Apply Constraints dialogue box. Yes, that option means you are 

changing the value of global constraints. All other devices in the same GCAS database will use the new 

constraint values you just specified. 

Condition Recommended override level 

You are unsure whether the new constraints would 

produce unwanted side-effects on other records. 

Record-level 

Some records are broken, while some others are 

not. 

Coefficient-level if those broken records use 

the same MLC coefficients, otherwise apply 

record-level override to each of those one by 

one. 

All records are broken, but records on other GC de-

vices are not. 

Device-level 
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Condition Recommended override level 

All records are broken, regardless of what GC device 

they belong to. (A very ultra-rare case) 

Global 

(Also check all MLC coefficient values for potential mis-

takes.) 

24.5.3 Revoking (Cancelling) an Override 

Open MLC Conversion Constraints dialogue again through Change MLC Constraints submenu in ISO 

10723 in the Action menu. Next to the blue info badge  you shall see what override level the record 

is using. If no text is displayed, then the record is still on global MLC constraints. 

 

As an example, the screenshot above tells the calibration record is using record-level override. Now 

click Revoke this override to revoke it. Confirm the message box and then the dialogue will reload 

the MLC constraints from one level lower. Eventually it falls back to the global MLC constraints if there 

are no more overridden MLC constraints found. You know it’s already on global MLC constraints when 

there is no text next to the blue icon badge. 

Finally click Cancel (yep, Cancel button) to dismiss the dialogue. Clicking OK instead of Cancel button 

will show another Apply Constraints dialogue which you don’t want anymore. 
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24.6 Offline Converter Tools 

Offline converters are intended for one-time conversion of bulk records such as those in CSV files. The 

term ‘offline’ means it is not associated to any GC devices in GCAS database, which implies you can 

test any arbitrary MLC coefficients, calibration certificates, RF values, and custom constraints as con-

version prerequisites without affecting any records in GCAS database. 

GCAS ships two converter tools. They can be found inside the Tools menu. Select MLC ↔ Single-

Point RF Offline Converter to convert response factor values of footprint/calibration data, or MLC ↔ 

Single-Point MC Offline Converter to convert mole composition values. 

 

Converter tools have a wizard-like appearance. To get help about specific converter tool, read the fol-

lowing two chapters. 

24.6.1 MLC ↔ Single-Point RF Offline Converter 

This is an ISO 10723 converter tool for response factors. First, choose a mode to determine which 

gases are available. Normal mode gets you all alkane gases from methane to decane, BTEX mode 

gives you four aromatic hydrocarbons, and the rest (Single gas, Hydrogen sulfide, Moisture) are for 

single-gas calculation with different gas names. Next, click the desired conversion direction whether 

from MLC to single-point or single-point to MLC. 
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Next, enter the MLC coefficients. This page has similar layout to MLC Coefficients form. You can copy 

from Microsoft Excel or other spreadsheet processing software as long as the data has 4 columns and 

equal number of rows as the number of gases; click Paste to do so. If the footprints/calibration rec-

ords to convert don’t have gases such as octane, nonane, decane, or neopentane, leave the coeffi-

cients of those gases to all-zeroes. 
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Click Next. Depending on conversion direction, the third page may be skipped. For MLC to single-

point conversion, you are prompted to choose MLC constraints. Single-point to MLC conversion 

doesn’t require constraints therefore this page is skipped. 

Most of the time you don’t have to worry about MLC constraints and you can click Next straight 

away. However, in case the conversion results having weird values, go back to this page and change 

the constraints to see whether the new constraints have corrected the results. 

 

Afterwards, enter the mole composition part of the calibration gas certificate. You can copy from Mi-

crosoft Excel or other spreadsheet software, click Paste to do so. If the footprints/calibration records 

to convert do not have gases such as neopentane, octane, nonane, or decane, leave their values to 

zero. 
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Next wizard page is where you put the response factor values to convert. In this example, we are con-

verting MLC RF into single-point RF. There are several ways to input RF values: 

1. Orthodox method – typing them manually, row by row. 

2. Copy and paste from Microsoft Excel or other spreadsheet processing software. Make sure the 

column ordering is correct as you may end up with wrong RF values in wrong gas. Click Paste 

append to paste from clipboard into new rows. Existing rows are not affected. 

3. Import from CSV – please specify whether the CSV file follows standard GCAS CSV template or 

a custom template. More about this later. 

4. Import from GC device in database – select a GC device and date range, then RF offline con-

verter will load all active footprints and calibration data of that device between that date 

range. Note if you try to load footprints and calibration data from a device that does not 

match current mode (normal, BTEX, or single-gas), this converter tool will alert you and offer 

to switch to the correct mode. 
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Above the grid there is a check box called Add the ‘average’ row. This check box inserts a special row 

at the very top, which contains the averaged value of all rows below it. Average row will be converted 

to MLC or single-point too, depending on selected direction during the first page. If you delete some 

rows or edit some rows or append new rows into this grid, the average values are updated automati-

cally. 

For CSV import, select whether the CSV file follows the standard template or you are using your own 

CSV file. Select the second radio button for CSV files with additional columns before the first gas, or 

with additional header rows before the first row, or with different gas ordering, or combination of 

these. Define at which column and which row the actual data start. If necessary, change the gas order 

definition to match your CSV file.  

Note 

The standard CSV template used by the offline converter tools under Normal mode (methane to dec-

ane) is the template used by Daniel, Siemens, Elster, and LNG—not ABB. For ABB devices, use the 

same template as Daniel cs. Make sure the response factor values to convert must be single-point and 

not the exponential one. 

Reorder those gases using drag-and-drop operation inside the green area. Had there any gases not 

present in your CSV such as octane/C8, nonane/C9, or decane/C10, drag them to the trash bin icon 

and they will move to the unused gases (pink) area. Drag gases out of the pink area back into the 

green area to reuse them if necessary. In BTEX or single gas mode, the labels of these gases will adjust 

accordingly, such as "B", "T", "E", "X" instead of "C1", "N2", and so on. 
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Finally, click Import. GCAS reads your CSV file and appends data into new rows. Existing rows are not 

affected. Also, the converter form reveals an additional column named Notes and writes the CSV file 

name followed by row number. 

If you import data from a device (second tab of the tab pages under the grid), the converter form re-

veals the Notes column and writes device tag name followed by record timestamps. These notes help 

you differentiate which rows belong to which device in case you are converting bulk records from 

multiple GC devices, or converting mixed data coming from manual entry, CSV file, and device. 

GCAS runs a validity check for invalid values such as negative RF. Should it find errors, the problematic 

rows will display red exclamation mark on their headers and are highlighted in light red. GCAS also 

refuses to move onto next wizard page unless the errors are fixed. 

Ultimately, click Next to move onto next page and you should see GCAS is doing its job performing 

ISO 10723 conversion. It may take a while if you are converting hundreds or thousands of records. 

When the conversion is finished, you have options to Save as CSV, Export to Excel, or Copy to Clip-

board. The average row, if ticked in previous wizard page, also appears in the conversion result at the 

very top. However, it is not the actual average of conversion results you see right now. It is simply the 

MLC or single-point conversion of the average value of all input rows before. 
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The leftmost column, Graph, provides a quick glance of how these converted records would look like 

in an RF chart. It generates a mini RF chart similar to the screenshot down here. By default, the chart 

omits zero values especially if the records don’t have gases like C8, C9, or C10. You can override this 

behaviour by ticking Draw zeroes. 

 

When you get a nice ascending chart for single-point RF or nice flat chart for MLC RF, most likely the 

three prerequisites (coefficients, certificate, and constraints) are correct. However, if you get a bad 

chart such as one or two dots skyrocket to hundreds of millions, it may indicate one or more among 

the three prerequisites are wrong. 
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24.6.2 MLC ↔ Single-Point MC Offline Converter 

This is an ISO 10723 converter tool for mole compositions. First, choose a mode to determine which 

gases are available. Normal mode gets you all alkane gases from methane to decane, BTEX mode 

gives you four aromatic hydrocarbons, and the rest (Single gas, Hydrogen sulfide, Moisture) are for 

single-gas calculation with different gas names. Next, click the desired conversion direction whether 

from MLC to single-point or single-point to MLC. 

 

Next, enter the MLC coefficients. This page has similar layout to MLC Coefficients form. You can copy 

from Microsoft Excel or other spreadsheet processing software as long as the data has 4 columns and 

equal number of rows as the number of gases; click Paste to do so. If the mole composition data to 

convert don’t have gases such as octane, nonane, decane, or neopentane, leave the coefficients of 

those gases to all-zeroes. 
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Click Next. Depending on conversion direction, the third page may be skipped. For MLC to single-

point conversion, you are prompted to choose MLC constraints. Single-point to MLC conversion 

doesn’t require constraints therefore this page is skipped. 

The third constraint (cubic constraint) has two parts: One for mole composition conversion, and the 

other for RF conversion. Mole composition conversion involves a set of RF values. These RF values 

must be convertible therefore they require their own MLC constraints and a calibration certificate 

(we’ll see in the next step). 

Most of the time you don’t have to worry about MLC constraints and you can click Next straight 

away. However, in case of the conversion results having weird values, go back to this page and change 

the constraints to see whether the new constraints have corrected the conversion results. 
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After MLC constraints, enter the mole composition part of the calibration gas certificate used by RF 

values followed by the RF values themselves. Save your time by copying and pasting from Microsoft 

Excel or other spreadsheet software. Click Paste if the copied data has 2 columns, click Paste/paste 

transpose certificate to paste calibration certificate only, or click Paste/paste transpose RF to paste 

RF values only. If the mole composition records to convert do not have gases such as neopentane, oc-

tane, nonane, or decane, leave both their certificate composition and RF value to zero. 

Don’t forget to specify whether the RF values are single-point or multilevel-calibrated. Under the grid, 

next to These RF values are [single-point or MLC], tick the correct radio button. 
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Click Next and you arrive at the input page. In this example, we are converting MLC composition into 

single-point composition. There are several ways to input mole composition (MC) values: 

1. Orthodox method – typing them manually, row by row. 

2. Copy and paste from Microsoft Excel or other spreadsheet processing software. Make sure the 

column ordering is correct as you may end up with wrong composition values in wrong gas. 

Click Paste append to paste from clipboard into new rows. Existing rows are not affected. 

3. Import from CSV – please specify whether the CSV file follows standard GCAS CSV template or 

a custom template. Keep reading after the screenshot on the next page. 

4. Import from GC device in database – select a GC device, date range, and the stream number 

too. More about this later. 
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Above the grid there is a check box called Add the ‘average’ row. This check box inserts a special row 

at the very top, which contains the averaged value of all rows below it. Average row will be converted 

to MLC or single-point too, depending on selected direction in the first wizard page. If you delete 

some rows or edit some rows or append new rows into this grid, the average values are updated auto-

matically. All numbers in this grid are treated as unnormalised. 

For CSV import, select whether the CSV file follows the standard template or you are using your own 

CSV file. Select the second option for CSV files with additional columns before the first gas, or with ad-

ditional header rows before the first row, or with different gas ordering, or combination of these. De-

fine at which column and which row do the actual data start. If necessary, change the gas order defini-

tion to match your CSV file.  

Note 

The standard CSV template used by the offline converter tools under Normal mode (methane to dec-

ane) is the template used by Daniel, Siemens, Elster, and LNG—not ABB. For ABB devices, use the 

same template as Daniel cs. Make sure the mole composition value to convert must be single-point 

and not the exponential one. 

Reorder those gases using drag-and-drop operation inside the green area. Had there any gases not 

present in your CSV such as octane/C8, nonane/C9, or decane/C10, drag them to the trash bin icon 

and they will move to the unused gases (pink) area. Drag gases out of the pink area back into the 

green area to reuse them if necessary. In BTEX and single gas mode, the labels of these gases adjust 

accordingly such as "B", "T", "E", "X" instead of "C1", "N2", and so on. 
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Finally, click Import. GCAS reads your CSV file and appends data into new rows. Existing rows are not 

affected. Also, the converter form reveals an additional column named Notes and writes the CSV file 

name followed by row number. 

For data import from a GC device, select the device followed by the desired date/time range and the 

stream number. Click Import and GCAS will query GCAS database to get these records. GCAS will un-

normalise mole composition values before putting them in new rows. If you try to load mole composi-

tion data from a GC device of a device type not matching the current mode (normal, BTEX, or single-

gas), this converter tool will alert you and offer to switch mode. 

 

The converter form reveals the Notes column and writes device tag name followed by record 

timestamps. These notes help you differentiate which rows belong to which device in case you are 

converting bulk records from multiple GC devices, or converting mixed data coming from manual en-

try, CSV file, and device. 

GCAS runs a validity check for invalid values such as negative composition. However, there is no check 

if sum of a composition record exceeds 100 because the record may be on a different scale, not only 

percentage. If GCAS finds errors, the problematic rows will display red exclamation mark on their 

headers and are highlighted in light red. GCAS also refuses to move onto next wizard page unless the 

errors are fixed. 

Ultimately, click Next to move onto next page and you should see GCAS is doing its job performing 

ISO 10723 conversion. It may take a while if you are converting hundreds or thousands of records. 
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When the conversion is finished, you have options to Save as CSV, Export to Excel, or Copy to Clip-

board. The average row, if ticked in previous wizard page, also appears in the conversion result at the 

very top. However, it is not the actual average of conversion results you see right now, it is simply the 

MLC or single-point conversion of the average value of all input rows before. 

 

By default, the displayed result is normalised. Check Show unnormalised total to reveal the unnor-

malised total column (after decane). Select the radio button Unnormalised or Normalised to flip all 

numbers between the two. 

Unlike RF converter, MC converter provides Compare column which contains buttons to compare 

normalised input (before conversion) versus normalised output (after conversion). These buttons call 

the Compare tool window similar to the screenshot on the next page. Check Show difference to re-

veal the absolute delta column, which is the absolute value of difference/bias between input composi-

tion and conversion result. 
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24.7 Low-Level ISO 10723 Implementation 

Provided the GCAS feature ISO 10723 is included in your licence, you already have ISO 10723 features 

in relevant modules such as Footprint, Calibration Data, Mole Composition, Data Analysis, Dashboard, 

and pretty much everything that uses response factor values or mole composition values. GCAS al-

ways checks the MLC flag bit of calibration or mole composition records and performs necessary ac-

tions before those modules use these records. For example, you cannot get a valid uncertainty of re-

producibility from a collection of multilevel-calibrated RF. Therefore, in order to calculate Ureproducibility 

GCAS needs to convert the RF records into single-point first. This is done on-the-spot and behind the 

screen. You didn’t notice the Dashboard always gives correct R2 value even though all calibration data 

are marked as MLC, did you? 

Visit the appropriate chapter on the module to get help about ISO 10723 features. Footprint and cali-

bration data are on chapter 7, Mole Composition is on chapter 8, Data Analysis is on chapter 10, and 

Mole Composition Comparison is on chapter 18. 
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25 Lag Time 

Lag time is the total time of gas stream measured from the time it is sampled at the main pipeline to 

the time it exits the detector of your GC. After leaving the sample probe, the gas enters pressure let-

down system to have its pressure reduced in order to be safe for the GC. The pressure letdown system 

is series of regulators, heating elements, and pipes with different diameter and length, which affect 

the travel time. Not to mention the GC device itself has a predefined cycle time and analysis time. 

Thus, when the gas finally reaches the detector within GC, it is no longer the same gas travelling inside 

main pipeline at the same exact moment. It can range from several minutes to few hours behind the 

pipeline. 

 

Typical pressure letdown systems. 

Lag time is used by spot samples. Its main purpose is to shift the date and time of the spot sample 

record. Spot sample values are then compared to the nearest mole composition data at the 

timestamp of spot sample plus lag time. Without lag time taken into account, spot sample will pre-

cede the mole composition record by several minutes to few hours ahead, making the spot sample 

values stay afar from the mole composition record. Hence, you cannot use it (or it becomes more diffi-

cult) to determine the health status of your pressure letdown system. 

Lag time is calculated per stage and summed together at the end. One stage is one configuration of 

pipes and regulators. Typical pressure letdown system may have three to four stages, which in turn 

makes typical lag time calculation has five or six stages in total. 

Note 

This module requires GCAS feature Lag Time Calculator to be included in GCAS licence. 

Modules using lag time data are Data Analysis, Mole Composition Comparison, and ISO 6976/GPA 

2172 Trend Comparison. On Data Analysis form, lag time is used when the user wants a mole compo-

sition trend, then ticked Include spot samples. By subsequently ticking Apply lag time, all spot sam-

ple dots on the chart will shift to the right by the amount of total lag time. For both Mole Composition 

Comparison and ISO 6976/GPA 2172 Trend Comparison, lag time data is used if the user put spot 
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sample streams into comparison list and ticked Apply lag time to spot samples before graphing a 

comparison chart. 

25.1 The Lag Time Calculator Form 

Lag Time Calculator form takes your stage data as input then calculates the lag time as output. Lag 

Time Calculator form is designed for two uses, offline calculation and device-bound calculation. Of-

fline calculation is one-time calculation that is not tied to any device in GCAS database. This chapter 

shows the Lag Time Calculator form for offline calculation. Steps for device-bound calculation is very 

similar to offline calculation, only tossing some extra steps of attaching an optional note and saving to 

database at the end. 

Go to the Tools menu and select Lag Time Calculator. If you do not see this menu, your GCAS user 

account may not have the menu permission for it. Contact your GCAS administrator. 

 

Left side of the form are the inputs, while right side is the output. The input section consists of three 

tabs: Global parameters, pressure letdown stages, and GC time.  

Global parameters have four inputs: Base temperature, base pressure, base compressibility, and sam-

ple flow. Base temperature is set at 0°C and base pressure is typically set at the atmospheric pressure 

(1 atm or 1.01325 bar). You need to provide the base compressibility factor (Z) and sample flow. When 

it’s done, click Next: Pressure letdown stages to move onto the next tab. 

Pressure letdown stages are the collection of stage data. A stage data consists of 7 inputs: stage 

name, line temperature, line pressure, line compressibility, tube inner diameter, tube length, and by-

pass flow. 
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• Stage name: Enter a name as an identifier to distinguish this stage from other stages. This 

name will appear in the first column of the output list. 

• Line temperature: Temperature at this pipe. 

• Line pressure: Pressure at this pipe as conditioned by the regulator. 

• Line compressibility: The compressibility factor (Z) of the gas at this stage. 

• Tube inner diameter: Inside-diameter of this pipe. 

• Tube length: Total length of the pipe. 

• Bypass flow: How much gas being discarded before entering the next stage. 

One stage data is contained in one tab. To add more stage, open the last tab (Add stage) then the 

form automatically creates a new tab for you. To remove a stage, click Remove this stage at bottom-

left corner of a tab. 

Note 

You can add up to 32 stages maximum. 

When you finished entering all stage data, click Next: GC time to move onto next tab. 
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GC time is cycle time plus analysis time of the GC device. This time value is added to the total lag time 

so far, but you have the option not to include GC analysis time if desired. 

The second radio button is disabled because Lag Time Calculator form is in offline calculation mode. 

For device-bound calculation, this radio button extracts GC analysis time defined in Analysis Parame-

ter. 

Be cautious on the units of measurement as wrong unit will produce wrong result. When you are 

ready, click Calculate at the bottom-left corner of the form. Lag Time Calculator computes the lag 

time and displays the calculation result in the list view on the right-hand side. Total lag time is dis-

played in bold face. 

 

Click Clear calculation results to empty the list and start over. 
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25.2 The Lag Time Form 

Lag Time form is a form to display historical lag time calculations of a GC device. One lag time record 

may survive for years because users need to calculate lag time when they change the piping or the 

design of pressure letdown systems, or when they replace the GC device. 

Select a GC device on your device panel or recent device panel. Next, go to View menu and select Lag 

Time. If you do not see this menu, your GCAS user account may not have menu permission for it. 

Contact your GCAS administrator. 

 

The Lag Time form. 

On the toolbar, click  New lag time calculation to create a new lag time record. That button brings 

the Lag Time Calculator form in device-bound mode (as opposed to offline calculation mode in chap-

ter 25.1). The form looks the same apart from Save to database button and a text field to add an op-

tional note. 
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Within Global parameters tab, you can optionally change the date of calculation if you wish this lag 

time record affect certain spot sample records in the past. If you don't change it, the date of calcula-

tion will be today. A lag time record calculated today can only shift spot sample records in the future. 

Provide the necessary inputs following the process described in chapter 25.1 to generate the lag time 

total value. At GC time section, all three options are available: Use GC's analysis time defined in Analy-

sis Parameter, override its analysis time and provide a custom value, or not using GC analysis time at 

all. Once you finished, click Save to database to commit this lag time calculation. You can write some 

notes prior to saving. After the record is written to database, GCAS returns to the Lag Time form with 

the new record listed as the last row. Date of calculation would be today (if you didn't change it), 

along with the total lag time in milliseconds and canonical format (hours-minutes-seconds) as well as 

number of pressure letdown stages. 

To edit a lag time record, highlight the row in Lag Time form and either click Details inside that row or 

 Edit on the toolbar. Lag Time form should call Lag Time Calculator form with all global parameters 

and pressure letdown stages loaded. Now you can change a number or two, create or delete stages, 

or just edit the text note. If you changed input values, click Calculate to update lag time value of each 

stage as well as the total lag time. When you are satisfied, click Save to database to save the edit. 

To delete a lag time record, highlight the row on the grid and then click Delete on the toolbar. Delet-

ing records is not recommended because in case you need to recreate the record, the value of date of 

calculation field will be the date and time you finished creating that new record, not the date and time 

of the original record. We recommend setting the lag time record as inactive by clicking  Set inac-

tive button so the date of calculation is preserved. Conversely, click  Set active to mark the record 

back as active. 

Creating record, editing, deleting, and changing the active status are ruled by each own action permis-

sion. Your GCAS administrator can grant or deny access to these permissions. If you find a toolbar 

button being disabled while it shouldn't be, the action permission associated with it may be disabled. 
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26 Device Management 

A device is a representation of an actual, physical GC device. Device in GCAS database has several 

properties for example device name (also known as device tag), device type, and device date format 

(whether American or rest-of-the-world format). These properties should match the actual configura-

tion of your physical GC device. Managing devices are conducted through the Devices form. Default 

installation of GCAS specifies only GCAS administrator and super users have access to this form. 

 

• One group has several workspaces. 

• Workspaces are a way to separate devices in the same group. This has been covered in chap-

ter 3.2 Groups and workspaces. 

• One device must belong to one workspace. 
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26.1 The Devices Form 

 

Go to the Devices menu > Manage Devices. This form lists all GC devices from all groups accessible 

from your user account. If the form shows a blank box, it means your GCAS user account is not as-

signed to any group, or the database is still blank that your GCAS administrator has not created any 

groups yet. 

Note 

Default installation of GCAS specifies that you have to be at least a super user to access this form. 

26.2 Create One Device 

Right-click a  workspace node, and select New. 
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Next, give the new device a name, set its date format, and assign a device type from the list.  
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Device date format: Select one of the list, or type a custom date format. This date format follows 

MySQL convention. We recommend selecting from the dropdown list. 

• %m/%d/%y %H:%M = USA format.  

For instance, 01/12/2013 07:55 is interpreted as 12 January 2013 07:55 AM. 

• %d/%m/%y %H:%M = rest-of-the-world format.  

For example, 01/12/2013 07:55 translates to 1 December 2013 07:55 AM. 

 

Custom format specifier Date/time element 

%d date (2 digits) 

%m month (2 digits) 

%y year (4 digits) 

%H hour (2 digits, 24h format) 

%M minute (2 digits) 

Device type: Select one from the list that matches your physical GC device. 

Device type 

C
1
 

N
2
 

C
O

2
 

C
2
 

C
3
 

IC
4
 

N
C

4
 

N
E
O

C
5
 

IC
5
 

N
C

5
 

C
6
 

C
7
 

C
8
 

C
9
 

C
1
0
 

B
 

T
 

E
 

X
 

H
2
S
 

H
2
O

 

G
 

Daniel, ABB, Siemens, Elster 

C6+ complete • • • • • • • • • • •            

C6+ without neopentane • • • • • • •  • • •            

C7+ complete • • • • • • • • • • • •           

C7+ without neopentane • • • • • • •  • • • •           

C9+ complete • • • • • • • • • • • • • •         

C9+ without neopentane • • • • • • •  • • • • • •         

C10+ complete • • • • • • • • • • • • • • •        

C10+ without neopentane • • • • • • •  • • • • • • •        

LNG 

C2− • • • •                   

C3− • • • • •                  

C4− • • • • • • •                

C5− complete • • • • • • • • • •             

C5− without neopentane • • • • • • •  • •             

BTEX 

BTEX analyser                • • • •    

Single gas 

H2S analyser                    •   

Moisture analyser                     •  

Single gas analyser                      • 

Help on abbreviations: go to chapter 6 Gas acronyms. 
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Click OK and you should see the new device is listed under this workspace node. When you close the 

Devices form, GCAS main window will refresh its device panel and your new device should be there. 

Note 

Your GCAS licence specifies how many devices you can create. You should not create more devices 

than this limit. The next time you try opening a GCAS database containing number of devices exceed-

ing this limit, you need to choose devices to be accessible during that session. 

If you use the old GCAS licence version 2, the limit of GC devices you can have is 10 (ten). 

26.3 Create Multiple Devices in Bulk 

This action creates multiple devices with the same date format and device type in one batch therefore 

saves you time. To do this, right-click a  workspace node and select New (Bulk). 

 

On the left side of Create Multiple Devices dialogue, enlist the names of your new devices. You can do 

it manually like this: 
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…or by utilising the name generator based on a template, like this one down here. In this screenshot, 

the "stem" is "MyDevice", suffix style is numerals (123), suffix starts from 1, and suffix separator is an 

underscore. 

 

Moving to the right side, set a device date format and device type. These two properties apply to all 

your new devices. Rewind to chapter 26.2 for more information about device date format and device 

types. 

Click OK to begin creating devices. These devices will be listed under the selected  workspace node. 

Note 

Your GCAS licence specifies how many devices you can create. You should not create more devices 

than this limit. The next time you try to open a GCAS database containing number of devices exceed-

ing this limit, you need to choose devices to be accessible during that session. 

If you use the old GCAS licence version 2, the limit of GC devices you can have is 10 (ten). 
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26.4 Edit Device 

You can either double-click a  device node, or right-click it and select Edit. This action brings up the 

Edit Device window. Here you can change the device name, date format, or device type. 
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A note if you change the device type, we strongly recommend reconfiguring data capture register 

mappings immediately. Otherwise, there are three possible outcomes: 

1. Data capture refuses to start because the number of gases does not match the expected one. This 

happens after you changed the device type to the one with a different carbon count such as from 

C9+ to C6+. This also happens after you changed the device type from a complete one to the 

non-neopentane one or vice versa 

2. Data capture works but the captured values are put into wrong gas. This happens after you 

changed the device type to another one having the same gas count but different gas sequence. 

For example, ABB C6+ complete and ABB C7+ without neopentane both read 11 gases, but the 

captured value for hexane is assigned to heptane and captured value for neopentane now goes 

to hexane. This causes domino effect such as wrong correlation (R2) value afterwards. 

3. Data capture works perfectly fine. This rare case happens after you changed the device type to the 

most similar one, for instance from Daniel C7+ complete to Siemens C7+ complete. Both have 

the same number of gases, both have neopentane, and both do not require special handling like 

how ABB does. 

To prevent unwanted errors, it is better to reconfigure register mappings before you forget. The Edit 

Device dialogue offers a check box to open Modbus Client Mappings form after you click OK. 

 

Another note: If you use data provision feature and this device is one of those included in data provi-

sion, recheck your server instance definition to avoid empty gas definitions due to device type change. 

26.5 Rename Device 

You could use the Edit Device dialogue to rename a device as explained in chapter 26.4, but there is a 

quicker way if all you want to do is just change the name. Click the  device node and press F2. Al-

ternatively, right-click that node and select Rename.  
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26.6 Move Device 

To move a device from a workspace to another, drag the corresponding  device node and drop it 

on the desired  workspace node. This may change the association between the device and the 

group where the new workspace belongs. 
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26.7 Duplicate Device 

Duplicating a device means creating a new device and copies all records associated with the original 

device to the new device. Then you can conduct various experiments on the new device without hav-

ing to worry about damaging the data of the original device. 

Note 

Duplicating a device is not intended as a regular backup feature because the original device and the 

clone both are still located inside the same database. It is more like a "fork" of this device (GitHub 

guys will understand). On another somewhat-related topic, you or your database administrator should 

back up the entire GCAS database periodically to a safe place. 

To clone a device, right-click the corresponding  device node and select Duplicate. This method is 

mainly for duplicating the device within the same workspace. To duplicate the device while moving it 

to different workspace, drag the  device node and hold Ctrl. Then drop it over the desired  

workspace node. Either action will show the Duplicate Device form. 
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On the left side, select the workspace where the new device will belong to. There is no restriction that 

it has to be different workspace or it has to be the same workspace. It is up to you. Moving to the 

right side, specify the name of this new device. By default, GCAS uses the original device name plus 

"- Copy" at the end. Finally, under device name input box, you can tick or untick which data to copy 

during the duplication process. 

When you are ready, click Start duplication. Once the process completes, GCAS presents a mini re-

port of how many records copied to the new device. 
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26.8 Delete One Device 

To delete a device, right-click the  device node and select Delete.  

 

GCAS displays this confirmation dialogue. Read the important bits, and then confirm the deletion. To 

confirm, write the device name at the supplied text box. Write the name precisely because it is case-

sensitive. Then, click Delete this device. 
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Important 

Deleting device will erase all records associated with it. The deletion is permanent and cannot be un-

done. No, GCAS does not create restore point. No, GCAS database does not have the luxury of creat-

ing snapshot. Make sure you no longer use the existing data when you scrap this device. Or else, ex-

port its data as a backup. 

Other users connected to the same database working with the device being deleted may see errors 

after deletion. Make sure everyone else is not touching this device before you delete. 

After deletion, GCAS presents a mini report of how many records were deleted. 

 

26.9 Delete Multiple Devices in Bulk 

There are possible scenarios where you need to delete multiple devices at once. For instance, you cre-

ated multiple devices in bulk as test beds for your experiment. After your experiment is finished, you 

may want to delete these devices. Another situation, you are using local offline database containing 

two workspaces. You already duplicated the .sdf file and want to have one workspace in each of them. 

Therefore, you want to remove devices of workspace B in first .sdf and remove devices of workspace A 

in second .sdf file. 

Obviously you can nuke the devices one by one using the 

method elaborated in chapter 26.8. But we have a faster way. 

Notice the blue link Mass deletion at the bottom-left corner 

of the Devices form? Yep, go click it. 

GCAS then displays the same tree view with check boxes. 

Here, tick all the devices you wish to obliterate. When you are 

confident, click Proceed.  
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GCAS displays this confirmation dialogue. Read the important bits, and then confirm the deletion. 

There is a list of devices to delete at the bottom-left region of the dialogue. To confirm, write two of 

these device names at the supplied text boxes. They can be in any order and they don't have to be the 

top two of this list. Write the names precisely because they are case-sensitive. Give a check mark at 

the box I know what I am doing if you really are, and ultimately click Delete all these devices. 

 

And once the deletion completed, GCAS presents a mini report of how many records were deleted. 

These number of records are aggregation (sum) of all deleted device. 
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Important 

Deleting devices will erase all records associated with them. The deletions are permanent and cannot 

be undone. No, GCAS does not create restore point. No, GCAS database does not have the luxury of 

creating snapshot. Make sure you no longer use the existing data when you scrap these devices. Or 

else, export their data as a backup. 

Other users connected to the same database working with the devices being deleted may see errors 

after deletion. Make sure everyone else is not touching these devices before you delete. 
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27 Data Capture (Modbus Client) 

Instead of relying on CSV or text file import, GCAS has the ability to connect to your physical GC de-

vice via Modbus® protocol in order to get live data. GCAS captures response factor, retention time, 

and mole composition data. 

Note 

To use this feature, you need the GCAS feature either Modbus Client over Serial or Modbus Client over 

TCP (or both) to be included in your GCAS licence. Additionally, to capture mole composition data you 

need another GCAS feature Live Data Analysis in your GCAS licence. 

27.1 Configure Register Mappings 

Before GCAS captures live data, you need to configure the Modbus registers. Register is small, volatile 

memory storage where your GC device outputs the data to. GCAS reads only holding registers on your 

GC device, therefore please configure your GC device to write the data to Modbus register 4:xxxxx. On 

GCAS side, configure GCAS to match those register addresses. This is administered through Register 

Mappings form. 

27.1.1 The Register Mappings Form 

Select the device you would like to configure on your device panel on the main interface. Then, click 

the Comms menu > Register Mappings. 
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When the form opens, it tries to find the device configuration if you have ever configured it before. 

The configuration is stored in an XML file in [Installation_directory]\Mappings-Devic-

eSpecific\ folder. If the corresponding XML file does not exist—implies that the device has never 

been configured, the form loads the appropriate template. The template being used depends on your 

GC device type. 

Now you are ready to configure the register addresses for calibration data and for mole analysis data. 

27.1.2 Bit Length and Byte Ordering 

For data capture, GCAS accepts single-precision IEEE-754 floating point data (32-bit) only. GCAS does 

not accept integer data. 

A standard Modbus register is 16 bits long, or 2 bytes. However, a standard single-precision float data 

requires 32 bits or 4 bytes. Two Modbus registers are then used to output one single floating-point 

datum. The floating-point byte swap options dictate how the bytes in these two registers be arranged 

to construct a 4-byte floating point value. 

 

Several GC devices such as Daniel and Enron implement a non-standard Modbus protocol extension 

which uses 32-bit Modbus registers, or 4 bytes for each register. GCAS supports these 32-bit registers 

as well. Choose 16-bit to use standard 16-bit Modbus registers or 32-bit to use non-standard 32-bit 

registers. 

Depending on how your GC device is configured, you need to match the byte ordering configuration 

on GCAS. Also, please note that GCAS operates using little endian order. Select one of four byte-order-

ing options: 

• Swap bytes, also known as Modicon standard, swaps the bytes within each word (ABCD → 

BADC). 

• Swap words swaps low and high word but not bytes inside each word (ABCD → CDBA). 

• Swap all swaps both words and bytes inside words (ABCD → DCBA). 

• Don't swap preserves the original byte order (ABCD → ABCD). 

27.1.3 Calibration Parameter Registers 

Calibration parameter refer to response factor and retention time. On Register Mappings form, set the 

registers for RF and RT data to match those on your physical GC device. Register address starts from 0 

(zero). Address 0 translates to Modbus holding register 4:00001. Address 1 translates to 4:00002, 

and so on. 

http://en.wikipedia.org/wiki/Single_precision_floating-point_format
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Change the gas order by selecting the correct gas names from the dropdown list. Depending on your 

GC device type, some input fields may be disabled. For instance, a GC device of C7+ without neopen-

tane reads 11 gases only. Therefore, twelfth to fifteenth input fields would be greyed out. 

To quickly change overall gas order, click either MW sort or Def sort button. MW sort will arrange 

gases per their molecular weight (MW). In this way, methane goes first. Def sort (default sort) on the 

other hand will arrange gases according to the sequence they exit the GC. On GC devices with back-

flush, the heavy-end comes first. On GC devices with two ovens (e.g. Daniel C9 and C10) Def sort but-

ton applies the default sort of oven 1 first, followed by the default sort of oven 2. 

Ignore a part of incoming data 

You can make GCAS ignore incoming RF data, for example, if you want to capture retention time only 

or mole composition streams only—or if your GC device doesn’t provide one of either RF or RT. To 

ignore response factor data, untick Read response factor. The same applies for RT data, which you 

can control using Read retention time tick box. 

On standard 16-bit Modbus, one gas requires two Modbus registers. For instance in the screenshot 

below, methane RF is set to use register address 7300. In practice, it uses register address 7300 and 

7301 altogether. Set the next gas/nitrogen RF register to address 7302. 

 

However in 32-bit Modbus, one gas requires only one register. There is no need to skip register ad-

dress once every two like in the prior example. 

Users with GCAS feature ISO 10723 included in their licences see an additional check box at the 

header of response factor fields called Mark MLC. This controls whether the incoming response factor 

data should be marked as multilevel-calibrated or not. Rewind to chapter 7.12 to read more about 

multilevel-calibrated RF. 
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Tip 

To quickly define sequential Modbus registers, enter the first register address then click  Flash fill. 

For example, type 110 in methane response factor, click  Flash fill, and GCAS shall assign 112 for 

nitrogen response factor, 114 for carbon dioxide, 116 for ethane, and so on. If you are on 32-bit 

Modbus then GCAS assigns 111 for nitrogen, 112 for carbon dioxide, 113 for ethane, and so on. 

You can also copy Modbus register addresses from Microsoft Excel or other spreadsheet processing 

software. Press Ctrl+V inside the first text box and the rest will follow. Alternatively, click  Paste. 

 

The  Copy button does the opposite—it copies register addresses from GCAS so you can paste 

onto Microsoft Excel spreadsheet. 

27.1.4 Mole Composition Streams 

GCAS supports multiple streams of mole composition data, provided that each stream has its own 

unique set of register addresses and there are no address collisions between streams. 

Note 

You need the GCAS feature Live Data Analysis to be included in your licence in order to capture mole 

composition data. 
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Click Add stream button to define a new stream. 

This brings forth another dialogue (see left) where 

you can define gas names and their register ad-

dresses. Also remember that each gas consumes 

two Modbus registers on 16-bit mode, but only 

one for each on 32-bit mode. 

The last register address is reserved for unnormal-

ised total. This is the sum of raw data read by GC 

device; for some devices may automatically nor-

malise mole composition values so they add up to 

exact 100%. 

Does your GC device not provide unnormalised 

total data? Visit chapter 27.1.5 for a workaround. 

Users with GCAS feature ISO 10723 in their li-

cences shall see an additional check box near the 

top-right corner named Mark as MLC. This check 

box controls whether the incoming composition 

data on this stream should be marked as multi-

level-calibrated or not. Rewind to chapter 8.11 to 

read more about multilevel-calibrated composi-

tion. 
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After you click OK, the new stream appears on the list. In this ex-

ample, it displays 40-65 because we use standard 16-bit Modbus 

thus register 64 (unnormalised total) actually uses address 64 and 

65. Next register available for subsequent stream is 66. If you use 

32-bit Modbus, it will display 40-52 instead, because each compo-

nent only uses one Modbus register. 

To edit a stream, click on the desired stream then click Edit 

stream. Likewise, to delete one, highlight the stream then the De-

lete stream button. 

 

 

Tip 

To quickly define sequential Modbus registers, enter the first register address then click  Flash fill. 

For example, type 40 in heptane, click  Flash fill, and GCAS shall assign 42 for propane, 44 for i-

butane, 46 for n-butane, and so on. If you are on 32-bit Modbus then GCAS assigns 41 for propane, 

42 for i-butane, 43 for n-butane, and so on. 

However; if the register address for unnormalised total is not on sequential series as the other com-

ponents, do not forget to edit the register address for the unnormalised total after clicking Flash fill. 

We emphasise this because many Daniel GCs are configured like this. 

You can also copy Modbus register addresses from Microsoft Excel or other spreadsheet processing 

software. Press Ctrl+V inside the first text box and the rest will follow, skipping the greyed out 

fields. Alternatively, click  Paste. 
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The  Copy button does the opposite—it copies register addresses from GCAS so you can paste it 

onto Microsoft Excel spreadsheet. The greyed-out fields, if any, are also included in the copy opera-

tion. 

MW sort button arranges gases according to their molecular weight (MW). Def sort (default sort) re-

orders gases using the default sort, which is the sequence these gases exit the GC. 

27.1.5 What if my GC device cannot provide some data? 

Depending on the make, model, and configuration of your GC device, the device may not be able to 

provide some data. For example, a GC device does not provide data for unnormalised total of mole 

composition. 

27.1.5.1 GC device does not provide retention time data 

Simply untick Read retention time as described in chapter 27.1.3. The same applies if the GC device 

does not provide whole set of response factor data, you would untick Read response factor. 

27.1.5.2 GC device does not provide response factor data, but it provides peak area 

Unfortunately, GCAS does not have the tool to calculate response factor from peak area and mole 

composition right on the GC Connect form. We suggest two workarounds: 
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a) Do not capture live data through GCAS, but obtain the data of peak area through other means 

(e.g. via the bundled software or report output). Later, go to Footprint form or Calibration Data 

form, open the Action menu and choose Import Data - Manual Entry. Select the third option 

("Response factor values are calculated from peak area") and enter the data. Have the component 

data table or calibration gas certificate ready because you will also need to input the mole per-

centage values. Click Save and GCAS will calculate the response factor values. Unfortunately, this 

workaround is effective only for one single record. Inputting multiple records through manual en-

try is a tedious work and very error-prone. 

b) Designate the RF register addresses for peak area and run the data capture as usual. But never 

send the incoming data directly to database, use the option Save to CSVs instead. After the data 

capture session ended, you can convert the peak area to RF values in the CSV file using your fa-

vourite spreadsheet editing software. Afterwards, import the CSV. 

27.1.5.3 GC device does not provide unnormalised total for mole composition streams 

Define a special register on your physical GC device and hard-code its value to 100 (or any scale you 

like, 100 is for percentage). Use two sequential registers if you are on 16-bit Modbus. On GCAS, set 

the register address for unnormalised total to the address of this special register. Repeat this step for 

every defined stream. 

27.1.5.4 GC device does not provide RF or RT data of one or several gases 

Define a special register on your physical GC device and hardwire its value to −1 (negative one). Use 

two sequential registers if you are on 16-bit Modbus. On GCAS, set the register address of the offend-

ing component(s) to the address of this special register. By this way, GCAS will record the value −1, 

thus will not display the component on RF or RT chart. The chart will have gap(s) at the offending 

component(s). 

27.1.6 For ABB Devices 

As ABB devices output exponential RF by default, there is a special setup to make them work with 

GCAS. To do that, GCAS needs to capture both single point RF and exponential RF, as well as peak 

area (PA).  
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Fortunately, ABB devices have higher degree of flexibility in terms of configuration. If the device is 

configured to output single-point RF, you can leave the check box Device has exponential RF un-

checked. By this way, GCAS treats the ABB GC just like Daniel or any other GCs—the response factor 

values are captured as single-point. 

If the device outputs exponential RF however, GCAS needs these sets of data to construct a complete 

calibration record: 

i) Single-point RF, this is what the response factor section of chapter 27.1.3 captures. You also need 

to configure the output formula in the Totalflow software which we will explain shortly. 

ii) Exponential RF. Click Configure on the appropriate field. 

iii) Retention time, this is what the retention time section of chapter 27.1.3 captures. Nothing new on 

this part. 

iv) Peak area. Click Configure on the appropriate field. 

All these data are captured as single-precision floating point. When you click Configure to set the 

registers of exponential RF or peak area, this is the dialogue window to expect: 

 

Same concepts apply—skip every other register address if the Modbus register length is 16 bits or 

don't skip if register length is 32 bits. All familiar buttons are also there. The  Flash fill, the way to 

 Paste, the  Copy button, MW sort (molecular weight sort), and Def sort (default sort), are simi-

lar to the parent Register Mappings form. Make sure there is no address clash among the single-point 

RF set, exponential RF set, retention time, and peak area. 
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To get the single-point RF output, configure your GC using Totalflow software to output peak area di-

vided by mole percentage of calibration gas certificate. First, create a maths operation. For example, the 

variable name R1 is the peak area and R2 is the mole composition. Here we define the single-point RF 

as R1 divided by R2. 

 

Then, create a register map range that outputs the result of this mathematical operation. In the exam-

ple below, we are using register address 8000 to 8010 for single-point RF followed by 8011 to 8021 

for retention time. Here the device has 32-bit holding registers. 

 

Finally, put these register range 8000 to 8010 (for single-point RF) and 8011 to 8021 (for retention 

time) in GCAS. Pay attention to the gas order as they must match exactly. Here we clicked Def sort to 

make the RF gas order match the defined gas order in Totalflow. As this example uses 32-bit registers, 

we also match the register length to 32-bit in GCAS. 
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27.1.7 Backup and Restore Configuration 

 

To back up your configuration, click on the Export current mappings to a file link. This will show the 

save file dialogue to save the XML file. 

To restore your configuration, click Browse button and load that XML file. Next, click Import button 

and GCAS should read the content and display register addresses accordingly. Click Save Mappings 

at the bottom of the form to commit the change. 

Note 

Backup and restore facility is not intended for copying settings from one device to another because 

we cannot guarantee that the other device is the same type of the current device. You cannot use the 

XML file intended for one device on a different device. If you need to do this and you are sure that 

both devices are of the same type, a workaround is available in chapter 27.1.10 Troubleshooting. 
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27.1.8 Reset to Default 

This section is only available if you have ever configured a device. For first-time configuration, this box 

is disabled. 

 

Your register configuration is stored in an XML file in [installation directory]\Mappings-

DeviceSpecific\ directory. Reset to default button will revert all register addresses back to the 

default definition as defined in template file. When you click Save Mappings button at the bottom of 

the form, your XML file is overwritten. 

If you first tick Permanently before clicking Reset to default button, not only GCAS restores all regis-

ter addresses to the default definition as defined in template file, but also it deletes your XML file. Per-

manent reset will put your GC device in GCAS database into unconfigured state. 

27.1.9 Tools/Shortcuts 

 

Instead of retyping all register addresses of RF and RT, use this section to shift registers addresses in 

one click. Choose which one to shift (RF or RT), enter the amount of address shift between −10,000 to 

+10,000, and then click Shift registers. 

You can also swap mole composition stream numbers without changing their register addresses. Enter 

two existing stream numbers to switch place, then click Swap stream number. 

27.1.10 Troubleshooting 

a) Q: I see an error message "This file is not a valid configuration file". 

A: There is a problem within the XML file. Open File explorer (Windows explorer), navigate to 

[installation directory]\Mappings-DeviceSpecific\. Default installation direc-

tory is C:\GCAS. Find the file of your device tag name.xml, then delete the file. This will reset 

the configuration of your device to follow template. 
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b) Q: I see an error message "Erroneous RF/RT entries" similar to this screenshot. 

 

A: Again, there is a problem within the XML file. Open File explorer, navigate to [installa-

tion directory]\Mappings-DeviceSpecific\. Find the file of your device tag 

name.xml, then delete the file. This will reset the configuration of your device to follow tem-

plate. 

 

c) Q: I see an error message "Device type not supported". 

A: GCAS cannot find the template file. Open File explorer, navigate to [installation di-

rectory]\Mappings-Template\. If the template file for your device type does not exist, 

either the device type is not yet supported by current version of GCAS or otherwise you might 

need to reinstall GCAS. 

d) Q: When I import a configuration (XML) file, it says that the file belongs to other device. 

A: The export configuration command link is not intended to copy settings among devices 

because we cannot guarantee that the other device is the same type as the device you are 

configuring. Their number of gases may differ. Therefore, we designed that the XML file be-

longs to a certain GC can only be used by that GC exclusively. 

Nevertheless if you are very sure that both this GC device and the other device are of the 

same type, you would need to edit the XML file using Notepad or any text editor. Open the 

XML file, and find the <devices> element. It should be near the beginning of the file. Inside 

<devices>, find the <tagname> element. Change the device tag name between 

<tagname> and </tagname> to match the name of the device you are configuring. Save the 

file, and then try to import the XML file again. 
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27.2 Capture Data 

As the Modbus register configuration is ready, GCAS is ready to get some data from the GC device.  

27.2.1 The GC Connect Form 

Select the device you would like to get data for, then go to the Comms menu > Connect to Device. 

This menu brings the GC Connect form. 

 

GC Connect form has two main parts, the options panel at the top and grid views at the bottom. Op-

tions panel consists of four parts, which are connection settings, device settings, data retrieval options, 

and unattended mode. If you see only three, resize the form so that it becomes larger to the right 

side. Unattended mode options may not be visible if your screen resolution is 1024×768. 

There are two grids at the lower part of the form, one for calibration parameters and one for mole 

composition. If you only see the grid for calibration parameters, it means you do not have GCAS fea-

ture Live Data Analysis included in your licence. 

To expand the grids and hide the options panel, click the  Expand button. On the opposite, to re-

store the options panel you would click  Collapse button. 
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Note 

On ABB device that is configured with exponential RF or MC, the GC Connect form also opens two ad-

ditional child windows right after it opens. Chapter 27.2.10 explains this behaviour. 

27.2.2 Connection Settings 

This section configures the connection medium between your computer and your GC device. GCAS 

supports two media, serial cable/RS-232 and Ethernet (or Wi-Fi, if your GC device supports it). 

 

To use serial cable connection, you need a GCAS feature Modbus Client over serial to be included in 

your GCAS licence. Similarly to use Ethernet cable, you need a GCAS feature Modbus Client over TCP. 

For serial cable connection, enter the appropriate COM port where the cable plugs to, followed by the 

baud rate, data bits, stop bit(s), and parity bit. These configurations should match the same configura-

tion as your GC device (except the COM number). 

For Ethernet or Wi-Fi connection, enter the IP address of your GC device and the TCP port. Refer to 

your GC device about the TCP port it listens. Modicon standard recommends 501, 502, or 1100 de-

pending of the Modbus protocol set in the device settings. 

27.2.3 Device Settings 

This sections configures the Modbus protocol to communicate with GC device. Available Modbus pro-

tocol depends on the connection medium set in connection settings.  
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Connection medium Available protocol 

Serial cable 1. ASCII (plain text) 

2. RTU (remote terminal unit) 

Ethernet or Wi-Fi 1. Modbus/TCP 

2. RTU over TCP 

Slave ID is the Modbus device identifier that ranges from 1 to 255. In a typical one device to one 

computer configuration, usually the slave ID is 1 (one). Refer to the configuration on your GC device to 

get the slave ID. 

Timeout is the period GCAS should wait after a Modbus command has been issued to the Device. De-

fault value is 1000 milliseconds (one second) for serial cable and 5000 ms (5 seconds) for Ethernet or 

Wi-Fi. Note for RTU protocol (serial cable), this timeout starts counting after the standard 3.5-second 

wait as specified in the RTU protocol specification itself. Minimum value is 10 ms. 

Poll delay is the period GCAS should wait after a timeout occurs before it retries to issue the same 

Modbus command to GC device. Default value is 1000 ms, but you can set it to zero if you don't want 

to wait. 

27.2.4 Data Retrieval Options 

 

You can set the poll interval at "poll every" input field starting from as frequent as every 5 seconds up 

to every 90 days. Typically, the poll interval is between 10 to 20 seconds. You can also match poll in-

terval to the cycle time of your GC device, however please make sure time difference between the poll 

and the end of cycle is not too far apart. 

Data destination: Choose where the captured data is being uploaded to. 

• Push to database: Data is uploaded to GCAS database. 

• Save to CSVs: Data is saved as two CSV files. 

For CSV option, GCAS creates two CSV files: One for RF and RT data, another for mole composition. If 

you do not have GCAS feature Live Data Analysis in your licence, the latter CSV is not created — GCAS 

writes only the RF and RT data into one CSV file.  
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The file for RF and RT data follows i-Vigilant CSV format so that it is usable for CSV import on Foot-

print or Calibration Data form. Similarly, CSV file for mole composition follows the format recognisable 

by CSV import on Mole Composition form. 

Mole composition values are left unnormalised when GCAS writes to the CSV. When you import this 

CSV through the Mole Composition form, the values will be automatically normalised. If you choose to 

push to database however, GCAS always normalises all mole composition values before they are com-

mitted to database. 

 

When you select Save to CSVs option, GCAS shows a dialogue. Here you set the CSV file names and 

their desired location. To change these later, click on the Change destination files link. 

 

27.2.5 Start Capture 

As the Modbus register mappings, connection settings, device settings, poll interval and data destina-

tion have been all configured, apparently now you are ready to get some data! 

Hit the  Start button to start the operation. GC Connect form will expand the grid view and poll the 

device for the first time after three seconds. After first poll, GC Connect form polls the device once 

every poll interval. 

By default, response factor and retention time are given equal priority in calibration data. New incom-

ing calibration data having same response factors as the previous row but with different retention 

time is still treated as new data. If you prioritise response factors over retention time, tick the check 

box Detect changes on RF only. By this way, incoming record having same RF but different RT from 

the previous one will not trigger a new row. 
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You can open multiple GC Connect forms and run multiple data capture sessions simultaneously, pro-

vided that no two GC Connect forms accessing the same device through the same COM port or same 

IP address. GCAS suspends the idle timer if there is at least one active connection to GC device. 

To stop capture, hit the  Stop button. 

If you accidentally close a GC Connect form during an active data capture session, either by pressing 

Ctrl+F4 or the close (×) button on its tile bar, the form is still running in background. The main in-

terface displays a panel notification at the bottom region, thus you can bring the GC Connect form 

back into view or stop its capture operation instead. Nevertheless, if you deliberately log out while a 

data capture is running in background, the capture operation will be stopped, form will close, and its 

pending records will be discarded. 

 

When multiple data capture operations are running in background, these two buttons become Show 

all and Stop all. 
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27.2.6 Stop Capture and Commit Data 

Click the  Stop button to stop the operation.  

Note 

If you click Stop button when GCAS is in the middle of polling GC device, GCAS waits two seconds in 

order to allow the poll to finish before terminating the connection. If the poll takes very long (e.g. on 

an extremely slow network or over VPN connection), GCAS waits for additional two seconds, up to five 

times (10 seconds) maximum. 

 

Untick records to ignore them, see green rectangle on the screenshot above. Ignored records will not 

be written to database or CSV files. For calibration parameters, you can change its flag in the "Flag as" 

column whether to mark a record as a footprint or a regular calibration data. (See orange rectangle on 

the screenshot above.) 

To commit (write) the data into database or CSV files, click either  Commit button or  Save to 

CSVs button. Otherwise,  Clear grid button removes all committed, pending, ignored, and failed 

rows from display. Alternatively, click the  Start button again to resume capturing data. 

The Status column may display any of the following: 
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• No text/blank: The record is ignored and will not be committed to database nor CSV files. 

• Pending (black): The record is awaiting commit or save operation. 

• Committed (green): The record has been successfully written to database or CSV files. Click 

Clear grid button to clear all committed rows from both grid views. 

• Failed (red): The record could not be written to database or CSV files.  

Usually the    Error log button appears on the bottom-left corner of the form and you 

click that button to see why the record failed to commit. Otherwise, open the Action menu 

and select View Error Log. 

(Note if you are in unattended mode, first click  Collapse button then deactivate unat-

tended mode to see Error log button). 

27.2.7 Unattended Mode 

Unattended data capture is a data capture operation where all incoming data are committed to data-

base or CSV files automatically. It is intended for remote sites where engineers rarely present in-situ 

while GCAS continuously captures data. You can then leave the computer on and come back later to 

stop the operation. 

The regular way to capture data as described in chapter 27.2.5 Start capture and 27.2.6 Stop capture is 

known as attended mode. The table below summarises difference between attended and unattended 

mode. 

Attended mode  Unattended mode 

Incoming records await your decision whether 

to commit or ignore. 

Incoming records are committed immediately. 

You need to click Commit button or Save to 

CSVs button in order to commit the records. 

Commit button, Save to CSVs button, and 

Clear grid button are not available in unat-

tended mode. 

You can review RF and RT records, giving you a 

time to change their flag either to footprint or 

calibration data. 

All records are automatically marked as cali-

bration data. 

Click the Stop button to stop operation. Click the Stop button to stop operation, or 

choose one of three available automatic stop 

triggers. 

To activate unattended mode, first tick the check box Enable unattended mode. 
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Notice that the Commit button/Save to CSVs button and Clear grid button disappear from the bot-

tom of the form. We don't need these buttons as the records would be committed automatically. 

Choose one of the following automatic stop triggers. 

1. After x records collected (default x = 20) 

GCAS stops the data capture operation after x new records have been collected. Operation 

stops whichever record type reaches x first, whether calibration parameter records or mole 

composition records. 

 

2. After x period of time 

GCAS stops the data capture operation after x period of time, whether it is x seconds, x 

minutes, x hours, or x days. You can choose from as short as 15 seconds to as long as 90 days. 

Note 

To prevent GCAS consumes too much memory (RAM), GCAS only display the last 25 commit-

ted records. Old committed records are removed from the grid view. (They are not deleted 

from database or CSV files, though.) Failed records are never removed from view. 

 

3. At specific time 

GCAS stops the data capture operation at the defined time.  

Note 

To prevent GCAS consumes too much memory (RAM), GCAS only display the last 25 commit-

ted records. Old committed records are removed from the grid view. (They are not deleted 

from database or CSV files, though.) Failed records are never removed from view. 

 

4. Never stop 

GCAS does not stop data capture operation. Someone must come back to the computer later 

and stop the operation manually through the  Stop button. 

Note 

To prevent GCAS consumes too much memory (RAM), GCAS only display the last 25 commit-

ted records. Old committed records are removed from the grid view. (They are not deleted 

from database or CSV files, though.) Failed records are never removed from view. 



GCAS® Manual Guide rev. 26 

Page 417 of 587 

 

And finally, hit the  Start button to start capturing data in unattended mode. 

To deactivate unattended mode, stop the data capture operation and untick the check box Enable 

unattended mode. 

27.2.8 Data Capture Error Log 

In case of records failing to commit, the Error log button usually appears at the bottom-left corner of 

the form. 

 

If you are on unattended mode, first stop data capture operation, show the options panel via  Col-

lapse button and then deactivate the unattended mode to see this button. Alternatively, simply open 

Action menu and select View Error Log. 

Error log shows you the error messages why the record could not commit on every occasion of failed 

record. In this example, Unauthorised access exception means either the CSV file was marked 

as read-only, or your Windows user account do not have write permission on the folder where the 

CSV file resides. 
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27.2.9 Data Capture Connection Log 

The connection log records several types of event during data capture operation. For example, when 

the connection is started, connection is stopped, poll results, whether the record successfully commit-

ted (unattended mode only), and error codes. 

One device has one connection log and error log. If you run multiple data capture operations simulta-

neously, each GC Connect form has its own error log and connection log. Both logs are cleared when 

you close the GC Connect form. 

To view the connection log, open the Action menu and select View Connection Log.  
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Click Show/hide to filter which types of event to display on the connection log window. Clicking a 

dropdown menu will toggle that filter to on or off. If you tick Hide successful polls with no new 

data, all polling events having 0x00000000 error code (which indicates "no error" or a successful poll) 

without new data will be hidden. 

 

To save the error log, click  Save. Connection log is saved in a CSV format. However, this button will 

save the filtered log, as only displayed items are saved. To save the entire log including those hidden 

items, open the small drop down menu near the Save button and select Save Entire Log. 
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In order to preserve computer memory, the connection log only retains the last 40,000 log items. 

When the connection log has reached 40,000 items, the oldest log items are discarded one by one. 

Click  Clear log to empty the entire connection log immediately. 

Type the search word in the search box and hit  Search to find the word in the connection log. Be-

fore clicking Search, you can change the search filter dropdown to limit the searching area. Notice 

that searching a term in connection log will search the entire log, not only the filtered log. Click  

Finish searching to end the search mode. 
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27.2.10 Again, for ABB Devices 

Oh ABB, you are so special. Again, this chapter applies only to ABB devices that are configured with 

exponential RF and/or MC. 

Users may be surprised that the GC Connect form opens two additional child windows after it starts. 

They may look like this. 

 

GCAS developer team faced a dilemma when they were implementing exponential RF/MC support for 

ABB: Where should we put the captured exponential RF and peak area data on the GC Connect form? 

If they tried to cram two more data grids to GC Connect form, two downsides. First, it would look clut-

tered and won't be a nice UI to the users. Second, other GC brands don't make use of them; thus it 

would become a waste of space. Therefore, we decided to put these "optional" captured data on sep-

arate child forms. These child forms will not appear on other GC brands. 

One window displays the captured exponential RF, while the other displays captured calibration peak 

area. Unlike the data grid for single-point RF on the main GC Connect window, exponential RF and 

peak area data are not displayed historically. Of course GCAS remembers every captured exponential 

RF and peak area data on every incoming record, but GCAS just use them to compute the multiplier 

values for the single-point RF. For that reason, GCAS just show the most recent data (Current column) 

and one record before it (Previous column). You can verify that GCAS captures the correct exponen-

tial RF data by comparing values displayed on this window and values on the GC. In addendum, if you 
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see the date 1 January 1970, it simply means there are no previous data existing in GCAS database for 

this GC device. 

You can close these child windows at any time to clean up your working area. To show them again, 

open the Action menu of GC Connect form and select the appropriate menu View Captured Expo-

nential RF or View Captured Peak Area. 

 

GC Connect form caches the latest calibration gas certificate because GCAS also requires it to convert 

the incoming exponential RF values into single-point RF. The form tries to load the latest certificate 

during startup. But GCAS does not know if a newer certificate is available— perhaps just installed by 

another user on another PC—because the database server cannot send any push notification about 

this. Therefore the Action menu has several options to automatically refresh this cache. The default is 

no automatic refresh because most likely users do not install new certificate that often. 

The calibration certificate currently in use is displayed at the top-centre of the RF and RT grids (see 

screenshot below). This information is not available for devices other than ABB. 
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We do not recommend refreshing certificate cache every time a new RF record comes. This would lead 

to large overhead (processing time) querying the database server to check for a new certificate while it 

is unlikely for users to install certificate every hour for instance. To refresh the cache manually, open 

the Action menu and go to Refresh Calibration Certificate Cache. Click Now. 

27.3 Modbus Error Codes and Handling 

Bad things happen during data capture. Source of problems might be bad cables, aging hubs, over-

loaded router, Wi-Fi interference, and so forth. When GCAS does not get a proper response from the 

GC device, it raises an error code. 

We make a distinction between error codes and exceptions. Error code indicates an error in the Mod-

bus protocol communication. The cause may be the computer, the GC device, or the medium between 

computer and GC device. Exception, by definition in technical term, is an error caused by problems 

inside GCAS itself and not your GC device. Both error codes and exceptions are logged in the connec-

tion log. 

27.3.1 About Error Codes 

If there was error in Modbus protocol communication during data capture, the GC Connect form will 

display the error code above the countdown. For example, the most common error is 0x00000044 

TCP/IP connection error. This error happens only in TCP connection — not in serial cable connection 

— and indicates problem such as congestion, corrupted TCP packet, wrong TCP checksum, or Wi-Fi 

connection between your computer and GC (if your GC supports Wi-Fi) is experiencing problems. An-

other common error code is 0x00000045 TCP/IP connection was closed by remote peer. This error 

code indicates problems like the Ethernet cable is unplugged or the main power to GC was cut. 

Some error codes are temporary, such as 0x00000084 Reply time out. By temporary it means the er-

ror may vanish by the next poll. However some error codes are persistent, which means the error code 

will be repeated during next poll and next poll and next poll until you stop the connection. This is par-

ticularly bad for unattended mode. In order to avoid that, GCAS introduced automatic connection re-

start and automatic connection termination. This feature is turned on by default, and you will go to 

the Advanced GC Connection Preferences dialogue in order to configure which error codes trigger the 

automatic restart or termination. 

27.3.2 Advanced GC Connection Preferences 

Go to the Comms menu > Advanced Preferences. This menu brings the Advanced GC Connection 

Preferences dialogue.  
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This dialogue configures the automatic connection restart and automatic connection termination. To 

get help on automatic connection restart, go to chapter 27.3.3. To read more about automatic con-

nection termination, head to chapter 27.3.4. 

27.3.3 Automatic Connection Restart 

Automatic connection restart is a feature to stop GC connection temporarily and restart it immediately 

or with delay when GCAS encounters certain error codes. To turn on this feature, give a check mark on 

Restart GC connection if these errors are encountered during poll.  This feature is already turned 

on by default for error codes 0x00000002 Illegal state error, 0x00000044 TCP/IP connection error, and 

0x00000045 TCP/IP connection was closed by remote peer. When GCAS encounters any of these three 

error codes, it will trigger a connection restart. 
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To remove an error code from the trigger list, highlight the error code and click Remove from list. 

The next link Clear selection deselects any selected items. 

To add an error code to this trigger list, choose one from the dropdown or type the error code in hex-

adecimal number (for example 0x00000084) then click Add. 

When GCAS restarts a connection, it stops the connection and restarts it immediately. However, there 

are chances that the first restart will still fail. If you want GCAS to keep retrying, give a tick mark on If 

connection restart failed, wait x minute(s) and set how much the delay GCAS should wait before 

another attempt of reconnection. During this wait time, you can abort the process by clicking  Stop 

button on GC Connect form and the restart attempt will be cancelled. If this is not ticked, the GC Con-

nect form will stay stopped after first restart attempt failed. 

Set how many retries GCAS should try. The default is 30 attempts, which means GCAS will give up af-

ter 30 times of unsuccessful reconnection. Pick one from the drop down or type a number. Choose 

infinite to make GCAS keep retrying forever. 

Note 

Automatic restart only works for the enlisted error codes during poll. It will not work if you get the er-

ror code at the start of connection.  

For example, if you get 0x00000044 TCP/IP connection error when you click  Start button, it means 

the IP address of your GC is wrong or the destination IP address does not listen to port 502 (or the de-

fined port). Restarting GC connection for wrong IP address is useless, therefore GCAS will not attempt 

to reconnect to your GC.  

It's a different story if you get 0x00000044 at a regular poll, it means there is network problem be-

tween your computer and your GC. This error code can be solved by restarting TCP connection. 

27.3.4 Automatic Connection Termination 

Automatic connection termination is a feature to stop GC connection permanently when GCAS en-

counters certain error codes. Typically the error codes in the auto-terminate list represent fatal errors. 

To turn on this feature, give a check mark on Terminate GC connection if these errors are encoun-

tered during poll. This feature is already turned on by default for error codes 0x00000046 Socket li-

brary error and 0x00000086 Invalid MBAP pointer. When GCAS encounters any of these two error 

codes, it will stop GC connection. 
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The error code 0x00000046 Socket library error indicates a problem within Microsoft Windows Socket 

(winsock). The way to fix this error is you need to open an elevated command prompt (run as adminis-

trator), enter this command: 

netsh int ip reset 

and restart the computer. It is not something GCAS can fix with a simple reconnection. 

The error code 0x00000086 Invalid MBAP pointer may happen to a very limited number of GC devices 

(usually GC with old firmwares) on ethernet connection. It has something to do with the way GC re-

spond back to the command issued by the computer. 

Simply explained, MBAP stands for Modbus Application Protocol. When a computer issues a Modbus 

command to a machine (the GC), there is a "transaction ID", a number at the beginning of every data 

packet travelling along the network. When your GC device finished executing the command and ready 

to send back a response, it must echo the same transaction ID at the beginning of response. This is 

how Modbus protocol works as already defined in the Modbus protocol standard. However, some GC 

devices do not follow this standard. Instead of echoing back the transaction ID, they set the transac-

tion ID to zero. Because GCAS follows Modbus standard, GCAS rejects this response and issues 

0x00000086 error code. To fix this problem you might have to upgrade the firmware of GC device. Re-

starting GC connection won't help, therefore it is better for GCAS to terminate the connection. 

Similar to automatic restart configuration, highlight an error code and click Remove from list to re-

move the error code from auto-terminate trigger list. To add an error code, select one from the 

dropdown list or type the error code in hexadecimal number and then click Add. 

27.4 Controlling Multiple Data Captures 

The Comms menu on the main user interface provides two shortcuts to control multiple data capture 

operations.  

http://en.wikipedia.org/wiki/Winsock
http://en.wikipedia.org/wiki/Winsock
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Start All Connections menu is a way to start multiple data captures simultaneously or with delay. 

Stop All Connections menu will attempt to stop all data capture operations and abort any GC Con-

nect form in reconnecting state. If there are some GC Connect forms being hidden, the Comms menu 

displays another menu called Reveal Hidden GC Connect Forms which pretty straightforwardly will 

unhide all hidden GC Connect forms. 

27.4.1 Start Multiple Data Captures with Delay 

This menu is accessible if you open multiple GC Connect forms but haven’t started some or all of them. 

Configure every GC Connect form to the correct parameters such as IP address or serial port, poll in-

terval, data destination, and so on. However, leave them and do not start any data capture operation. 

Next, go to the Comms menu > Start All Connections > With Delay. This menu displays the GC Con-

nect Delay Start form. 
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On the left side, there is a list of idle GC Connect forms. Those with check mark will be queued for de-

lay start. Reorder this queue by selecting one item and click Move up or Move down. GC Connect 

form at the top will be started first, and subsequently so according to the order of this queue. 

If you tick Delay the start of first GC Connect form, the start capture operation of first GC Connect 

form in the queue will be delayed by the specified amount of time. 

If you tick Delay the start of subsequent GC Connect forms, the start capture operation of the sec-

ond, third, and the rest of the queue will be delayed by specified amount of time one after another. 

Furthermore if you tick Randomise within, the delay between GC Connect forms is randomised within 

the specified delay. For example, let's use 1-minute delay. Without randomisation, GCAS will start GC 

Connect forms in the given order exactly 1 minute one after another. With randomisation, the delay is 

randomised between immediate (0 second) to 1 minute. As an example, GCAS may start the second 

GC Connect form after 27 seconds, the third GC Connect form 56 seconds afterwards, and the fourth 

GC Connect form 43 seconds after the third. 

Hit  Start timer to begin the delay start. While the timer is running, a command link Cancel will ap-

pear to the right side of Start timer button. Click Cancel to stop the timer and abort the delay start. 

Delay first GC 

Connect form 

check box is… 

Delay subsequent 

GC Connect forms 

check box is… 

What would happen 

Checked, 10 

minutes 

Checked, 1 minute 1. GCAS waits 10 minutes then starts the first GC Con-

nect form. 

2. GCAS waits 1 minute then starts the second GC Con-

nect form. 

3. GCAS waits 1 minute then starts the third GC Connect 

form, and similarly for the rest of queue. 

Checked, 10 

minutes 

Unchecked GCAS waits 10 minutes then starts all GC Connect forms 

in the queue simultaneously. 

Unchecked Checked, 1 minute 1. GCAS starts the first GC Connect form immediately. 

2. GCAS waits 1 minute then starts the second GC Con-

nect form. 

3. GCAS waits 1 minute then starts the third GC Connect 

form, and similarly for the rest of queue. 

Unchecked Unchecked GCAS starts all GC Connect forms in the queue simulta-

neously and immediately. 

This configuration is the same as Comms menu > Start 

All Connections > Now. 

If any of GC Connect forms in the queue is started manually or is closed before the timer countdown 

reaches zero, it is automatically removed from the queue. The GC Connect Delay Start form shall skip 

to the next GC Connect form in the queue. When this queue becomes empty, the timer stops. 
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27.5 AlertMe 

AlertMe is the name of data capture alert feature. It alerts you about problems happening during data 

capture process, especially an unattended one. If for some reason the data capture stopped while all 

engineers are away, GCAS can send you an alert so that you can send someone over to check and re-

solve the problem—hopefully saving some of the gas flowing through your GC but not captured by 

GCAS. 

These are events that GCAS would alert you in case they actually occur during data capture. 

1. Records failing to commit to database, 

2. Three consecutive pending records or more, 

3. Modbus error codes (any error code), 

4. Modbus error codes that triggered reconnection, 

5. Modbus error codes that triggered data capture termination, 

6. Automatic stop (if set), 

7. Exceptions (Microsoft .NET Framework errors). 

Default setting defines event number 1, 2, 5, 6, and 7 are enabled. Event 3 and 4 won't make GCAS 

sends alert unless you enable them in AlertMe configuration dialogue. Speaking of default settings, 

AlertMe is also inactive when GCAS is installed. This is due to the prerequisites to use AlertMe de-

pending on the alert method you choose. 

27.5.1 AlertMe Configuration Dialogue 

On GCAS main menu bar, open Comms menu and select AlertMe. This menu brings forth the AlertMe 

configuration dialogue. 
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At the top-left corner, you see the big check box Enable AlertMe. Check this box to allow GCAS to 

send alert. By default, GCAS alerts you only on unattended mode, as the next check box is ticked. If 

you prefer to get alert on attended data capture as well, remove the tick. 

Moving down, at the check box list Alert me for, choose which events to trigger alert submission. 

On Alert frequency, pick one of the three available options.  

• Send alert immediately, as it sounds, causes GCAS to alert you straight after the trigger 

event happened.  

• Send alert after 3 events recorded causes GCAS to wait for three trigger events to occur be-

fore sending one alert. Be warned that there may be long time gap between one event to the 

next. 

• Pool alerts within 5-minute interval and then send. This option uses a timer that runs in 

the background at all time. This timer ticks every 5 minutes. GCAS pools all alerts occurring 

within this 5-minute window, and then sends all those alerts in one go when the timer ticks. 

If you receive too many alerts, you can limit the number of alerts received per hour or per day. Check 

Limit maximum number of emails or texts and set the limit to your preferred value. In case the limit 

has reached but you still need to receive alerts, click Reset counter to bypass the limit temporarily. 

Moreover, you can also choose not to get alerts while off duty by enabling Quiet hours.  

Moving to the right, there are options for alert method. GCAS supports two methods of alert delivery: 

emails and text messages (SMS). Each method has some prerequisites before GCAS can deliver alerts. 

To configure AlertMe using email, head to chapter 27.5.2. To get text messages delivered to your mo-

bile phone, jump to chapter 27.5.3. 



GCAS® Manual Guide rev. 26 

Page 431 of 587 

 

27.5.2 AlertMe by Email 

To get alerts delivered via emails, GCAS needs to use your corporate internal mail server. Please al-

locate one email account for GCAS alerts. The email account does not even have to own a mailbox, 

GCAS just need an email address to impersonate an entity that you see at the "From:" field of an alert 

email—plus the associated credential if your mail server use it. 

AlertMe works with a traditional SMTP server for email submission. GCAS cannot send alert through 

other types of mail transfer protocol such as Microsoft Exchange ActiveSync (EAS) protocol. Do not 

get mistaken between Microsoft Exchange Server and Exchange ActiveSync, for GCAS works with Mi-

crosoft Exchange Server provided that it is configured to allow SMTP connection in addition to EAS 

protocol. 

Q: Why does GCAS need access to my internal mail server? Why don't you guys send me alerts 

from some address like alert@i-Vigilant.com? 

A: There are reasons why we choose to use customer's own mail server.  

• Because the mail server is already inside your network, emails are delivered faster because 

they are treated as local (intranet) traffic. 

• If we send alerts from external mail address such as alert@i-Vigilant.com, we have to per-

suade your network administrator to allow our email domain address to be in the whitelist. 

Otherwise the alert mails may end up marked as spam or junk. That also involves continual 

blocklist suppression request to public spam blocklist services such as SpamCop and Spam-

Haus. 

• External emails must go through several layers of corporate network security such as firewall 

packet scans, antivirus scans, and so on. This yields longer delivery time and increases the risk 

of alert mails get undelivered. 

• If your corporate use Microsoft Exchange Server (with SMTP enabled), Exchange can deliver 

the alert through push mail. That's even better. 

Using email as delivery method also poses several risks. 

• GCAS requires a working network connection to the mail server. If the network is down, the 

emails won't get sent. This problem escalates if your network topology involves VPNs. When 

the public internet connection goes down, so does the VPN connection, and emails won't get 

sent either. 

• AlertMe emails are HTML emails. Some corporates impose a restriction on their mail servers 

such as only allowing plain text emails or requiring S/MIME signature. In these cases, GCAS 

cannot send emails. 

On AlertMe configuration dialogue, find the section depicted in the next page. At the Alert method 

part, select the radio button Email. 

https://en.wikipedia.org/wiki/Exchange_ActiveSync
https://en.wikipedia.org/wiki/Microsoft_Exchange_Server
mailto:alert@i-Vigilant.com
mailto:alert@i-Vigilant.com
https://www.spamcop.net/
https://www.spamhaus.org/
https://www.spamhaus.org/
https://en.wikipedia.org/wiki/S/MIME
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Fill the required details in Send as and Send to. The Send as part becomes the "From:" field of an 

email, which you need to put the email address that was allocated for GCAS alert. Next, enter the in-

tended recipients in the provided table. You can enter as many recipients as needed, up to the limit 

enforced by your mail server. You can set who becomes the To: (primary recipient), who becomes the 

Cc: (carbon copy), and who becomes Bcc: (blind carbon copy). 

 

To temporarily block a recipient from getting emails, untick the check box in the Send? column. 

 

To remove one or more recipients, highlight their rows and press Delete on your keyboard. 
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Next, specify the mail server host name (or its IP address) and its port. Your network administrator or 

IT department can provide this information. For connection security, pick one of the three. 

• None: Connection to the mail server is not encrypted. 

• Implicit SSL/TLS: GCAS negotiates SSL encryption at the time the connection is established. 

Afterwards, email submission begins on secured communication. 

• Explicit STARTTLS: The connection begins as an unsecured, then GCAS issues a STARTTLS 

command to upgrade the connection to be a secured one. 

Typically, different connection security uses different port. Unsecured connection uses port 25, implicit 

TLS uses 465, and explicit TLS uses 587. But the port should be set according to the instruction given 

by your network administrator. 

Moving down, depending on your mail server, it may require authentication before the server accepts 

email submission. If so, give a tick on SMTP server requires authentication and provide the creden-

tial of the mail account allocated for GCAS alert. 

Click Test sending email to verify the configuration is correct. This is how test email would look like. 

 

In case your mail server enforces implicit or explicit TLS security, GCAS executes standard SSL certifi-

cate chain validation—the one that is performed by your internet browser all the time. If the SSL cer-

tificate is untrusted, GCAS presents you this question.  

https://en.wikipedia.org/wiki/Transport_Layer_Security
https://en.wikipedia.org/wiki/Opportunistic_TLS
https://en.wikipedia.org/wiki/Opportunistic_TLS
https://en.wikipedia.org/wiki/SMTP_authentication
https://en.wikipedia.org/wiki/X.509#Certificate_chains_and_cross-certification
https://en.wikipedia.org/wiki/X.509#Certificate_chains_and_cross-certification
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Many corporate networks employ self-signed SSL certificate to create secured connections. Self-

signed SSL certificates are not trusted unless the root certificate is distributed and installed on every 

corporate computer by your network administrator. If you trust the certificate, click Yes, allow TLS 

connection to continue email submission. You are prompted this dialogue only once per session. 

27.5.3 AlertMe by Text Message (SMS) 

Other than email, you can get alerts delivered as text messages to your mobile phone. Some pros and 

cons of using SMS to send alerts are: 

+ Text messages do not require internet connection. Even if network connection to your mail 

server got disrupted, GCAS can still send texts. 

+ Text messages may deliver faster than emails in case the mail server uses POP3 or IMAP4 to 

access mailboxes (which these two protocols do not support push mail and rely on periodic 

polls from your mail client software). 

− You need to be in your mobile provider's coverage. Well, probably not if you are in offshore 

site. 

− Sending text message costs money. Contact your mobile provider to see if they have some 

kind of SMS plan and get the best deal of it. 

Hardware requirements 

To send text messages, GCAS needs: 

1) A modem that supports short messaging service. This modem can be 

a) A common GSM 2G/3G/4G USB modem card or stick. CDMA2000/EV-DO modems are wel-

come as long as they are compatible), 

b) A dedicated SMS modem using serial (RS-232) or USB, 

https://en.wikipedia.org/wiki/Short_Message_Service
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c) An old-school mobile phone (not a smartphone), usually comes with a driver and a proprie-

tary data cable or infrared link, or 

d) A Bluetooth transceiver + certain Android smartphones supporting Bluetooth Serial Port Pro-

file (SPP). Not all smartphones support this feature. Congratulations if you happen to have 

one. 

2) The modem must support Hayes AT command set and AT command extensions for SMS.  

3) Not all modems are compatible! The point is, no matter what kind of "modem" it is, the modem 

must be registered as a serial port device in Device Manager on Windows operating system. Some 

USB modems or mobile phones do not appear as a serial device at all, thus are incompatible. 

Some USB modem sticks appear as serial port device after you run the software utility that comes 

with them. In such scenario, the software utility must be kept running though you should not use 

the modem stick to connect to internet—which makes its serial port interface "busy" (in use). 

4) Not all modems support AT commands for SMS! Depending on the vendor, the modem may 

not recognise nor respond to certain AT commands necessary for sending text messages. That is 

what Test AT commands button for. GCAS will determine if the modem is usable. 

5) A valid SIM/RUIM card with PIN protection disabled.  

6) Be within your mobile provider's coverage and receive adequate signal strength. 

7) Enough credit (for prepaid/PAYG SIM cards) or subscription (for postpaid SIM cards). 

8) If your "modem" is a mobile phone, make sure its battery is charged.  

a) Warning: Leaving your phone connected to wall charger for prolonged period of time will 

damage the battery. Depending on the manufacturer, some phones can operate without bat-

tery—drawing power solely from the wall charger. But most mobile phones cannot, thus we 

recommend utilising a power outlet equipped with a timer to control the phone's battery 

charge and discharge cycle. 

 

Example of a compatible modem. Wavecom Fastrack M1306B GSM modem (RS-232 model) 

 

On AlertMe configuration dialogue, find this section. At the Alert method part, select Text messages 

(SMS). 

https://en.wikipedia.org/wiki/List_of_Bluetooth_profiles#Serial_Port_Profile_.28SPP.29
https://en.wikipedia.org/wiki/List_of_Bluetooth_profiles#Serial_Port_Profile_.28SPP.29
https://en.wikipedia.org/wiki/Hayes_command_set
https://en.wikipedia.org/wiki/Short_Message_Service#AT_commands
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First thing you need to do is to find out which serial port your modem is using. Head to Device Man-

ager in Windows control panel and navigate to the Ports (COM & LPT) node. For example, on the 

next page, the modem is on port COM 5. 
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Put the serial port in the corresponding input field. Next, fill in the Baud rate, data bits, stop bits, 

parity bit, and flow control. These things should be set according to the data provided by modem 

manufacturer. Try consulting the user manual of your modem. If you cannot find them, try using the 

value 9600 bps for serial devices or 115200 bps for USB devices, 8 data bits, 1 stop bit, no parity, and 

no flow control. 

Flow control is a method to prevent buffer overflow on either side of serial port communication. The 

options for flow control are: 

• None: No flow control mechanism. 

• XON/XOFF: Software flow control. When the buffer is full, the modem or computer sends 

XOFF signal—ASCII code 19—so that the other end pauses any further transmission. After the 

buffer has enough space, the modem/computer sends XON signal—ASCII code 17—to resume 

receiving data. 

• RTS: Hardware flow control. A voltage is applied on the pin 7 ("request to send", RTS) of the 

RS-232 port. The other end replies with a voltage on the pin 8 ("clear to send", CTS). Data 

communication occurs as long as the RTS and CTS pin are active. When the modem or com-

puter detects its buffer is about to fill up, pin 7 is turned off to halt the transmission momen-

tarily. 

• RTS + XON/XOFF: A combination of software flow control and hardware flow control. 

 

 

Example on Wavecom Fastrack M1306B GSM modem. 
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Click Test modem port. If no other software is using the modem, the serial port should be free thus 

GCAS can use it. This message should appear if the modem is available to use. 

 

Next, GCAS needs to determine if the modem supports SMS. Click Test AT commands to run the ex-

amination. If your modem does support SMS, report window should look like the one in the next 

page. 

 

 

A special note: Modems not supporting SMS commands in PDU mode (see report line 6 of the 

screenshot example above) will prevent GCAS from sending concatenated texts.  

If the content of a text exceeds 160 characters, the text will be chopped after the 160th character. 

Another special note: If the bottommost item AT+CMGD reports "Error", your modem does not sup-

port message deletion from SIM card message store through AT commands. The SIM card message 

store is—going back to early generations of GSM mobile phones—a storage area embedded in the 

SIM card to store a small number of text messages, usually 30 items. If this message store is full, your 

modem may refuse to send any more messages. GCAS always tries to delete every text message that 

https://en.wikipedia.org/wiki/Concatenated_SMS


GCAS® Manual Guide rev. 26 

Page 439 of 587 

 

was sent successfully, freeing space in SIM card message store. Some modems do not respond to 

AT+CMGD command and thus the message store must be cleared through other methods—such as a 

special command or button in the software utility created by the modem manufacturer. 

At this point, we assume your modem supports text messaging. Congratulations! For the last part, 

specify up to two mobile numbers that will get the alert messages. If you need GCAS to alert only one 

person, leave the second mobile number blank. Enter the mobile number in international format. Put 

the +country code in front and omit the leading zero. GCAS ignores dashes, spaces, and parentheses. 

 

 

Reminder 

Sending text messages to recipients in different country may incur higher charge. 

Final step, click Test sending text. Wait a few seconds. If the message is sent, verify that the text is 

delivered to the intended recipient(s). If the text failed to send, check if you get enough reception of 

your mobile provider's coverage or if the SIM card is in grace period. 
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The message has been delivered successfully. 

The link Reset modem (send ATZ command) is used if you suspect you are not getting text alerts 

after a while. First thing to do is to check if your mobile account is in active period and have enough 

credits left (for prepaid/PAYG SIM cards), or the SMS plan is still working (for postpaid SIM cards). 

First, try sending a sample text message through the AlertMe configuration dialogue. If you get unu-

sual response such as "The modem does not support AT commands" or "Response from the modem 

was incomplete", while usually it is able to send without problems, then you can click this link. It sends 

an ATZ command (AT Zero) to reset your modem to its default state, followed by an ATE0 command 

(AT echo cancellation). Afterwards, try sending a text again.  
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28 Data Provision (Modbus Server) 

Chapter 27 explained how GCAS gets data from your GC device, now it's time to switch role where 

your device or another software gets data from GCAS. GCAS provides data via Modbus® protocol 

whereas it acts as a Modbus slave device, so your Modbus master device or software can issue Mod-

bus commands to query data. 

Note 

To use this feature, you need the GCAS feature either Modbus Server over Serial or Modbus Server over 

TCP (or both) to be included in your GCAS licence. On top of that, your GCAS licence should include 

various GCAS features in order to be able to provide those data. For example, to provide mole com-

position data, your GCAS licence should have Live Data Analysis included. To provide uncertainty val-

ues, your GCAS licence should have Uncertainty Calculation included. 

Known limitations 

Here are known limitations on the Modbus server module. 

- Read-only registers (input registers) are always 16-bit long. Read/write registers (holding reg-

isters) can be configured to be 16 or 32-bit long. 

- Modbus Server Instance Editor form can hold up to approximately 150 addresses (tiles). This is 

due to limitation in Win32 programming in terms of the number of window handles one win-

dow may have. These 150 addresses must be spread across four categories and across differ-

ent slave IDs. 

- To support more than 150-ish addresses, we have developed a separate utility called GCAS 

Modbus Server Instance Editor. You should find the executable in the same directory as the 

main GCAS software. 

- Modbus diagnostic command (function 0x07) is supported but always returns zero. 

Hardware requirements 

Other than a PC having a serial port or Ethernet port or Wi-Fi, we recommend using multicore CPU 

because Modbus server utilises a lot of background threads. Especially if your Modbus master device 

or software polls GCAS really often, like every one second, the background threads will be quite occu-

pied. For a modern physical desktop or laptop PC, this would not be a problem. But it becomes a dif-

ferent story when you run GCAS inside a virtualised environment having only one core processor. For 

example, inside a Microsoft Azure virtual machine A1 basic tier (1 core, 1.75 GB RAM). 
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28.1 Terminologies 

Here is a list of terminologies used by Modbus server module. 

Term Description 

Server engine The module that listens on the designated TCP port or serial port, ready to 

serve incoming requests.  

One server engine is created for each serial port, but only one server engine is 

running to handle all TCP connections. Every server engine carries its own 

background thread executing the listen-serve loop. 

Server instance A data table containing the actual data to provide through server engines. 

Server instance is identified through its Modbus slave ID. Every instance is at-

tached to all running server engines, so you can query the same data through 

any channel of connection. 

One server instance supports up to 4 × 65,536 addresses. 

Server instance 

definition 

List of slave IDs, and list of addresses on each slave ID, and the purpose plus all 

related properties of each address. 

Instance definition is saved as an XML file which is used during server instance 

creation on startup. 

Slave ID A number ranging from 1 to 255. Typically, the ID is 1 for single instance sce-

nario. 

Slave ID 0 (zero) is reserved for broadcast destination and should never be 

used. 

Server interface A window to monitor the actual values of all registers and coils. 

Tile A representation of one address inside a server instance. Modbus Server In-

stance Editor form uses tile-based approach to create or delete addresses. 

Tiles are explained in greater detail in chapter 28.3.2. GCAS Modbus Server In-

stance Editor (a separate utility) uses grid/table view to create or delete even 

more addresses. 

Address The actual Modbus coil or register address. GCAS uses zero-based address 

(0 to 65535) to make it consistent with the Modbus client module. 

Absolute address has the form of P:XXXXX with P is a prefix of each category, 

while X is the address from 1 to 65536. Address 0 (zero) on read/write register 

maps to 4:00001. 

Category Four divisions of a server instance. They are: 

- Read/write bit (0:XXXXX) 

- Read-only bit (1:XXXXX) 

- Read-only register (3:XXXXX) 

- Read/write register (4:XXXXX) 

Each category can hold 65,536 addresses. 

Read/write Both GCAS and your Modbus master software or system can write data to 

these addresses. 

Read-only GCAS can write to these addresses, but your Modbus master software/device 

cannot. 

Read/write bit Coil (1 bit) 
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Term Description 

Read-only bit Input discrete (1 bit) 

Read-only 

register 

Input register (16 bits) 

Read/write 

register 

Holding register (16 or 32 bits) 

For first time configuration, you should visit server engine settings. 

28.2 Server Engine Settings 

Server engine settings configure fundamental aspects of Modbus server module. They dictate whether 

you would like to use serial port connection, TCP connection, or both, and also the register length as 

well as byte swapping options. 

On the main window, go to Comms menu and select Server Engine Settings. This menu calls Modbus 

Server Engine Settings dialogue. 

 

At the top-left region you see a check box Run server on startup. By default, this option is ticked. As 

soon as you log in to GCAS and all GC devices have been loaded, Modbus server engines are ready to 

listen to incoming Modbus requests. If you prefer to start the server manually, untick this option. 
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28.2.1 Connection Settings 

 

Give a check mark on either Enable server on serial connection or Enable server on ethernet/wifi 

connection, or both. Users may choose to purchase the serial connection only, or TCP connection 

only, or both. If either one is not included in the GCAS licence, the corresponding option group will be 

disabled on this form. 

For serial connection, add a pair of serial port (COM) and the Modbus protocol. You may add as many 

serial ports as you want, as long as your PC has enough number of serial ports. GCAS will attempt to 

request use of these ports to the operating system during Modbus server startup. The protocol selec-

tion offers ASCII protocol and RTU protocol. Different serial port may use different protocol, for ex-

ample, it is possible to set up COM1 using ASCII protocol but COM2 using RTU. 

Moving down, you see a standard serial port configuration such as baud rate, parity, data bits, and 

stop bits. These settings are used by all serial ports added to the list.  

For TCP connection, GCAS supports Modbus/TCP protocol only. Modbus RTU-over-TCP protocol is 

not supported. Configure the TCP port which GCAS has to listen to. The default port is 502. After-

wards, configure the IP binding. By default, GCAS binds all IP addresses on your PC (first option). If you 

like GCAS to listen on specific IP address, choose the second option and select the desired IP address. 

The problem on second option is when you move your PC to another network environment, its IP ad-

dress would change, thus you need to reconfigure this binding. 

If your PC is behind a router or firewall and you need to access GCAS data from another network, you 

have to configure the appropriate port forwarding on your router and allow that incoming connection 

at your firewall as well. Otherwise, GCAS data is only accessible by computers on the same subnet. 
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Note 

If you change these connection settings while Modbus server is running, you need to restart server in 

order to enforce the change. 

28.2.2 Register Length 

 

These radio buttons configure the bit length of Modbus registers. The default is 16 bits, adhering to 

the standard Modbus specification. GCAS supports 32-bit registers as well (known as Daniel/Enron ex-

tension), but input registers (3:XXXXX) are always 16-bit nevertheless. 

Warning 

Changing bit length would reset the instance definition. You need to reconfigure server instance defi-

nition and restart server. GCAS saves your instance definition to an XML file, and this XML contains 

two separate definitions for 16-bit and 32-bit mode. What we meant by the word "reset" was GCAS 

switches to the other definition group, leaving all the configuration for the previous bit length behind. 

If you changed back to the previous bit length and restarted server, your previous definitions would 

come back. 
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28.2.3 Byte Swapping 

 

GCAS uses little endian byte order. For data types requiring multi-registers such as 32-bit or 64-bit in-

tegers, GCAS uses lowest address to write the least significant word (or dword) then goes up to the 

highest address. For example, consider a 32-bit floating point number 94.575. In hexadecimal repre-

sentation, this number is 42BD2666. Assuming 16-bit Modbus, GCAS writes 0x2666 on the first reg-

ister followed by 0x42BD on the next address. 

If your Modbus master software or device operates on different byte ordering, you need to configure 

byte swapping here. Default setting keeps all byte swapping to don’t swap, but you are free to 

change swapping on each data type independently. 

Configure swapping for 16-bit integers, 32-bit integers, 64-bit integers, as well as 32-bit floating point 

and 64-bit floating point data. Under the radio buttons, GCAS provides text boxes to input some test 

values. Enter a test number, press Tab to move the focus out of the text box, and GCAS displays its 

hexadecimal representation followed by the final byte order according to the selected byte swap op-

tion. 

28.3 Server Instance Definition 

Server instance definition is a list of Modbus coil and register addresses, the purpose of each address, 

and all related properties of each address, for all configured slave IDs. GCAS reads this instance defini-

tion when Modbus server is starting up. Once the instance definition is successfully loaded, GCAS be-

gins a data refresh to fill the registers and coils with the right data. 
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Server instance definition is configured through Modbus Server Instance Editor form or through a 

separate utility called GCAS Modbus Server Instance Editor. This user manual doesn't cover GCAS Mod-

bus Server Instance Editor as this document is intended for GCAS only. 

28.3.1 The Modbus Server Instance Editor Form 

From GCAS main window, go to the Comms menu, choose Server Instance Definition, and select 

Edit in GCAS Desktop. 

 

 

GCAS supports up to 8 (eight) server instances. That means GCAS can act as a data provider with 8 

different slave IDs. Each instance is represented by a tab on this window. When you open Modbus 
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Server Instance Editor for the first time, there is only one tab (one server instance) with slave ID 1. You 

can easily add another server instance by clicking  Add instance on the tab header. Then GCAS will 

create another tab with a slave ID equal to the next number in sequential order. 

 

To delete a server instance, click  Remove instance on the toolbar of the desired tab. GCAS deletes 

the tab and all its contents after your confirmation, and the slave ID associated with that instance is 

now reusable on another tab. 

Note 

Server instance definitions are saved as an XML file in [installation directory]\Server-Con-

fig\[your username].xml. If you click  Remove instance all the way until no tab exists on this 

window and then click OK down there, GCAS deletes your XML file too. Hence your user account looks 

like never configured any server instance. 

Let’s take a closer look at the toolbar. 

 

Element Description 

Modbus slave ID Sets the slave ID of this instance. Slave ID is a number from 1 

to 255. Do not clash one slave ID to another. 
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Element Description 

New address Creates a new address (tile) on this instance. 

New address > Read/write bit Creates a new address for a read/write bit (coil). 

New address > Read-only bit Creates a new address for a read-only bit (input discrete). 

New address > Read-only regis-

ter 

Creates a new address for a read-only register (input register) 

New address > Read/write regis-

ter 

Creates a new address for a read/write register (holding reg-

ister) 

Delete addresses Deletes all selected tiles. 

Repeat action Creates a successive sequence of addresses based on what 

address is currently selected. Chapter 28.3.5 explains more 

about repeat action. 

Repeat action >  

Repeat this data source for all 

gases 

Creates a sequence of address having the same data source 

but for different gases. 

*Works only for certain data sources, e.g. raw RF data. 

Repeat action > 

Repeat this data source for all de-

vices 

Creates a sequence of address having the same data source 

but repeated for every selected device. 

Repeat action > 

Repeat all data sources for this 

device 

Creates a sequence of address having the same device but 

repeated for every selected data source. 

Repeat action > 

Repeat all data sources for all de-

vices 

The two previous submenus combined.  

Beware while using this shortcut because it may generate a 

large number of tiles on the UI and may exhaust the limit of 

window handles of this form (Win32 programming limitation). 

Repeat action > 

Repeat this hardcoded value 

Creates a sequence of address having “hardcoded value” as 

the data source and copies the said value to the new tiles. 

Undo Undoes your previous action. 

Redo Redoes your previous action. 

Sort If you have a jumbled arrangement of tiles, this button sorts 

your tiles based on their addresses. Children tiles are always 

keep intact with their parent tile. 

Renumber If you have a jumbled arrangement of tiles, this button re-

numbers all tiles (or all selected tiles) so they have sequential 

addresses. 

Remove instance Deletes this server instance. 

Remove instance > Remove in-

stance 

Deletes this server instance. 

Remove instance > Duplicate in-

stance 

Creates a new server instance and copies all tiles from this in-

stance to the new instance. It is faster than creating a new 

blank instance then recreating all tiles on that instance. 

Remove instance > Export regis-

ter address list 

Exports all addresses (tiles) defined on this server instance to 

an XML file. 

Remove instance > Import regis-

ter address list 

Reads the XML file generated by the previous submenu and 

recreates the tiles based on this file. If there are multiple in-

stances defined in the XML, GCAS asks which one. 
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Element Description 

Remove instance > Print register 

address list 

Sends a list of addresses plus their purposes and all related 

properties of this server instance to the printer. 

Remove instance > Print preview Generates a preview of what to be printed. 

Mark inactive Marks this server instance as inactive. Inactive server instance 

cannot be accessed through Modbus server engines, as if its 

slave ID does not exist. 

Select all Selects all tiles. 

Select all and all of its submenus Selects some tiles based on their category, their data sources, 

their devices, or unselects all tiles, or inverts selection. 

Colour by source Gives the tiles some background colours to distinguish one 

another based on their data sources. 

Colour by source > Colour by 

device 

Gives the tiles some background colours to distinguish one 

another based on their selected GC device. 

Colour by source > Define col-

ours 

Configures the colour palette for this colouring cosmetic. 

Hide children Hides all children tiles. You only see parent tiles which may 

make it easier to manage addresses, however the delete (×) 

button on the last child tile would be hidden too. 

28.3.2 Tile 

Modbus Server Instance Editor uses tiles to represent Modbus ad-

dresses. One tile is one address. On the left, we see a picture of an 

empty tile. A tile has address, data source, and up to three properties. 

Down here is a dissection of a tile into its parts. 

 

 

 

 

Address: Enter a number from 0 to 65535 in 

order to set the address of this tile. Delete button: Deletes this 

tile and all its children. 
Drag handle: Drag this tile 

from here and drop else-

where to rearrange. 

Absolute address 

Data source 

Property 1 

Property 2 

Property 3 
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Creating and deleting tiles 

To create a new tile, click New address on the toolbar and select which category. For example, try 

Read-only bit. An empty tile is created under "Read-only bits (Input discrete) 1:XXXXX". 

Next, select a data source from the dropdown list. After you select one, properties associated with this 

data source are unlocked. 

 

To delete a tile, click the delete button (×) at the top right corner of that tile. To delete a lot of tiles, it 

is quicker to select the tiles and hit Delete addresses on the toolbar. To select a tile, just click on the 

empty area of the tile. A thick border is rendered to indicate that the tile is selected. 

 

A bunch of selected tiles 
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Linked tiles 

For read/write and read-only bits, one tile is definitely one coil. But it is a different story for read/write 

and read-only registers. If a data type can fit into one register, that’s good, and one address (tile) is 

dedicated for that data. Unfortunately, many data types such as floating point and date-time do not fit 

into one register. They require a span of registers which is represented by a chain of tiles like this one. 

 

In this example, address 17 is the parent tile while address 18, 19, and 20 are its children tiles. 

Children tiles inherit properties from their parent, and a property change anywhere in this chain will 

propagate to other tiles. Selecting any of the tile will select the entire chain. Notice that you can set 

the address only at the parent tile. Children tiles update their addresses to keep them sequential. To 

rearrange this chain, start dragging from drag handle on the parent tile. By contrast, to delete a series 

of tiles, click delete button (×) on the last child tile. 

Some properties are configurable independently. For example, on data sources using “date/time ca-

nonical integer” type, the device and data type is linked across all tiles in this chain but the date/time 

part can be configured independently. This enables most users to use dd/mm/yyyy date format while 

providing US citizens option to use mm/dd/yyyy format. 

 

Purple: Linked properties, shared by all children tiles. 

Green: Property which is configurable independently. 

 

Rearrange tiles 

Rearranging tiles is performed through drag-drop operation. Drag a tile from its drag handle and 

drop on other tile to move it to the position before the target tile. Note that you can only drag a tile 

and drop it on the same category. For instance, you cannot move a tile under read/write bit section 

and drop it on read-only bit or read-only register section. 
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In the example above, the final address sequence will be 1, 2, 0, 3, 4, 5, 6, 7, and so forth. Don’t forget 

to renumber the addresses so they become ascending again. It doesn’t have to be sequential, although 

sequential is good, but more importantly it has to be ascending. As a shortcut, click Renumber on the 

toolbar. 

Dragging a chain of tiles is the same. Drag from the drag handle of the parent tile, and drop it else-

where as long as the drop target is in the same category. Instead of “1 move here”, GCAS displays the 

number of tiles to move such as “4 move here”. When you release the mouse button, the entire chain 

sit before the drop target tile. Children tiles are always tied to their parent. 

28.3.3 Data Types 

Before we talk about data source, let's talk about data types. GCAS supports one data type for coils 

and input discrete which is bit (because they contain single binary digit). For registers however, there 

are 10 data types—five numeric, and five for date/time. 

Numeric data types: 

Name Description Range 

Short Integer Signed 16-bit integer −32,768 

+32,767 

Integer Signed 32-bit integer −2,147,483,648 

+2,147,483,647 

Long integer Signed 64-bit integer − 9,223,372,036,854,775,808 

+ 9,223,372,036,854,775,807 

Single float 32-bit IEEE-754 floating point Max and min = ± 3.402823 × 1038 

Smallest nonzero =  ± 2-149 (≈ ±1.4 × 10-45) 

Typical precision = 7~8 decimal digits 

Special values = "Infinity", "-Infinity", "NaN" 

Double float 64-bit IEEE-754 floating point Max and min = ± 1.79769313486232 × 10308 

Smallest nonzero =  ± 2-1074 (≈ ±4.94 × 10-324) 

Typical precision = 14~15 decimal digits 

Special values = "Infinity", "-Infinity", "NaN" 
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Date/time data types: 

Name Description 

Date/time canonical 

int 

Date and time in canonical format (day, month, year, hour, minute). Each 

date part is put inside its own register; hence five registers are required. 

Each register is 16-bit integer, making them equivalent to five short inte-

gers in a row. 

You can configure the date part on each register, enabling alternative use 

of USA format (month-day-year-hour-minute) or east Asian format (year-

month-day-hour-minute). 

Date/time canonical 

float 

Date and time in canonical format (day, month, year, hour, minute). Each 

date part is put inside its: 

- own pair of registers in 16-bit standard Modbus, or  

- own register in 32-bit Modbus. 

Depending on the register bit length setting, this data type requires 10 

registers or 5 registers in a row. Each date part is 32-bit IEEE-754 floating 

point, making them equivalent to five single-float data in a row. 

You can configure the date part on each register or pair of registers, ena-

bling alternative use of USA format (month-day-year-hour-minute) or 

east Asian format (year-month-day-hour-minute). 

Date/time UNIX 32-bit A signed 32-bit integer that represents number of seconds elapsed since 

the UNIX epoch (1 January 1970 00:00:00 UTC). The date/time value is 

first converted to UTC time zone, and then counted down to new year 

midnight of 1 January 1970. Time zone conversion is based on the time 

zone setting on your computer. 

Caution: This data type will stop working after 19 January 2038. 

Google “year 2038 problem” for more information. 

 

Date/time UNIX 64-bit A signed 64-bit integer that represents number of seconds elapsed since 

the UNIX epoch (1 January 1970 00:00:00 UTC). The date/time value is 

first converted to UTC time zone, and then counted down to new year 

midnight of 1 January 1970. Time zone conversion is based on the time 

zone setting on your computer. 

Unlike its 32-bit counterpart, the 64-bit UNIX time will exhaust after the 

heat death of our universe. 

Date/time OLE auto-

mation format 

A 64-bit IEEE-754 floating point with two parts: The integer part repre-

sents the day elapsed since 30 December 1899 midnight, and the decimal 

part represents time of that day divided by 24. The OLE epoch is much 

earlier than the UNIX epoch. Also, the date/time value is not converted to 

UTC time zone beforehand.  

For example, 29 February 2016 06:10 AM is 42,429.2569444. 

42,429 is the number of days between 29 Feb. 2016 and 30 Dec. 1899; 

while 0.2569444 is 0.25 day (6 hours since midnight) + 0.0069444 day 

(10 minutes). 
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28.3.4 Data Source 

Data source defines the purpose of an address by designating which data to output at that address. 

Choose a data source from the dropdown list on a tile. Once you have chosen a source, the properties 

associated with this data source are unlocked. 

 

28.3.4.1 GC Data, Non-GC Data, and Computed Data 

Data sources are categorised into three: GC data, non-GC data, and computed. 

- GC data are data bound to a particular device. This includes health status, raw RF data, raw RT 

data, raw mole composition data, calibration certificates, uncertainty values, and many more. 

- Non-GC data are data not bound to any device. For example, a hardcoded value. Or generic 

MLC constraints. Current computer time. List of dashboard items. Those kinds of data. 

- Computed data encompass both mathematical and logic gate operations on one or two ex-

isting values. Thus, GCAS can provide precomputed values to your Modbus master software 

or device.  

For computed data, GCAS uses the term P and Q to represent the referenced coil or register address. 

For example, register address 140 is defined to output "P + Q" (register source no. 73) with the P set 

to 132 and Q set to 136. Therefore, GCAS takes whatever value already at address 132 and 136, sums 

them together, and outputs the sum value at address 140. 
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28.3.4.2 Coil Data Sources 

For coils, there are 27 data sources. 

No. Group Data source Class Description 

1 Alarm Health status GC 

data 

Outputs 1 if the health status of the selected GC device 

is red (unhealthy) or yellow (math error). 

2 Alarm Lowest R2 GC 

data 

Outputs 1 if the lowest of all R2 values of the selected 

GC device is below the threshold defined in its Analysis 

Parameter module and the rule for lowest R2 is enabled 

in Dashboard settings. 

3 Alarm First R2 GC 

data 

Outputs 1 if the first R2 value of the selected device is 

below the threshold defined in its Analysis Parameter 

module.  

“First” R2 means the first sequence of correlation calcu-

lation. For example, on Daniel C7+ devices, first R2 is 

calculated from C1-C2-C7 sequence. 

4 Alarm Second R2 GC 

data 

Outputs 1 if the second R2 value of the selected device 

is below the threshold defined in its Analysis Parameter 

module.  

“Second” R2 means the second sequence of correlation 

calculation. For example, on Daniel C7+ devices, sec-

ond R2 is calculated from C3-C4-C5-C6 sequence. 

5 Alarm Third R2 GC 

data 

Outputs 1 if the third R2 value of the selected device is 

below the threshold defined in its Analysis Parameter 

module. 

Some GC device types don’t have third R2 such as Dan-

iel C9+ and C10+. 

6 Alarm Fourth R2 GC 

data 

Outputs 1 if the fourth R2 value of the selected device 

is below the threshold defined in its Analysis Parameter 

module. 

At the time this document is written, no device type 

has fourth R2 sequence. Therefore, the fourth R2 value 

is always zero, which is definitely below the threshold, 

which in turn makes the coil always outputs 1. We pro-

vide this data source to prepare just in case there is a 

new device type definition in the future having four 

R2 sequences. 

7 Alarm Timestamp of 

last calibration 

data 

GC 

data 

Outputs 1 if the timestamp of last calibration record of 

the selected device exceeds the threshold defined in 

Dashboard settings and the rule for timestamp of last 

calibration record is enabled in Dashboard settings. 
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No. Group Data source Class Description 

8 Alarm Timestamp of 

last mole com-

position record 

GC 

data 

Outputs 1 if the timestamp of last mole composition 

record of the selected device exceeds the threshold 

defined in Dashboard settings and the rule for 

timestamp of last mole composition is enabled in 

Dashboard settings. 

This requires Live Data Analysis in GCAS licence. 

9 Alarm Uncertainty of 

CV 

GC 

data 

These are alarms for ISO 6976 uncertainties. 

They output 1 if the corresponding uncertainty value of 

the selected device is above the threshold defined in 

Dashboard settings and the rule for that uncertainty is 

turned on in Dashboard settings. 

These five require Uncertainty Calculation and ISO 

6976 Calculator in GCAS licence. 

 

10 Alarm Uncertainty of 

MW 

GC 

data 

11 Alarm Uncertainty of 

Wobbe index 

GC 

data 

12 Alarm Uncertainty of 

relative density 

(ISO 6976) 

GC 

data 

13 Alarm Uncertainty of 

standard den-

sity 

GC 

data 

14 Alarm Uncertainty of 

GHV 

GC 

data 

These are alarms for GPA 2172 uncertainties. They out-

put 1 if the corresponding uncertainty value of the se-

lected device is above the threshold defined in Dash-

board settings and the rule for that uncertainty is 

turned on in Dashboard settings. 

These three require Uncertainty Calculation and GPA 

2172 Calculator in GCAS licence. 

 

15 Alarm Uncertainty of 

compressibility 

GC 

data 

16 Alarm Uncertainty of 

relative density 

(GPA 2172) 

GC 

data 

17 Flag Last calibration 

is MLC 

GC 

data 

Outputs 1 if the last calibration record of the selected 

device is marked as multilevel-calibrated. 

This requires ISO 10723 in GCAS licence. 

 

18 Flag Last mole com-

position is MLC 

GC 

data 

Outputs 1 if the last mole composition record of the 

given stream number (configurable) of the selected de-

vice is marked as multilevel-calibrated. 

This requires Live Data Analysis and ISO 10723 in GCAS 

licence. 

19 Others Hardcoded 

value 

Non-

GC 

data 

Outputs a custom binary value. 

You set the value to 0 or 1, and it will stay like that. 

20 Others Flip-flop Non-

GC 

data 

Outputs a binary value that changes from 0 to 1 to 0 to 

1 and so forth every time GCAS receives a poll from 

Modbus master device.  

You set the initial value to 0 or 1, and then it will flip 

and flop continuously. 
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No. Group Data source Class Description 

21 Logic 

gate 

P and Q Com-

puted 

Outputs logic gate AND between coil P and Q. 

P Q Output 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

22 Logic 

gate 

P or Q Com-

puted 

Outputs logic gate OR between coil P and Q. 

P Q Output 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

23 Logic 

gate 

P xor Q Com-

puted 

Outputs logic gate XOR between coil P and Q. 

P Q Output 

0 0 0 

0 1 1 

1 0 1 

1 1 0 

24 Logic 

gate 

Not P Com-

puted 

Inverts the output of coil P. 

If P is 0, then the output is 1.  

If P is 1, then the output becomes 0. 

25 Logic 

gate 

P nand Q Com-

puted 

Outputs the logic gate NAND between coil P and Q. 

P Q Output 

0 0 1 

0 1 1 

1 0 1 

1 1 0 

26 Logic 

gate 

P nor Q Com-

puted 

Outputs the logic gate NOR between coil P and Q. 

P Q Output 

0 0 1 

0 1 0 

1 0 0 

1 1 0 

27 Logic 

gate 

P xnor Q Com-

puted 

Outputs the logic gate XNOR between coil P and Q. 

P Q Output 

0 0 1 

0 1 0 

1 0 0 

1 1 1 
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28.3.4.3 Register Data Sources 

For registers, there are 96 data sources. The table is too long (horizontally) to fit this paper in portrait 

orientation, therefore we will switch temporarily to landscape starting from the next page. 



Register data sources: 

No. Group Data source Class Description Available data types 

(bold = default) 

1 General Health status GC data Outputs the health status of the selected device. The output value follows 

a special convention. Read chapter 28.5 for more details. 

Short integer on 16-bit 

Integer on 32-bit 

2 General Device ID GC data Outputs the ID number of this GC device in GCAS database. Integer 

3 General Device type GC data Outputs the device type identifier of this device in GCAS database. The 

output value follows a special convention. Read chapter 28.5 for more de-

tails. 

Short integer on 16-bit 

Integer on 32-bit 

4 General Cycle time GC data Outputs the cycle time of this device as defined in Analysis Parameter. The 

cycle time is in seconds. 

Integer 

5 General Device-level MLC 

constraints 

(calibration) 

GC data Outputs the device-level override of MLC constraints for calibration rec-

ords. The output value follows a special convention. Read chapter 28.5 for 

more details. 

Short integer on 16-bit 

Integer on 32-bit 

6 General Device-level MLC 

constraints (mole) 

GC data Outputs the device-level override of MLC constraints for mole composi-

tion records. The output value follows a special convention. Read chapter 

28.5 for more details. 

Short integer on 16-bit 

Integer on 32-bit 

7 Raw data Response factor 

(single-point) 

GC data Outputs raw response factor value of the selected gas, of latest calibration 

record, of the selected device, converted to single-point. 

- Integer* 

- Long integer* 

- Single float 

8 Raw data Response factor 

(MLC) 

GC data Outputs raw response factor value of the selected gas, of latest calibration 

record, of the selected device, converted to multilevel-calibrated. 

This requires ISO 10723 in GCAS licence. If the record could not be con-

verted, this outputs zero. 

Single float 

*The value will be rounded. For integer type (32-bit), if the RF value exceeds 2,147,483,647, the output value will stay at 2,147,483,647. 
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No. Group Data source Class Description Available data types 

(bold = default) 

9 Raw data Response factor 

(exponential) 

GC data Outputs raw response factor value of the selected gas, of latest calibration 

record, of the selected device, converted to exponential. 

This data source works on ABB devices only. For all other device types, this 

outputs zero. 

Single float 

10 Raw data Retention time GC data Outputs raw retention time value, of the selected gas, of latest calibration 

record, of the selected device. 

- Short integer** 

- Integer** 

- Single float 

11 Raw data Mole composition 

(single-point) 

GC data Outputs raw mole composition value of the selected gas, of latest mole 

composition record, of the selected stream number, of the selected device, 

converted to single-point. 

This requires Live Data Analysis in GCAS licence. 

Single float 

12 Raw data Mole composition 

(MLC) 

GC data Outputs raw mole composition value of the selected gas, of latest mole 

composition record, of the selected stream number, of the selected device, 

converted to multilevel-calibrated. 

This requires Live Data Analysis and ISO 10723 in GCAS licence. 

If the record could not be converted, the output is zero. 

Single float 

13 Raw data Mole composition 

(exponential) 

GC data Outputs raw mole composition value of the selected gas, of latest mole 

composition record, of the selected stream number, of the selected device, 

converted to exponential. 

This data source works on ABB devices only. For all other device types, this 

outputs zero. 

Single float 

14 Raw data Stream number of 

last record 

GC data Outputs the stream number of latest mole composition record of the se-

lected device.  

This requires Live Data Analysis in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

**The value will be rounded; thus you shall lose the decimal part. 
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No. Group Data source Class Description Available data types 

(bold = default) 

15 Raw data Calibration certifi-

cate, mole% part 

GC data Outputs the raw mole percent part of the selected gas, of latest calibration 

gas certificate, of the selected device. 

This requires Calibration Gas Certificate feature in GCAS licence. 

- Single float 

- Double float 

16 Raw data Calibration certifi-

cate, absolute un-

certainty 

GC data Outputs the absolute uncertainty part (the plus-minus part) of the selected 

gas, of latest calibration gas certificate, of the selected device. 

This requires Calibration Gas Certificate feature in GCAS licence. 

- Single float 

- Double float 

17 Raw data Multiplier GC data Outputs raw multiplier value of the selected gas, of last calibration record, 

of the selected device. 

Only ABB devices have multiplier values. For all other device types, this 

outputs zero. 

- Single float 

- Double float 

18 Raw data Lag time GC data Outputs the total lag time in milliseconds. The lag time value is taken from 

the latest lag time calculation record. 

This requires Lag Time Calculator feature in GCAS licence. 

- Integer 

- Long integer 

- Single float 

- Double float 

19 Raw data Record-level MLC 

constraints 

(calibration) 

GC data Outputs the record-level override of MLC constraints that applies to the 

last calibration record. The output value follows a special convention. Read 

chapter 28.5 for more details. 

This requires ISO 10723 feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

20 Raw data Record-level MLC 

constraints (mole) 

GC data Outputs the record-level override of MLC constraints that applies to the 

last mole composition record. The output value follows a special conven-

tion. Read chapter 28.5 for more details. 

This requires ISO 10723 and Live Data Analysis feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

21 Correlation Lowest R2 GC data Outputs the lowest of all available R2 values calculated from the latest cali-

bration record of the selected device. 

- Single float 

- Double float 
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No. Group Data source Class Description Available data types 

(bold = default) 

22 Correlation First R2 GC data Outputs the first R2 value calculated from the latest calibration record of 

the selected device. 

"First" R2 means the first sequence of correlation calculation. For example, 

on Daniel C7+ devices, first R2 is computed from C1-C2-C7 sequence. 

- Single float 

- Double float 

23 Correlation Second R2 GC data Outputs the second R2 value calculated from the latest calibration record 

of the selected device. 

"Second" R2 means the second sequence of correlation calculation. For ex-

ample, on Daniel C7+ devices, second R2 is computed from C3-C4-C5-C6 

sequence. 

- Single float 

- Double float 

24 Correlation Third R2 GC data Outputs the third R2 value calculated from the latest calibration record of 

the selected device. 

"Third" R2 means the third sequence of correlation calculation. For exam-

ple, on Daniel C7+ devices, third R2 is computed from C1-C2-C3-C4-C5-

C6-C7 sequence. 

- Single float 

- Double float 

25 Correlation Fourth R2 GC data Outputs the fourth R2 value calculated from the latest calibration record of 

the selected device. 

At the time this document is written, no device type has fourth R2 se-

quence. Therefore, the fourth R2 value is always zero. We provide this data 

source to prepare just in case there is a new device type definition in the 

future having four R2 sequences. 

- Single float 

- Double float 

26 Correlation R2 assigned 

threshold 

GC data Outputs the R2 threshold defined for this device. If there is no threshold 

defined in Analysis Parameter, this will output the default value 0.995. 

- Single float 

- Double float 
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No. Group Data source Class Description Available data types 

(bold = default) 

27 Timestamp Last calibration 

date/time 

GC data Outputs the timestamp of last calibration record of the selected device. - Date/time  

canonical int 

- Date/time canonical 

float 

- Date/time UNIX  

32-bit 

- Date/time UNIX 

64-bit 

- Date/time OLE auto-

mation format 

28 Timestamp Last mole compo-

sition date/time 

GC data Outputs the timestamp of last mole composition record regardless of its 

stream number, of the selected device. 

This requires Live Data Analysis in GCAS licence. 

29 Timestamp Last certificate  

install date 

GC data Outputs the installation date of last calibration gas certificate of the se-

lected device. 

This requires Calibration Gas Certificate in GCAS licence. 

30 Timestamp Last lag time  

calculation date 

GC data Outputs the calculation date of last lag time record of the selected device. 

This requires Lag Time Calculator feature in GCAS licence. 

31 Timestamp Last uncertainty-

coefficient-set 

date 

GC data Outputs the timestamp of last uncertainty coefficient set of the selected 

device.  

This requires Uncertainty Calculation feature in GCAS licence. 

32 Timestamp Last MLC- 

coefficient-set 

date 

GC data Outputs the timestamp of last MLC coefficient set of the selected device. 

This requires ISO 10723 in GCAS licence. 

33 Coefficients Repeatability  

coefficient A 

GC data Outputs the coefficient a, b, c, or d of the repeatability coefficient part of 

the selected gas, of last uncertainty coefficient set, of the selected device. 

y = a + bx + cx2 + dx3. 

 

These require Uncertainty Calculation feature in GCAS licence. 

- Single float 

- Double float 

34 Coefficients Repeatability  

coefficient B 

GC data 

35 Coefficients Repeatability 

coefficient C 

GC data 

36 Coefficients Repeatability 

coefficient D 

GC data 



GCAS® Manual Guide rev. 26 

Page 465 of 587 

 

No. Group Data source Class Description Available data types 

(bold = default) 

37 Coefficients Response  

concentration  

coefficient A 

GC data Outputs the coefficient a, b, c, or d of the response concentration coeffi-

cient part of the selected gas, of last uncertainty coefficient set, of the se-

lected device. 

y = a + bx + cx2 + dx3. 

 

These require Uncertainty Calculation feature in GCAS licence. 

- Single float 

- Double float 

38 Coefficients Response 

concentration 

coefficient B 

GC data 

39 Coefficients Response 

concentration 

coefficient C 

GC data 

40 Coefficients Response 

concentration 

coefficient D 

GC data 

41 Coefficients MLC coefficient A GC data Outputs the coefficient a, b, c, or d of the selected gas, of the last MLC co-

efficient set, of the selected device. 

y = a + bx + cx2 + dx3. 

These require ISO 10723 feature in GCAS licence. 

- Single float 

- Double float 
42 Coefficients MLC coefficient B GC data 

43 Coefficients MLC coefficient C GC data 

44 Coefficients MLC coefficient D GC data 

45 Coefficients Coefficient-level 

MLC constraints 

(calibration) 

GC data Outputs the coefficient-level override of MLC constraints for calibration 

records. The output value follows a special convention. Read chapter 28.5 

for more details. 

This requires ISO 10723 feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

46 Coefficients Coefficient-level 

MLC constraints 

(mole) 

GC data Outputs the coefficient-level override of MLC constraints for mole compo-

sition records. The output value follows a special convention. Read chapter 

28.5 for more details. 

This requires ISO 10723 feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 
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No. Group Data source Class Description Available data types 

(bold = default) 

47 ISO 6976 

actual values 

Calorific value GC data Outputs the ISO 6976 calculation result which is based on the last mole 

composition record of the specified stream number, of the selected de-

vice. 

 

The units are: 

- Calorific value: MJ/m3 

- Molecular weight: g/mol 

- Standard density: kg/m3 

These six data sources require ISO 6976 Calculator feature in GCAS licence. 

- Single float 

- Double float 

48 ISO 6976 

actual values 

Molecular weight 

sum 

GC data 

49 ISO 6976  

actual values 

Wobbe index GC data 

50 ISO 6976  

actual values 

Relative density  GC data 

51 ISO 6976 

actual values 

Standard density GC data 

52 ISO 6976  

actual values 

Compressibility GC data 

53 GPA 2172 

actual values 

Gross heating 

value 

GC data Outputs the GPA 2172 calculation result which is based on the last mole 

composition record of the specified stream number, of the selected de-

vice. 

The units are: 

- Gross heating value: BTU/scf 

These three require GPA 2172 Calculator feature in GCAS licence. 

- Single float 

- Double float 

54 GPA 2172 

actual values 

Compressibility GC data 

55 GPA 2172 

actual values 

Relative density GC data 

56 ISO 6976 

uncertainties 

Uncertainty of CV GC data Outputs the uncertainty values of ISO 6976 properties. These uncertainty 

values can be expanded values (in percent) or absolute values (in each 

item's unit) depending on the configuration set in Dashboard settings. 

These five sources require Uncertainty Calculation and ISO 6976 Calculator 

in GCAS licence. 

- Single float 

- Double float 

57 ISO 6976 

uncertainties 

Uncertainty of 

MW 

GC data 
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(bold = default) 

58 ISO 6976 

uncertainties 

Uncertainty of 

Wobbe index 

GC data Outputs the uncertainty values of ISO 6976 properties of the selected de-

vice. These can be expanded values (in percent) or absolute values (in each 

item's unit) depending on the configuration set in Dashboard settings. 

These five sources require Uncertainty Calculation and ISO 6976 Calculator 

in GCAS licence. 

- Single float 

- Double float 

59 ISO 6976 

uncertainties 

Uncertainty of 

relative density 

(ISO 6976) 

GC data 

60 ISO 6976 

uncertainties 

Uncertainty of 

standard density 

GC data 

61 GPA 2172 

uncertainties 

Uncertainty of 

GHV 

GC data Outputs the uncertainty values of GPA 2172 properties of the selected de-

vice. These can be expanded values (in percent) or absolute values (in each 

item's unit) depending on the configuration set in Dashboard settings. 

These three sources require Uncertainty Calculation and GPA 2172 Calcu-

lator in GCAS licence. 

- Single float 

- Double float 

62 GPA 2172 

uncertainties 

Uncertainty of 

compressibility 

GC data 

63 GPA 2172 

uncertainties 

Uncertainty of 

relative density 

(GPA 2172) 

GC data 

64 Others Generic MLC  

constraints  

(calibration) 

Non-GC 

data 

Outputs the generic MLC constraints (lowest override level) for calibration 

records. The output value follows a special convention. Read chapter 28.5 

for more details. 

This requires ISO 10723 feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

65 Others Generic MLC  

constraints (mole) 

Non-GC 

data 

Outputs the generic MLC constraints (lowest override level) for mole com-

position records. The output value follows a special convention. Read 

chapter 28.5 for more details. 

This requires ISO 10723 feature in GCAS licence. 

Short integer on 16-bit 

Integer on 32-bit 

66 Others Hardcoded value Non-GC 

data 

Outputs a custom value. You need to set the data type and supply the 

value accordingly. 

All ten data types are 

available. The default is 

short integer. 
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(bold = default) 

67 Others Increasing  

number 

Non-GC 

data 

Outputs an integer that increases by 1 every time GCAS receives a poll 

from Modbus master device. You set the minimum and maximum value as 

a boundary. The number starts at the minimum value and it will increase 

by 1 on every poll, up to the set maximum value. Afterwards it shall wrap 

to the minimum value, starting over again. 

You can use increasing number, random number, or current computer 

time to verify that the current poll is different from the previous poll.  

- Short integer 

- Integer 

- Long integer 

68 Others Random number Non-GC 

data 

Outputs a random number, can be integer or float, that updates every 

time GCAS receives a poll from Modbus master device. You set the mini-

mum and maximum value as a boundary. The random number generator 

should produce numbers within this boundary. 

You can use increasing number, random number, or current computer 

time to verify that the current poll is different from the previous poll. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

69 Others Current computer 

time 

Non-GC 

data 

Outputs current computer time. It updates in real-time as the clock ticks. 

Register source 69 is computer time in local time zone, while register 

source 70 is computer time converted to UTC. 

You can use increasing number, random number, or current computer 

time to verify that the current poll is different from the previous poll. 

- Date/time  

canonical int 

- Date/time canonical 

float 

- Date/time UNIX  

32-bit 

- Date/time UNIX 

64-bit 

- Date/time OLE auto-

mation format 

70 Others Current computer 

time (UTC) 

Non-GC 

data 
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71 Others Offset from UTC Non-GC 

data 

Outputs how many minutes or hours your local time zone to the UTC is. 

If you select short integer data type or integer, it will output how many 

minutes. If you select single float, it will output how many hours.  

For instance, Darwin (Australia) is UTC+9:30. For short integer or integer, 

the output is 570 (= 9 × 60 + 30 minutes). For single float, the output is 

9.5. Places located at the west of meridian have negative output value. 

- Short integer 

- Integer 

- Single float 

72 Others Dashboard items Non-GC 

data 

Outputs the health status indicators shown on the Dashboard. The output 

value follows a special convention. Read chapter 28.5 for more details. 

Short integer on 16-bit 

Integer on 32-bit 

73 Maths P + Q Computed Takes the existing value of register P and Q, then outputs the value of  

P plus Q. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

74 Maths P − Q Computed Takes the existing value of register P and Q, then outputs the value of 

P minus Q. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

75 Maths P × Q Computed Takes the existing value of register P and Q, then outputs the value of 

P times Q. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

76 Maths P ÷ Q Computed Takes the existing value of register P and Q, then outputs the value of 

P divided by Q. This may result in decimal or floating-point number. 

- Single float 

- Double float 
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77 Maths P modulo Q Computed Takes the existing value of register P and Q, then outputs the remainder of 

P ÷ Q. 

For example, if register P contains value 17 and register Q contains value 

3, 17 modulo 3 yields 2. The closest multiple of 3 is 15, and then the gap 

from 15 to 17 is 2. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

78 Maths P ÷ Q, integer  

division 

Computed Takes the existing value of register P and Q, then outputs the value of P 

divided by Q and truncating the decimal part.  

For example, 17 ÷ 3 should return 5.6666…; but with integer division the 

result becomes 5. 

- Short integer 

- Integer 

- Long integer 

79 Maths P ^ Q Computed Takes the existing value of register P and Q, then outputs the value of 

P raised to the power Q. 

- Integer 

- Long integer 

- Single float 

- Double float 

80 Maths Logarithm P of 

base Q 

Computed Takes the existing value of register P and Q, then outputs the value of 

Q log P.  

- Single float 

- Double float 

81 Maths P + constant Computed Takes the existing value of register P and a constant k, then outputs the 

value of P plus k. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

82 Maths P – constant Computed Takes the existing value of register P and a constant k, then outputs the 

value of P minus k. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 
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83 Maths P × constant Computed Takes the existing value of register P and a constant k, then outputs the 

value of P times k. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

84 Maths P ÷ constant Computed Takes the existing value of register P and a constant k, then outputs the 

value of P divided by k. 

- Single float 

- Double float 

85 Maths P modulo con-

stant 

Computed Takes the existing value of register P and a constant k, then outputs the 

remainder of P ÷ k. 

- Short integer 

- Integer 

- Long integer 

- Single float 

- Double float 

86 Maths P ÷ constant,  

integer division 

Computed Takes the existing value of register P and a constant k, then outputs the 

value of P divided by k and truncates the decimal part. 

- Short integer 

- Integer 

- Long integer 

87 Maths P ^ constant Computed Takes the existing value of register P and a constant k, then outputs the 

value of P raised to the power k. 

- Integer 

- Long integer 

- Single float 

- Double float 

88 Maths eP Computed Takes the existing value of register P and outputs the value of constant e 

(2.78182…) raised to the power P. 

- Single float 

- Double float 

89 Maths Ln P Computed Takes the existing value of register P and outputs the value of natural log-

arithm (base e) of P. 

- Single float 

- Double float 

90 Maths Log P Computed Takes the existing value of register P and outputs the value of logarithm 

(base 10) of P. 

- Single float 

- Double float 
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91 Maths P << constant Computed Takes the existing value of register P and a constant k, converts P into its 

binary representation, then performs bit-shift on P to the left for k times. 

- Short integer 

- Integer 

- Long integer 

92 Maths P >> constant Computed Takes the existing value of register P and a constant k, converts P into its 

binary representation, then performs bit-shift on P to the right for k times. 

- Short integer 

- Integer 

- Long integer 

93 Bitwise P and Q Computed Performs bitwise-AND (logic gate AND on every binary digit) between the 

value of register P and Q. 

- Short integer 

- Integer 

- Long integer 

94 Bitwise P or Q Computed Performs bitwise-OR (logic gate OR on every binary digit) between the 

value of register P and Q. 

- Short integer 

- Integer 

- Long integer 

95 Bitwise P xor Q Computed Performs bitwise-XOR (logic gate XOR on every binary digit) between the 

value of register P and Q. 

- Short integer 

- Integer 

- Long integer 

96 Bitwise Not P Computed Takes the existing value of register P, converts P into its binary representa-

tion, then flips every bit from 0 to 1 or 1 to 0, and finally outputs it in deci-

mal representation. 

- Short integer 

- Integer 

- Long integer 

 



28.3.5 Repeat Action 

Repeat action is a shortcut on the toolbar of Modbus Server Instance Editor form to quickly define a 

series of addresses (tiles) based on the selected tile. You need to have one tile selected before open-

ing the Repeat action dropdown button on the toolbar. 

There are five repeat actions. Each of them is explained in their own subchapter. 

28.3.5.1 Repeat This Data Source for All Gases 

This repeat action is applicable if you select a register with data source demanding you to select a gas, 

which are these ones: 

- Raw data → Response factor (all three kinds) 

- Raw data → Retention time 

- Raw data → Mole composition (all three kinds) 

- Raw data → Calibration certificate (either part) 

- Raw data → ABB Multiplier 

- Coefficients → Repeatability coefficient A, B, C, D 

- Coefficients → Response concentration coefficient A, B, C, D 

- Coefficients → MLC coefficient A, B, C, D 

First, select a compatible tile. For example, the selected tile source is set to Response factor (single-

point), device set to DEMO1, and gas is set to Methane. Then click Repeat action on the toolbar and 

select Repeat this data source for all gases. The result is a series of tiles similar to this: 

[Response factor single-point, DEMO1, methane] 

[Response factor single-point, DEMO1, nitrogen] 

[Response factor single-point, DEMO1, carbon dioxide] 

[Response factor single-point, DEMO1, ethane] 

[Response factor single-point, DEMO1, propane] 

[Response factor single-point, DEMO1, i-butane] 

[Response factor single-point, DEMO1, n-butane] 

[Response factor single-point, DEMO1, neopentane] 

[Response factor single-point, DEMO1, i-pentane] 

[Response factor single-point, DEMO1, n-pentane] 

[Response factor single-point, DEMO1, hexane] 

[Response factor single-point, DEMO1, heptane] 

The exact result depends on the type of GC device set at the originating tile. Some devices don’t have 

neopentane, and some devices go full-range up to decane. Some read aromatic hydrocarbons, some 

have only one gas (repeat action doesn’t produce any new tile for single gas devices). 

If you repeat a mole composition tile, GCAS creates an additional tile at the tail of this series to ac-

commodate the unnormalised total. It is treated like a gas and appears on the dropdown list of gas 

selection property. 
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28.3.5.2 Repeat This Data Source for All Devices 

This action creates a series of tiles sharing the same data source, but each tile is set for different GC 

device. First click on any tile (coil or register will do) to make it selected. The tile has to have a data 

source selected already. Then click Repeat action button on the toolbar and choose Repeat this data 

source for all devices. GCAS presents this Repeat Action dialogue. 

 

Select all devices you want to include in the repeat loop. Then click Next to decide the order of these 

devices. Finally, click OK and enjoy. 
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28.3.5.3 Repeat All Data Sources for This Device 

This action is the opposite of the previous repeat action. This action creates a series of tiles sharing the 

same device but each tile is set for different data source. 

First, select a tile having any data source categorised as GC data. Then go to Repeat action on the 

toolbar and select Repeat all data sources for this device. GCAS presents the familiar Repeat Action 

dialogue but now it asks what data sources to include in the repeat loop. 

The screenshot here is for coils. For registers, 

it should display 63 register sources out of 

96, because non-GC data and computed data 

cannot be repeated this way. Click Next to 

continue defining data source order and click 

OK. 

 

 

 

 

 

 

There is a special case where you perform a 

repeat action on a register. During the first 

step of the wizard, you ticked at least one 

data source that requires gas, such as RF, RT, 

mole composition, certificate, or uncertainty 

coefficients. For that reason, GCAS includes 

two additional steps on this wizard: gas selec-

tion and gas order. This becomes step three 

and four—choose which gas to include in the 

repeat loop as well as their order. 
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28.3.5.4 Repeat All Data Sources for All Devices 

This action is combination of two previous repeat actions. This action creates a series of tiles consist-

ing of various data sources for a particular GC device, then this whole thing is looped for various GC 

devices. 

First, create an empty tile under desired category—read/write bits, read-only bits, read-only registers, 

or read/write registers. Why? Because GCAS needs to know whether you are repeating data sources 

for coils or registers, what data sources are available (coils and registers have different data sources), 

and to know where to put the resulting tiles. Click Repeat action on the toolbar and select Repeat all 

data sources for all devices. 

Step one of the wizard is to tick which GC 

devices to include in the repeat loop. Step 

two defines the order of the selected de-

vices. 

 

 

 

 

 

 

 

Step three is to define which data source 

to include in the repeat loop. Step four 

defines the order of these data sources. 

Finally, click OK and enjoy. 

 

 

There is a special case which is when you 

use this menu to create a series of register 

tiles and you ticked at least one data 

source on step three which involves gases. 

This includes RF, RT, mole composition, 

ABB multipliers, certificates, and coeffi-

cients. 
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Now we have two problems: 

1. These are data sources which can be defined for any gas. Which gas is it, or which gases are 

they? 

2. Suppose you want to repeat methane to hexane (total 12 gases). During step one of the wiz-

ard, you already ticked several GC devices. But some of these devices don’t have neopentane. 

What should GCAS do? 

For this special case, GCAS displays two additional steps: gas selection and gas order. This is step five 

and six of the wizard. Choose the gases to repeat and what to do if GCAS encounters mixed device 

types in which some types do not include some gases. 

 

Again, here we see methane is shared with benzene and “the gas”. Reason is because BTEX and single 

gas devices share the same database columns as regular GC devices. Anyway, on the right side there 

are three options. Choose the best one for you. 

• Exclude gases that are not always present from this list. This option hides gases that are 

not available on at least one selected device. For example, you ticked three devices: Daniel C7 

complete, Daniel C6 complete, and Daniel C6 without neopentane. The resulting set becomes: 

Methane, nitrogen, CO2, ethane, propane, isobutane, butane, isopentane, pentane, and hex-

ane. Here we don't see neopentane and heptane anymore. 

• Include those gases in this list; but if a device doesn't support that gas, do not create 

Modbus register for it. This option does not hide any gas; but when GCAS encounters a de-

vice not supporting a particular gas, that gas is skipped. 

• Include those gases in this list; but if a device doesn't support that gas, create Modbus 

register for it and leave its value zero. This option does not hide any gas; but when GCAS 

encounters a device not supporting a particular gas, GCAS creates a tile with the gas selection 

left empty. If you don't change the selected gas, the Modbus server will output zero. 
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28.3.5.5 Repeat This Hardcoded Value 

Chapter 28.3.5.1 to 28.3.5.4 dealt with data sources classified as GC data. For non-GC data, you can 

only repeat one data source in this category—the hardcoded value. Other non-GC data and computed 

data cannot be repeated. Why would you repeat registers outputting computer time, for instance? 

First, select a tile with data source set to hardcoded value. Then, go to Repeat action button on the 

toolbar and select Repeat this hardcoded value.  

 

Enter how many times you wish to repeat this value. For example, let’s repeat a hardcoded short inte-

ger register 4 more times. You get five hardcoded short integer tiles at the end: One original tile plus 

four new tiles. These new tiles copy their hardcoded value from the original tile. 

28.3.6 Address Clash 

When you are done defining addresses and their purposes, click OK at the bottom of Modbus Server 

Instance Editor form to save the instance definition. GCAS runs a check to ensure no address is used 

twice. On such cases, GCAS alerts you and renders dotted red border on the offending tiles. 

 

Address chain 2-3-4-5 is conflicting with the previous chain (address 1-2) because address 2 is already 

used. We need to renumber this chain to 3-4-5-6 in order to resolve the conflict. 

All conflicting addresses must be resolved before GCAS can save your instance definition. 
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28.4 Starting, Stopping, and Restarting Server 

Start Server 

If you ticked Run server at startup check box at Server Engine Settings dialogue, Modbus server en-

gine is already running by the time you log in to GCAS and after all the devices have been loaded 

from the database. Look for the status Server is running at the right corner of the status bar. 

If you unticked this option or has stopped the server previously, open the Comms menu and select  

Start Server. Alternatively, open Modbus Server Interface and find the  Start button at the top re-

gion. Note that you cannot run server if there are no server instance defined, or if all server instances 

are marked as inactive. 

 

Shortly after the server engine starts, you see a Modbus Server Data Refresh progress window near the 

bottom-right corner of GCAS work area. This small window reports the progress of data refresh. A 

data refresh is a process where GCAS queries the database and performs necessary calculations to fill 

all data tables (all server instances) with real data. Once data refresh finished, your Modbus master 

software or device should get the correct data. GCAS initiates data refresh either every time Dash-

board finished refreshing itself, or every certain period of time (default is every 30 minutes) depending 

on the configuration in server interface. 

You can cancel the data refresh if it takes too long and you need to work on something else. Cancel-

ling data refresh causes server instances to be partially updated, meaning some Modbus addresses 

still hold the old data. 
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Note 

We recommend disabling idle timer if you leave GCAS unattended while it is providing data to your 

Modbus master device. GCAS idle timer will shut down Modbus server when it's time to log you out. 

 

Stop Server 

To stop Modbus server, open the Comms menu and select  Stop Server. Alternatively, open Mod-

bus Server Interface and hit  Stop button (next to the  Start button). Please allow three seconds 

for the Modbus server module terminating all background threads gracefully. Once it stops, GCAS is no 

longer accepting Modbus commands issued by your Modbus master software or device. 

Note 

GCAS stops providing data when you log out.  

 

Restart Server 

In a similar manner, go to Comms menu and select  Restart Server. Or click  Restart button on 

the server interface. This action is equivalent to stopping the server, waiting 3 seconds, and starting 

the server again. Some occasions where you may have to restart Modbus server module are: 

- You changed the connection settings (added or removed some serial ports, or changed the IP 

binding) while Modbus server is running, 

- You changed the register bit length while Modbus server is running,  

- You edited the server instance definition while Modbus server is running, and 

- For some magical reasons, your Modbus master device received illegal state error 

(0x00000001) reply from GCAS. 

On the contrary, changing byte swap options in server engine settings does not require server restart. 

New swapping instructions apply immediately. 
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28.5 Output Values of Special Data Sources 

This chapter documents the values of some register data sources because their output values follow a 

special convention. 

28.5.1 Health Status (Register Source no. 1) 

These are possible output values of registers defined for GC health status. 

Value Equivalent Dashboard light Meaning 

0 Red Not healthy 

1 Green Healthy 

2 Yellow Math error or overflow (e.g. log 0 = −∞) 

4 White GC has no data 

8 Black Calculation is pending, or aborted, or no Dashboard 

rules are active. 

The reason why we use these values is because they are bit fields. Let’s examine the values in binary. 

Value 

 

In binary 

 

Error flags Value 

Equivalent  

Dashboard 

light 

 U
n
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o
w

n
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ta
te

 b
it
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o

-d
a
ta

 b
it

 

M
a
th

-e
rr

o
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b
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e
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0 0000 0 0 0 0 Red 

1 0001 0 0 0 1 Green 

2 0010 0 0 1 X Yellow 

4 0100 0 1 X X White 

8 1000 1 X X X Black 

X = "don’t care" as this bit should not be examined. 

28.5.2 Device Type (Register Source no. 3) 

These are possible output values of registers defined for GC device type. 

Value Meaning Value Meaning 

1 Daniel C6+ complete 4 Daniel C7+ without neopentane 

2 Daniel C6+ without neopentane 5 ABB C6+ complete 

3 Daniel C7+ complete 6 ABB C6+ without neopentane 
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Value Meaning Value Meaning 

7 ABB C7+ complete 24 Siemens C10+ without neopentane 

8 ABB C7+ without neopentane 25 Elster C6+ complete 

9 Daniel C9+ complete 26 Elster C6+ without neopentane 

10 Daniel C9+ without neopentane 27 Elster C7+ complete 

11 Daniel C10+ complete, type A 28 Elster C7+ without neopentane 

12 Daniel C10+ without neopentane, type A 29 Elster C9+ complete 

13 BTEX analyser 30 Elster C9+ without neopentane 

14 Single gas analyser 31 Elster C10+ complete 

15 LNG C2− 32 Elster C10+ without neopentane 

16 LNG C3− 33 H2S analyser 

17 Siemens C6+ complete 34 Moisture analyser (H2O) 

18 Siemens C6+ without neopentane 35 LNG C4− 

19 Siemens C7+ complete 36 LNG C5− complete 

20 Siemens C7+ without neopentane 37 LNG C5− without neopentane 

21 Siemens C9+ complete 38 Daniel C10+ complete, type B 

22 Siemens C9+ without neopentane 39 Daniel C10+ without neopentane, type B 

23 Siemens C10+ complete   

Why the numbers are not clustered sequentially, you may ask. It has something to do with history, as 

more and more GC device types became supported by GCAS as the software version goes up. That is 

why LNG C4 and C5 are separated from their cousins LNG C2 and C3. 

28.5.3 MLC Constraints (Register Source no. 5, 6, 19, 20, 45, 46, 64, and 65) 

This applies to: 

- Generic MLC constraints (register data source no. 64 and 65), 

- Device-level MLC constraints (register data source no. 5 and 6), 

- Coefficient-level MLC constraints (register data source no. 45 and 46), and 

- Record-level MLC constraints (register data source no. 19 and 20). 

To interpret the output of MLC constraints, you must read the value in hexadecimal base. MLC con-

straints are always provided as short integer (16-bit) and therefore will have four hexadecimal digits. 

On 32-bit Modbus, only the low 16 bits are used. The high word is zeroes and should be ignored. 

The hexadecimal digits read from left to right (most significant to least significant) will take the format 

of 0XYZ. First digit is zero and is safe to snub. The subsequent digits carry these meanings: 
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Hex digit Is the constraint for Value Meaning 

X Linear equation 1 Take the absolute value of the negative solution. 

2 Reject the negative solution and set the result zero. 

Y Quadratic equation 1 Take the smallest positive root. 

2 Take the largest positive root. 

Z 

 

on source 

no. 5, 19, 

45, and 

64 

Cubic equation 

when converting MLC 

response factors to 

single-point response 

factors 

1 Take the smallest positive root. 

2 Take the largest positive root. 

3 Take the first root that falls within the defined RF 

range. 

4 Take the root that falls within the defined RF range 

or the closest one to the RF range. 

Z 

 

on source 

no. 6, 20, 

46, and 

65 

Cubic equation 

when converting MLC 

mole composition to 

single-point mole 

composition 

1 Take the smallest positive root. 

2 Take the middle root if there are three positive 

roots, or take the smallest one if there are two. 

3 Take the middle root if there are three positive 

roots, or take the largest one if there are two. 

4 Take the largest positive root. 

A special value of −1 (in hexadecimal becomes 0xFFFF) means the MLC constraints at that level is not 

overridden. GCAS will fall back to one override level lower when converting MLC records to single-

point. 

For example, a register is defined to output device-level MLC constraints for calibration records (data 

source no. 5). At runtime, this register outputs 545 (decimal). Convert this into hexadecimal and you 

get 0x0221. Reading from left to right, we have: 

2 = For linear equation, reject any negative solution, 

2 = For quadratic equation, take the largest positive root, and 

1 = For cubic equation, take the smallest positive root. 

28.5.4 Dashboard Items (Register Source no. 72) 

Register data source number 72, the dashboard items, takes six sequential short integer registers. Each 

register may output one of these values. 

Value GC health status displayed at this Dashboard order position 

0 None (nothing is displayed at this position) 

1 Lowest R2 

2 Uncertainty of CV 
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Value GC health status displayed at this Dashboard order position 

4 Uncertainty of molecular weight sum 

8 Uncertainty of Wobbe index 

16 Uncertainty of relative density (ISO 6976) 

32 Uncertainty of standard density 

64 Timestamp of last calibration record 

128 Timestamp of last mole composition record 

256 Uncertainty of GHV 

512 Uncertainty of compressibility 

1024 Uncertainty of relative density (GPA 2172) 

2048 Unnormalised total of last mole composition record 

As you might have noticed, these values are also bit fields. If your Modbus master software or device 

wants to know what health statuses displayed altogether, simply OR-gate all six values. 

Value In hexadecimal In binary GC health status at this order position 

0 000  0000 0000 0000 None 

1 001 0000 0000 0001 Lowest R2 

2 002 0000 0000 0010 Uncertainty of CV 

4 004 0000 0000 0100 Uncertainty of molecular weight sum 

8 008 0000 0000 1000 Uncertainty of Wobbe index 

16 010 0000 0001 0000 Uncertainty of relative density (ISO 6976) 

32 020 0000 0010 0000 Uncertainty of standard density 

64 040 0000 0100 0000 Timestamp of last calibration record 

128 080 0000 1000 0000 Timestamp of last mole composition record 

256 100 0001 0000 0000 Uncertainty of GHV 

512 200 0010 0000 0000 Uncertainty of compressibility 

1024 400 0100 0000 0000 Uncertainty of relative density (GPA 2172) 

2048 800 1000 0000 0000 Unnormalised total of last mole composition 

record 

As an illustration, let's borrow a picture from chapter 17. 

 

https://en.wikipedia.org/wiki/OR_gate
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If the Dashboard module is configured that way and we define register address 20-25 to output dash-

board items with register data source no. 72, then these registers will output these values: 

Register address Output value Meaning 

20 1 Lowest R2 

21 2 Uncertainty of CV 

22 64 Timestamp of last calibration record 

23 128 Timestamp of last mole composition record 

24 0 Not used 

25 0 Not used 

28.6 Server Interface 

Modbus Server Interface is a window to display the actual values of all Modbus coils and registers be-

ing provided to the Modbus master software or device at present time. To open server interface, go to 

the Comms menu and select Server Interface or press Ctrl+I. 
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This is an example of Modbus Server Interface window while server engine is running. If server engine 

is not running, server interface shows you a blank (white) window. 

On the left side of server interface there are several check boxes and buttons to control Modbus 

server module. On the right side there are data grids containing the actual data being served by server 

engine. Data grids are contained in tabs, and one tab is one server instance (one slave ID). Let’s take a 

closer look to the left side. 

UI element Purpose 

 Start Starts Modbus server engine. 

 Stop Shuts down Modbus server engine. 

 Restart Restarts Modbus server engine. 

Layout Changes the layout of data grids on the right side. 

There are 8 layouts: 

1. Automatic: Server interface positions the grids according to their 

category and number of addresses in each. 

2. All four: All four grids are displayed in 2 x 2 formation. 

3. Read/write side-by-side: Read/write bits on the left, read/write 

registers on the right. 

4. Read-only side by side: Read-only bits on the left, read-only regis-

ters on the right. 

5. Read/write bits only: Displays read/write bits' grid only. 

6. Read-only bits only: And so do the remaining options. 

7. Read-only registers only 

8. Read/write registers only 

Linear view Switches all data grids to linear view. 

Table view Switches all data grids to table view. 
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UI element Purpose 

Show: Purpose On linear view, shows or hides the Purpose column. 

Show: Device On linear view, shows or hides the Device column. 

XX rows per column On table view, controls how many rows for each column. 

Display raw data Displays the data in raw format (checked) or canonical format (unchecked). 

Display raw data – 

Hexadecimal 

Displays the data in raw format using hexadecimal (base-16) digits. 

Display raw data – 

Decimal 

Displays the data in raw format using decimal (base-10) digits. 

Show absolute ad-

dress 

Displays the coil and register addresses in absolute address format 

(checked) or in zero-based format (unchecked). 

Show server log Shows or hides the server log. 

Show server inter-

face on startup 

Controls whether to automatically open this server interface window after 

you log in to GCAS. 

Detach from main 

window 

Detaches or attaches the server interface from GCAS main window. De-

tached window can be dragged outside of main window boundary and is 

probably useful if you have multiple displays. 

Auto refresh/recal-

culate 

Enables or disables automatic data refresh. Unticking this check box will 

stop the timer. 

 

Auto refresh/recalcu-

late >  

On dashboard re-

fresh 

Links Modbus server module to an existing Dashboard window so that data 

refresh is performed after Dashboard has finished refreshing. Only the left-

over tasks are performed, therefore it saves time. More about this on chap-

ter 28.6.2. 

Auto refresh/recalcu-

late > 

Every XX [minutes] 

Sets the automatic data refresh by timer, not by dependency to Dashboard 

window. You need to enter the value, select the time unit, and click Set to 

enforce the change. Minimum value is 5 minutes, and maximum value is 20 

days. More about this on chapter 28.6.2. 

 Refresh Initiates a manual data refresh. 

Manual data refresh does not affect automatic data refresh triggered by the 

timer. 

 Synchronise Synchronises what server interface window displays with the actual values 

on all server instances. To sum it up, 

1. Refresh = Refreshes all server instances + updates server interface, 

2. Synchronise = Only updates server interface window. 

 Edit values Enters edit mode. 

 Commit edit Commits all changes you made during edit mode. 

 Cancel edit Discards all changes and revert to the original values. 

Last refresh,  

Next refresh 

Displays information about the time of last data refresh and next automatic 

data refresh. 
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UI element Purpose 

Server information Displays all slave IDs, followed by all COM (serial) ports GCAS is using, as 

well the IP address and TCP port GCAS is listening to. 

28.6.1 Linear View vs. Table View 

This screenshot on the next page is server interface in linear view. It lists all addresses in a long vertical 

list that contains the address, purpose of the address, GC device, and the actual value. 

 

There is another view called table view. In table view, server interface focuses your view to the values 

only. Address is represented at the column header plus the offset written in the first column. While 

data grids in linear view grow downward, grids in table view propagate to the right. There is a control 

on the left side of server interface window to set how many rows per column before a new column is 

created to the right. 
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28.6.2 Data Refresh Schedule and Manual Refresh 

These options control the automatic data refresh. By default, 

GCAS refreshes all server instances every 30 minutes. 

The first option, On dashboard refresh, links Modbus server 

module with Dashboard. It causes Modbus server to wait for 

an open Dashboard window finishing its data refresh. Mod-

bus server copies all available data from Dashboard and then 

continues its own data refresh but only for the remaining 

data not served by the Dashboard.  

This Dashboard-Modbus server linkage saves time because 

the same data is not loaded twice (once by Dashboard, then 

by Modbus server). The downside is, Modbus server follows 

Dashboard's auto refresh schedule. Even dashboard's auto 

refresh could be disabled in Dashboard Settings form; which 

in turn, causes data refresh of Modbus server begins only af-

ter you click  Refresh button on Dashboard window. Addi-

tionally, if you close Dashboard while Modbus server is linked 

to Dashboard, Modbus server reverts back to timer mode 

(the second option). 

The second option utilises a timer. Modbus server sets the timer to the defined interval and starts data 

refresh when the countdown reaches zero. By this way, Modbus server does not have to wait for Dash-

board. However, it may happen that Dashboard finished its data refresh and few minutes afterward 
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the Modbus server data refresh begins, yet both of them load the same data. This option is best used 

if you don't plan to open Dashboard window at all. To change data refresh schedule, enter the num-

ber followed by time unit (minutes, hour) and click Set. Default setting is 30 minutes. The time of next 

data refresh is displayed under  Edit values button. 

To disable automatic data refresh, uncheck Auto refresh/recalculate box. This puts Modbus server 

module in manual refresh mode, for you need to click  Refresh button to commence another data 

refresh. 

28.6.3 Raw Data and Absolute Address 

Modbus Server Interface displays data in its canonical (human-readable) format. Therefore, any data 

requiring multiple registers are displayed in all part of the address chain. For example, take a look at 

read/write register address 3, 4, 5, and 6 on the screenshot down here. 

 

These four registers are defined to hold a double-float data (64-bit floating point). The value 16.7539 

is duplicated in these four addresses. Parent address is presented in black text while its children ad-

dresses are rendered in grey. But behind the screen, every register is only 16 bits long. This 64-bit rep-

resentation of 16.7539 must be broken down into four 16-bit words. To see the actual data in raw 

format, check Display raw data on the left side. Next, choose whether to use hexadecimal or decimal 

representation. Assuming hexadecimal is selected and byte swap option for 64-bit float was set to “no 

swap”, users should see 0x7454 on address 3, 0x9274 on address 4, 0xC0FF on address 5, and 

0x4030 on address 6. Combine these four together in little endian order (because no byte swap), we 

get 0x4030C0FF92747454 which is exactly the IEEE-754 representation of 16.7539. 
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Raw data view is useful to test whether the byte swapping configuration is correct. To verify, compare 

the hexadecimal displayed on the server interface to the hexadecimal received on your Modbus mas-

ter software or device. Screenshot above is an example of Modbus master simulator software polling 

data to GCAS. Data provided by GCAS and data actually received at Modbus master should be the 

same. 

You may notice a steady delay on registers outputting increasing number (register source no. 67) or 

random number (register source no. 68). The value received by your Modbus master device is not the 

one displayed at the server interface window. It seems to be off by one poll interval. The cause is, 

GCAS serves the existing value to your Modbus master device first, and then generating new value af-

terwards. When GCAS generates a new value, server interface picks up this new number and updates 

itself immediately, while your Modbus master device received the value before this one. 

Along with raw data, GCAS can display raw address (absolute address) too. Give a tick mark on Show 

absolute address on the left side of server interface window. 
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28.6.4 Edit Mode 

Edit mode is a way to edit (override) values of Modbus coils and registers. It is intended to edit registers 

or coils defined to provide hardcoded values, not to override data coming from GCAS database such as 

R2 values or ISO 6976 outputs. While technically you can edit register values of data coming from 

GCAS database, the edited values will again be replaced with real values from GCAS database upon 

next automatic data refresh. 

To enter edit mode, click  Edit values button. The grids turn orange on cells you can edit, while 

 Edit values button morphs into  Commit edit button. Navigate to the desired cell and hit F2. 

Change the value and press Enter. Proceed to edit other cells as required. 
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GCAS checks all new values against a standard validation algorithm. For example, if you are editing a 

date/time value on its 'month' part and you entered 15, this value will be rejected because there is no 

15th month on Gregorian calendar. If you try to edit some registers with output values are bound to 

follow special convention (see chapter 28.5), GCAS checks your edited value against the special con-

vention as well. 

Once everything is done, click  Commit edit. The new values are put inside the corresponding 

Modbus server instance data table. Next Modbus poll coming from your Modbus master software or 

device will see these new values immediately. Otherwise to cancel your edit, click  Cancel edit. 

Modbus Server Interface reverts all server instances to their original values. 

You cannot enter edit mode while the grids are showing raw data because this is dangerous. For ex-

ample, editing a floating-point in raw may result in invalid binary combination which yields a Not-a-

Number value (NaN). Modbus Server Interface disables Display raw data check box during edit mode. 

28.7 Data Provision Log 

Data provision log, or simply server log, records all activities the server engines and instances do. To 

access this log, fire up server interface window and check Show server log. 
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The log appears under the data grids. Click Pop out to separate window to separate the server log 

from the server interface window. Clear log deletes all log entries. Trim log deletes all logs except the 

latest 1000 entries. And finally Export log lets you save the server log to an HTML document. 
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29 Report 

Report is a module to bring what have been presented on GCAS—RF chart, RT chart, correlation, his-

torical data, uncertainty calculation, and so on—to physical papers.  

Note 

To use this feature, you need the GCAS feature Simple Report to be included in your GCAS licence. On 

top of that, you also need the corresponding GCAS feature to be able to print report items. For exam-

ple, you need Data Analysis to print trend charts. 

A simple report typically contains latest calibration data, latest footprint, historical RF trend, RF devia-

tion trend, RT trend, RT deviation trend, and correlation trend. Reports can also include uncertainty 

calculation and uncertainty trend. 

Report Wizard 

GCAS report is printed through the Report Wizard that is accessible through the Report menu on 

main menu bar. First, select a GC device on your device panel or recent device panel that you want to 

print. Next, go to the Report menu and select Generate Report. 

 

The Report wizard. 
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Hardware Requirements 

A printer that supports A4 paper. Even better if the printer is not monochrome. 

29.1 Overall Options 

The first wizard page specifies which items to be included in the printout. 

29.1.1 Items to Include  

 

Tick an item in this list to include that report item in the printout. Some items may be missing if you 

don't have certain GCAS feature in your licence. Trend charts require Data Analysis feature, Uncertainty 

calculation requires Uncertainty Calculation feature, and Uncertainty trend charts require Uncertainty 

Trend feature. 

• Summary table: A list of health status (pass or fail) of the device from every calibration record 

included in the selected date range. 

• Individual records: The detailed calibration record including RF chart, RT chart, RF-MW loga-

rithm chart, R2 values, health status, system diagnostic comments, and user comments. 

• Trend charts: The historical graph of calibration records of every gas as well as their deviation 

from the footprint; plus historical correlation values (R2 trend charts). 

• Uncertainty calculation: Uncertainty calculation result of the selected ISO 6976 outputs. Your GC 

device must have an active calibration gas certificate. 

• Uncertainty trend charts: Graph of uncertainty values over a specified time range. Your GC de-

vice must have an active calibration gas certificate as well as an active footprint record. 

Cover page is optional to print. Check Print cover page to include it in the printout. 

29.1.2 Uncertainty Results to Include 

If you checked Uncertainty calculation or Uncertainty trend charts in this list box, there are two ad-

ditional list of check boxes at the bottom of the wizard. 
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Note 

Items shown in these lists depend on the availability of ISO 6976 Calculator and GPA 2172 Calculator 

feature in your GCAS licence. Uncertainty of CV, MW, Wobbe index, relative density (ISO 6976), and 

standard density require ISO 6976 Calculator; while uncertainty of GHV, relative density (GPA 2172), 

and uncertainty of compressibility require GPA 2172 Calculator. 

 

These lists specify which uncertainty calculation tables to be included in the printout or which uncer-

tainty trend graphs to print. You can configure items for uncertainty calculation and uncertainty trend 

independently. By default, GCAS prints uncertainty of calorific value and standard density if ISO 6976 

Calculator is available; or uncertainty of gross heating value and compressibility if only GPA 2172 Cal-

culator is available. 

29.1.3 Date Range  

 

These date pickers set the range of calibration records to be included in the summary table, individual 

record pages, and trend charts. By default, the wizard prints the last 7 days. These date pickers do not 

set the date range to compute uncertainty or uncertainty trend. 

GCAS queries GCAS database to find out how many calibration records are there within this date 

range. The number of records are displayed below the date pickers to give you heads up about how 

many pages your printer will consume. 
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29.2 Individual Records 

 

If you ticked Individual records on the first wizard page, you should see this page upon clicking 

Next. The options here control which type (i.e. flag) of calibration records to print. 

• Footprint and calibration data: Include all records within the specified date range. 

• Footprint only: Skip regular calibration records, print footprints only. 

• Calibration data only: Skip footprint records, print the rest of calibration data. 

Every record consumes one A4 page (or more if there are system comments or user comments). Inac-

tive calibration records are not printed unless you tick Also print inactive records. If the GC device is 

configured to utilise multilevel-calibrated RF (ISO 10723), this wizard prints RF values converted to sin-

gle-point. And at last, for ABB devices, Report wizard prints single-point RF values instead of exponen-

tial RF. 
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29.3 Trend Chart Options 

 

This page contains options for trend charts if you ticked Trend charts on the first wizard page. Select 

which charts to be included in the printout. 

• Trends: This prints the actual RF and RT values over the specified date range. 

• Deviation trends: This prints the deviation of RF and RT values from the footprint. 

• Correlation trends: This prints the historical correlation (R2) values over time. 

Note 

You need the GCAS feature Data Analysis in your GCAS licence to print trend charts. 

The plot range of trend charts starts and ends at the timestamp specified by date range dropdowns 

on the first wizard page. To extend this range into earlier time, check Start from earlier date check 

box and specify the starting boundary using the date picker below it. Alternatively, you can use the 

timestamp of any earlier footprint through select from existing footprint link beneath the date 

picker. That link brings the familiar Select Record dialogue to choose the footprint record. 
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29.3.1 Deviation Reference 

 

By default, GCAS calculates calibration deviation to each record’s latest footprint, similar to the default 

RF/RT error trend calculation in Data Analysis.  

 

If you need to compare all calibration data in range to a specific footprint, select This footprint only 

to pin one particular footprint as comparison reference. Then, use the link under it to select the de-

sired footprint. 
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29.3.2 Mean and Standard Deviations 

 

Check Print mean and standard deviations to include the mean and standard deviation lines on the 

printed RF and RT charts, on both trend charts and error trend charts. The options are the same as 

mean and standard deviation calculation in Data Analysis. Rewind to chapter 10.4 for more infor-

mation. 

29.4 Uncertainty Calculation 

 

If you ticked Uncertainty Calculation on the first wizard page, you shall see this page at some point. 

In this page, you configure all input parameters for uncertainty calculation to print. For more detail 

about uncertainty calculation, jump back to chapter 11. 
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Note 

You need the GCAS feature Uncertainty Calculation to be included in your GCAS licence in order to 

print uncertainty calculation tables. 

29.4.1 Uncertainties to Include 

 

The list box Uncertainties to include controls which part of uncertainty calculation to include. Re-

member that the uncertainty value of each gas is calculated using this formula 

UGC = √ (Ucal gas)
2

+ (Urepeatability)
2

+ (Ureproducibility)
2
 

and by unticking one component, the corresponding uncertainty part under the square root is re-

garded as zero. 

The check box Calculate and print additional 30-day uncertainty creates another separate uncer-

tainty calculation in which the Ureproducibility component is calculated using a collection of calibration 

records down to 30 days before the last record. This record range is fixed. The result will be printed in 

separate tables with distinct titles. 

29.4.2 Calibration Certificate 

 

Uncertainty calculation requires a calibration gas certificate. During wizard startup, GCAS loaded the 

latest certificate for you. To select another certificate, click Change. The button brings the familiar Se-

lect Record dialogue. Pick the certificate from the displayed list or double click the list item. 

Note 

If there are no active calibration gas certificates for this GC device, both Uncertainty calculation and 

Uncertainty trend check box and associated options on the first Report wizard page will be disabled. 
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29.4.3 ISO 6976/GPA 2172 Calculation 

 

This section has two tabs. ISO 6976 tab sets the base pressure and combustion-metering temperature 

pair for ISO 6976 calculation. The default pressure is 1 atmospheric pressure (1.01325 bar) and default 

combustion-metering temperature pair is 15°C/15°C. GPA 2172 tab sets the reference pressure for 

GPA 2172 calculation. Tick Use ISO 6976 base pressure if you want to use the same pressure as in 

ISO 6976 tab. 

Either ISO or GPA standard carries a calculation uncertainty of 0.05% at k = 1. Head to the Miscellane-

ous section and find these check boxes. They control whether the 0.05% uncertainty should be in-

cluded in the calculation. By default, both check boxes are ticked. 

 

29.4.4 Uncertainty of GC Repeatability 

 

This section specifies all parameters for the calculation of uncertainty of GC repeatability and linearity. 

The device must have uncertainty coefficients available in GCAS database, otherwise you cannot tick 

Uncertainty of GC repeatability in the first place. If your device does not have uncertainty coefficients 

yet, use the Uncertainty Coefficients form to input a new set. 
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GCAS already loaded the last coefficient set before your selected calibration certificate. If you need to 

use another set, select an uncertainty coefficient set through the Change button. 

Next, choose one of the mole percentage range options. This mole range will affect the final Urepeatability 

value. 

• Universal: Every component has the same plus-minus range. The default is ±20%. 

• Individual: Every component has its own plus-minus range. Click Set range to enter these 

range values. 

• Manual: Explicitly set the lower and upper bound value of each component. Click Set range 

to enter the lower and upper bound. For comparison purpose, the initial mole composition 

from the selected calibration gas certificate is displayed in the second column. 

• Use ±2σ of mole composition records: The range is taken from twice standard deviations 

of mole composition records over the specified period of time, filtered to the specified 

stream number; as illustrated in this chart: 

 

The Largest component is balanced check box controls whether to treat the component having the 

largest percentage as balanced gas. It means the mole percentage value of said gas is replaced by 

100% minus the sum of all other components. This option is ignored if you chose Manual mole 

range. 
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29.4.5 Uncertainty of GC Reproducibility 

 

This section configures the required parameters for the calculation of uncertainty of GC reproducibil-

ity. First, select the footprint as starting reference. GCAS already loaded the latest footprint for you. If 

you want to start from another footprint, click Change footprint. 

Note 

It is not recommended to select a footprint that sits before the selected calibration certificate. 

Next, decide how many calibration data to include in the calculation. 

• Until GCAS bumps into next footprint: The selected footprint itself and all calibration data 

up to one last calibration before next footprint are included in the calculation of Ureproducibility. 

• Until today: The selected footprint itself and all calibration data including subsequent foot-

prints and all their calibration data afterwards, all the way to this very moment (i.e. current 

computer time) are included in the calculation of Ureproducibility. 

• Custom range: You can define arbitrary date range, or choose from which calibration record 

exactly to which calibration record that are included in the calculation of Ureproducibility. A  star 

symbol indicates a footprint. 
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29.5 Uncertainty Trend Charts 

 

If you ticked Uncertainty trend charts on the first wizard page, you should see this page before the 

wizard begin printing. This page configures all parameters for uncertainty trend chart generation. 

Most elements are similar to Uncertainty Trend form and the uncertainty calculation page of this wiz-

ard. This chapter explains only the UI elements that differ. If you need help for other UI elements not 

explained in this chapter, refer to chapter 13 Uncertainty trend as they are very similar. 

Note 

To print uncertainty trend charts, you need the GCAS feature Uncertainty Trend to be included in your 

GCAS licence. 

If no active calibration gas certificate is available for the device, you cannot tick Uncertainty trend 

charts on the first wizard page. 

29.5.1 Plot Range 
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Unlike the Uncertainty Trend form that uses date pickers, Report wizard requires you to specify the 

first and last record in order to define the plot range. Click Change button on either side to set the 

start and end record boundary of the plot range. A  star symbol on the subsequent Select Record 

dialogue indicates a footprint. 

29.5.2 Direction of Calculation 

 

Direction of calculation determines which calibration record to include in the calculation. Uncertainty 

calculation may go forward or backward. Consult chapter 13.2.6 Uncertainty trend direction for more 

detailed information. The HTML version of GCAS manual guide also includes some animations to help. 

To recap, forward direction means the trend starts at a footprint and heads forward, including more 

and more calibration records as time goes by. There is a minimum number of calibration records for 

the Report wizard to start graphing the uncertainty trend graph. You can also set whether the trend 

line resets at every footprint record found along the way, or keep going. 

Backward direction means for every calibration record C found in the plot range, the uncertainty is 

calculated from C minus x days to C, or C going x records backward then back to C. You can configure 

whether the backward travel stops if a footprint is encountered, or continues through. 

29.5.3 30-Day Uncertainty Trend 
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The Graph additional 30-day backward trend check box creates additional uncertainty trend calcu-

lation with predefined configuration: Backward direction of 30 days and trim at any footprint encoun-

tered. If Underlay this 30-day trend beneath the main chart is also checked, the additional trend 

line will be plotted in the same chart as the original uncertainty trend chart, with the original uncer-

tainty trend line is overlaid on top of the 30-day trend line. Otherwise, GCAS prints a separate chart for 

the additional trend chart. 

 

 

Example of 30-day backward trend (light blue) underlaid beneath the main uncertainty trend in forward 

direction (dark blue). 

29.5.4 ISO 6976/GPA 2172 Calculation 

This section looks different from what appeared in Uncertainty Trend form. Here, the Report Wizard 

separate the inputs into two tabs similar to the options for uncertainty calculation printout. 
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The ISO 6976 tab configures the base pressure and combustion-metering temperature pair for ISO 

6976 calculation. The GPA 2172 tab configures the reference pressure for GPA 2172 calculation with 

the default to 14.6959 psi (about 1 atm). Tick Use ISO base pressure to use the same pressure on 

both ISO 6976 and GPA 2172 calculation. 

Both ISO 6976 and GPA 2172 carry a standard measurement error of 0.05% at k = 1. Navigate to the 

Miscellaneous section and locate two check boxes that control whether these 0.05% uncertainties 

should be included in the calculation. By default, these two check boxes are ticked. 

 

29.6 Print Confirmation 

This is the last page of the Report wizard. The wizard lists what items to print so that you can review 

and go back if there are mistakes.  

 

If you opted to print Summary page, the summary page has the overall pass/fail status printed at the 

top of the page. This pass or fail status is solely determined by the correlation values (R2) of the last 

calibration record in the given date range. For devices without correlation values such as Siemens GCs 
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and BTEX devices, this pass or fail status is governed by whether the last calibration record occurs 

within 30 days before the report is printed, not by the end date of the date range.  

For any reason, you can override the pass/fail status of the summary page by ticking Override device 

health status and choose the desired status. We recommend inserting some pages manually, either 

from other printout or handwritten ones, explaining the reason and recommendation. 

 

When you are ready, click Print preview to get a preview or Print to send the report to the printer. 
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30 Batch Report 

Batch Report module enables you to generate report for multiple devices at once. It is like the Report 

wizard looped for many GC devices on one click.  

Note 

To use this feature, you need the GCAS feature Simple Report to be included in your GCAS licence. 

This is the same requirement as the original Report module. On top of that, you also need the corre-

sponding GCAS feature to be able to print report items. For example, you need Data Analysis to print 

trend charts. 

Batch Report module consists of two parts: the thing called batch report configuration and the Batch 

Report form itself. Batch report "configuration" stores all settings to generate a particular batch report; 

thus, you can have multiple configurations such as "monthly report", "weekly report", or "last 90-day 

report". One batch report configuration is stored as one XML file and this XML can be loaded anytime 

you need. On the other hand, the Batch Report form is the dialogue to select which GC devices to have 

reports generated, which batch report configuration to use, and which printer to use. 

30.1 The Batch Report Form 

Batch Report form is the main user interface of Batch Report module. To access this form, go to the 

Report menu on main menu bar and select Generate Batch Report. 

 

Devices to generate report of: This is a list of your GC devices. Tick the ones you want to include in 

the batch queue. 
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Batch report configuration: This lets you select which batch report configuration set to use. Click 

Browse to load a batch report configuration XML file; or click New configuration to create a new 

batch report configuration set. Clicking New configuration will bring the Batch Report Configuration 

form. 

Select a PDF writer or a printer: This dropdown lists available printers to output the generated re-

port. There are three kinds of printers in this list, each with different behaviour. 

1. Hardware printers 

All of your hardware (physical) printers should be on this list. Hardware printers simply print the 

report pages sequentially. One GC device report becomes one print job. You can see these print 

jobs in the printer queue on Windows control panel. If you are on Windows 7 or 8, using a hard-

ware printer is recommended. 

2. Third-party PDF printers or other virtual printers 

These "printers" generate files such as PDF or XPS document instead of physical papers. Some 

popular third-party options are CutePDF writer or Foxit PDF creator. The problem with most virtual 

printers is that they display a save dialogue before they write the file. As one device report be-

comes one print job, you will see multiple save dialogues popping up one after another. We do 

not recommend using this type of printer. 

3. Microsoft Print to PDF (Windows 10 only) 

Technically, Microsoft Print to PDF is still a virtual printer. But we can configure this virtual printer 

to output the PDF files to one folder and skip the save dialogues, thus no user intervention is re-

quired at all. When you select this printer, the Batch Report form displays an additional button 

called Select folder to choose where the PDF files will go to. Unfortunately, Microsoft Print to PDF 

is shipped with Windows 10 (or later) therefore Windows 7 and 8.1 users are out of luck. If you are 

using Windows 10, this is the most recommended printer to use. 

To configure the paper size, margins, and orientation, go to the File menu on main menu bar and se-

lect Page Setup. 

When you are ready, click the big button Generate reports down there. Batch Report module should 

start retrieving the required data from GCAS database and begin printing shortly thereafter. Note that 

depending on how big the data and how large the time range set in the batch report configuration, 

one GC device may produce hundreds of pages. If you are using a real physical printer, we recom-

mend setting either duplex printing to save paper or draft quality print to save ink. Set these as the 

default printer settings because GCAS does not show any additional Print dialogue. 

30.2 Batch Report Configuration 

Batch report configuration stores all settings to generate one report, then the same settings are re-

applied to the remaining GC devices in the batch queue. Imagine the regular Report wizard being 

saved as a profile and you can use the same profile on multiple devices. In practice, one batch report 

configuration is stored as one XML file. This makes it possible to have multiple configurations such as 

"monthly report", "weekly report", or "last 90-day report". Make sure to load the correct XML file on 

Batch Report form before you click Generate report button. 

http://www.cutepdf.com/Products/CutePDF/writer.asp
https://www.foxitsoftware.com/
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To create or edit a batch report configuration, use the Batch Report Configuration form. Use the Re-

port menu on main menu bar, then select Batch Report Configuration. 

30.2.1 The Batch Report Configuration Form 

 

The form is organised in five tabs. They are: 

1. Global options 

Determines what will be included in the report, which uncertainty calculation or trend to be 

printed, and whether 30-day uncertainty calculation or trend is included. 

2. Calibration records and performance history 

Configures options if you include individual calibration records and performance history (the sum-

mary table with pass/fail status on each row) in the printout. 

3. Calibration trends 

Configures options for RF/RT trend chart, RF/RT error trend chart, and R2 chart. 

4. Uncertainty calculation 

Configures options for uncertainty calculation. 

5. Uncertainty trend 

Configures options for uncertainty trend calculation and the plot range. 

To navigate between tabs, either click the tab header or use the Previous/Next button at the bottom-

right corner. 
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30.2.2 Specifying Time Range 

Batch Report module introduces a new method to specify start time and end time of a range, be it a 

range of individual calibration records, a range for calibration (RF/RT) trend, a range for correlation 

trend, a range for uncertainty trend calculation, or anything related. Why? Because it's all relative. We 

are talking about multiple GC devices to generate report of, each one has different calibration record 

dates, different footprint dates, and different certificate installation dates. Hence, we cannot simply set 

a start and end date and hope all GC devices in this batch report to have the same number of records 

in this fixed range—we can, actually, but that provides little use. In Batch Report module, start and end 

point are specified either as relative unit to footprint, as relative unit to a date/time point, or as fixed 

date/time values.  

30.2.2.1 End point 

Typically, human brains expect a range definition from a start to an end, not the other way around. 

Unfortunately, the internals of Batch Report module work in backward. It asks you to specify an end 

point of a range, and later on, asks for a start point relative to this end point. The UI still shows start 

and end date input picker in the correct order to make it easier for you. 

There are 7 types of end point specifier available: 

1. Now: The range ends at current computer time. 

 

 

2. Fixed date: The range ends at the specific date and time you enter. 
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3. Today: The range ends at today 00:00 midnight. 

 

 

4. Last day of previous month: The range ends on 28th, 29th, 30th, or 31st of the previous month, de-

pending on what month it was. 

 

 

5. Fixed interval: The range ends on x days before another reference point. 

 

 

6. Last record: The range ends at the last record of each GC device. 

 

 

7. n last records: The range ends at (n − 1)th latest record before another reference point. 
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Option 5 and 7 require another reference point. There are 4 types of reference point: 

1. Now: Current computer time. 

2. Today: This day at 00:00 midnight. 

3. Last day of previous month: Refers to the 28th, 29th, 30th, or 31st of the previous month, depend-

ing on what month it was. 

4. Fixed date: A custom date/time point. 

 

30.2.2.2 Start Point 

Start point is defined as a relative time or relative record count before the end point, except for "Fixed 

date" and "Today". There are 5 types of start point specifier available: 

1. Fixed date: The range begins at the specific date and time you enter. 

 

 

2. Today: The range begins at today 00:00 midnight. 

 

 

3. Fixed interval: The range begins on x days before the end point. 

 

 

4. Nearest footprint: The range begins on the latest footprint before the end point. 
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5. n last footprints: The range begins on the n-th latest footprints before the end point. The dia-

gram below shows example of 3 last footprints. 

 

 

30.2.3 Global Options Tab 

 

In this tab, you choose which parts to include in the report. Each part is represented as a check box, 

and they have additional settings in different tab. 

Cover page: Check to include cover page in the report. It has the device name, user name who creates 

the report, and creation date. Each GC device in the batch queue has its own cover page. 

Calibration records and performance history: 

• Health status page holds a summary of performance history, listing all calibration dates in 

the selected range and their pass/fail status. This is the same as the summary page on regular 

Report wizard. 
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• Individual calibration records: This prints the RF chart, RT chart, correlation charts, and user 

comments on each calibration record found in the defined range. 

Calibration trends: 

• Calibration trend and deviation trend: This prints the RF/RT values over time as well as 

RF/RT deviations from footprints over time. 

• Correlation (R2) trend: This prints the R2 values chronologically. 

Uncertainty calculation: 

• Uncertainty results to print: Choose which ISO 6976 or GPA 2172 uncertainties to print. By de-

fault, uncertainty of CV and standard density are ticked. 

• Print additional 30-day uncertainty calculation: This prints an extra uncertainty calculation 

result with Ureproducibility calculated from today minus 30 days. 

Uncertainty trend: 

• Uncertainty results to print: Choose which ISO 6976 or GPA 2172 uncertainty trends to print. 

• Print additional 30-day uncertainty trend graph: This prints an extra uncertainty trend 

graph with Ureproducibility calculated from today minus 30 days. 

• Print 30-day uncertainty trend in the same chart: If this is checked, the 30-day uncertainty 

lines would be printed under the main uncertainty trend lines. Otherwise, the 30-day uncer-

tainty chart would be printed separately. 

30.2.4 Calibration Records and Performance History Tab 

This tab is relevant if you ticked either check boxes under Calibration records and performance history 

section in Global options tab. 
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Start point, End point: These inputs configure the range of calibration records to grab from GCAS 

database. Refer to chapter 30.2.2 Specifying time range for more information about record range op-

tions. 

What record types to print: Tick whether to print calibration data only or with footprints included. If 

you tick neither of these two, GCAS assumes you tick both. 

Include inactive records: Tick this to include calibration records marked as inactive. If you don't, inac-

tive records are not printed in both summary table and individual RF/RT/R2 chart pages. 

30.2.5 Calibration Trends Tab 

This tab configures more options for RF and RT trend, if you include them under Calibration trends 

section in Global options tab. 
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Start point, End point: These inputs configure the range of calibration records to grab from GCAS 

database. Refer to chapter 30.2.2 Specifying time range for more information about record range op-

tions. 

Use individual calibration records range: If this is ticked, the range to generate RF/RT trend chart 

copies the one defined in the previous tab, on both start and end point. 

Use the end point of individual calibration records range: If this is ticked, the range to generate 

RF/RT trend chart goes from the start point defined in this tab to the end point defined in the previ-

ous tab. 

RF and RT charts to print: Tick which trend charts to print, whether the normal RF/RT historical val-

ues or the deviation from footprints. If you tick neither, Batch Report module assumes you tick both. 

Note that the option to print R2 charts is not here. It is in Global options tab. 

Calculate mean and ±2 standard deviation lines: Select this to print the mean and 2 standard devi-

ation lines below the RF/RT trend lines. Select one of the three option buttons to define how many 

records used to compute the mean and standard deviation. These three are the same options found in 

Data Analysis module. 
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30.2.6 Uncertainty Calculation Tab 

Oh boy, this tab is where the user interface starts to get complicated. This tab sets the advanced op-

tions for uncertainty calculation in case you ticked that part under Uncertainty calculation section in 

Global options tab. But fear not, this tab has some similar elements to that part of the regular Report 

wizard.  

 

First off, you don't see any option to choose which calibration certificate to use. Batch Report module 

always uses last certificate on each GC device. 

Uncertainties to include: Controls which components to include in the calculation. Unchecked com-

ponents are treated as zero. 

ISO 6976 calculation and GPA 2172 calculation sets the base pressure/reference pressure and com-

bustion-metering temperature pair for these calculation standards, as well as whether to include 

0.05% standard measurement error at the end. 

Uncertainty of GC repeatability section has options to select the desired mole composition plus-mi-

nus range of the calibration gas certificate in order to compute Urepeatability. The four options—universal, 

individual, manual, and standard deviation—are there, except for the standard deviation option there 

is a difference. We'll come back to that after the next paragraph. The check box Largest component 

is balanced adjusts the composition of the largest one to become (100 – the rest), therefore the sum 

would always be 100%. This option does not apply for manual percentage range. 
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Uncertainty of GC reproducibility section controls the range of calibration records used to calculate 

Ureproducibility. Refer to chapter 30.2.2 Specifying time range for more information about the start and 

end point specifier. 

Okay, now let's discuss things that are new to this tab. Inside Uncertainty of GC repeatability, on the 

±2 standard deviation mole range option, you need to specify the stream number of mole composi-

tion records as well as the range. There are two options to define the range. 

1. Use the range defined under uncertainty of GC reproducibility (see previous page, at the bottom). 

That implies take both the start point and end point of the range. 

 

2. Use the range defined under uncertainty of GC reproducibility but take the start point only. The 

end point is counted x days or x records after this start point. This option has a further selection 

for what GCAS should do in case the number of mole composition records is not enough.  

 

On "fail" cases, choose what GCAS should do. Note that these options would not affect the extra 

30-day uncertainty calculation in case you ticked it in Global options tab. 

a) Skip repeatability calculation causes GCAS to slap the final value zero to Urepeatability calcula-

tion of current GC device in queue, making it feels like Urepeatability was not ticked to begin with. 

b) Abort this uncertainty calculation causes GCAS to cancel all uncertainty calculation and thus 

no uncertainty tables are printed for current GC device in queue. 
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Inside Uncertainty of GC reproducibility, you have additional options to enforce calibration record 

policies. There are two options to enable if you require: 

1. Require minimum x days (or x records) of calibration data: Enforces there should be enough 

calibration records within the defined range. 

Choosing x days as the unit is useful to weed out high uncertainty due to insufficient number of 

records—for example, the range starts at last footprint and ends at today. Depending on where 

the last footprint is and what date today is, there can be less than x days' worth of calibration data 

which in turn causes uncertainty values to go high.  

 

Choosing x records as the unit is useful in case there were problems on data capture that might 

have caused calibration records stopped coming, thus the uncertainty values would be less valid. 

 

2. Require all calibration records in this range to have the same footprint: As it sounds, this en-

forces a policy that there should be only one footprint in the defined range. Different footprints 

usually tell us a story about different GC configuration therefore their Ureproducibility values should 

not mix. Do not enable this option if the start point of the range is set to "n last footprints" be-

cause you will have more than one footprints in the range. 

 

Next, choose what GCAS should do if you enable at least one of these options, and there are not 

enough calibration records to pass the policy check. 

1. Skip reproducibility calculation causes GCAS to stick the final value zero to Ureproducibility calcula-

tion of current GC device in queue, as if Ureproducibility was not ticked in the first place. 
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2. Abort this uncertainty calculation causes GCAS to cancel all uncertainty calculation altogether; 

therefore, no uncertainty tables are printed for current GC device in queue. 

Note that neither of the two actions above applies to the 30-day uncertainty calculation, if included. 

30.2.7 Uncertainty Trend Tab 

This tab controls the parameters and plot range for uncertainty trend charts, if you included Uncer-

tainty trends in the Global options tab. Most options here are very similar to Uncertainty calculation 

tab. 

 

Uncertainties to include set the uncertainty components to include in the calculation. ISO 6976 cal-

culation and GPA 2172 calculation set the base pressure and metering temperatures, while Print 

threshold line offers to draw a red line at the percentage mark of your choice. 

Inside Uncertainty of GC repeatability things are pretty much the same with similar section in Uncer-

tainty calculation tab—including the new options for ±2 standard deviation mole percentage range. 

Inside Plot range (which controls the range for Ureproducibility), pick a start point and end point of the 

range. These point specifiers follow the same convention as what has been explained in chapter 30.2.2 

Specifying time range. 
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There is only one additional optional policy for Ureproducibility, which is the option to enforce minimum 

number of days or records in the plot range. Uncertainty calculation tab offered two optional policies, 

but uncertainty trend calculation is highly likely to have multiple footprints inside the plot range. 

Hence, the second optional policy is not available. There are also two available actions in case the 

minimum number of calibration records is below the threshold: whether to Skip reproducibility cal-

culation (treat Ureproducibility as zero) or to Abort this uncertainty calculation—causing uncertainty 

trend charts not being printed for this GC device currently in queue. 

Scroll right to see options about calculation direction: 

 

Quick recap, calculation direction sets how many calibration records are retrieved to calculate Ureproduci-

bility at each calibration data point. Refer to chapter 13.2.6 Direction for more information about spe-

cific options on either direction. If you are reading this user manual on HTML version, there are anima-

tions to explain how uncertainty trend direction works. 
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31 Administrator Menu 

Administrator menu is available to GCAS administrators. Look for the "Administrator" menu on the 

menu bar of main user interface. Through this menu, GCAS administrators manage GCAS users, 

groups, and access control list. 

31.1 Manage Users 

Go to Administrator menu > Users. This menu displays the Users form which lists all GCAS users regis-

tered in this GCAS database. 

 

31.1.1 Create a New User 

Click New button on the toolbar. Define the new username and initial password. Choose a user type 

and user role, and finally enter the information for his or her user profile. Finally, click Save. 
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Note 

1. Username cannot contain spaces.  

2. Empty time zone information is replaced by the default Europe/London time zone. 

31.1.2 Edit an Existing User 

To edit a user, tick the user on the list and click the Edit button on the toolbar. Make changes as re-

quired then click Save. Otherwise click Reset to roll back to the previous user profile. 
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About reset password 

You cannot alter the user's password directly, but you can rather reset it to the default password 

"password" (all lowercase). Do this on an explicit request from the user himself to reset his password. 

To set user as inactive, edit the user and set his status as  Inactive. Alternatively, tick multiple users 

on the list then click  Set as Inactive button on the toolbar. Inactive users cannot log in to GCAS. 

To set the user back as active again, edit the user then set her status as  Active. Alternatively, tick 

multiple users on the list then click  Set as Active button on the toolbar. 

31.1.3 Delete Users 

To delete one or more users, tick the user(s) you want to delete on the list then click Delete button on 

the toolbar. 

Note 

You cannot delete yourself. Ask another GCAS administrator to delete your user account to do so. 
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Warning 

If the user being deleted is still logged in on another computer, deleting her account will cause errors 

on her computer. Make sure she has logged out beforehand. 

Deleting users will also delete all their comments in any footprint, calibration data, mole composition, 

calibration gas certificate, data analysis, uncertainty trend, ISO 6976/GPA 2172 trend, and repeatability 

test* records. If you need to preserve their comments, set them as inactive instead. 

*available only on GCAS Web version. 

31.2 Define New User Types and Roles 

Default installation of GCAS sets up three user types and six user roles. Should you need to create an-

other user type or user role, you would go to the Administrator menu > User Type and Role Defini-

tion. 

 

Click New to create one. Click an existing user type or role and you can rename it via Rename button 

or delete it through the Delete button. 

Note 

You cannot delete "System Administrator" user type and user role. 

You cannot delete a user type or role if there are users of this type or role. Change the user type or 

role of these users before deleting the type or role. 

Do not forget to assign menu permission for the new user type or action permission for the new user 

role, later. 
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31.3 Manage Groups 

Go to the Administrator menu > Groups and Workspaces to manage groups. This menu displays the 

Groups form which lists all groups registered in the GCAS database. Note that your GCAS user account 

may not have been assigned to all these groups even though you are a GCAS administrator. Click 

Show my groups on the toolbar to highlight which groups are assigned to your user account. 

 

Note 

The last column, Agreements, lists the number of agreements linked to the group. Agreements are no 

longer part of GCAS. However, the last column is preserved to maintain compatibility with older GCAS 

local-offline databases which were used before GCAS version 1.4. It will be gone in GCAS version 2 

where the database uses a completely new schema, and won’t be compatible with any GCAS 1.x data-

bases.  

Agreement column should contain 1 (one) for every row. If any other number appears here, that indi-

cates your offline database must be upgraded. Otherwise, you won't be able to delete the group. Con-

tact i-Vigilant customer support to upgrade your offline database or use the supplied GCAS database 

upgrade tool. 

31.3.1 Create, Edit, Delete Groups 

To create a new Group, click New on the toolbar. Enter the group name, followed by business infor-

mation of the company that is being represented by this new group. Finally, click Save. To edit a 

group, highlight the group on the list and then click Edit button on the toolbar. Similarly, to delete a 

group, highlight the group then click Delete. 

mailto:support@i-Vigilant.com
mailto:support@i-Vigilant.com
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Note 

Creating a group also creates one workspace within that group. The workspace has initially a same 

name as the group. 

After a new group has been created, your user account is automatically assigned to the new group. 

Head to chapter 31.4 Assign users into groups if you don’t like this assignment and to remove yourself 

from this group. 

31.3.2 Add, Edit, Delete Workspace within Groups 

To edit workspaces within a group, click on the workspace count of that group. 
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That button brings you to the Workspaces dialogue where you can manage workspaces for this group. 

 

To define a new workspace, click Add. Enter the name of this new workspace then click the  red ar-

row to commit. 
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Similarly, to rename a workspace you need to select the corresponding workspace on the list and then 

click Rename. Type the new name and press Enter on your keyboard to commit the change.  

 

To delete a workspace, click the corresponding workspace on the list and then click Delete. 

Note 

You cannot delete a workspace if there are devices assigned to this workspace. Move them into a dif-

ferent workspace or delete the devices before deleting a workspace. 

31.4 Assign Users into Groups 

To assign users into groups or remove users from groups, go to the Administrator menu > User-

Group Relationship. The menu takes you to the User-Group Relationship window. 

This form has two views: user view, and group view. Both carry the same information, but under differ-

ent focus. Switch to user view if you want to focus on the users, i.e. how many groups one user has. 

Switch to group view if you want to focus on the groups, that is, how many users one group has. 

Assigning and removing users or groups are conducted through drag-and-drop operations. Go to one 

of the oncoming subchapters to use the form using a particular view. 
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31.4.1 User View 

User view focuses on the users. You see how many groups each user has. 

Assign a group to a user: Drag the group from left pane to the user. 

 

Remove a group from a user: Drag the group under a user and put it on the trash bin. 
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31.4.2 Group View 

Group view focuses on the groups. You see how many users each group has. 

Move a user to a new group: Drag a user to the new group. In this example, we are moving User D 

to a new group. User D loses access to One group but is given access to Another another group. 

 

Assign a user to a new group while retaining the previous one: 

If you want to assign User D to both groups instead, hold the Ctrl key on your keyboard while drag-

ging her to the new group. User D retains access to One group while is also being assigned to Another 

another group. 
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Remove a user from a group: Drag the user under a group and put him on the trash bin icon. 
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Unassigned users: If you remove the same user from every group she had, she will appear on the list 

of unassigned users. 

 

Reassign an unassigned user to a group: To reassign an unassigned user back to a group, drag her 

to the desired group. 
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31.5 Menu Permissions 

Menu permissions are a part of access control list (ACL) that controls which menu is available to each 

user type. Go to the Administrator menu > Menu Permissions to show the Menu Permissions form. 

 

To grant or revoke permissions, tick or untick the corresponding check box. Administrator always has 

access to all menus. Click Save to enforce the change. If other GCAS users are currently logged in to 

GCAS database on other computers, the change will take effect on their user accounts after they log 

out or exit GCAS. 

31.6 Action Permissions 

In tandem with menu permissions, action permissions constitute the access control list (ACL). Action 

permissions control which action menus — and in some cases, actions in literal meaning itself — avail-

able to each user role. Go to Administrator menu > Action Permissions to bring forth the Action Per-

missions form. 
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Similar to menu permissions, tick the check box to grant permission or untick to revoke. Click Save to 

enforce the change. If other GCAS users are currently logged in to GCAS database on other comput-

ers, the change will take effect on their user accounts after they log out or exit GCAS.  
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32 Export Data 

GCAS can export a portion of GCAS database into several file formats for further analysis. Go to the 

File menu > Export Data and the Export Wizard window shall appear. If you don't see this menu, that 

means you do not have any GCAS feature related to data export in your GCAS licence.  

 

 

The Export Wizard. 

Note 

If you are working offline, only the data available in your temporary database—which is a subset of 

GCAS database—can be exported. If you choose to synchronise your data for the latest 6 months for 

instance, you cannot export data beyond 6 months ago. 
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32.1 Export to CSV 

This exporter module exports GCAS data into a standard comma-separated value (CSV) spreadsheet. 

The CSV file contains additional columns for extra information, but the sequence of columns is ar-

ranged in such a way so that you can copy and paste them into new CSV file for re-import, starting at 

column C. Even more, record timestamps of the output CSV file are matched with device date format 

(mostly mm/dd/yyyy) therefore the CSV file—starting at column C— conforms to the CSV template of 

both calibration data import and mole composition import. 

Choose Export to CSV to begin. 

Note 

You need the GCAS feature Export to CSV to be included in your GCAS licence in order to use this fea-

ture. 
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Tick all GC devices you would like to have their data exported. 

 

Choose which data to export and the date/time range. 

 

If you tick Mole compositions, there is an option to limit which streams to export. The default option 

is Export all streams. To export certain streams, change to Only these streams and put the desired 

stream numbers in the available box. Conversely to exclude certain streams from the export, change 
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to Except these streams and input the stream numbers. Separate stream numbers by comma, for ex-

ample 1, 2, 4. You can use hyphen to create range such as 1-3, S. Here, the letter S stands for 

spot samples. The mathematical operator <, >, <= or ≤, and >= or ≥ are accepted too, so you can 

write something like "1, 2, > 4, <= 12" to create a range. An open range looks like "< 4, 

> 7". A closed range goes similar to ">= 4, < 10". Only one range is supported, either open or 

closed, so you cannot enter something like "> 3, < 6, >= 12, <= 18" which has two closed 

ranges. 

Moving down, the check box Always include latest calib certificate ensures the latest calibration gas 

certificate of every selected device is exported, even though you didn't tick Calibration certificates to 

export, or even though you ticked it but the latest certificate is outside of date range. We recommend 

ticking this box if you are going to re-import the CSV file and compute uncertainties on its data. 

On the right side, there are date pickers to set the date range. Under those, there is a check box Also 

include records marked as inactive. This check box causes every inactive record within the set date 

range is exported along with all active records. 

CSV exporter supports record conversion on calibration records and mole composition records. If you 

ticked Footprint and calibration data to export, you should see a list of check boxes titled Export RF 

as. Similarly, if you ticked Mole compositions to export, the list Export MC as should appear. Here 

you can set whether the RF values or mole composition values should be converted into one or more 

record types. Ticking Original will export calibration data or mole composition records as they are, no 

conversion performed. The option Single point and MLC (multilevel-calibrated) requires GCAS fea-

ture ISO 10723 in your licence. The last option, Exponential, is applicable to ABB devices only. 

Next step, set the destination CSV file. 
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Review the export settings, and click Next to begin the export process. 

 

GCAS commences the export operation. For CSV export, this step is typically very fast — unless the 

number of records to export is way too many. If you are using i-Vigilant central database or local cor-

porate database, the process of loading MLC and exponential conversion prerequisites may take a bit 

longer depending on your network connection. 
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This wizard page confirms that the export has been successful. You can now open the CSV file. 

 

A quick note if you open the CSV file using Microsoft Excel. Excel tends to truncate large number into 

scientific notation up to 2 decimal place (the number of decimal place follows the regional settings on 

your Windows Control Panel). This truncation may lead to large rounding error and is permanent. 

As soon as you notice this Excel evildoing, change the number format for the selected cells to general 

numeric format before you save the file. 
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32.2 Copy to Microsoft Excel 

This exporter module opens a new Microsoft Excel worksheet, formats the worksheet, and writes data 

to it. The process is much slower compared to other exporter module, so it is suitable for small num-

ber of records. But the upside is that the sheet is formatted and pretty. The process is faster if Mi-

crosoft Excel window is minimised while export is in progress. Anyway, choose Copy to Excel to 

begin. 

Note 

You need the GCAS feature Export to Microsoft Office to be included in your GCAS licence in order to 

use this feature. 

Moreover, this exporter also requires Microsoft Excel 2010, 2013, 2016, or later to be installed on your 

computer. Running this export module without Excel installed will raise an error. 
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Tick all GC devices you would like to have their data exported. 

 

Choose which data to export and the date/time range. 

 

If you tick Mole compositions, there is an option to limit which streams to export. The default option 

is Export all streams. To export certain streams, change to Only these streams and put the desired 

stream numbers in the available box. Conversely to exclude certain streams from the export, change 
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to Except these streams and input the stream numbers. Separate the stream numbers by comma, for 

example 1, 2, 4. You can use hyphen to create range such as 1-3, S. Here, the letter S stands for 

spot samples. The mathematical operator <, >, <= or ≤, and >= or ≥ are accepted too, so you can 

write something like "1, 2, > 4, <= 12" to create a range. An open range looks like "< 4, 

> 7". A closed range goes similar to ">= 4, < 10". Only one range is supported, either open or 

closed, so you cannot enter something like "> 3, < 6, >= 12, <= 18" which has two closed 

ranges. 

Moving down, the check box Always include latest calib certificate ensures the latest calibration gas 

certificate of every selected device is exported, even though you didn't tick Calibration certificates to 

export, or even though you ticked it but the latest certificate is outside of date range. 

On the right side, there are date pickers to set the date range. Under those, there is a check box Also 

include records marked as inactive. This check box causes every inactive record within the set date 

range is exported along with all active records. 

Excel exporter supports record conversion on calibration records and mole composition records. If you 

ticked Footprint and calibration data to export, you should see a list of check boxes titled Export RF 

as. Similarly, if you ticked Mole compositions to export, the list Export MC as should appear. Here 

you can set whether the RF values or mole composition values should be converted into one or more 

record types. Ticking Original will export calibration data or mole composition records as they are, no 

conversion performed. The option Single point and MLC (multilevel-calibrated) requires GCAS fea-

ture ISO 10723 in your licence. The last option, Exponential, is applicable to ABB devices only. 

Click Next. Unlike other export modules, you don't set the output file. It goes straight to review page. 
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Click Next again to commence the export operation. On this screen you should see a new window of 

Microsoft Excel opening (possibly minimised in background). If you switch to that Microsoft Excel win-

dow, you see GCAS data is being written to the worksheet. Better keep that Excel window minimised 

in order to speed up the writing process until the wizard finishes. 

 

For large number of records, the process may take a prolonged time. Do not close Microsoft Excel un-

til GCAS display this final wizard page. To abort, click Cancel on the wizard instead. 

 



GCAS® Manual Guide rev. 26 

Page 550 of 587 

 

This is an example Microsoft Excel worksheet after export process is finished. 

 

32.3 Export to Microsoft Access 

This exporter module exports GCAS data to Microsoft Access database file (.accdb). Unlike the SQL 

Compact export, the export result is not a GCAS database thus you cannot use it as "local offline" data-

base. The export result is a simple Microsoft Access database intended for further analysis. 

Note 

You need the GCAS feature Export to Microsoft Office to be included in your GCAS licence in order to 

use this feature. Additionally, this exporter also requires just one of these… 

- Microsoft Access 2010, 

- Microsoft Access Database Engine 2010, 

- Microsoft Access 2013 32-bit, 

- Microsoft Access Runtime 2013 32-bit (the 64-bit won’t work), 

- Microsoft Access 2016 32-bit, or 

- Microsoft Access Runtime 2016 32-bit (the 64-bit won't work) 

…to be installed on your computer.  

There are some limitations on Microsoft Access export. First, spot samples will appear as normal mole 

composition records with stream number −1 (negative one). Second, some database columns are 

shared. For example, you see "RF_Methane_Benzene_TheGas" instead of just "RF_Methane". Regular 

GC devices use this column to store methane, but BTEX devices use this to store benzene.  
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Choose Export to MS Access to begin. 

 

 

Tick all GC devices you would like to have their data exported. 
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Choose which data to export and the date/time range. 

 

If you tick Mole compositions, there is an option to limit which streams to export. The default option 

is Export all streams. To export certain streams, change to Only these streams and put the desired 

stream numbers in the available box. Conversely to exclude certain streams from the export, change 

to Except these streams and input the stream numbers. Separate the stream numbers by comma, for 

example 1, 2, 4. You can use hyphen to create range such as 1-3, S. Here, the letter S stands for 

spot samples. The mathematical operator <, >, <= or ≤, and >= or ≥ are accepted too, so you can 

write something like "1, 2, > 4, <= 12" to create a range. An open range looks like "< 4, 

> 7". A closed range goes similar to ">= 4, < 10". Only one range is supported, either open or 

closed, so you cannot enter something like "> 3, < 6, >= 12, <= 18" which has two closed 

ranges. 

Moving down, the check box Always include latest calib certificate ensures the latest calibration gas 

certificate of every selected device is exported, even though you didn't tick Calibration certificates to 

export, or even though you ticked it but the latest certificate is outside of date range. On Microsoft 

Access exporter, this check box is ticked by default. 

On the right side, there are date pickers to set the date range. Under those, there is a check box Also 

include records marked as inactive. This check box causes every inactive record within the set date 

range is exported along with all active records. 
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Next, set the destination Access database file. 

 

 

Review the export settings, then click Next to begin the export process. 
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GCAS commences the export operation. 

 

 

This wizard page confirms that the export has been successful. You can now open the ACCDB file. 
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Here is an example of export result Microsoft Access database file. 

 

Note 

If you opted to export uncertainty coefficients or MLC coefficients, the coefficients are stored in two 

separate tables: UncertaintyCoefficients and UncertaintyCoefficients_Details for uncertainty, or Multi-

levelCoefficients and MultilevelCoefficients_Details for multilevel calibration. 

The table UncertaintyCoefficients and MultilevelCoefficients store the principal metadata of the coeffi-

cient sets while UncertaintyCoefficients_Details and MultilevelCoefficients_Detail table contain the ac-

tual coefficients.  

You only need to open UncertaintyCoefficients table because UncertaintyCoefficients_Details is already 

linked to this table. Rep stands for repeatability coefficient, while Rcc means response concentration 

coefficient. Likewise, you need to open MultilevelCoefficients, not the _Details one. 
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32.4 Export to Microsoft SQL Server Compact Database 

This exporter module exports GCAS data to Microsoft SQL Server Compact Edition database file (.sdf). 

The export result is a complete GCAS database thus you can use it as a "local offline" database.  

Note 

You need the GCAS feature Export to Microsoft SQL Server Compact Edition to be included in your 

GCAS licence in order to use this feature. Additionally, make sure that Microsoft SQL Server Compact 

Edition v4.0 has been installed on your computer (it is already a pre-requisite anyway). Otherwise, the 

Export Wizard will raise an error. 

What included in the export result will be: 

1. The information about of the selected devices in wizard step 1, 

2. The agreement records for these devices, 

3. Analysis parameter of these devices, 

4. Footprint and calibration data of these devices (if selected in wizard step 2) *, 

5. Multiplier values of these devices (if selected in wizard step 2 and if the selected device list 

has ABB devices in it) *, 

6. Mole composition data of these devices (if selected in wizard step 2) *, 

7. Calibration gas certificates of these devices (if selected in wizard step 2) *, 

8. Uncertainty coefficients of these devices (if selected in wizard step 2) *, 

9. Multilevel calibration coefficients of these devices (if selected in wizard step 2) *, 

10. Lag time records of these devices (if selected in wizard step 2) *, 

11. Comments for these devices (if selected in wizard step 2) *, 

12. The groups to which these devices belong, 

13. The workspaces belong to these groups, 

14. Login data of all users who joined these groups (yes, they can log in to the exported database 

file too), 

15. User profile data of all users who joined these groups, 

16. All user types and roles including custom ones, 

17. All menu permissions and action permissions. 

*within the selected date range. 

Choose Export to SQL Compact to begin. You cannot export to SQL Compact when you are working 

offline because database structure of full database and temporary database are different. 
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Tick all GC devices you would like to have their data exported. 
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Choose which data to export and the date/time range. 

 

If you tick Mole compositions, there is an option to limit which streams to export. The default option 

is Export all streams. To export certain streams, change to Only these streams and put the desired 

stream numbers in the available box. Conversely to exclude certain streams from the export, change 

to Except these streams and input the stream numbers. Separate the stream numbers by comma, for 

example 1, 2, 4. You can use hyphen to create range such as 1-3, S. Here, the letter S stands for 

spot samples. The mathematical operator <, >, <= or ≤, and >= or ≥ are accepted too, so you can 

write something like "1, 2, > 4, <= 12" to create a range. An open range looks like "< 4, 

> 7". A closed range goes similar to ">= 4, < 10". Only one range is supported, either open or 

closed, so you cannot enter something like "> 3, < 6, >= 12, <= 18" which has two closed 

ranges. 

Moving down, the check box Always include latest calib certificate ensures the latest calibration gas 

certificate of every selected device is exported, even though you didn't tick Calibration certificates to 

export, or even though you ticked it but the latest certificate is outside of date range. We strongly rec-

ommend to tick this box as a lot of times customers send their exported database to us for analysis 

but because the certificates are out of date range, we could not compute uncertainty values or con-

vert multilevel-calibrated records to single-point. P.S: Unique to SQL compact export, this check box 

also forces latest MLC coefficient set of every selected device to be included in the export. 

On the right side, there are date pickers to set the date range. Under those, there is a check box Also 

include records marked as inactive. This check box causes every inactive record within the set date 

range is exported along with all active records. 
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Set the destination database file. 

 

 

Review the export settings, and click Next to begin the export process. 
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GCAS commences the export operation. 

 

 

This wizard page confirms that the export has been successful. Click Finish to close the wizard. 
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In order to verify the export result, try changing database to the SDF file. Use local offline option, 

choose Microsoft SQL Server Compact and point to the export file. 

Note 

If the option Local offline database as in the screenshot below is greyed out, it means you do not 

have GCAS feature Local Offline Database in your GCAS licence. 

 

You should see the file name on your device panel and use GCAS as usual. However, you would notice 

several differences: 

• This offline database file contains only the devices you have selected in wizard step 1, 

• This offline database file contains data for the limited date range you have set in wizard step 

2, 

• Users who can log in to this offline database file are only you and those who joined the same 

groups as you. 
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33 Work Offline 

GCAS supports offline mode which might be useful in certain scenarios, such as when your network 

connection is disrupted or when you need to take your laptop away to a remote site where internet 

connection is a luxury. To work offline, you need to set up your own temporary database. GCAS uses 

this temporary database while in offline mode. 

Note 

To use this feature, you need the GCAS feature Work-offline Capability to be included in your GCAS 

licence. 

Work-offline is available if your main database server is i-Vigilant central database or your local corpo-

rate database. Offline working is not available for local offline database because it is already offline. 

Some features are not available in offline mode. For instance, you cannot change database, edit your 

profile, edit your password, or use the Administrator menu while working offline. 

33.1 Set Up Temporary Database 

You can either create new temporary database or reuse an existing backup. 

33.1.1 Create New Temporary Database 

Close all open forms to make sure GCAS is not performing any operations to the GCAS database. 

Then, go to the File menu > Work Offline > Initialise Temporary Database. 

 

Do not open any forms or dialogue box while initialisation is in progress. This is to ensure no read or 

write operations are executed upon database. 
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GCAS creates your temporary database located in the [installation directory] \DB-

WorkOffline\your username.sdf. GCAS then synchronises all data since last month from the 

main database server to your temporary database. That is, all data having timestamp greater than to-

day minus one month. On completion, the progress window displays the confirmation message. 

 

To change how much data to synchronise into temporary database, go to the File menu > Work Of-

fline > Work Offline Preferences. Change how many months of data to store on your temporary da-

tabase between 1 month and 24 months (2 years), then do a manual sync to enforce the change. 
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33.1.2 Restore a Backup 

Open the File menu > Work Offline > Use Existing Temporary Database. A file open dialogue should 

appear and you can point GCAS to your backup. 

 

33.2 Synchronise Temporary Database 

To initiate a manual sync between your temporary database and your main database server, first you 

need to work online. Look at the work-offline indicator on the status bar of main user interface, it 

should display “Online”. If not, follow chapter 33.3 to switch into online mode. 

Go to the File menu > Work Offline > Sync Now. 
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Any changes made on the temporary database are first committed to the main database server, then 

your temporary database is refreshed with new data from server. Sync process may take a prolonged 

time if you have ten thousands of unsynchronised records, especially mole composition data. 

Should the progress bar turn red and you see an error message, click on the Error message button to 

see the error log. Or if it turns yellow and you see conflicts, click Resolve conflicts to resolve them. 

Note 

Some cases of stale condition bug (the progress bar halts but the computer does nothing) have been 

reported. Now we implemented stale prevention mechanism. If for any reason you clicked Abort in 

the middle of sync operation, GCAS tries to stop the sync sequence within 10 seconds. If the operation 

couldn't abort after 10 seconds, the form displays the Force abort button. Use this button to termi-

nate all background threads immediately. 

33.3 Going Offline, Going Online 

Manual switch between online and offline mode requires all open forms to be closed. This is to make 

sure that GCAS is not performing any operation onto GCAS database. 

Switch into offline mode: Go to the File menu > Work Offline > Go Offline to switch immediately. 

Alternatively, choose the second menu (Sync then Go Offline). The second menu will initiate a sync 

and afterward switches GCAS to offline mode. 

 

On successful switchover, the work-offline indicator displays “Offline” and there will be a notifica-

tion that you are now working offline. 
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Switch into online mode: Similarly, go to the File menu > Work Offline > Go Online. 

 

On successful switchover, the work-offline indicator on the status bar displays “Online” and also 

there will be a notification that you are now working online. If automatic sync on switchover is turned 

on, GCAS initiates a database sync automatically. 
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33.4 Automatic Sync when Returning Online 

GCAS can start an automatic database sync when you go online. To enable this feature, open the 

Work Offline Preferences dialogue by opening the File menu > Work Offline > Work Offline Prefer-

ences. 

 

Tick Automatically sync to central/online database server when I go online to turn on this feature. 

Next time you work offline and is about to switch into online mode, GCAS synchronises the temporary 

database and the main database server as soon as it enters online mode. 

33.5 Automatic Switchover on Network Problem 

GCAS switches to your temporary database if the network connection between your computer and 

GCAS database server gets interrupted. To enable this feature, open Work Offline Preferences through 

the File menu > Work Offline > Work Offline Preferences. Give a tick mark on Automatically switch 

to temporary database if network connection is lost. 
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In case of network disturbance, GCAS displays an overlay notification telling you that GCAS has 

switched to offline mode. Click anywhere on the overlay to dismiss the notification. 

 

We strongly recommend to close and reopen all open forms. This is because each form retains a 

connection to GCAS database server but the disruption cut this connection. Attempting to continue 

working on open forms may raise an error especially when there is a task to load or reload data from 

the database. Why? Because there is no guarantee the record ID of the same record is the same in 

both main database server and your temporary database. The form can reload the record (the ID still 

the same) but now the ID belongs to a different record, and that may cause wrong calculation. 
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Please do not attempt to go back online should your network connection had not recovered. At-

tempting to do so would make GCAS tries to connect to your main database server, finds it failing, 

and switches back to your temporary database. 

 

33.6 Automatic Resumption of Data Capture 

GCAS stops all data capture operations immediately after it detects network connectivity problem. 

This is because the connection between GC Connect form and GCAS database server was cut during 

this disruption, thus an attempt to commit an incoming new record to database server would yield an 

error. 

If you don't have GCAS feature Work-offline Capability in your GCAS licence, or if you never set up a 

temporary database beforehand, all GC Connect forms remain stopped after the disruption. This is 

particularly bad if you used unattended mode, as no one knows that the operation terminated until 

someone visits the computer. 

With work-offline capability, GCAS can safely resume all data capture operations after switching to 

temporary database. To enable this feature, open Work Offline Preferences dialogue through the File 

menu > Work Offline > Work Offline Preferences. 
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First, automatic switch on network problem must be checked. Then, give a check mark on Resume all 

Modbus operations after a successful switchover. Through this way, all unattended data capture 

operations stop temporarily and continue soon after GCAS enters offline mode. Records committed 

before network disruption are still available on your main database server but records committed after 

network disruption will be stored on your temporary database. You can synchronise records between 

these two databases later after the network connectivity is up again. 

33.7 Automatic Detection of Online Connectivity 

After all the fuss of automatic switchover on network problem, GCAS may ping the database server 

from time to time in order to see if you can return online. To activate this feature, open Work Offline 

Preferences dialogue through the File menu > Work Offline > Work Offline Preferences. 

Note 

This feature works only for offline mode caused by network disruption. GCAS will never ping the data-

base server if you intentionally switched into offline mode as described in chapter 33.3 Going offline. 
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First, automatic switch on network problem must be checked. Next, tick Do a periodic check if GCAS 

can return online and set the desired interval. You can choose ping interval from every single minute 

to every one hour. 

And if GCAS can return online, choose one of the available sub options. 

1. Notify me: GCAS displays a panel notification at the bottom of the main user interface saying 

you can return online. Pick the appropriate decision whether to go online or stay offline. 

 

As a reminder, when you choose to go online, make sure that all open forms have been closed. 

You can reopen these forms later after the switchover. 

2. Automatically switch back to central/online database: GCAS performs another automatic 

switchover to online mode when possible. This is particularly useful for unattended data capture. 

If you choose this option, all data capture operations will once again be stopped during the 

switchover. Tick Resume all Modbus operations after a successful switchover to make GCAS 

resume all data capture operations after entering online mode. Special case if you also enabled 

automatic sync when returning online, the sequence is temporary database sync comes first then 

data capture resumption goes next. 
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33.8 Sync Error Log 

During a database sync, the process may stop when GCAS encounters errors. Red progress bar indi-

cates serious errors, while yellow progress bar indicates less severe errors. Click the Error message 

button to see more details about the error. 

 

Error messages can be as simple (yet fatal) as one message box like this one… 

 

…or more complicated that the errors are displayed in a dedicated window. 
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These kinds of error are usually related to database. For example, the message in first example "Col-

umn name is not valid" means the database structure is incomplete. This indicates the file [in-

stallation directory] \DB-Template\WorkOffline.sdf is corrupt (or outdated) and you 

need to upgrade the GCAS database file. In the second example, "Cannot add or update a 

child row: a foreign key constrain fails" means there are some records missing in an-

other table inside the database, but GCAS needs these records in order to write current record. 

If you use i-Vigilant central database and see Database Sync Error Log such as in the second example, 

click Save error log button and send the file to our support team so that we can look for the cause of 

error. If you use local corporate database, your database administrator (DBA) might help you solve the 

problem. 

GCAS tries to create a backup file of your temporary database before sync process begins. You can 

find the backup in the same directory as your temporary database. Some scenarios might prevent 

GCAS to create this backup though, such as if your hard disk is full. The file resides on [installa-

tion directory] \DB-WorkOffline\your username.sdf.backup. Should these sync errors 

render your temporary database unusable, follow these steps. 

1. Go online and cancel automatic sync (if any; by pressing the Abort button). 

2. Open the File Explorer (“Windows Explorer” on Windows Vista and 7) and navigate to [in-

stallation directory] \DB-WorkOffline\ directory. 

3. Delete your temporary database (your username.sdf) 

4. Rename your username.sdf.backup into your username.sdf 

A better solution is available if you have ever made a proper backup of your temporary database. 

1. Copy your current (broken) temporary database file to somewhere else. 

2. Go online and stop any automatic sync by pressing the Abort button. 

3. Open the File menu > Work Offline > Delete Temporary Database. This will delete the prob-

lematic temp database file. 

4. Open the File menu > Work Offline > Use Existing Temporary Database. 

5. Point to your backup .sdf file. 

6. Do a manual sync to refresh the temporary database file. 

Should all the steps above did not provide remedy to the problem, you might need to delete your 

temporary database and recreate a new one. You may lose data which has not been synchronised to 

the main database server. 

33.9 Conflict Resolution 

A conflict is a mismatch between database record on your main database server and the correspond-

ing record on your temporary database so that GCAS cannot determine which one to keep. GCAS 

keeps track of when a record was changed and uses this information to determine which one is the 

most recent. When a conflict happens, this last-modified information is either equal (meaning that 
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both records were updated at the same time) or unavailable. The probability you would find a record 

conflict is quite rare, nevertheless a slim chance is not zero chance. 

 

When conflicts arise, the sync progress bar turns yellow. Click Resolve conflicts to see what records 

are conflicting. The button brings the Resolve Conflicts dialogue similar to the screenshot down here. 

Conflicting fields are highlighted in yellow. 

 

To resolve one conflict, click the appropriate button whether to Use online record or Use offline rec-

ord. Using online record wins the record on your main database server and replaces the conflicting 

record on your temporary database. On the opposite side, using offline record wins the record on 

your temporary database and replaces the offending record on your main database server. 

Once you clicked the appropriate button, GCAS applies change to both databases and moves on to 

the next conflict if any. To repeat your action whether using online record or offline record for a par-

ticular database table, first tick Repeat my action for all conflicts on the same table and then click 

the appropriate decision whether to Use online record or Use offline record. GCAS applies the same 

action for all conflicts on the same database table in the queue. Eventually GCAS may load a conflict 
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of a different database table; GCAS will display both records and ask you to review and decide an ac-

tion again. At the end, when all the conflicts have been resolved, the dialogue closes automatically. 

Note 

To leave all conflicts as they are, i.e. to let the records be different between your main database and 

your temporary database, close the Resolve Conflicts dialogue using the close (×) button on the title 

bar. GCAS will ask you to resolve them later upon next sync operation. 

33.10 Login Form in Offline Mode 

When you are working offline, you can also log out from GCAS as usual (or be automatically logged 

out for inactivity). However please notice that the login form is in offline mode now. A warning icon 

appears on the right side of Quit button. 

 

 

During offline mode, only users who already set up their temporary databases can log in. 

Login form in offline mode behaves differently compared to normal (online) mode. As in online mode, 

GCAS is continuously connected to GCAS database server so that any login attempt is immediately 

verified against user credential in the database server. However in offline mode, the login form first 
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checks if the user has his temporary database available, then verifies the login attempt against creden-

tial stored inside his temporary database. This is why users without temporary databases (i.e. never set 

them up before) cannot log in to GCAS. 

In an unfortunate scenario where you have never set up your temporary database, you would not be 

able to log in during offline mode. You can force GCAS to return online and here are the steps to do 

so. 

1. Verify that your network or internet connection is working. 

2. Exit GCAS through the Quit button on the login form. 

3. Run GCAS with an additional /online parameter. 

4. GCAS is now back in online mode. 

5. Log in as usual, and now is the chance to set up your temporary database. 

 

33.11 Online/Offline Mode Persistence 

By default, GCAS assumes online mode every time it is launched. If you choose to work offline, GCAS 

enters offline mode until you exit the software but returns to online mode on the next time you run 

the software again. 

You can make GCAS stay in offline mode even after you exit GCAS. To do so, open Work Offline Pref-

erences dialogue through the File menu > Work Offline > Work Offline Preferences. Give a tick on 

Remember current state (offline/online) for the next time GCAS is launched. 
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When you switch to offline mode and exit GCAS, the login form will stay in offline mode upon next 

time you launch GCAS. 

Warning 

Only users who have set up their temporary database can log in during offline mode. 

To override the initial mode, run GCAS with one of the following parameters: 

• /online : Forces online mode. 

• /offline : Forces offline mode. 
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33.12 Maintenance of Temporary Database 

To perform maintenance, you need to go online. Then open the File menu > Work Offline > Maintain 

Temporary Database. It contains all submenus to perform database maintenance. 

 

Menu What it does 

Information Displays the size of your temporary database file, how much data stored in it 

(i.e. the timestamp of the earliest data available), and also the date and time of 

last sync operation. 

Compact Tries to shrink the size of your temporary database file by consolidating sparse 

free spaces similar to defragmenting a hard disk.  

Verify Uses the built-in verification feature on Microsoft SQL Server Compact Edition 

in order to check that all tables and indexes are not corrupt. If verification re-

sult says the database is corrupted, try the Repair menu. 

Repair Should the Verify menu reported a problem on your temporary database, this 

menu attempts to repair the file. 

Backup Makes a backup copy of your temporary database. To restore from this 

backup, use the Restore menu. Otherwise if you have deleted your temporary 

database, go to chapter 33.1.2 Restore a backup to reuse this backup file. 

Restore Replaces your current temporary database with a backup. 
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33.13 Deactivate Offline Working 

To deactivate this work-offline feature, you need to go online. It is a good idea to synchronise your 

main database server with your temporary database for the last time, in order to make sure there are 

no pending data in your temporary database which have not been synchronised to your database 

server. Then, open the File menu > Work Offline > Delete Temporary Database. 

 

This will delete your temporary database file. You cannot work offline until you set up a new tempo-

rary database or open an existing backup. 
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34 Diagnostic and Maintenance 

This chapter attempts to assist you in case of errors and malfunctions of GCAS.  

34.1 Diagnostic Mode 

On rare occasions of malfunctions such as exceptions, unhandled exceptions, crashes, or wrong calcu-

lations, you can run GCAS in diagnostic mode to collect additional information about the reason for 

the malfunction to happen. On diagnostic mode, GCAS displays an additional window that acts like a 

debugger output window. When you report a bug to us, this diagnostic log helps us a lot in order to 

resolve the problem. 

Start GCAS with an additional parameter /enablediagnostic to activate diagnostic mode. Formerly it 

was "/enablediagnostics" (with an incorrect "s" at the end of word), now it is "/enablediagnostic". 

 

The diagnostic window looks like a console. GCAS runs normally alongside this window and you can 

use the software as usual. 

http://en.wikipedia.org/wiki/Exception_(computing)
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You can minimise or close the diagnostic window at any time. The diagnostic window continues to 

output debug information even after it is closed. To show the window again, go to the Diagnostics 

menu > View Log Window. 

 

To save the diagnostic information, use the  Save button on the toolbar. Alternatively you can copy 

the contents through the  Copy button then paste it onto notepad or any text editor. 

Info 

If GCAS crashed, it might not be possible to use the Save or Copy button on the toolbar because the 

user interface is frozen (white-shadowed) by Windows operating system. A screenshot of this frozen 

diagnostic window should suffice to help us understanding what the reason and at which point the 

error happened. 
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34.2 What Happened to Bug Report Wizard? 

Unfortunately, we disabled Bug Report Wizard due to policy changes of our third-party mail provider. 

In the past, Bug Report Wizard worked by sending your report and all additional attachments (diag-

nostic log and optional screenshots) via email to our development team behind the screen. However, 

our mail provider didn’t seem happy and made few changes in their terms of use. For that reason, we 

need to temporarily disable the Bug Report Wizard until we developed a new reporting mechanism 

which doesn’t involve SMTP (email). Bug Report Wizard has disappeared since GCAS version 1.7.2.0. 

For the time being, please send your bug report with any additional attachments such as diagnostic 

log, stack trace, or screenshots to support@i-Vigilant.com.  

  

mailto:support@i-Vigilant.com
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35 GCAS Startup Parameters 

Startup parameters are optional arguments used to run GCAS or GCAS Activator, with the intention to 

enable or disable some advanced functionality. 

Below is a list of additional start up parameters for GCAS (GCASMain.exe). 

/changedatabase : Displays the Change Database dialogue only. GCAS terminates 

immediately after you click the OK button. This parameter can-

not be combined with any other parameters. 

/online :  Forces online mode. Cannot be combined with /offline switch. 

/offline : Forces offline mode. Cannot be combined with /online switch. 

Only users who have set up their temporary database can log in 

to GCAS. 

/disablefilecheck : Disables the integrity check during startup. GCAS will not check 

the files inside the installation directory for any unauthorised 

changes. 

/disablekeepalive : Turns off the database ping timer. Database ping timer sends a 

ping to your database server once every 30 seconds. This is be-

cause some database servers disconnect the client if there were 

no activity for a certain interval. By running GCAS with this pa-

rameter, ping timer will not run and GCAS database server may 

terminate your connection for extended period of inactivity. 

/disableexcel : Disables the Microsoft Office interop module. That is, Export 

Data to Excel won't be available, Copy to Excel button on the 

Comments form will be greyed out, Export Values to Excel button 

on the Mole Composition Comparison form will be disabled, Ex-

port to Excel button on MLC offline converter tools will be una-

vailable, and pretty much everything that exports directly to Mi-

crosoft Excel. Use this switch if you see "COM exception" contin-

uously every time you use features related to Microsoft Excel. 

/enablediagnostic : Activates the diagnostic mode. 

/confirmimport : Causes GCAS to display a confirmation dialog whenever you im-

port a footprint or calibration data from a text file. Clicking Can-

cel on the confirmation dialog will abort the import process. 

/modbusbase:X : Translates the base register address from the default 0 (zero) to 

any number you have specified. There is a colon (:) between 

“modbusbase” and the number, but there must not be any 
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spaces between modbusbase, the colon, and the number. This 

works Modbus client module only, not for Modbus server mod-

ule. 

For example, /modbusbase:40000 specifies base address 

40000 instead of 0. This switch is only used for certain GC de-

vices and on specific circumstances. 

/disablecalibrationcache : By default, whenever you open GC Connect form, the latest RF 

and RT data for that device is cached. If the first poll returns the 

exact same RF and RT data, this incoming record is not regarded 

as a new data, thus GCAS avoids duplicated RF/RT data. 

This switch disables the caching behaviour. If you run GCAS with 

/disablecalibrationcache, latest RF/RT data is not cached during 

the launch of GC Connect form. 

/drawincompleteRFRT : If GCAS was instructed to ignore RF or RT data during data cap-

ture, GCAS assigns a special value −1 to all RF or RT values. This 

−1 value is not drawn on Data Analysis form. Using this switch 

overrides the behaviour; −1 values are always graphed. 

/disabledoublebuffering : Disables double buffering on your graphic card when rendering 

GCAS main form. Use this switch if you experience display prob-

lem or performance drop when using GCAS. 

/drawemptyUT : Forces GCAS to reveal empty points in Uncertainty Trend chart 

or Component Uncertainty Trend chart. 

Empty points are data points that only has X value, without Y 

value or its Y value is undefined. Example of empty points is 

when you set the uncertainty trend in forward direction and the 

minimum number of data is 10, then the first 9 calibration data 

after a footprint are marked as empty (hence is not drawn on the 

chart and you see a gap). 

With /drawemptyUT, GCAS draws grey dots for empty points. 

The X values of these grey dots are valid (correspond to dates 

and times on X-axis correctly), but their Y values are meaning-

less. 

/disableUTcache : Disables cache in the Uncertainty Trend module. GCAS caches 

the calibration certificate and footprint reference while calculat-

ing uncertainty values. Disabling the cache means GCAS will al-

ways retrieve the footprint and certificate values from database. 

This makes calculation time becomes longer. 

http://en.wikipedia.org/wiki/Multiple_buffering#Double_buffering_in_computer_graphics
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/excludefootprintUT : Forces GCAS to exclude the last footprint while calculating un-

certainty values in Uncertainty Trend module. 

On normal forward calculation, the data included to calculate the 

uncertainty at one point is taken from the last footprint (includ-

ing the footprint itself) up to this point. This switch causes GCAS 

to exclude that last footprint, so data range starts from one cali-

bration after the footprint. 

On normal backward calculation, the data included to calculate 

the uncertainty at one point is taken from that point and travels 

backward. If you set GCAS to trim at footprint, the last footprint 

is included in the calculation but it stops (hence the footprint is 

the last data). With /excludefootprintUT, GCAS stops at one 

calibration after the footprint. Nevertheless, if you set GCAS to 

continue through (include data before footprint) then this switch 

has no effect. 

/UTdiagnostic : Activates the Uncertainty Trend diagnostic. 

/normaliseISO6976 : Forces ISO 6976 Calculator to always normalise input composi-

tion even if it is BTEX composition or single-gas composition. 

/normaliseGPA2172 : Forces GPA 2172 Calculator to always normalise input composi-

tion even if it is H2S composition. 

/normaliseuncertainty : Forces Uncertainty Calculator, Uncertainty Trend, uncertainty cal-

culation in Dashboard, and anything related to uncertainty cal-

culation to always normalise the calibration certificate's mole 

composition values even if it is BTEX composition or single-gas 

composition. 

/allowMLCzerocertmole : Disables a safeguard on ISO 10723 conversion where zero mole 

composition value of a gas in a calibration certificate would be 

replaced with 0.0001.  

Using this switch will produce NaN (Not-a-Number) or infinity 

value on gases not present in the calibration certificate because 

the calculation will encounter divide-by-zero operation. 

 

Additionally, these are a list of advanced start-up parameters for GCAS Activator 

(GCASActivate.exe). 

/? : Displays a quick help in a console window or a message box. 
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/info : Displays the details of the licence and registration key installed on 

your computer. 

/compcode : Displays the computer code of your computer. 

/install <licence string> : Installs the specified GCAS licence, or replaces currently installed li-

cence with a new one. Cannot be combined with /revoke parameter. 

Recommended to combine /install with /regkey parameter so that 

you install the licence and registration key in one go. 

/regkey <6-digit regis-

tration key> 

: Installs the specified registration key, or replaces current registration 

key with a new one. Cannot be combined with /revoke parameter. 

/revoke : Uninstalls the current licence and registration key from your com-

puter. Cannot be combined with /install nor /regkey. 

/silent : Do not display any message boxes or confirmation messages. Com-

bine this switch with /install, /regkey, or /revoke. 

Note  

GCAS Activator (GCASActivate.exe) requires elevation. Run GCASActivate.exe on an elevated 

command prompt (run as administrator) to use the commands above. 

 

**End of Document** 
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